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Chapter 1. Release Notes

Operations Hub Release Notes
This topic provides a list of product changes in Operations Hub for this release.

Version: 2023

• What's New  (on page 3)

• Known Issues and Limitations  (on page 4)

• Fixed Defects  (on page 9)

• Compatibility Matrix  (on page 13)

What's New

Table  1. Enhancements and New Features

The following enhancements and new features have been added.

Description Tracking IDs

An integrated installer  (on page 20)  to install the latest version of Opera

tions Hub and Common Components.

F64682

New and improved Operations Hub user interface:

• Getting Started with Operations Hub  (on page 15)

• Panels Layout  (on page 138)

• Navigation Panel  (on page 139)

• Components Panel  (on page 142)

• Display Panel  (on page 152)

• Details Panel  (on page 157)

• Page Grid Details  (on page 159)

• Coordinate Card  (on page 169)

• Flexbox Card  (on page 161)

• Interactive Map  (on page 170)

• Repeater  (on page 172)

• Page Building Tools  (on page 154)

• Line Connector  (on page 155)

F63201, F63378, 

F63765, F63927, 

F64147, F63848, F65438
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Table  1. Enhancements and New Features

The following enhancements and new features have been added.

(continued)

Description Tracking IDs

Added a list of out-of-the-box high-performance HMI graphics, and an SVG 

graphics editor to create custom graphics. See About HMI Graphics  (on page 

173).

F65222

Enhanced preview  (on page 143)  of the real-time data within the page de

signer.

F64025

Export partial model  (on page 345). F56941

Automatic binding of dynamic properties on plug-ins. Refer to Fetch Data 

Property  (on page 159).

F62070

Ability to programmatically authenticate by 3rd-party software, as well as per-

device pre-authentication.

US554920

Known Issues and Limitations

Table  2. Known Issues and Limitations

The following known issues and limitations exist.

Description Tracking ID

Applies to the following plug-ins when importing applications from an older 

version of Operations Hub Classic to Operations Hub 2023.

• Image  (on page 588)

• Indicator  (on page 635)

Issue: When you import an App to the new system, the plug-in’s image source 

settings are altered.

• In the Image plug-in, Image Source  > Type  is altered.

• In the Indicator plug-in, Background Image Mode  > Type  is altered.

DE198548



Operations Hub for Windows  | 1 - Release Notes  | 5

Table  2. Known Issues and Limitations

The following known issues and limitations exist.

(continued)

Description Tracking ID

Workaround: Access the Image/Indicator plug-in in the imported App and 

change the altered Type  back to its original type settings. The original source 

information (if exists) is retrieved.

In a trend chart, if you add a tag that is identical to the one that is already 

plotted but the case of the tag name does not match the case of the tag 

name in Historian, a straight line appears in the trend chart. To resolve this is

sue, modify the tag name to match the case of the tag name in Historian.

DE123833

During Operations Hub  installation, when you provide the tenant user ID, the 

following conditions apply:

• If you are installing Operations Hub  for the first time, do not provide 

StudioAdmin as the tenant user ID because it is used by Operations 

Hub.

• If you want to use a shared Proficy Authentication (UAA) to work with 

Operations Hub, do not provide the user ID of an existing user of the 

UAA instance. If you do so, the installation fails.

• If you are installing Operations Hub  after uninstalling it without purge, 

do not provide a tenant user ID that matches any previously used user 

ID (including any previously used tenant ID). This is because after 

you uninstall Operations Hub  without purge, previous Operations Hub 

users (along with tenant administrators, their groups, and privilege as

signments) still exist in the database.

DE123770

When you create a data source, you can provide a certificate only in the 

base-64-encoded format. A DER-encoded certificate is not supported.

DE116706

Operations Hub  uses Kafka, which generates a large number of logs in the 

following location: C:\tmp\kafka-logs\. To avoid consuming too much 

space for these logs, we recommend that you periodically delete the logs, es

pecially if the system has low disk space.

N/A
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Table  2. Known Issues and Limitations

The following known issues and limitations exist.

(continued)

Description Tracking ID

If you encounter intermittent responsiveness issues with the Operations Hub 

runtime environment when using the Safari browser on your mobile device, it 

is recommended that you use the Chrome browser instead.

DE131011

When adding environment variables to Windows System Variables, be aware 

that environment variables are case-sensitive. If your environment variables 

in Operations Hub  do not match the case of the ones used by the target His

torian Server, the data source will fail when tested. Be sure that you use the 

same case when configuring data sources in Operations Hub. A data source 

target in Operations Hub  should match the case in the environment variables, 

as the variables are case-sensitive.

DE130896

Historian REST response time increases exponentially when there are over 30 

users logged into Operations Hub accessing an End app that utilizes Histori

an REST queries.

DE134904

When using Safari 13+ on iOS, trend card functionality like adding tags to the 

trend, favorites, and annotations perform inconsistently. The workaround is 

to use the Chrome browser on the iPad.

DE136597, DE149433

If a Historian data point being trended transitions to a bad quality (such is 

the case when a collector goes down or loses communications), the trend 

card displays a flatline for the last known good value. If you experience one 

or more flatlines in your trends, and all the various requests from the same 

source, you should check the communication chain for an issue with Histori

an, a collector, or a SCADA driver, for instance.

DE138128

There are currently some page printing issues. For instance, if you have 

iframe that spills over to a second page, that can cause an issue.

DE146462

The uaa-provisioning.log  file generates in a new folder if the location path 

provided during Operations Hub installation contains a space in it. For exam

ple, C:\Custom Logs.

DE148827

As a workaround to address VC++ (x64) failure, follow these steps to install 

Task Client on Operations Hub 2.1.

DE161643
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Table  2. Known Issues and Limitations

The following known issues and limitations exist.

(continued)

Description Tracking ID

1. Uninstall the VC++ 2015-2019 Redistributable (x64) version installed 

with Operations Hub 2.1.

2. Open the Workflow install media, navigate to the  \Installers\Re

sources\Microsoft\2015_2019  folder, and run the vc_redist.x64.exe.

3. Open the Services console dialog and restart these services:

◦ GE Operations IQP PostgreSQL Database

◦ GE Proficy Authentication PostgreSQL Database

4. Install Workflow Task Client.

5. Install the VC++ 2015-2019 Redistributable (x64) version that got in

stalled with Operations Hub 2.1.

If the Data Distributor service started at a time when the datasource was of

fline, reload the end application.

DE158762

For REST connection, if you enter an IP address instead of the hostname in 

the Auth URL  field, it results in a 404 error. You must add the IP address to 

the list of supported subdomains/zones. To do this:

1. Browse to the location directory on the machine where Operations Hub 

is installed: ..\ProgramData\GE\Operations Hub\uaa-config

2. Open the uaa.yml  file in a text editor.

3. Search for hostnames  in the file, and enter the IP address.

4. Save and close the file.

5. Restart Proficy Authentication for the changes to take effect.

DE153631

When importing a model containing a second CIMPLICITY namespace table, 

it overwrites the values in the first namespace table.

Workaround: Combine the server and namespace information from the two 

namespace tables into one namespace table, and then import the model 

again.

DE47669

The inline mimic write operations performed in Operations Hub are indicated 

as successful even if the entries did not meet the criteria of these CIMPLICI

TY attributes.

DE156030

https://www.ge.com/digital/documentation/workflow/t_wf_install_task_client.html
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Table  2. Known Issues and Limitations

The following known issues and limitations exist.

(continued)

Description Tracking ID

• WARNING_LOW_N

• WARNING_HIGH_N

• ALARM_LOW_N

• ALARM_HIGH_N

The values do not get updated to the CIMPLICITY point control panel.

Error message does not appear when you perform a write operation on a 

CIMPLICITY tag value that is outside of a given range.

DE157698

If you select Acknowledge All  in Operations Hub to acknowledge 5000 iFIX 

alarms, an internal error occurs in the iFIX application.

DE161742

Only a single instance of the CIMPLICITY HMI Webspace widget per app is 

supported. If using multiple instances of webspace widgets across multiple 

pages, you may encounter access error messages when navigating between 

pages that contain webspace instances. After confirming the message, the 

widget loads as expected.

The typeName  parameter in the custom widget’s manifest.json  file does not 

support special characters.

DE162893

For Operations Hub 2022 release, Proficy Authentication server validation 

fails while installing Workflow Task Client. As a workaround to fix this issue, 

please refer to Resolving Proficy Authentication Issue During Workflow Task 

Client Install  (on page 690).

DE174960

In Operations Hub 2022.4.1, line chart legend is not updating based on the 

updated parameters for the chart. The line chart always shows only the ini

tially fetched data for a query.

If an App uses multiple nested containers and a large number of queries, it 

impacts the page load performance.

DE170644

While using the trend card on iOS 15 Safari browser, the tags in a drop-down 

menu are not displaying properly. This occurs when there is more than one 

page in an App.

DE184797
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Table  2. Known Issues and Limitations

The following known issues and limitations exist.

(continued)

Description Tracking ID

The following issues are noticed in Operations Hub on Android device:

• Unable to select data sources from the Add Sources  (on page 625) 

dialog to configure a trend card.

• Unable to navigate between multiple pages in the End App.

DE184895, DE184901

If you create a display condition for a widget (or container), the widget (or 

container) is hidden regardless of the condition not being met. Condition al

ways defaults to true at runtime.

DE184491

In Histogram, when X-axis range is provided manually, the bins towards the 

left and right end of the chart get truncated.

DE186605

Unable to publish iFIX / CIMPLICITY screens to Operations Hub using a re

mote Proficy Authentication (UAA) instance.

DE197305, DE197304

Unable to publish model from CIMPLICITY project to Operations Hub using a 

remote Proficy Authentication (UAA) instance.

DE197366

Currently in Operations Hub page designer, every undo and redo action caus

es a redraw of all the elements on the page.

DE196399

Fixed Defects

Table  3. Fixed Defects

The following fixed defects have been addressed with this version of Operations Hub.

Description Tracking ID

Previously, the logged-in user was able to delete the currently logged-in ac

count in Operations Hub. This option has been disabled now.

DE161913

Previously, lengthy comments for an application were cut off and not view

able. This issue has been resolved.

SF00988397
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Table  3. Fixed Defects

The following fixed defects have been addressed with this version of Operations Hub.

(continued)

Description Tracking ID

UAA Tomcat, IQP Tomcat, and WebHMI Tomcat default logging level is DE

BUG or INFO. As a result, the logs occupied a large space on the disk. To fix 

this issue, option has been provided to customize logging.

SF01020127

Previously, the Image widget was not displaying a picture when using "Data" 

type source with the global variable pointing to the graphic file. This issue 

has been resolved.

SF01014509

Previously, MQTT slow response impacted page load performance. It has 

been advised to make use of a time series database, which is optimized to 

respond to a huge volume of entries.

SF01005733

Previously, when the Alarm Card and the DatePicker were on the same page, 

alarms did not function properly at runtime. This issue has been resolved.

SF01025355

Previously in Datagrid, clearing the check boxes of multiple records did not 

clear the global values. This issue has been resolved.

SF01026826

On evaluating a customer's Operations Hub database after migrating from 

v2.1 SIM 1 to v2022.6, a script has been shared as a utility to be down

loaded from a GE site. This fix is not shared with the ISO.

DE187417

Previously, favorites were not displayed if the logged in username and the 

userid associated to the favorites did not match. This issue has been re

solved.

DE187418

Previously, favorites associated to the Historian data source did not load if 

the data source was renamed. This issue has been resolved.

SF01034617

Previously after export/import operations, the interactive map image and 

marker images were replaced with other images. This issue has been re

solved.

SF01038767

Previously, the Dropdown plug-in values did not update properly in a cascad

ing query setup. This issue has been resolved.

SF01036385

Previously, performance issues were found when using the TrendCard and 

Analysis App. This issue has been resolved.

SF01041427
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Table  3. Fixed Defects

The following fixed defects have been addressed with this version of Operations Hub.

(continued)

Description Tracking ID

Previously, applications with Graph and Grid had display issues on importing 

to an upgraded version of Operations Hub. This issue has been resolved.

SF01039456

Previously, if the Button and TrendCard were added to a page, the button’s 

background color did not appear at runtime. This issue has been resolved.

DE190017

Previously, duplicate entries were added to the favorites dropdown list. This 

issue has been resolved.

SF01040011

Previously, it was not possible to login to Operations Hub as the login page 

did not appear. This issue has been resolved.

SF01043266

Previously, the database backup was failing due to open connections to the 

database. This issue has been resolved.

SF01044295

Previously in graph/chart, decimals could not be rounded off for axis values. 

This issue has been resolved.

SF01047164

The 'GE Operations Hub WebHMI Tomcat Web Server' service was not prop

erly working. This issue has been resolved with a recommendation to unin

stall and reinstall Operations Hub.

SF01045505

Previously, the date and time range picker formats were not applied as per 

the selection in the page designer. This issue has been resolved.

SF01036329

Previously, if object names in an asset model had Norwegian letters, then 

the app using the model failed to open. This issue has been resolved.

SF01008446

Previously, events did not trigger after they worked properly for a while. The 

web services had to be restarted to get them to work. This issue has been 

resolved.

SF01012500

Previously, only the events that had device conditions were not getting trig

gered. This issue has been resolved.

SF01015339

Previously in Interactive Map, two sets of Marker Type  property appeared 

for one marker. This occurred whenever 'add URL' action was set as the first 

action for the marker. This issue has been resolved.

DE191933
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Table  3. Fixed Defects

The following fixed defects have been addressed with this version of Operations Hub.

(continued)

Description Tracking ID

Previously in the UAA localhost_access_log, a user's password from the 

Rest API data source appeared in plain text. It was not encoded. This issue 

has been resolved.

SF01050499

Previously, error occurred on entering a lengthy comment in the text box. 

This issue has been fixed by adding a 500 character maximum length to the 

text area box.

DE189751

Previously, adding an output parameter to a query led to errors. This issue 

has been resolved.

SF01039294

Previously, container border did not appear on selecting container based 

height check box. This issue has been resolved.

SF01057076

Previously, removing any part of the LDAP configuration in the Security ap

plication, disabled the Submit  button. This issue has been resolved.

DE191928

Previously on the solid gauge, the dynamic range property added alert limits 

to the gauge instead of ranges. This has been fixed with proper labelling of 

the property.

DE195436

Previously on the Trend Card, tag descriptions were not being displayed 

even if the Trend Configuration Display Mode was set to tagDesc  in the 

JSON input. Instead, only the tag names were being displayed, regardless of 

the input. This issue has been resolved.

DE195435

Previously, the end-user could not configure the time axis on the Trend Card 

to display in a 24-hour time format. This issue has been resolved.

DE197530

Previously, the asset import failed with the definition of #AssetInstanceEnti

tyMetadata  while importing a large file. This issue has been resolved.

DE197533

Previously, performance issues were encountered with the Analysis App 

when switching from the live mode to historic mode. This issue has been re

solved.

DE197537
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Compatibility Matrix

Table  4. Compatibility Matrix

The following products are compatible with Operations Hub.

Product Required Version

Proficy Historian • Historian 2023

• Historian 2022

Note:

Historian REST APIs are required for REST inte

gration between Operations Hub and Historian. 

Historian REST APIs are installed automatically 

when you install Historian web-based clients.

Proficy Plant Applications For feature-specific compatibility, refer to the table be

low.

• Plant Applications 2023

• Plant Applications 2022

Configuration Hub Configuration Hub 2023

Proficy Authentication (UAA) Proficy Authentication 2023

Proficy iFIX • iFIX 2023

• iFIX 2022

Proficy CIMPLICITY • CIMPLICITY 2023

• CIMPLICITY 2022

Industrial Gateway Server IGS OPC Server 7.68 and later

Proficy Workflow Workflow Task Client 2.6 SP1 SIM5

GE Common Licensing Version 20.4.2182 and later

The following table lists feature-specific compatibility for Plant Applications version.
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Operations Hub 2023 Features Plant Appli

cations 8.2

Plant Appli

cations 2022

Plant Appli

cations 2023

Classic Designer Layout:

• Add pages

• Add Plant Applications widgets to 

pages

Yes Yes Yes

Classic Designer Layout:

• Able to view content at runtime

Yes Yes Yes

New Designer Layout:

• Create content with Plant Applica

tions widgets

No No No

New Designer Layout:

• Able to launch applications with con

tent created in the classic designer 

layout

Yes Yes Yes



Chapter 2. Getting Started with Operations Hub

Getting Started with Operations Hub
This topic describes how to work with Operations Hub using the latest (HMI powered designer) and the 

classic version.

With 2023 release, Operations Hub is now available as a plug-in in Configuration Hub. The latest version 

is equipped with a HMI designer layout, and has enhanced plug-in functionality. All the features from the 

classic version of Operations Hub are also available in this latest version.

1. Install the latest version of Operations Hub. Refer to Use Integrated Installer  (on page 20).

2. Log in to the Operations Hub classic  (on page 62)  and set up the following:

◦ Data Sources  (on page 351)  (required)

◦ Queries  (on page 247)

◦ Entities  (on page 225)

◦ Themes  (on page 394)  (optional)

3. Log in to the latest version of Operations Hub via Configuration Hub.

a. Double-click the Configuration Hub desktop shortcut.

b. Log in with the credentials that you specified during installation.

c. On the Configuration Hub navigation panel, navigate to the Operations Hub home page. For 

more information on using the Operations Hub new layout, refer to Panels Layout  (on page 

138).

4. Create an application  (on page 204).

5. Create pages for your application  (on page 376).

6. Use the following features to design your application pages:

◦ Page Grid Details  (on page 159)

◦ Design a layout using the coordinate card  (on page 169).

◦ Design a layout using the flexbox card  (on page 161).

◦ Apply format tools to design your pages  (on page 154).

◦ Connect plug-ins with a line connector  (on page 155).

◦ Animate HMI graphics  (on page 173).

◦ Bind data to your plug-ins  (on page 147).

7. Save the application pages, and preview the end application.
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Installing Operations Hub

System Requirements
This topic provides the requirements for hardware components, browsers, and operating systems.

When you install Operations Hub, all the required components are automatically installed.

Minimum Hardware Requirements

You can install Operations Hub  on a processor with 4-core configuration and a RAM of 16 GB.

To support up to 300 concurrent users, you need a hardware configuration of at least 32GB and an 8-core 

CPU.

Supported Operating Systems

You can install Operations Hub  on any of the following desktop operating systems:

• Microsoft Windows Server 2019

• Microsoft Windows Server 2022

Operations Hub can also be installed on VMs deployed on Azure and AWS.

Supported SQL Versions

You can use Operations Hub  with external data sources from the following relational databases:

• Microsoft SQL Server 2016

• Microsoft SQL Server 2017

• Microsoft SQL Server 2019

Supported Browsers

You can access Operations Hub  using any of the following web browsers:

• Google Chrome (recommended)

• Mozilla Firefox

• Apple Safari

• Microsoft Edge
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We recommend using a resolution of 1600 x 1200 for the browser. In addition, use a relatively modern 

device so that the browser has enough resources to render the visualizations and respond to user 

interactions with adequate performance.

The following mobile devices are supported for client access (end-app support only):

• iOS 12.0 and later

• Android 9.0 and later

Note:

We recommend using a device with medium to high resolution, and in landscape mode.

Compatibility Matrix

The following products are compatible with Operations Hub.

Product Required Version

Proficy Historian • Historian 2023

• Historian 2022

Note:

Historian REST APIs are required for REST inte

gration between Operations Hub and Historian. 

Historian REST APIs are installed automatically 

when you install Historian web-based clients.

Proficy Plant Applications For feature-specific compatibility, refer to the table be

low.

• Plant Applications 2023

• Plant Applications 2022

Configuration Hub Configuration Hub 2023

Proficy Authentication (UAA) Proficy Authentication 2023

Proficy iFIX • iFIX 2023

• iFIX 2022
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Product Required Version

Proficy CIMPLICITY • CIMPLICITY 2023

• CIMPLICITY 2022

Industrial Gateway Server IGS OPC Server 7.68 and later

Proficy Workflow Workflow Task Client 2.6 SP1 SIM5

GE Common Licensing Version 20.4.2182 and later

The following table lists feature-specific compatibility for Plant Applications version.

Operations Hub 2023 Features Plant Appli

cations 8.2

Plant Appli

cations 2022

Plant Appli

cations 2023

Classic Designer Layout:

• Add pages

• Add Plant Applications widgets to 

pages

Yes Yes Yes

Classic Designer Layout:

• Able to view content at runtime

Yes Yes Yes

New Designer Layout:

• Create content with Plant Applica

tions widgets

No No No

New Designer Layout:

• Able to launch applications with con

tent created in the classic designer 

layout

Yes Yes Yes

Licenses for Operations Hub
This topic describes the licenses available, and the differences between them.

Install the licensing client software from the Operations Hub ISO right after installing Operations Hub.



Operations Hub for Windows  | 2 - Getting Started with Operations Hub  | 19

Note:

Previous licensing is replaced with Proficy licensing. For information on installing and configuring 

your license, refer to the GE Support site.

These are the three license levels for using Operations Hub.

Trial Version

If you do not have a license yet, you can start with a trial version that lasts for a period of two hours, and is 

limited to a single user.

Operations Hub Add-On for Historian

It is available as an Add-On when you purchase Proficy Historian. This is the only application provided for 

this tier with limited functionality. Refer to the Functionality Comparison  (on page 19)  table to compare 

with the full product functionality.

Analysis Tier

With this tier, you have complete access to Operations Hub end-to-end functionality.

Functionality Comparison

Functionality
Operations Hub Add-

On for Historian
Analysis Tier

Ability to create, edit, and delete data sources Yes Yes

Ability to create, edit, and delete entities Yes Yes

Ability to create, edit, and delete queries Yes Yes

https://ge-ip.force.com/communities/en_US/Article/GE-Intelligent-Platforms-Software-Product-Licensing
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Functionality
Operations Hub Add-

On for Historian
Analysis Tier

Ability to assign permissions for events Yes Yes

Ability to view Out of the box Analysis App Yes Yes

Ability to create, edit, and delete apps No Yes

Ability to assign permissions for apps Yes Yes

Ability to assign permissions for app pages Yes Yes

Ability to create, edit, and delete users Yes Yes

Ability to change your own password Yes Yes

Ability to create, edit, and delete roles Yes Yes

Ability to map existing UAA groups Yes Yes

Ability to map Existing LDAP groups Yes Yes

Use Integrated Installer
This topic describes how to use the integrated installer to install Operations Hub.

The latest version of Operations Hub is distributed as follows:

• Dedicated installer: Enables to install the common components and Operations Hub.

See Install Operations Hub from a Dedicated Installer  (on page 21).

• iFIX or Cimplicity installer suite: Enables to install the common components and Operations Hub 

along with additional Proficy applications.

See Install Operations Hub for SCADA  (on page 28).

Note:

It is highly recommended to first install common components (Configuration Hub and 

Proficy Authentication) followed by any additional product installations. See Install Common 

Components  (on page 33).
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Note:

If installing Operations Hub remotely from Configuration Hub, make sure that the Operations Hub 

certificate is trusted by Configuration Hub. If not trusted, then the request to load plug-ins gets 

blocked. See Install the Certificate on your Clients  (on page 41).

About Upgrading Operations Hub

If Proficy Authentication version is older than Operations Hub version you are upgrading to, then you will 

be requested to first upgrade or uninstall Proficy Authentication. The request does not appear if Proficy 

Authentication version is same or greater than Operations Hub upgrade version.

Do not uninstall Proficy Authentication if other Proficy products are using the application. Choose to 

upgrade to the latest version.

Install Operations Hub from a Dedicated Installer
This topic describes how to install Operations Hub from its dedicated installer.

• Ensure that the machine on which you want to install Operations Hub  meets the System 

Requirements  (on page 16).

• Use a machine that does not host any applications that are bundled with Operations Hub.

• Run a Windows update (including security updates).

• Use a host name that contains up to 24 characters and any of the following characters:

◦ Alphabetic characters

◦ Numeric characters

◦ Minus

◦ Period

• Ensure that you have administrative privileges to the machine on which you want to install 

Operations Hub.

Consider these points during installation:

• First time installation: You can choose to provide the same user name and password for 

Operations Hub tenant admin and Configuration Hub. This will allow you to use the same 

credentials to log in to both the applications.

• Re-installation: If re-installing Operations Hub without DB purge  (on page 78), provide the same 

user name and password as the earlier install. If you provide a different set of credentials other 

than the tenant admin credentials used in the initial install, the user ID will not match what already 

exists in Proficy Authentication (UAA). As a result, users will not be able to log into Operations Hub.
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1. Download the Operations Hub 2023 ISO install media from the Salesforce and mount the file.

2. From the ISO folder, double-click Setup.bat  to run the file.

The welcome screen appears.

3. On the welcome screen, you must first install Configuration Hub and Proficy Authentication before 

installing Operations Hub.

For step-by-step instructions, refer to Install Common Components  (on page 33).

4. On the welcome screen, select Operations Hub.

5. Accept the license agreement to continue with the install.

The Install Location  screen appears and validates for port conflicts.

6. Browse and select a location for installation, then continue to the next screen.
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If port conflicts are detected, you must fix them before proceeding to the next screen.

If there are no conflicts, the Operations Hub Credentials  screen appears.

7. Create these login credentials for Operations Hub and proceed to the next screen.

USERNAME Enter a user name, which you can use to login to the Operations 

Hub application.

For example, ch_admin

PASSWORD Enter a password for your Operations Hub user login.

CONFIRM PASSWORD Enter the password again to confirm.
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The Select Proficy Authentication  screen appears.

8. Complete the following and proceed to the next screen.

Use Locally Installed Proficy 

Authentication

If you select this check box, then the local instance of Proficy 

Authentication will be used.

If you want to use an external Proficy Authentication (UAA), then 

leave this check box blank and proceed to provide more details.

Note:

Prior to Operations Hub installation, you must have a 

local or remote instance of Proficy Authentication in

stalled. The Operations Hub installation will not be al

lowed to continue if you select Use Locally Installed 

Proficy Authentication  and it is not detected.

BASE URL Enter the url address to access the Proficy Authentication appli

cation.

For example, https://win10vm2/uaa

ADMIN CLIENT ID Enter the administrator client id to login to Proficy Authentica

tion.

For example, admin

ADMIN CLIENT SECRET Enter the secret password for the Proficy Authentication admin

istrator client id.
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CERTIFICATE FILE You can browse and select the security certificate, (or) let the 

system do it for you.

When you test for validation, the system provides you with an 

option to use a detected certificate as shown here:

TEST Select this option to validate all your field entries.

The validation results appear on the Test External Proficy Au

thentication  screen, wherein you can do the following:

◦ Add and trust self-identified base url

◦ Add detected security certificate

Proceed to next only after the validation test is successful as 

shown here:

VIEW Select this option if you want to open and check the added secu

rity certificate.
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The Registration with Configuration Hub  screen appears.

9. Complete the following and proceed to the next screen.

Note:

We provide Configuration Hub login credentials that we already created. Refer to step 4a in 

the Install Common Components  (on page 33)  topic.

Register After Install If you select this check box, then you can skip registering Op

erations Hub with the Configuration Hub application for now. 

You will then need to register after the current Operations Hub 

installation using the application shortcut on the Desktop. Re

fer to Register Operations Hub with Configuration Hub  (on page 

50).

If you choose to register along with the current Operations Hub 

installation, then leave this check box blank and proceed to pro

vide more details.

BASE URL Enter the url address to access the Configuration Hub applica

tion.

For example, https://sbbuaahco.meridium.com:5000/contain

er-svc

CLIENT ID Enter the client id created for logging in to Configuration Hub.

For example, admin
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CLIENT SECRET Enter the secret password created for your Configuration Hub 

client id.

The Start Install  screen appears.

10. Select from the following install options:

Silent Install Select this option if you want to run a silent installation of products 

without any further user interaction or input. See Install Operations 

Hub in Unattended Mode  (on page 40).

Interactive Install Select this option if you want to install the following:

◦ Install Dataflow Editor  (on page 37)

11. Select START  to start the installation.

12. After the installation is complete, select CLOSE.

A message appears asking whether you want to restart your computer, or install more products.

13. Select Reboot Now  to restart your computer.

After installation, shortcut icons of the installed applications are created on your desktop.

Important:

If a firewall is running on the server, configure the firewall to make sure the public https port used 

by Operations Hub Public is not blocked. Typically, the port is 443, but can be a different value that 

you have selected or that was changed to avoid a conflict. If you are not sure of the port number, 

the shortcut (URL) placed on the desktop should contain it.
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• Install the Certificate on your Clients  (on page 41)  (on each client that you will use to access 

Operations Hub ).

• Install Site Administration Addon  (on page 63).

Install Operations Hub for SCADA
This topic describes how to install Operations Hub from the iFIX integrated installer.

• Ensure that the machine on which you want to install Operations Hub  meets the System 

Requirements  (on page 16).

• Use a machine that does not host any applications that are bundled with Operations Hub.

• Run a Windows update (including security updates).

• Use a host name that contains up to 24 characters and any of the following characters:

◦ Alphabetic characters

◦ Numeric characters

◦ Minus

◦ Period

• Ensure that you have administrative privileges to the machine on which you want to install 

Operations Hub.

In the following steps, we run the iFIX integrated installer to install Operations Hub. Consider these points 

during installation:

• First time installation: You can choose to provide the same user name and password for 

Operations Hub tenant admin and Configuration Hub. This will allow you to use the same 

credentials to log in to both the applications.

• Re-installation: If re-installing Operations Hub without DB purge  (on page 78), provide the same 

user name and password as the earlier install. If you provide a different set of credentials other 

than the tenant admin credentials used in the initial install, the user ID will not match what already 

exists in Proficy Authentication (UAA). As a result, users will not be able to log into Operations Hub.

1. Download the iFIX 2023 ISO install media from the Salesforce and mount the file.

2. From the ISO folder, double-click Setup.bat  to run the file.

The welcome screen appears.

3. On the welcome screen, you must first install Configuration Hub and Proficy Authentication before 

installing Operations Hub.

For step-by-step instructions, refer to Install Common Components  (on page 33).

4. On the welcome screen, select Operations Hub  > START.
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5. Accept the license agreement to continue with the install.

The Install Location  screen appears and validates for port conflicts.

6. Browse and select a location for installation, then continue to the next screen.

If port conflicts are detected, you must fix them before proceeding to the next screen.
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If there are no conflicts, the Operations Hub Credentials  screen appears.

7. Create these login credentials for Operations Hub and proceed to the next screen.

USERNAME Enter a user name, which you can use to login to the Operations 

Hub application.

For example, ch_admin

PASSWORD Enter a password for your Operations Hub user login.

CONFIRM PASSWORD Enter the password again to confirm.
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The Select Proficy Authentication  screen appears.

8. Select the check box for Use Locally Installed Proficy Authentication  and proceed to the next 

screen.

Proficy Authentication was locally installed during the installation of common components  (on 

page 33).

Note:

Prior to Operations Hub installation, you must have a local or remote instance of Proficy 

Authentication installed. The Operations Hub installation will not be allowed to continue if 

you select Use Locally Installed Proficy Authentication  and it is not detected.

The Registration with Configuration Hub  screen appears.

9. Complete the following and proceed to the next screen.

Note:

We provide Configuration Hub login credentials that we already created. Refer to step 4a in 

the Install Common Components  (on page 33)  topic.

Register After Install If you select this check box, then you can skip registering Op

erations Hub with the Configuration Hub application for now. 

You will then need to register after the current Operations Hub 

installation using the application shortcut on the Desktop. Re

fer to Register Operations Hub with Configuration Hub  (on page 

50).
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If you choose to register along with the current Operations Hub 

installation, then leave this check box blank and proceed to pro

vide more details.

BASE URL Enter the url address to access the Configuration Hub applica

tion.

For example, https://sbbuaahco.meridium.com:5000/contain

er-svc

CLIENT ID Enter the client id created for logging in to Configuration Hub.

For example, admin

CLIENT SECRET Enter the secret password created for your Configuration Hub 

client id.

The Start Install  screen appears.

10. Select from the following install options:

Silent Install Select this option if you want to run a silent installation of products 

without any further user interaction or input. See Install Operations 

Hub in Unattended Mode  (on page 40).

Interactive Install Select this option if you want to install the following:

◦ Install Dataflow Editor  (on page 37)

11. Select START  to start the installation.

12. After the installation is complete, select CLOSE.
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A message appears asking whether you want to restart your computer, or install more products.

13. Select Reboot Now  to restart your computer.

After installation, shortcut icons of the installed applications are created on your desktop.

Important:

If a firewall is running on the server, configure the firewall to make sure the public https port used 

by Operations Hub Public is not blocked. Typically, the port is 443, but can be a different value that 

you have selected or that was changed to avoid a conflict. If you are not sure of the port number, 

the shortcut (URL) placed on the desktop should contain it.

• Install the Certificate on your Clients  (on page 41)  (on each client that you will use to access 

Operations Hub ).

• Install Site Administration Addon  (on page 63).

Install Common Components
This topic describes how to install Configuration Hub and Proficy Authentication from an integrated 

installer.

You must be an Administrator to perform these steps.

You can install the common components, Configuration Hub and Proficy Authentication, from any of 

these install packages:

• Dedicated installer for Operations Hub

• iFIX integrated installer

• CIMPLICITY integrated installer

In the following steps, we run the iFIX integrated installer to install the common components. You can 

refer to these steps while installing from any other install package.
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1. Select Common Components  > START.

2. Accept the license agreement to continue with the install.

The Install Location  screen appears and validates for port conflicts.

3. Continue to the next screen with the default install location.

If port conflicts are detected, you must fix them before proceeding to the next screen.
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If there are no conflicts, the Credentials  screen for Configuration Hub and Proficy Authentication 

appears.

4. Complete the following and proceed to the next screen.

Note:

Remember the information you enter here, as you shall need it later for logging in to the 

applications. If you lose the credentials, you will have to reinstall common components to 

set them up again.

a. Create these login credentials for Configuration Hub:

CLIENT ID Enter a client id, which you can use to login to the Configu

ration Hub application.

For example, admin

CLIENT SECRET Enter a secret password for your Configuration Hub client 

id.

CONFIRM CLIENT SECRET Enter the secret password again to confirm.

b. Create these login credentials for Proficy Authentication:

Use the same credentials 

for Configuration Hub and 

Proficy Authentication

If you select this check box, then you do not have to enter 

any additional credentials for Proficy Authentication. The lo

gin credentials you entered for Configuration Hub is auto

matically applied to Proficy Authentication.

This is a useful feature if you do not want to remember two 

sets of login credentials.

However, if you want to set unique login credentials for 

Proficy Authentication, then clear the check box and pro

ceed to enter additional details.

Note:

It is recommended to install common components 

(Configuration Hub, Proficy Authentication) with the 

same client id/secret.
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CLIENT ID Enter a client id, which you can use to login to the Proficy 

Authentication application.

CLIENT SECRET Enter a secret password for your Proficy Authentication 

client id.

CONFIRM CLIENT SECRET Enter the secret password again to confirm.

The Start Install  screen appears.

5. Select START  to start installing the products.

6. After the installation is complete, select CLOSE.

A message appears asking whether you want to restart your computer, or install more products.
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Select from these options:

Install More Products You are redirected to the installation welcome screen, from where 

you can choose to install more applications.

Reboot Later Closes the installation setup screen without restarting your com

puter.

Reboot Now Restarts your computer.

Note:

You must reboot for applications to function properly. You 

may choose to do this after installing all the applications, 

or at a later time.

Install Dataflow Editor
This topic describes how to install the dataflow editor from the installation wizard.

Run the installation wizard to install Operations Hub. See Use Integrated Installer  (on page 20).

1. On the Install Dataflow Editor  screen, select the Install Dataflow Editor  check box.

This installs the tool along with Operations Hub  installation.
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2. Enter the following details, then select Next.

Field Name Description

Http Node Pass

word

Password to secure the Dataflow Editor http node.

Re-enter Http 

Node Password

Verifies and confirms the password.

Register with 

Configuration 

Hub

Select the check box if you want to register Dataflow Editor with Configuration 

Hub. Before registering, make sure that security authentication source is con

figured for Configuration Hub. Refer to Set up Proficy Authentication  (on page 

51).

If you choose to register later, refer to Manually Register Dataflow Editor with 

Configuration Hub  (on page 129).
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If you choose to register with Configuration Hub, the Configuration Hub Information  screen 

appears.

3. Enter the following details, then select Next.

Field Name Description

Base URL Base URL of Configuration Hub container service, such as https://

chhost:5000/container-svc/.

Client Id Identifier of a client that has permission (authority) to register with 

Configuration Hub.

Client Secret Client secret that can authenticate the client.
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Upgrade Operations Hub
This topic describes the steps to upgrade the application.

Close any applications or components before upgrading Operations Hub.

Use any of these methods to install a newer version of Operations Hub on your machine:

• First uninstall the existing version on your system, and then install the new version. Uninstallation 

allows to purge the database. (OR)

• Directly install/upgrade the new version without uninstalling the existing version. No scope for 

purging the database.

1. Uninstall the existing version of Operations Hub if you want to purge the database.

2. Install the newer or the latest version of Operations Hub.

3. Restart your computer following an upgrade of Operations Hub  if Plant Applications and 

Operations Hub  coexist on the same resource.

4. On upgrading to Operations Hub  2022 or later, the IQP designer uses app_name  instead of app_id  in 

its URLs.

5. If upgrading from 2.0 to 2.1 or later, restart the WebClient services to allow the Plant Applications 

Web Client to connect successfully to Operations Hub.

◦ If using Enterprise WebClient version, restart the Docker service.

◦ If using Standard WebClient version, restart the GE PlantApps WebClient Master Control 

service.

◦ If you have installed Operations Hub 2022 or 2022 SP1, restart your machine prior to 

WebClient installation.

6. Remember to clear your browser cache after upgrading to a newer version of Operations Hub.

7. If a firewall is running on the server, configure the firewall to make sure the public https port used 

by Operations Hub Public is not blocked. Typically, the port is 443, but can be a different value that 

you have selected or that was changed to avoid a conflict. If you are not sure of the port number, 

the shortcut (URL) placed on the desktop should contain it.

Install Operations Hub  in Unattended Mode
This topic describes how to perform a silent install for Operations Hub.

1. Open an elevated command prompt in Windows.

Command Prompt  > Run as administrator

2. Run the following command:
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<Operations Hub installation folder>\OpHub-Windows-Installer>ophub_bundle.exe <switch>, 

where <switch>  is one of the following values:

◦ -q, -quiet, -s, -silent: Use one of these values to initiate the automated installation.

◦ -passive: Use this value if you want progress bar to appear during the installation.

For example: ophub_bundle.exe /quiet UAA_ADMIN_CLIENT_SECRET=adminclientsec 

OPHUB_TENANT_PASSWORD=adminuserpassword

Operations Hub  is installed.

To install to a different drive from the command line, refer to Non-System Drive Install  (on page 41).

Log in to Operations Hub  (on page 62).

Non-System Drive Install
This topic describes how to install to a drive other than C: drive using command line.

Open Windows PowerShell or the Command Prompt with Administrative privileges to install from 

command line.

1. Right-click Windows PowerShell or Command Prompt and select Run as administrator.

2. Type Ophub_bundle.exe CUSTOM_INSTALL_DRIVE=E:

3. Press Enter on your keyboard.

The application program files (which usually go to C:\Program Files\GE) and runtime data directories 

(usually under C:\ProgramData\GE\) are relocated to E: drive.

Install the Certificate on your Clients
This topic describes how to install the Certificate Authority (CA) certificate on each client that you will use 

to access Operations Hub.

1. On the client machine, open a browser such as Google Chrome and access the Operations Hub 

server using the url: https://opshubservername/iqp.

The browser should display a "Not secure" icon.

2. Right-click the Not Secure icon, which should lead you to a Certificate dialog box.

3. Find the issuer in the Certificate Path  tab.

4. On the issuer, select View Certificate.

5. In the Certificate  dialog box, on the issuer certificate, select the Details tab and then Copy To File.

6. Right-click that exported certificate file, and choose to import it into the Trusted Root Certificate 

Authorities store.
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Install Operations Hub, Historian and SCADA on a Single Machine
This topic describes the installation of Operations Hub, Historian, and SCADA (iFix or Cimplicity) on the 

same computer.

Ensure that the machine on which you want to install meets the installation requirements for these 

applications.

• Operations Hub 2023

• Historian 2023

• iFIX 2023

• CIMPLICITY 2023 and Webspace 6.0

In the following steps, we use the iFIX integrated installer to install the products on the same machine. For 

CIMPLICITY SCADA, use the CIMPLICITY integrated installer.

1. From iFIX 2023 ISO install media, run the Setup.bat  file.

The welcome screen appears.

2. Install Configuration Hub and Proficy Authentication.

For step-by-step instructions, refer to Install Common Components  (on page 33).

3. On the welcome screen, select SCADA Standalone Server, then select the check box for all the 

products, and start the installation wizard.

4. Accept the license agreement to continue with the install.
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The Install Location  screen appears and validates for port conflicts.

5. Continue to the next screen with the default install location for SCADA, and IFIX NODE NAME.

If port conflicts are detected, you must fix them before proceeding to the next screen.

If there are no conflicts, the Historian Details  screen appears.

6. Complete the following and proceed to the next screen.
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Enable Historian services se

curity

Select the check box.

CERTIFICATE PASSPHRASE Enter a password to protect your certificate.

CONFIRM CERTIFICATE 

PASSPHRASE

Enter the password again to confirm.

HISTORIAN DATA PATH Enter the location path to access Historian data.

The Operations Hub Credentials  screen appears.

7. Complete the following and proceed to the next screen.

USERNAME Enter a user name, which you can use to login to the Operations 

Hub application.

For example, ophubadmin

PASSWORD Enter a password for your Operations Hub user login.

CONFIRM PASSWORD Enter the password again to confirm.
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The Select Proficy Authentication  screen appears.

8. Select the check box for Use Locally Installed Proficy Authentication  and proceed to the next 

screen.

Note:

In step 2, we already installed Proficy Authentication as part of common components.
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The Registration with Configuration Hub  screen appears.

9. Select the check box for Register After Install  and proceed to the next screen.

Note:

You have the option to register Operations Hub with Configuration Hub with the ongoing 

installation or post installation.
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The Start Install  screen appears.

10. Select from the following install options:

Silent Install Select this option if you want to run a silent installation of products 

without any further user interaction or input. See Install Operations 

Hub in Unattended Mode  (on page 40).

Interactive Install Select this option if you want to install the following:

◦ Install Dataflow Editor  (on page 37)
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11. Select START  to start the installation.

12. After the installation is complete, close the wizard and restart your computer.
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After installation, application shortcut icons are created on your desktop.

13. Register Operations Hub with Configuration Hub  (on page 50).

14. Launch Configuration Hub and set up the authentication.

Upon first launch, you will be asked to set up the authentication. For step-by-step instructions, refer 

to Set up Proficy Authentication  (on page 51).

15. Register iFIX with Configuration Hub  (on page 55).

16. Log in to Configuration Hub with your user credentials.

Operations Hub and iFIX are available as plug-ins.

Register Operations Hub with Configuration Hub
This topic describes how to register Operations Hub with Configuration Hub post installation.

Note:

You cannot have multiple instances of Operations Hub in Configuration Hub.

You should perform the following steps only if you select the Register After Install  option on the 

Registration with Configuration Hub  screen.

1. On your desktop, double-click the Register Operations Hub with Configuration Hub  shortcut icon.

The registration screen appears.

2. Enter the following details.

Note:

You must provide the same Configuration Hub credentials entered when installing 

Configuration Hub as part of common components.

CONFIGURATION HUB BASE 

URL

Enter the url address to access the Configuration Hub applica

tion.

CLIENT ID Enter the client id created for logging in to Configuration Hub.

CLIENT SECRET Enter the secret password created for your Configuration Hub 

client id.
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3. Select Register.

Set up Proficy Authentication
This topic describes how to set up Proficy Authentication in Configuration Hub.

The following steps describe how to set up Proficy Authentication in Configuration Hub. Setting up 

authentication provides access to all the products (Historian, iFIX, etc.) registered with Configuration Hub. 

You use the same Proficy Authentication server to authenticate.

1. On your desktop, double-click the Configuration Hub shortcut icon to launch the application.

2. Select Setup Authentication.

The Configuration Hub Administrator Credentials  screen appears.

3. Enter the details for logging in to the Configuration Hub application.
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Field Description

Client ID The client ID provided during installing Configu

ration Hub. Example: confighubadmin

Client Secret The client secret provided during installing Con

figuration Hub.

4. Select Verify.

If the credentials are correct, the Register with Proficy Authentication  screen appears.

5. Provide these details to configure the Proficy Authentication application.

These fields are populated automatically if you opted for installing Proficy Authentication along 

with Configuration Hub. You have the option to edit and update the details.

Field Description

Server Name (Fully Qualified Name) The host name of the machine where Proficy 

Authentication is installed.

Enter a fully qualified domain name. For exam

ple, desktop-sahfg5f.logon.ds.ge.com

Refer to step 6 to establish a trust with this 

server connection.

Server Port The port number to communicate with the host 

machine. The default port where UAA is in

stalled is 443.
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Field Description

The server connection is automatically tested 

on entering the port. You can also select Test 

to test the connection.

Use Configuration Hub Administration creden

tials for Proficy Authentication

Select this check box to populate the same lo

gin credentails you entered for Configuration 

Hub Admin account.

If you want to use unique login credentials for 

Proficy Authentication, clear the check box and 

enter CLIENT ID  and CLIENT SECRET.

Proficy Authentication Client ID The administrator client identifier that has per

mission (authority) to log in to Proficy Authenti

cation.

Proficy Authentication Client Secret The administrator client secret to log in to Profi

cy Authentication.

6. Select Not trusted  to establish a trust connection between Configuration Hub and Proficy 

Authentication.

The Certificate Details  screen appears.
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7. Select Trust.

The trusted certificate(s) are added to the windows store on the machine where Configuration Hub 

is installed.

8. Select Register.
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9. Select Ok.

The Configuration Hub Login  screen appears.

Configuration Hub is set up as a client for Proficy Authentication. The following default user is created to 

log in to the Configuration Hub application.

User ID Password

ch_admin The client secret you entered for Proficy Authenti

cation.

Register iFIX with Configuration Hub
This topic describes how to register iFIX with Configuration Hub.

• Make sure that users have been added in Windows, and that security is enabled on all of the iFIX 

SCADAs.

• Be aware that the Configuration Hub web server and the iFIX plug-in ports must be allowed in the 

firewall exception rules during installation. If you do not do this during installation, you will need to 

add these applications manually to the firewall rules.

• If you are using Configuration Hub on a domain, you may need to update the HOSTS files on your 

network with the name of the Configuration Hub server, the iFIX SCADA Server, and Historian Server 

(if applicable).
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Tip:

• You can find the HOSTS file in the C:\WINDOWS\system32\drivers\etc folder.

• Depending upon your permissions, you may need to copy this file to another folder, edit it, 

and then copy it back to the etc folder after your edits are complete.

• Use a text editor such as Notepad to edit the HOSTS file. To prevent Notepad from 

automatically adding a .TXT file extension when you save the file, in the Save as Type field, 

select “All Files.”

• An example entry in the HOSTS file is as follows: 198.212.170.4 SCADA01. If SCADA1 

was the iFIX SCADA Server node name, but the computer name where the iFIX SCADA 

Server was installed was AREA1, you would need to add a second line to the HOSTS file for 

AREA1: 198.212.170.4 AREA1.

• If you do not know the TCP/IP address of a computer, run the IPCONFIG command on the 

SCADA Server to obtain it.

• The contents of the HOSTS file should be identical on each node in your network.

• If your iFIX SCADA Server node name is different from the computer name where iFIX is 

installed, you also need to add this name to each HOSTS file.

• For Historian, you may need to use the fully qualified domain name (FQDN) in the hosts file 

of the Web clients machine so it can connect properly to the Configuration Hub machine.

A registration tool is installed during the iFIX install. This tool allows you to register (in the case of an 

existing Configuration Hub), or re-register your iFIX product plug-in with Configuration Hub when and 

if your setup changes. iFIX security must be enabled before you can register Configuration Hub. The 

following steps describe how to access the Registration Tool and the fields available.

1. You can access the Configuration Hub Registration tool from the Windows Desktop, or from the 

iFIX WorkSpace, on the Applications tab, in the Configuration Hub area. Click Register  to open the 

tool.
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2. After you launch it, the following login screen appears.

3. Enter your iFIX user name and password for authentication. The Registration the tool appears, as 

shown in the following figure.
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4. For both Configuration Hub and Proficy Authentication, first test the connection. Enter the server 

name and port number (if required). If on a domain, use the fully qualified domain name. Click Test 

Server Connection. Confirm that you can connect to both servers.

5. If successfully connected and the server certificate shows as Not Trusted  (in blue next to the 

server name), click the Not Trusted link next to the server name to establish the trust. Here is an 

example of what the Not Trusted link looks like next to the Proficy Authentication Server Name 

field:

6. After clicking Not Trusted, the Certificate Details window appears. From the Certificate Details 

window, click Trusted  in order to trust the certificate.

Both Configuration Hub and Proficy Authentication must have Trusted certificates before 

proceeding to register.

7. To complete the registration for Configuration Hub and Proficy Authentication, in the Configuration 

Hub Server Registration diaog box, supply the client IDs and client secrets entered during the 
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common component install, and then click Register. When registration is complete, the following 

screen appears.

8. You can now login to Configuration Hub with the ch_admin  user. Use the client secret supplied 

when you installed Proficy Authentication as the password.

9. Add the scada.fix.shared.APPLICATION_DESIGNER  group to the user for iFIX access in 

Configuration Hub access, and the scada.fix_shared_IFIX_PROFICY_AUTH_ADMIN  group to 

provide access for to all iFIX features (iFIX administrator access).

10. Logout of Configuration Hub and log back in to start using iFIX features in Configuration Hub.

Backup and Restore
This topic describes how to perform backups and restore the Operations Hub database.

You must have Administrator access.

You can backup and restore Operations Hub versions starting from 1.7 to the current release.

Note:

During the execution of backup and restore scripts, all services are stopped. Services start 

automatically once the backup/restore is complete.
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1. Download  the PowerShell scripts for backup, restore, and scheduler.

2. Unzip the downloaded file to access the scripts and jar files.

3. Perform an Operations Hub backup  (on page 60).

4. Restore from an Operations Hub backup  (on page 60).

5. Schedule a backup of Operations Hub  (on page 61).

Back Up the Operations Hub Database

Refer Backup and Restore  (on page 59).

1. Launch Windows PowerShell, and navigate to the location of the backup script file.

2. Execute BackUp_OperationsHub.ps1  to perform a backup of the UAA, IQP, and WebHMI database.

The OPERATIONS_HUB_BKP_20211013-120559.zip  backup is saved to C:\ProgramData. The filename 

includes the respective backup's datetime in the YYYYMMDD-HHMMSS  format.

Restore the Operations Hub Database

It is recommended to take a backup of your current database before continuing with the restore 

operation. In case you cancel the restore operation, you can recover your current data from the backup.

Note:

The restore operation deletes everything from the current system database.

Refer Backup and Restore  (on page 59).

1. Log in to the machine where Operations Hub is installed.

2. Copy the db-intializer.jar  of the version you want to restore to this location: \Program Files\GE

\Operations Hub\iqp-tomcat\webapps\site\WEB-INF

Note:

You can skip this step if you are restoring versions 2.1 SIM 2 or later. The jar file is already 

available at the location.

3. Launch Windows PowerShell, and navigate to the location of the restore script file.

4. Enter the path to the backup zip file, and execute Restore_OperationsHub.ps1  to restore the 

database.

For example:

oxy_ex-1/file_downloads/operations-hub-backup-restore.zip
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PS C:\Users\Administrator\Desktop> .\Restore_OperationsHub.ps1 

 C:\ProgramData\OPERATIONS_HUB_BKP_20211013-120559.zip

The database is restored.

Schedule Operations Hub Database Backup

Refer Backup and Restore  (on page 59).

1. Launch Windows PowerShell, and navigate to the location of the backup scheduler script file.

2. Execute BackupScheduler_OperationsHub.ps1  to schedule a backup.

a. To create a scheduler, enter Create.

b. Enter a name for your backup.

c. Enter a description of your backup.

d. Enter Daily  to take a backup every day, or Weekly  to backup every week.

e. Enter time in the suggested format to take a daily/weekly backup at the given time.

f. Enter the location of your backup script.

For example:

PS C:\Users\Administrator\Documents\db-backup-restore\Backup_OperationsHub.ps1

A daily/weekly backup is scheduled.

a. To delete a scheduler, enter Delete.

b. Enter the name of the backup for which you want to delete the schedule.

The daily/weekly schedule for the respective backup is deleted.

The backups are saved to C:\ProgramData.

Troubleshooting:

• When you run a .ps1  PowerShell script you might get the following message .ps1 is not 

digitally signed. The script will not execute on the system.

To fix it you have to run the following command to run Set-ExecutionPolicy  and change the 

Execution Policy setting.
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Set-ExecutionPolicy -Scope Process -ExecutionPolicy Bypass

This command sets the execution policy to bypass for only the current PowerShell session after 

the window is closed. The next PowerShell session will open running with the default execution 

policy. “Bypass” means nothing is blocked. No warnings, prompts, or messages are displayed.

• For LDAP user connectivity, make sure the Active Directory server is accessible to both the servers:

◦ the server from where we take the data backup

◦ the server to which we restore the data

If the data restored server cannot access LDAP server, the Invalid Credentials  error message 

appears.

Post-Installation Tasks

Setting Up Operations Hub

Log in to Operations Hub  (Classic)
Use your credentials to login and access the Operations Hub homepage.

Only a single user from a UAA instance can be logged into a browser instance at a time, even across 

multiple tabs.

If you want to log in as a different user, you must first log out of all the active product sessions. For 

Operations Hub, this includes the Operations Hub Designer, the Site Admin console, and applications 

created using Operations Hub.

1. In a web browser, enter the server name. Alternatively, you can use the shortcut provided on the 

desktop after installation.

2. Log in with the credentials that you specified during installation.

The Operations Hub  home page appears.



Operations Hub for Windows  | 2 - Getting Started with Operations Hub  | 63

Depending on the Operations Hub  solution you purchased, perform one of the following steps:

• If you have installed Operations Hub  by downloading it from Salesforce, run the siteadmin_addon 

installer package  (on page 63)  to access the Site Admin console, which is used to configure an 

MQTT server  (on page 65)  or an email server.

• If you have installed the Operations Hub  add-on for Historian, access the Historian analysis 

application. This is the only application you can access. You cannot modify or delete this 

application.

On iOS devices (iPhone/iPad), enable the self-signed certificate to secure websockets.

1. Go to Settings  > General  > About  > Certificate Trust Settings.

2. Under Enable Full Trust for Root Certificates, enable your root certificate.

Install Site Administration Addon
You must install the addon to access the Site Administration Console.
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Log out and close all the browser windows before you run the installer.

1. Run the siteadmin_addon  Windows installer package from the Operations Hub installation DVD.

2. Accept the license agreement and install the package.

3. Make a note of the Site Admin user account credentials before you finish the installation.

◦ In case you closed the setup wizard without making a note of the credentials (password), 

then reinstall the addon and note them down.

◦ If you changed the password of the Site Admin user account, remember to enter the new 

password on the login page. Some web browsers may populate cached credentials that are 

outdated.

◦ The Site Admin Console is used to configure MQTT settings or an email server. Do not use 

the console to change the password.

◦ If you have configured Historian UAA as the external UAA to be used with Operations Hub, 

you can change the password only after performing the following steps:
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a. Access the uaa.yml  file. By default, this file is located in the following folder: C:

\Program Files\GE Digital\UAA

b. Add the following line at the end of the uaa.yml  file: issuer: uri: https://

historian:8443/uaa. Do not enter a leading space before the line.

c. Restart the Historian Embedded Tomcat Container service.

Configure MQTT Broker Settings  (on page 65).

Set up an Email Server
If using a Self-Signed certificate to set up an email server, follow these steps:

1. Copy the certificate.pem  to a folder on the Operations Hub host machine.

2. Access C:\ProgramData\GE\Operations Hub\iqp-config\IQP\app\setting.conf.

3. Update setting.conf  with the following code: iqp_mail_cert_file=c:\\cert\\certificate.pem

Configure MQTT Broker Settings
If you want to use an MQTT broker to connect to devices, you must configure the settings.

Install Site Administration Addon  (on page 63).

1. In the Site Administration Console  page, select Server settings, and then select Mqtt settings.

2. In the Select tenant to configure  drop-down list box, select the tenant, and then select Continue.

The Account Settings  workspace appears.

3. Enter values as specified in the following table, and then select Update.

Field Name Description

Cloud url Enter the IP address or the URL of the MQTT broker that you want to 

use.

Pull interval Enter the time interval, in milliseconds, at which the Operations Hub 

MQTT client will connect to send or receive data. By default, it is set to 

500 milliseconds.

Use password Specify if the MQTT broker requires a user name and password to 

connect. By default, the value in this field is False.

Password If you selected True  in the Use Password  field, enter the password 

in this field. The default password for the installed MQTT broker is 

mqttpassword.
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Field Name Description

Note:

It is highly recommended to create a new password if us

ing MQTT in a production environment. The Mosquitto pass

word file is located here: C:\Program Files\GE\Operations Hub

\mosquitto.

To create a new password file, run the following command:

mosquitto_passwd -c passwordfile mqttuser

Visit https://mosquitto.org/man/mosquitto_passwd-1.html 

for command related information.

Visit https://mosquitto.org/man/mosquitto-conf-5.html  for in

formation on Mosquitto configuration.

User If you have selected true in the Use password field, enter the user 

name in this field. The default user for the installed MQTT broker is 

mqttuser.

Qos Specify the quality of service (QoS) of the MQTT broker by entering 

one of the following values:

◦ 0: Indicates that the message is delivered at most once or it is 

not delivered at all.

◦ 1: Indicates that the message is always delivered at least once.

◦ 2: Indicates that the message is delivered once.

Port The port number of the MQTT broker. By default, the value in this field 

is 1883, which is the standard MQTT port number.

The MQTT broker settings are configured.

Display Asset Locations on a Map
Enable Google Maps for your applications to display asset locations.

While designing a page, you can use the Google Maps widget to display the locations of assets on a map. 

To do so, you require the API key generated by Google. This topic describes how to access the key and 

use it in the application that you want to create.

https://mosquitto.org/man/mosquitto_passwd-1.html
https://mosquitto.org/man/mosquitto-conf-5.html
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1. Access https://cloud.google.com/maps-platform/, and follow the on-screen instructions to 

generate the API key.

The API key is generated.

Note:

Ensure that the following APIs are enabled for the key:

◦ The Geocoding API

◦ The Maps JavaScript API

2. Modify the userconfig.json  file located here:

C:\Program Files\GE\Operations Hub\iqp-endapp\public\scripts\data

3. Update the file using the API key and version information provided by Google:

Search for "googleMapsVersion"  and enter the version number for it.

Search for [GOOGLEAPIKEY]  and replace (including the brackets) with your API key.

4. Save and close the file.

5. Restart the Operations Hub IQP Tomcat Web Server service.

The Google Map widget is now available for use in the application. Asset locations are now 

displayed on a map.

Configure Session Timeouts
With Operations Hub, you can configure how soon a login session expires when a session is idle.

Before doing so, consider which application sessions you need to configure. The Designer, the End-app, 

and Proficy Authentication (formerly UAA) each can have its session timeout configured independently.

Operations Hub Session Timeouts

Access the web.xml  file from these locations, and update the configuration as follows, for End-app and 

Designer session timeouts respectively:

• C:\Program Files\GE\Operations Hub\iqp-tomcat\webapps\app\WEB-INF

• C:\Program Files\GE\Operations Hub\iqp-tomcat\webapps\site\WEB-INF

<session-config>

 <session-timeout>30</session-timeout>

</session-config>

https://cloud.google.com/maps-platform/
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A session is tracked by a cookie, wherein the cookie age must be longer than the session timeout. 

Therefore, if the timeout is increased, make sure the cookie’s max-age (configured in the same web.xml) is 

not shorter than the session timeout as shown here:

<session-config>

 <session-timeout>2</session-timeout>

 <cookie-config> <max-age>120</max-age> </cookie-config>

</session-config>

session-timeout  and cookie-config/max-age  are in different units of measurement (see note below).

Additionally, if you set either of the session timeouts greater than one hour in web.xml, you also need to 

add a system environment variable  SESSION_DESTROY_TIMEOUT  with value session_timeout_in_millisec + 

10 minutes in millisec. For example, if you set a session timeout to two hours, then set it to 130 * 60 * 

1000 = 7800000.

Note:

1. Restart IQP tomcat service whenever you reconfigure any of the settings/parameters 

mentioned above.

2. session-timeout  is measured in minutes, whereas cookie-config/max-age  is measured in 

seconds.

3. Any manual configuration changes, including changes for timeouts, are overwritten on 

upgrade.

Proficy Authentication Session Timeout

Proficy Authentication session timeout decides how long your Proficy Authentication login session 

remains valid. It in turn determines whether you need to enter the credentials again when logging into an 

application that depends on Proficy Authentication for login.

Example: If the session timeout for Operations Hub Designer is set to 30 minutes, and Proficy 

Authentication is set to one hour, then you are not required to enter the credentials to re-login if the 

Designer session times out within one hour. You need to enter credentials only when the Designer session 

lasts longer than an hour, or you explicitly log out of a session.

You can configure session timeout during Proficy Authentication installation. To configure after 

installation, access the web.xml  file from C:\ProgramFiles\GE\Proficy Authentication\uaa-tomcat\webapps
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\uaa\WEB-INF  or C:\ProgramFiles\GE\Operations Hub\uaa-tomcat\webapps\uaa\WEB-INF), and update the 

configuration as follows:

<session-config>

 <session-timeout>30</session-timeout>

</session-config>

The cookie’s max-age may also need to be adjusted, similar to Operations Hub session timeouts.

Setting Up Operations Hub for Kiosk Mode

Overview
This topic provides an overview of Operations Hub kiosk mode setup.

With 2023 release, Operations Hub extends support for interactive user login when the application is run 

on non-interactive devices. For example, a TV dashboard or a digital signage system. Operations Hub 

allows these two options for interactive login:

• Pre-authentication

• Kiosk Mode

Pre-authentication

Pre-authenticated application loading is in the form of a REST endpoint, when responding to a request 

with proper credentials, which will lead the client (browser) to the application without further need for 

interactive login. This option is suitable for digital signage with a content management system that needs 

to programmatically start an Operations Hub application.

Pre-authentication is carried out when a client sends a POST  request (form submission) to the endpoint 

https://ophub-host/app/autologin  with the following fields in the request body:

• username: User name used for pre-authentication.

• password: Password for the user account.

• appURL: URL of the Operations Hub application to be loaded after authentication.

Data in the request body should be URL-encoded, and the content type of the request should be set 

to application/x-www-form-urlencoded. For more information on form submission, refer to https://

developer.mozilla.org/en-US/docs/Learn/Forms/Sending_and_retrieving_form_data#the_post_method

Example (shown as parsed in Chrome Developer Tools):

https://developer.mozilla.org/en-US/docs/Learn/Forms/Sending_and_retrieving_form_data#the_post_method
https://developer.mozilla.org/en-US/docs/Learn/Forms/Sending_and_retrieving_form_data#the_post_method
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Following the request, the response will be a redirect that leads to the application.

Kiosk Mode

The kiosk mode option builds on pre-authentication, and allows the user to persist user credentials on a 

client device, which is to be used to start pre-authenticated application loading automatically.

For Kiosk mode, a client device must be first configured, which results in user credentials persisted on 

device. Note that credentials are only persisted and used on the configured client device. If setting up 

multiple client devices, each device should be configured. See Configure Kiosk Mode  (on page 70).

Configure Kiosk Mode
This topic provides steps to configure Operations Hub for kiosk mode.

You are an administrator.

1. Open the following URL on the device browser:

https://ophub-host/app/autologin

And the following form will be displayed:

The Set up this client device for Kiosk mode  form appears.

2. Enter the details as described below:

Field Description

Username User name used for pre-authenticated application loading.

Password Password for the user account.

Application URL URL of the Operations Hub end-application.

Test Credentials Select this button to test the pre-authentication in a new brows

er tab based on the credentials and application URL entered in 

the form. This test does not use persisted data (any data already 

saved to the device).
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3. Select Save  to save the entered login credentials and application URL to the client device.

To remove the saved data (persisted credentials) on the device, select Clear. This is useful when 

you want to clear sensitive data to re-purpose or decommission the client device.

Note:

Clearing the browser cache also clears the kiosk pre-authorization credentials. If kiosk 

mode is required and you cleared the browser cache, then re-run the setup for kiosk mode.

The URL that appears at the bottom of the configuration form is the actual URL to start the Kiosk 

mode. You can copy the link to use at runtime. You may use this for testing, and note that the 

persisted data will be tested, unlike the Test Credentials  button.

4. Once the device is properly configured, access the following URL using the browser on the client 

device:

https://ophub-host/app/autologin?kiosk

This is the same URL that appears at the bottom of the configuration form.

The persisted credentials are read from the device to start pre-authenticated application loading.

Mapping Proficy Authentication Groups
Mapping to Proficy Authentication groups helps with user management, access control, and security 

within Operations Hub.

User accounts created in Proficy Authentication represent people who need to access Operations Hub. 

Each user is associated with an identity provider (UAA, LDAP, SAML) and a set of groups that determine 

their permissions and access levels within Operations Hub. The authentication credentials for users 

associated with LDAP/SAML are verified by the identity provider before they can access Operations Hub. 

These are the different types of users in Operations Hub:
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Type of User Description

Site administrator This user creates tenants and tenant administrators using the Site Admin 

Console application. This user is created automatically when installing 

Operations Hub. You cannot access, modify, or delete this user from the 

Designer.

Tenant administrator This user manages the user accounts of developers and application 

users. The first tenant administrator is created automatically when in

stalling Operations Hub. You cannot delete this user from the Designer.

Developer This user creates applications using Operations Hub.

Application user This user accesses applications created using Operations Hub.

Groups in Proficy Authentication are created for specific type of users, likely to perform the same type of 

activities. You can create groups based on user roles, responsibilities, or permissions, and then assign 

users to these groups. This allows you to manage user permissions and access levels at the group level 

instead of managing individual users.

• Create Proficy Authentication Groups

• Map Groups  (Existing UAA, LDAP, SAML)

For more information, refer to the Proficy Authentication documentation.

Certificate Management

About the Certificate Management Tool
The Certificate Management tool allows you to manage external certificates and renew expired 

certificates.

The tool is installed automatically when you install Operations Hub. Using the Certificate Management 

tool, you can manage the following types of certificates:

• Server certificates, which include local certificates and imported certificates.

• Issuer certificates, which include certificates that are trusted by Operations Hub. This is required 

to connect to an external UAA instance. If you want to connect to LDAP, use the LDAP service to 

generate the certificate. Typically, you will only require the root CA certificate.

Using the Certificate Management tool, you can perform the following tasks:

https://www.ge.com/digital/documentation/uaa/t_uaa_create_uaa_groups.html
https://www.ge.com/digital/documentation/uaa/version2023/t_proficyauth_mapping_groups.html
https://www.ge.com/digital/documentation/uaa/
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• Access a certificate  (on page 73).

• Renew a local certificate  (on page 74).

• Import a server certificate or an issuer certificate  (on page 73).

• Remove a server certificate or an issuer certificate  (on page 75).

• View log messages  (on page 75)  that are generated while managing the certificates.

Access a Certificate
Using the Certificate Management tool, you can access server certificates and issuer certificates.

1. Double-click  on your desktop.

The icon appears on your desktop after you install Proficy Operations Hub.

The GE Operations Hub Certificate Management Tool  page appears, displaying the Server 

Certificate  section.

2. Depending on the type of certificate that you want to access, perform one of the following tasks:

◦ If you want to access a server certificate, select View  in the Local Certificate  or the 

Imported Certificate  subsection.

◦ If you want to access an issuer certificate, select External Trust, and then select View.

The certificate appears.

Import a Certificate

Using the Certificate Management tool, you can import the following types of certificates:

• Server certificates: You can import a certificate (chain) file of the PEM, PFX, or P12 format. To 

import a certificate of the PFX or a P12 format, you must enter a password.

• Issuer certificates: You can import a certificate file of the PEM format that contains only one 

certificate for the root CA. If you are currently using a certificate for the external UAA instance, it is 

replaced by the imported certificate.

1. Double-click  on your desktop.

The icon appears on your desktop after you install Proficy Operations Hub.

The GE Operations Hub Certificate Management Tool  page appears, displaying the Server 

Certificate  section.

2. If you want to import a server certificate, perform the following steps:
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a. In the Imported Certificate  subsection, next to the Certificate File  box, select Select.

b. Navigate to and select the certificate file, and then select Open.

c. Next to the Key File  box, select Select.

d. Navigate to and select the key file, and then select Open.

e. If you have selected a PFX or a P12 file, enter the password in the Password  box.

f. Select Import.

A message appears, asking you to confirm that you want to import a certificate.

g. Select Yes.

The certificate is imported.

3. If you want to import an issuer certificate, perform the following steps:

a. In the External Trust  subsection, next to the Certificate File  box, select Select.

b. Navigate to and select the certificate file, and then select Open.

c. Select Import.

A message appears, asking you to confirm that you want to import a certificate.

d. Select Yes.

The certificate is imported and replaces the currently used certificate for the external UAA, if any.

Renew a Certificate
Using the Certificate Management tool, you can renew local certificates that have expired.

1. Double-click  on your desktop.

The icon appears on your desktop after you install Proficy Operations Hub.

The GE Operations Hub Certificate Management Tool  page appears, displaying the Server 

Certificate  section.

2. Select the local certificate that you want to renew, and then select Renew.

A message appears, specifying that the certificate has been renewed.
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Remove a Certificate

Using the Certificate Management tool, you can remove a server certificate or an issuer certificate. When 

you do so, the local certificate is used by Operations Hub.

1. Double-click  on your desktop.

The icon appears on your desktop after you install Proficy Operations Hub.

The GE Operations Hub Certificate Management Tool  page appears, displaying the Server 

Certificate  section.

2. Depending on the type of the certificate that you want to remove, perform one of the following 

tasks:

◦ If you want to remove a server certificate, in the Imported Certificate  subsection, select 

Remove.

◦ If you want to remove an issuer certificate, select External Trust, and then select Remove.

A message appears, asking you to confirm that you want to remove the certificate.

3. Select Yes.

The certificate is removed, and the local certificate is used by Operations Hub.

View Log Messages
Using the Certificate Management tool, you can view the log messages that are generated while 

managing certificates.

1. Double-click  on your desktop.

The icon appears on your desktop after you install Proficy Operations Hub.

The GE Operations Hub Certificate Management Tool  page appears, displaying the Server 

Certificate  section.

2. Select Messages.

The Messages  section appears, displaying the log messages.

Send Certificate Expiry Notification
Sends email notification on certification expiry.

Install Site Administration Addon  (on page 63).
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Email notifications must be sent to the recipients when their Operations Hub certificate expires, or is 

about to expire. Use the default entity  (on page 227), event  (on page 296), and template  (on page 

305)  to complete this task. These are available on installing Operations Hub  (on page 20).

• SendEmailEntity

• CertificateExpiryEvent

• CertificateEmailTemplate

1. Log in to Site Administration Console and set up an email server.

Here is an example of gmail setup:

If using a Self-Signed certificate, you need to perform additional steps  (on page 65)  to update 

the setting.conf  file.

2. Log in to Operations Hub as an administrator.

3. From the main navigation menu, select Events.

4. Open CertificateExpiryEvent.

5. On the ACTIONS  tab, enter the email address of the recipients.

Note:

Do not modify the default populated details for CertificateExpiryEvent  or 

CertificateEmailTemplate.
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6. Select Save And Exit.

When certification expiry is detected in the next 45 days, daily emails are sent to the recipients asking 

them to renew their certificates. The email also contains the details of the certificates about to expire (or 

already expired, if not renewed within 45 days).

Integrating with Historian

Integrating Operations Hub and Historian
A trend chart allows you to trend data from Historian.

You can choose to trend data from an asset model or directly from Historian. To do so, you must integrate 

Historian and Operations Hub.

Access the Trend Chart with Asset Model

1. Create a data source to connect to the Historian server.

For instructions, refer to the Data Sources section of the User Guide.

2. Set up the Historian server.

For instructions, refer to the Administration section of the User Guide.

3. Import the model to Operations Hub.

For instructions, refer to the Administration section of the User Guide.
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4. For the model that you have imported, enable the trendable properties by performing the following 

properties:

a. In the Admin  workspace, select Visualizations  > Designer.

b. For each data variable that is trendable, select the check box in the Trendable check box.

5. Access the Historian Analysis application.

For instructions, refer to the Applications section of the User Guide.

When you navigate to the model, the trend chart plots data based on the selected context.

Access the Trend Chart without Asset Model
You can access the trend chart without the asset model (that is, by browsing through the Historian data 

source directly for use in the trend chart).

1. Create a data source to connect to the Historian server.

For instructions, refer to the Data Sources section of the User Guide.

2. Set up the Historian server.

For instructions, refer to the Administration section of the User Guide.

3. Access the Historian Analysis application.

For instructions, refer to the Applications section of the User Guide.

4. Access the trend chart configuration to select the tags that you want to plot on the trend chart.

For instructions, refer to the Widgets section of the User Guide.

Data for the selected tags is plotted on the trend chart.

Uninstalling Operations Hub

Uninstall Operations Hub  on Windows
This topic describes the uninstalling of Operations Hub.

To completely remove the Proficy product installation, you need to uninstall the following applications as 

per the instructions that follow:

• Configuration Hub

• Operations Hub

• Proficy Authentication



Operations Hub for Windows  | 2 - Getting Started with Operations Hub  | 79

1. If you want to uninstall Operations Hub  automatically, open Command Prompt, and 

enter the following command: <Installation folder path of Operations Hub>\OpHub-

Windows_Installer>ophub_bundle -uninstall

2. If you want to uninstall Operations Hub  manually, perform the following steps:

a. On the machine on which you want to uninstall Operations Hub, select Control Panel  > 

Uninstall a Program.

A list of programs that you can uninstall appears.

b. Right-click Operations Hub, and then select Uninstall.

The Uninstall Options  screen appears.

c. In addition to uninstalling Operations Hub, if you want to delete all the related data and 

applications, select the Purge databases during uninstall  check box.

d. Select Next.

The You are ready to uninstall  screen appears.
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e. Select Uninstall.

Operations Hub  is uninstalled from the Windows machine.

Getting Started with Proficy Historian

Get Started with Proficy Historian and Operations Hub
This topic guides you through how to get started integrating Proficy Historian and Operations Hub.

Before You Begin

Before beginning, make a note of the following:

• Ensure the Historian Web Clients are installed on the Historian machine; this is very important if 

you will be using the Historian REST API in Operations Hub.

• Ensure that you can access Historian Web Trending Client from a remote machine or from the 

Operations Hub machine.

• Ensure that certificates are trusted for both Operations Hub and Historian (not strictly necessary if 

you use option to ignore TLS/SSL, but a good idea).
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Steps

The following sections walk you through:

1. Configuring a Historian data source (System API or REST API) in Operations Hub. See Configure 

Historian Data Sources for Operations Hub  (on page 81).

2. Creating a Model. See Create a Model for Operations Hub to use with Historian  (on page 83).

3. Using the Trend widget to trend model-based Historian data or trend data directly from a Historian. 

See Use the Trend Widget for Historian Data Source  (on page 85).

4. Creating a Historian REST query. See Create Historian REST Query for Operations Hub  (on page 

88).

5. Using the Query in the page designer. See Use the Historian Query in the Operations Hub Page 

Designer  (on page 89).

Configure Historian Data Sources for Operations Hub

Overview

Look at the following examples for configuring a data source for Historian 7.x and Historian 8.x.

• Historian 7.x  requires entry of port used – in this instance, port 8443.

• The Auth Client ID is the admin (case sensitive) for Historian 7.x.

• Historian 8.x  does not require any port to be specified.

• The Auth Client ID for Historian 8.x must be in the form of MachineName.admin, where 

MachineName is case sensitive.

• For both Historian 7.x and 8.x, ensure Data source URL and Client ID are in the right format.

Note:

• The System API  connection is necessary for Trending Historian data in the Trend widget.

• The REST API  connection is necessary for creating REST queries against the Historian 

REST API. These queries can then be bound to widgets like gauges, grids, etc to visualize 

this data

• When configuring a REST data source, be sure to provide all necessary parts to the Base 

URL, including any required ports. (Example: https://<HistorianServerName>:8443)

Refer to Add Historian or Custom REST Data Source (Classic)  (on page 355).
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Configuring Historian 7.x in Operations Hub
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Configuring Historian 8.x in Operations Hub

Note:

The Auth Client ID field is case sensitive. For example, if the Historian server name is hist8Server, 

the user must use hist8Server.admin and not HIST8Server.admin or Hist8Server.admin, otherwise 

REST authentication will fail. If your rest connection fails, make sure you can login to the Historian 

Web trend client (https://webhmitaco/historian-visualization/hwa) Once successful, use the 

same user name and password for the client id in the REST configuration in Operations Hub.

Create a Model for Operations Hub to use with Historian
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Create an Object Type

Create an Object based on the New Type

Tie the properties of the Data variables to the Historian data source.

Refer to Set Up the Model Structure (Classic)  (on page 338)  and Define Objects (Classic)  (on page 

339).



Operations Hub for Windows  | 2 - Getting Started with Operations Hub  | 85

Use the Trend Widget for Historian Data Source

When using Operations Hub  with Historian use the following guidelines to successfully get data flowing in 

the Trend widget.

Use the Trend Widget with an Asset Model

1. Create a Historian data source  (on page 355).

2. Import the model from the Admin  > Import/Export  option.

3. After the model is successfully imported, go the Visualizations > Designer  section and enable the 

Trendable properties and save.
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4. Switch to the Apps  section.

5. Choose the Historian Analysis  app.

6. Select the  button to open the app.

7. At run time, navigate through the model and the Trend chart will display data based on the context 

selected.

Use the Trend Widget without an Asset Model (Browsing Data Source 
Directly for Trend Widget)

1. Create a data source to historian via the Data Sources  section.

2. Make sure the test passes.
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3. In the Admin, make sure the Historian server is also setup via the Setup area.

4. Switch to the Apps  section.

5. Choose the Historian Analysis  App

6. Select the  button to open the app.

7. At run time, open the Trend chart configuration via the  button, then select Add Tags for 

Trend  to browse Historian and add tags to the chart for trending.
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Create Historian REST Query for Operations Hub



Operations Hub for Windows  | 2 - Getting Started with Operations Hub  | 89

1. Make sure the data source for Historian REST API is configured as described in the Configure 

Historian Data Sources for Operations Hub  (on page 81)  section.

2. Create a query for Current value.

Refer to Create REST Query (Classic)  (on page 269).

Use the Historian Query in the Operations Hub Page Designer



Operations Hub for Windows  | 2 - Getting Started with Operations Hub  | 90

1. Go to Apps  > Pages  and then Add a New Page  from within the App.

2. Within Page > Page Data, select Query > REST, next to Get Current Value, click Add to add the 

“Current Value Query” to Page.
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3. Add widgets to the Page, by first adding three containers to the page. From Layouts, select and 

drag Containers.
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4. Add an Input > Input widget and a button into the first container, Display > Gauge into the second 

container, and Display > Table into the third container.

5. Now we need to bind the query parameters to each of the widgets: For the Input widget set the 

target data to the “GetCurrentValue” > TagNames. For the Source you can put in a manual entry of 

a known Historian tag name.
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6. For the Gauge widget, set the style to “Arc Meter” and set the Data > Source > Get Current Value > 

historian_data.Data.Samples.Value.
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7. Set the color and start position numbers based on the data source High and Low as shown in the 

following figure.
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8. For the Table widget, set the Flow->Get Current Value. Now add fields, and set the value for each of 

the fields.

9. Alternatively, you can drag and drop the output parameters from the query onto the grid.

10. Bind the Submit Action  on button to the query as shown in the following figure:
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11. Save the App.

12. Open the App.

13. In the End app, click the Submit  Button.

14. To update the gauge and the table with the current value of the specified Historian tag, enter a 

different Historian tag name and click on the Submit  button.

Getting Started with the Relational Database Connector

Get Started with Relational Database Connector
This topic guides you through how to get started integrating the Relational Database Connector and 

Operations Hub.
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Before You Begin

Before beginning with your relational database connector, be aware of the following:

• This release of Operations Hub supports fetching data via stored procedures from Microsoft SQL 

Server only.

• Be sure to confirm that you can to successfully connect to the SQL Database:

◦ Test that you can connect to SQL Server with another client (for example: SSMS, UDL files), 

using the SQL account you want to use in Operations Hub.

◦ Confirm that the TCP/IP Protocol is enabled on the SQL Server. You will not be able to 

connect from Operations Hub until you enable TCP/IP using the SQL Server Configuration 

Manager.

• Ensure that you have a working SQL Database, and that the selected database has stored 

procedures.

Steps

The following sections walk you through:

1. Create a data source of type Relational Database. Refer to the Add Relational Database Data 

Source (Classic)  (on page 353)  section.

2. Provide the details to the external database. Refer to the Create a Query to a Relational Database 

(on page 98)  section.

3. Create a Query of type Relational Database, and specify the expected inputs and outputs of a 

Stored Procedure. Refer to the Create a Query to a Relational Database  (on page 98)  section.

4. Map the query in the page designer to use the query to fetch the data from the external database. 

Refer to the Use the Relational Database Query in the Designer  (on page 102)  section.

5. View the page in the end app. For an example, see Example of Adding Relational Database Queries 

to a Page  (on page 106).

Create a Query to a Relational Database
This topic describes how to create a SQL query.

In order to proceed you must have a working SQL database, and the selected database must have stored 

procedures. You must also have created a data source for the relational database in Operations Hub. See 

Create a SQL Data Source (Classic)  (on page 369).
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1. From the main navigation menu, select  QUERIES.

The QUERIES  workspace appears.

2. Select Add new query.

The Create Query  window appears.

3. In the Name  field, enter a name, and then select Create. The name must contain at least one 

uppercase or lowercase letter.

The available options for creating the query appear.

4. In the Description  field, enter a description for the query.

5. In the Type  field, select Relational Database .

6. In the Data Source  field, select the name of the data source from the list.

7. In the Query Type field, observe that the field defaults to ‘Stored Procedure’ when you select 

‘Relational Database’ as the Type.

8. In the Schema  field, select the database schema that you want to use. All the database schemas 

will be loaded for the selected data source. The default selection is dbo.

9. In the Stored Procedure field, select the Stored Procedure that you want to use from the selected 

schema.

After you selects all the required fields, the list of input parameters will be loaded if there are any, 

for the selected stored procedure.

The value for the input parameters can be configured either while creating the query or while 

consuming the query in the page builder page.

10. To assign the value for an input parameter while creating the query, select the type drop-down in 

the input parameter list. It has two options:
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◦ Fixed Value: If this option is selected, the value given will be taken as the input to the Stored 

Procedure. The input parameter will not be shown in the page builder page.

◦ Input Field: If this option is selected, the value given will be taken as the default input to the 

Stored Procedure. The input parameter will be shown in the page builder page and if there is 

any input provided to while execution, the default value will be overridden.

11. After the default values for input parameters are provided, click the Execute  button under the Test 

category. You will then be presented with the various fields in Result Sets and Output Parameters 

sent out of the Stored Procedure.

Note:

Currently we do not support dynamic responses from the Stored Procedures. Meaning, the 

fields that we see while building the query after clicking the Execute button, should match 

the fields returned by the stored procedure while using the application.

12. Add the required fields.

The following figure displays an example:
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13. Select Save  or Save And Exit.

The query is created.

Use the Relational Database Query in the Designer
This topic describes how to apply SQL queries to a page.

1. From the main navigation menu, select  APPS.

The APPS  workspace appears, displaying a list of applications created in Operations Hub.

2. In the Name  column, select the application in which you want to create a page.

The PAGES  workspace appears.
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3. Select Add new page.

The Create Page  screen appears.

4. Enter or select values as described in the following table.

Field Description

Page name Enter a name for the page. The name must con

tain at least one uppercase or lowercase letter.

Page description Enter a description for the page.

Include in app navigation Select this check box if you want this page to 

be included in the application navigation. By de

fault, this check box is selected.
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5. Select Create.

The page is created, and the page designer appears.

6. Select Page Data.

7. To add a Relational Database Query to the page, do the following:

a. Select the flow type as Query.

b. Select the Data source type as Relational Database.

c. Select the required data source.

d. Select the required query.

e. Select a result set.

f. Select Add.

The query with sub-selected result set will be added to the page. The naming convention will 

be QueryName - ResultSetName. Inputs and Outputs are assigned to components exactly like 

that of REST and Entity pages.

◦ Applies to Operations Hub 2022 and earlier versions:

▪ For SQL queries with multiple result set, if a result set is added to the page, you 

cannot add that result set multiple times with different inputs to the same page. You 

need to create a separate query each time you want to add that result set to the page.

▪ In case a SQL query with multiple result is added to the page, the inputs and query 

execution options (check boxes for auto-submit, auto-update, etc.) appear only for 

the first added result set. Only outputs appear for result sets added subsequently. 
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The selected inputs and query execution options for the first result set apply to all the 

query result sets.

▪ For a query with single result set, you can add it multiple times to the page. But, if the 

same query output is changed to contain multiple result sets at a later time, then you 

must remove the second instance of the query before adding the new result set.

◦ Applies to Operations Hub 2022.4.1 and later vesions: Every ResultSet in a query is an 

independent query (inputs and query execution options appear for every result set). This 

new behavior does not impact the existing apps and queries (created in earlier versions).

Note:

As of Operations Hub  1.7, The inbuilt pagination and infinite scrolling for Grid and Table 

components will not work with Relational Database Queries. The pagination must be 

handled using the input and output parameters of the stored procedure.

8. Select Save App.

An example is shown in the following figure.
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The changes made to the page are saved.

Note:

View the Page in the End app, by clicking Open App button.

Example of Adding Relational Database Queries to a Page

In the following example, the query has two result sets. One is the result from the stored procedure and 

the other is from the output parameters. It also has inputs PageNumber  and PageSize.

1. Design a page by adding two buttons and two input boxes, and disable the input controls.

2. Map the input parameters of the query to the input controls.

3. Create two custom globals for page number and page size and provide default values as shown in 

the following figure.
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4. Select each button and set the action to set the global value using a formula as shown in the figure 

(+ for next, - for previous).
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5. Select each button and set the display condition as shown in the following figures.

6. Select Save App.
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The final page appears as shown here: 

Getting Started with OPC UA

Get Started with OPC UA and Operations Hub
This topic guides you on how to configure an OPC UA data source, and build visualization.

Steps

The following sections walk you through:

1. Create a data source with OPC UA configuration in Operations Hub  (on page 360).

2. Build an asset model for OPC UA data sources in this order:
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◦ Create object types  (on page 338)  with Proficy iFIX, Proficy CIMPLICITY, and IGS data 

variables.

◦ For the object types, create object instances  (on page 339).

3. Build an asset hierarchy to specify the hierarchical relationships of assets. Operators navigate 

through this hierarchy to select the equipment context for a given layout at runtime. Refer to Set Up 

Runtime Navigation (Classic)  (on page 341).

4. Use the Trend Widget for OPC UA Data Sources  (on page 110).

5. To enable write operations in Proficy CIMPLICITY for Operations Hub, refer to Configure Proficy 

CIMPLICITY for Writes  (on page 112).

6. To enable write operations in Proficy iFIX for Operations Hub, refer to Configure Proficy iFIX for 

Writes  (on page 114).

Use the Trend Widget for OPC UA Data Sources
Data visualization with trend widget for OPC UA data sources.

Use the following guidelines to successfully get data flowing in the Trend widget. Refer to Configuring a 

Trend Chart  (on page 619).

Use the Trend Widget with an Asset Model

• Create a data source with OPC UA configuration in Operations Hub  (on page 360).

• Build an asset model for OPC UA data sources.

1. In the main navigation menu, select APPS.

The Apps  workspace appears, displaying a list of applications.

2. Open the application.

3. Select .

The Trend Configuration  pane appears.

4. Select Add Tags for Trend.

The Add Sources  window appears.
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5. Select Asset Model  from the drop-down.

A list of assets appear.

6. Browse and select the check box for the properties you want to add to the trend chart.

Refer to Browse Data Sources (Classic)  (on page 368).

The live data from the data source starts displaying in a trend chart.

Use the Trend Widget without an Asset Model

• Create a data source with OPC UA configuration in Operations Hub  (on page 360).

1. In the main navigation menu, select APPS.

The Apps  workspace appears, displaying a list of applications.

2. Open the application.

3. Select .

The Trend Configuration  pane appears.

4. Select Add Tags for Trend.

The Add Sources  window appears.
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5. Select iFIX, CIMPLICITY, or OPC UA from the drop-down, then select the server.

The address space for the selected data source appears in a tree structure.

6. Browse and select the check box for the tags you want to add to the trend chart.

Refer to Browse Data Sources (Classic)  (on page 368).

The live data from the data source starts displaying in a trend chart.

Configure Proficy CIMPLICITY for Writes
This topic describes how to configure Proficy CIMPLICITY to enable write operations.

1. Log in to Proficy CIMPLICITY.

2. From the main menu, go to Project  > Properties.

The Project Properties  window appears.

3. Select Operations Hub  tab.

4. Provide these details to set up the connection to Operations Hub.

Field Name Description

Server name Operations Hub machine name

Port Port number for the machine
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Field Name Description

User name Enter the user name for logging in to the machine. Select Test Con

nection  to verify the Operations Hub machine details for establish

ing a connection.

Require trusted connection Select the check box to enable SSL security for the connection. If 

the security appears as (Not Trusted), you must trust it. To do so, 

select View Certificate  for instructions on where to copy the issuer 

certificate on your CIMPLICITY machine.

OK Save the details and close the window.

5. To verify the write operations, log in to Operations Hub.

6. Create a data source with OPC UA configuration  (on page 360)  in Operations Hub.

7. Set up an extension query  (on page 275)  for CIMPLICITY with these details:

Method WRITE

Tag Source OPC UA
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Tag inputs and outputs As required

8. Create an application page and bind the extension query with widgets.

9. Log in to the end application, and perform the write operations in runtime.

Configure Proficy iFIX for Writes
This topic describes how to configure Proficy iFIX to enable write operations.

1. Log in to Proficy iFIX.

2. Go to C:\Program Files (x86)\GE\iFIX  and open the secmgr.clr.dll.config  file in a notepad.

3. Save the dll file after verifying and updating these details:

Ensure that uaa_oauthHost  points to the UAA server that provides the authentication services. If 

default UAA server is installed with Operations Hub, this will generally be the hostname (short or 

FQDN) used during Operations Hub installation.

4. To verify the write operations, log in to Operations Hub.

5. Create a data source with OPC UA configuration  (on page 360)  in Operations Hub.

6. Set up an extension query  (on page 275)  for iFIX with these details:

Method WRITE

Tag Source OPC UA
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Tag inputs and outputs As required

7. Create an application page and bind the extension query with widgets.

8. Log in to the end application, and perform the write operations in runtime.

Configure Third Party OPC UA Servers for Writes
If you are using third party OPC UA server configuration for data to update any value, you must provide 

user name and password credentials to perform write operations. In case of alarm card or a mimic card 

receiving data from a third party OPC UA server, a pop-up dialog prompts for user name and password 

credentials to perform write operations.

1. Create a third party data source with OPC UA configuration  (on page 360)  in Operations Hub.

2. In the data source, under Authentication  > Write, select User Name/Password (provided by user).

3. Create an application  (on page 204).

4. Create application pages  (on page 376)  for Alarm card  (on page 530)  and Mimic Card  (on page 

541).

5. Acknowledge alarms  (on page 540)  at runtime to verify alarm write operations.

A pop-up dialog appears requesting for user name and password to perform write operations.
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If you choose to acknowledge multiple alarms from multiple sources, then enter the credentials for 

all the data sources listed in the authentication popup.

6. Similarly perform set point operation on mimics at runtime to verify mimic write operations.

7. Select the Remember Credentials  check box to save the user name and password.

When data source credentials are saved, the authentication popup for that data source does not 

appear again to acknowledge additional alarms.

In case you selected this check box and entered invalid credentials, the invalid data gets saved. 

You must clear the saved data source credentials to be able to enter the valid user name and 

password.

Select  to clear all the saved data source credentials.

Get Started with Proficy Plant Applications
This topic guides you through how to get started integrating Proficy Plant Applications and Proficy 

Operations Hub.

Ensure that system requirements for Plant Applications  and Operations Hub  are met.

Overview

1. Install Proficy Operations Hub.

2. To install Proficy Plant Applications, choose your installation type:

◦ Standard Edition  (on page 117)

◦ Enterprise Edition  (on page 117)

3. Work with Web Client applications  (on page 117).

4. (Optional) Refer to the API documentation  to customize applications.

https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_ppa_software_requirements.html
https://www.ge.com/digital/documentation/opshub/windows/windows/r_system_req_windows.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/index_api_endpoint.html
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Steps for Installing Standard Web Client

1. Configuring Apache CouchDB Settings

2. Standard Edition Web Client Requirements

3. Install Plant Applications Standard Web Client

4. Run Message Bridge Configuration Utility

5. Run Operations Hub Posting Utility

6. Verify the Installation

Steps for Installing Enterprise Web Client

1. Configuring Apache CouchDB Settings

2. Enterprise Edition Web Client Requirements

3. Review the files provided by GE

4. Pre-Installation Checklist

5. Install Enterprise Edition Web Client

6. Run Message Bridge Configuration Utility

7. Run Operations Hub Posting Utility

8. Verify the Installation

Work with Web Client Applications

Note:

These applications appear based on user privileges.

• Unit Operations

• Non Conformance

• Work Order Manager

• Route Editor

• Work Queue

• Time Booking

• Property Definition

• Security

• Configuration

• Approval Cockpit

• Downtime

• OEE Dashboard

• Reports

https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/t_configuring_apache_couchdb_settings.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_install_pa_uc_prerequisites.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/t_install_pa_uc.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/t_install_pa_wc_messagebridge_update.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/t_install_pa_uc_ophubpostingutility.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/t_test_the_installed_application.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/t_configuring_apache_couchdb_settings.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_enterprise_software_requirements.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_files_provided.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/t_%20pre_installation_steps.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/t_installation.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/t_install_pa_wc_messagebridge_update.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/t_install_pa_uc_ophubpostingutility.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/t_test_the_installed_application.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_op_overview_of_operations.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_ncm_overview.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_om_overview.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_rm_overview.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_wq_overview.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_pa_tb_time_booking_overview.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_pd_about_property_definition_app.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_sm_about_the_security_management_app.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_cm_about_configuration.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_ac_overview.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_dos_about_operator_screens.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_about_equipment.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_about_oee_reports.html
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• My Machines

• My Machines

• Analysis

• OEE Aggregation Store

• Activities

• Process Orders

• Alarm Event Notification

• Waste

• Receiving Inspection

• BOM Editor

• Genealogy

Data Binding to Widgets/Plug-ins (Classic)
This topic describes the options you can use to bind values to widgets/plug-ins.

Attention:

In case you modified the data source alias (machine name), then all references to the data source 

(Historian or OPC UA) server are lost. You must rebuild queries for all your widgets in use.

Tag Browser

A list of out-of-the-box (OOTB) queries of 'Extension' type are available with the tag browser.

1. Select the OOTB query that you want to apply to the widget.

2. Browse the data source and select tags  (on page 368).

3. Drag-and-drop the query on your widgets. This automatically populates the data fields for the query 

under PAGE DATA.

4. Save the page with the default data from the query, (OR) modify the data fields to your requirement.

Note:

The tag browser does not apply to REST or SQL queries. It works only with Extension queries. If 

you want to configure tags in a REST query, then enter them as Text. You can also enter multiple 

tags separated by a semicolon.

https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_about_my_machines.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_about_my_machines.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_about_analysis.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_pa_about_oee_aggregation.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_about_an_activity.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_pa_about_production_scheduler.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_about_an_alert_event.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_pa_wm_about_waste_management.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_ri_overview.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_pa_about_bom_editor.html
https://www.ge.com/digital/documentation/proficy-plant-applications/version2022/c_pa_about_genealogy.html
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Refer to:

• Create Extension Query (Classic)  (on page 275)

• About Queries  (on page 247)

Example:  Refer to Sample Page with Historical Data  (on page 660).

Inputs

Queries have input values. On drag-and-drop from tag browser, these inputs are bound to the widget, and 

appear under PAGE DATA.

Each input has these options that are populated with default values as per the query:

• Manual: Allows to use a variety of components to provide manual values for query inputs - text, 

number, date, time, datetime, browser, combo box, and boolean.
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• Global

• UI

Note:

At any point in time, ensure that only one binding exists for the query inputs. For example, there 

should be no manual or global binding if you have already bound the query input to UI through 

a widget or plugin. To remove a binding from the query input, select the unlink icon next to the 

binding.

Link to Access the Query

If you changed the Asset Context  for the page, access a direct link to the query to update or modify it.

On selecting the widget, a link to the associated query appears under the widget properties. Select the link 

to directly jump to the query on the PAGE DATA  tab.

Drag-and-Drop Data

This feature is applicable when configuring widgets/plug-ins in Operations Hub. You have the option to 

drag-and-drop selected tags/properties (from the tag browser) directly on to the widgets. The data is 

quickly bound to the widget without the need to manually configure its value fields. After you drag and 

drop data on the widget, go to the widget properties tab to verify. The source value fields are auto-filled 

with the data that you dropped on the widget.

For widgets with multiple array fields to bind to, the drag-and-drop feature shows the available value 

fields. A menu appears, where you can drill down and select the specific item to bind data. Items in the 

menu are arranged according to their sequence order.
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To bind the drag-and-drop data to a new item, select + Add Item. A new item is created and data is bound 

to it.

HMI

Work with Alarms

• Configure iFIX for Alarms  (on page 533)

• Configure CIMPLICITY for Alarms  (on page 535)

• Alarm Card  (on page 530)

• Alarm Count  (on page 541)

• Apply Filters to View Alarms  (on page 538)

• Acknowledge Alarms  (on page 540)

Related reference

Work with Mimics  (on page 121)

Work with Mimics

• Configure iFIX for Mimics  (on page 543)

• Configure CIMPLICITY for Mimics  (on page 551)

• Import Mimics (Classic)  (on page 348)

• Assign Mimics to Assets (Classic)  (on page 348)
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• Override an Assigned Mimic (Classic)  (on page 349)

• Set Up Mimic Target Zones (Classic)  (on page 350)

• Mimic Card  (on page 541)

Related reference

Work with Alarms  (on page 121)

Get Started with Proficy Batch
This topic describes how to get started with batch execution process.

1. Set up Batch  (on page 123).

2. Add a Batch Data Source (Classic)  (on page 366)  in Operations Hub.

3. Import and start using the sample application.

a. Open your installation ISO, and navigate to the Installation Content\Apps  folder.

b. Copy Proficy Batch Execution App  to a temporary folder on your hard drive.

c. Import  (on page 215)  the sample batch application to Operations Hub.

d. After import, navigate to your Batch data source, and modify the Endpoint URL  to reflect the 

host name of your Batch Server.

Alternatively, you may skip step 3 and proceed to creating your own application  (on page 204).

4. Configure properties for batch widgets  (on page 640).

5. Create and execute batch instances at runtime.

Perform these steps if your Batch Server uses a self-signed certificate. Ignore the following for 

digitally signed certificates.

a. Open your browser console.

b. Right-click any of the URLs and open in a new tab.
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The Your connection is not private  error screen appears on the new tab.

c. To bypass the error, select Advanced  > Proceed to <BatchServerName> (unsafe).

d. Close the tab.

6. Restart the Batch Server. After restart, make sure BatchRestService  is up and running.

Set up Batch
This topic describes how to set up Proficy Batch REST API.

Download these files from GE Salesforce.

• Proficy Batch Execution ISO file

• Batch REST API zip file

• Latest Batch SIM file

Note:

You also require a GE Digital Batch License Key with Batch Integration Services and Electronic 

Signatures for the Batch computer.

With Proficy Batch, operators can oversee batch processing using a set of batch widgets  (on page 640). 

Operator views and controls are provided in the form of Batch list, Batch control, etc. to execute batches 

efficiently. A sequential flow chart (SFC) widget presents a graphical view of the batch flows. For more 

information, refer to Proficy Batch Execution.

1. Log in to the machine where Operations Hub is installed.

2. Run the ISO file to install the Proficy Batch Execution application with default settings.

To create a Windows user account for the batch executive, provide the User name  and Password 

details.

https://www.ge.com/digital/documentation/batch/index.html
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After installation, Batch Execution  folder is created on your desktop.

3. Install the latest Batch SIM.

4. Restart your machine.

5. Unzip the BatchRestAPI  file and place the folder in your C drive.
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6. From the command prompt, run the installation for BatchRestAPI  service.

7. Access the Readme file in the unzipped BatchRestAPI  folder and follow the instructions for 

installation.

For example,

Country Name US

State or Province Name Massachusetts

Locality Name Boston

Organization Name GE

Organization Unit Name Digital

Common Name Enter your server name

Email Address ophubuser@gmail.com

Enter Export Password Enter a password.

You must modify the batch_config_rest_ser

vice.json  file to reflect this password.
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8. From the unzipped BatchRestAPI  folder, open batch_config_rest_service.json  in a text editor. For 

example, Notepad.

Refer to the BatchRestAPI Readme.txt  for more details.

9. Verify and update these parameters:

serverCertificatePassword Enter the export password.

basicAuthWindowsGroupValidation If true, then the Windows user (used for ba

sic auth and for bearer token security) should 

be a member of the Windows user group indi

cated by the property  basicAuthWindowsGroup. 

This is initially set to PROFICY_BATCH_REST_USERS. 

You must create this Windows group on the 

Batch REST Service computer, and add the cor

responding Windows users to this group.

Set this to false  if you do not want to use Win

dows Group validation.

basicAuthWindowsGroup PROFICY_BATCH_REST_USERS

uaaServers Enter the URL for Operations Hub Proficy Au

thentication (UAA).

Note:

Only one UAA server is supported.
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10. Ensure that the Operations Hub user is also a domain user or a local Windows user on the batch 

computer system. Refer to Configuring Windows User Accounts on the Batch REST Service 

Computer  (on page 128).

11. From the Batch Execution  folder, launch Server Manager.

The BatchServerManager  application screen appears.

12. Select Start Server  > Cold.

Important:

◦ Use the Windows Services to start/restart the BatchRestService  after you start/

restart the Batch Server.

◦ If BatchRestService  fails to start, stop the VBIS service and try again. If it still fails, 

check for error messages in the logs\batch_rest_api.log  file. Look for a syntax 

error in the batch_config_rest_service.json  file, which may be responsible for the 

BatchRestService  to not start.

◦ Remember to restart BatchRestService  if you make changes to the 

batch_config_rest_service.json  file.

◦ You can also start your Batch Client if you want to compare the data screens with 

the batch widgets.

◦ After the Batch REST Service starts, it can take a minute before it is available to 

receive REST calls.

For additional information on the UI screens of the batch widgets, refer to https://

www.ge.com/digital/documentation/batch/Operations_Manual.pdf.

https://www.ge.com/digital/documentation/batch/Operations_Manual.pdf
https://www.ge.com/digital/documentation/batch/Operations_Manual.pdf
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13. From the Batch Execution  folder:

Note:

You can perform this step right after installing the ISO file as well.

a. Launch Equipment Editor  and define your equipment models.

Refer to https://www.ge.com/digital/documentation/batch/

Equipment_Configuration_Manual.pdf.

In case you modify the equipment model:

▪ Make sure to validate your recipes.

▪ If the Batch Server was running, you must restart the Batch Server and the Soft Phase 

Server.

▪ If the VBIS Service was running, you should stop it. Then start/restart the Batch REST 

Service (this will automatically start the VBIS Service).

b. Launch Recipe Editor  and create your recipes.

A recipe contains a series of automated steps to execute a particular batch instance. The 

steps may also contain prompts that request for permission to proceed ahead, and trigger 

alarms that need your attention.

Refer to https://www.ge.com/digital/documentation/batch/

Recipe_Development_Manual.pdf.

Configuring Windows User Accounts on the Batch REST Service Computer

The batch widgets send a bearer token to the Batch Rest Service containing the currently logged in 

Ophub User account name. This account name must exist on the Batch Rest Service computer as a local 

Windows user, or as a domain user.

• If using local Windows user accounts, create the corresponding local Windows user accounts on 

the Batch REST Service computer that match the Ophub user account names.

• If you are using a domain user, the domain name can be a part of the Operations Hub user name 

(for example: ophubuser@DomainName). You can also use an Ophub account name without domain as 

part of the Operations Hub username. For example, ophubadmin.

• If you use an Operations Hub user name without domain, for example ophubadmin, the Batch 

REST Service will first look up this user to see if it is a valid local Windows user on the Batch 

REST Service computer. If it is not found, then it will look up this user on the Domain used by the 

computer. The order of the user lookup can be customized with the UAAUserDomainLookupOption 

property and is described in more detail the Batch Rest API readme.txt.

https://www.ge.com/digital/documentation/batch/Equipment_Configuration_Manual.pdf
https://www.ge.com/digital/documentation/batch/Equipment_Configuration_Manual.pdf
https://www.ge.com/digital/documentation/batch/Recipe_Development_Manual.pdf
https://www.ge.com/digital/documentation/batch/Recipe_Development_Manual.pdf
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• As an extra security feature, if the basicAuthWindowsGroupValidation  property is true, the Batch 

REST Service will validate that this user is a member of the basicAuthWindowsGroup. This group is 

initially set to PROFICY_BATCH_REST_USERS. If this is set to true, then be sure to add the windows user 

accounts to this Windows User Group.

Use e-Signatures

To use e-Signatures for batch widgets, do the following:

1. Create Windows user groups on the Batch REST Service computer that correspond to the e-

Signature Requirement Performed By  and Verified By  group names in the batch widgets.

For example, Operator  and Supervisor  group names are used in the Batch widgets sample 

application.

2. Create Windows users on the Batch REST Service computer and add them to the appropriate 

Windows user group used for e-Signature. Or if you are using Domain users, add the domain users 

to the appropriate Windows user groups used for e-Signature.

3. Be sure that the Windows User accounts full name  is not blank.

4. If using Domain users, be sure to set the GE Intelligent Platforms Security Server 

(iSecurity.exe)  Windows Service to run under a Domain user account, and restart this service.

About Dataflow Editor
A lightweight flow-based programming tool.

Use Dataflow Editor to interact across the Proficy portfolio via. REST or connect to third party data 

sources via SQL, MQTT or OPC-UA, etc. (requires additional downloads) to orchestrate real-time data 

transformation based on your business or process requirements. Refer to https://nodered.org/  for 

additional downloads and help.

You have the option to install Dataflow Editor  (on page 37)  when installing Operations Hub on your 

machine. Access the Dataflow Editor plug-in either from within the Configuration Hub application, or 

via. its independent URL. To access the Dataflow Editor user interface, you should be a member of 

iqp.nodered  group.

The URL to access Dataflow Editor independently is case-sensitive after the hostname: 

https://<hostname>/Node-RED/admin

Manually Register Dataflow Editor with Configuration Hub
This topic describes how to manually register and unregister Dataflow Editor with Configuration Hub.

https://nodered.org/
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• Ensure that security authentication source is configured for Configuration Hub.

• You should be an administrator to perform this task.

Perform these steps if you did not register Dataflow Editor with Configuration Hub during Operations Hub 

install.

1. On the Operations Hub machine, open Windows Command Prompt.

2. Change the directory to the path where Operations Hub is installed on your system: \Program Files

\GE\Operations Hub\ node-red\

3. Run the following command replacing placeholder with actual values:

node.exe ch_reg_plugin.js  <OPHUB_HOST>   <HTTPS_PORT>  <configHubContainerServiceBaseUrl>  

 =<clientId>:<clientSecret>    nodered

Placeholder Replace With

<OPHUB_HOST> The primary host name you selected during in

stall.

<HTTPS_PORT> The port assigned to https protocol for Opera

tions Hub. Typically it is 443.

<configHubContainerServiceBaseUrl> The base URL of the Configuration Hub Con

tainer Service.

<clientId> Identifier of a client that has permission (au

thority) to register with Configuration Hub.

<clientSecret> Client secret used to authenticate the client.

For example,

node.exe  ch_reg_plugin.js  ophubhost1.test.net   443  https://chhost:5000/container-svc/  

 =confighubadmin:itsSecret   nodered

4. To unregister manually, you must run the following command before uninstalling Operations Hub:

Note:

If you registered manually, then you should also manually unregister. Uninstalling 

Operations Hub does not unregister if you did not choose to register during installation.

https://www.ge.com/digital/documentation/confighub/version2022/t_authentication_setup.html
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Replace placeholder with actual values:

node.exe ch_reg_plugin.js  <OPHUB_HOST>   <HTTPS_PORT>  <configHubContainerServiceBaseUrl>  

 =<clientId>:<clientSecret>    nodered  unreg

Enable Windows Auto-login in an Active Directory Environment
This topic describes how to enable Windows Auto-login in an Active Directory Environment.

Note:

Windows Auto-login authentication is not supported on a local client browser if Proficy 

Authentication is installed on the same machine.

See also Proficy Authentication Windows Auto-login.

1. Install Proficy Authentication.

During installation (standalone or as part of Operations Hub), use a FQDN that has a proper 

record on the DNS server as the primary host name. A local name will not work. IP address is not 

recommended either.

2. Log in to Proficy Authentication, and configure LDAP identity provider using the domain’s LDAP 

server.

Test the LDAP login to make sure it works for LDAP users.

3. Create a user account on the Active Directory domain.

Proficy Authentication (UAA) uses this account for validating Windows domain credential 

(Kerberos service tickets) presented by browser on user’s behalf.

4. Build the Service Principal Name (SPN).

The SPN is formed based on the host’s canonical domain name, not any other aliases. It is in the 

form ofHTTP/fqdn@REALM, where HTTP is literal. The fqdn  should be replaced by the actual FQDN 

of the host, typically in lower case, and REALM  be replaced by the Active Directory domain name, 

typically in upper case.

For example, if the Active Directory domain name is test.net, the host’s FQDN isuaa.test.net, then 

the full SPN is HTTP/uaa.test.net@TEST.NET

5. Create a keytab file for this account.

The keytab file contains the cryptographic keys that are private to this account. Each key is specific 

to an encryption algorithm, so all the algorithms allowed for the account must be accounted for in 

the keytab file. It is recommended to specify All  for the crypto parameter Crypto. The following is 

an example of how ktpass.exe  command is used to generate a keytab file on a domain server:

https://www.ge.com/digital/documentation/confighub/version2022/c_proficyauth_enable_autologin.html
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ktpass.exe -out xyz.keytab -mapUser xyz@TEST.NET +rndPass -mapOp set +DumpSalt -crypto All

-ptype KRB5_NT_PRINCIPAL -princ HTTP/xyzuaa.test.net@TEST.NET

6. Copy the generated keytab file to the machine where Proficy Authentication is installed.

For convenience, it is recommended to place the keytab file under the same directory as uaa.yml 

file, which is found in either of these locations:

◦ C:\ProgramData\GE\Operations Hub\uaa-config

◦ C:\ProgramData\GE\Proficy Authentication\uaa-config

The keytab file contains crypto information, So it is strongly recommended to set a security for the 

file. The file should not be readable by non-privileged user accounts, except for the service account 

NT SERVICE\uaaTomcat.

7. Configure UAA with the SPN and keytab file.

a. Create a new file kerberos.yml  (or use a different name but with .yml  extension) under the 

sec  subdirectory of the uaa-config  directory, with the following code:

kerberos:

  service-principal: HTTP/xyzuaa.test.net@TEST.NET

  keytab-location: 'file:///C:/ProgramData/GE/Operations Hub/uaa-config/xyz.keytab'

b. Open uaa.yml  file under uaa-config  directory and copy the kerberos section at the end of 

the file as a template (the SPN and the full path to the keytab file as referenced in the above 

code).

8. On client machines, make sure that the Proficy Authentication host is recognized on the Local 

Intranet zone or as a Trusted Site.

If not recognized, the Chrome browser will not request a Kerberos ticket to send to Proficy 

Authentication. For test/staging purposes, it can be done via Control Panel as shown here:
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If the setting is configured interactively using Control Panel, then it is effective only for one user 

on one client machine. To configure for all users on one client machine, use local group policy. In 

an enterprise setting, an administrator should configure client machines via group policy. You can 

access the policy from User Configuration  > Administrative Templates  > Windows Components 

> Internet Explorer  > Internet Control Panel  > Security Page  > Site to Zone Assignment List, as 

shown here:
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9. If Operations Hub is installed on a different machine than Proficy Authentication (i.e., in case of 

External Proficy Authentication or External UAA), then only the external UAA host name matters.

10. As an administrator, you may allow users to interactively choose an authentication option, or you 

may set it in the URLs you distribute to users.

a. Use a query parameter in Operations Hub Designer app or End app’s URL.

For example, if a regular Designer app’s URL is https://xyz.test.net/iqp, then a URL that 

enables Windows Auto-login would be: https://xyz.test.net/iqp?authOption=kerberos

This addition of authOption  query parameter enables Windows Auto-login for the session.

b. If the authentication is not included in the URL, then the following screen appears:
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Standard Proficy Authentication Login Choose this option if you want to use the 

standard login (username/password or 

SAML), or if Windows Auto-login has not 

been configured with Proficy Authentica

tion.

This is a regular login, which is based on 

username/password, including LDAP, or 

SAML.

Active Directory (Windows) Integrated Login Choose this option only when it is set up 

with Proficy Authentication.

This allows for autologin, wherein a user’s 

domain login session is used to log in to 

Proficy Authentication.

Don’t ask me again Select this check box, if you don't want to 

display the Select Authentication  screen 

every time you login.

The system remembers the last selected au

thentication (between regular and autologin) 

and applies it for future logins.

With Don’t ask me again  enabled, you can 

clear the last selected authentication only 

during logout.

Select You may also click here to clear the 

previously selected authentication option 
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to clear the saved selection. Once cleared, 

the clearing option is hidden from the logout 

screen.

Select click here to login again  to return to 

the login page.

Defer Select to dismiss this screen, and skip se

lecting an authentication. You have the 

choice to select authentication next time 

you login.

Note:

◦ It is not  necessary for Proficy Authentication (or Operations Hub if different) host to 

be a domain member; it only needs to have a valid DNS record. However, both the 

user and the client machine that the user has logged into must be of a domain user/

domain member respectively, in order to produce a Kerberos ticket to authenticate 

with Proficy Authentication.

◦ For Administrator’s Console, the only way to use Windows Auto-login is to use the 

additional query parameter in the URL: https://xyz.test.net/site/adminconsole?

authOption=kerberos



Chapter 3. User Guide

Overview

Overview of Operations Hub
Operations Hub  is an end-to-end solution for developing, managing, and delivering applications to 

leverage the capabilities of big data analytics and the internet of things.

Using Operations Hub, you can create applications that will collect and analyze data from a machine or a 

server, and trigger actions based on certain events.

Operations Hub  provides you with a user-friendly interface to create components of an application 

such as queries  (on page 247), database tables  (on page 225)  (called entities), events  (on page 

295), email templates  (on page 305), users  (on page 316), and so on without the need to use your 

programming skills. You can also design pages and dashboards using these components.

Advantages of using Operations Hub:

• Operations Hub  is quick, easy, and cost-effective. You do not need programming skills to develop 

an application.

• The Operations Hub  applications use HTML5 and CSS3, and hence, they are platform-independent.

• You can access an application using a computer or a mobile device.

• You can provide controlled access to an application and data based on user roles.

• You can create entities and queries for a relational database.

Note:

If you have installed only the Operations Hub  add-on for Historian, you cannot create, modify, 

or delete an application or a component of an application. You can only access the Historian 

analysis application.

Refresh Session Timeout
Refresh the session to reset its expiration time.

Operations Hub login session expires based on the configured timeout settings  (on page 67). When the 

session is close to expiration, an alert appears requesting to save your work.

Select Refresh  to reset the session timeout settings, and continue with your work.
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The session expires if the warning is left unacknowledged. You must log back in to Operations Hub to 

start a new session, and resume your work. Any unsaved work prior to a session timeout will be lost.

Operations Hub (New Layout)

Panels Layout
This topic provides an overview of the latest Operations Hub application layout.

Log in to the latest version of Operations Hub via Configuration Hub and access the Operations Hub home 

page. The following screen provides an overview of all the panels that appear in the Operations Hub new 

layout.

1 Toolbar Menu  (on page 139)

2 Navigation Panel  (on page 139)

3 Components Panel  (on page 142)

4 Display Panel  (on page 152)

5 Details Panel  (on page 157)
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Toolbar Menu

The toolbar contains the following menus:

Select this icon to reload the application.

Select this icon to work in the configuration mode, wherein you are con

nected to the Configuration Hub navigation panel.

Select this icon to work in the Operations Hub designer mode. The Con

figuration Hub navigation panel is disconnected to allow more work area 

for Operations Hub designer.

Save The Save  button on the toolbar is highlighted whenever you modify set

tings.

Select this icon to access Operations Hub online documentation.

Select the icon to open/close Navigation  and Details  panels for a clut

ter-free workspace.

Select this icon to logout of the application.

Navigation Panel
This topic provides an overview of the navigation panel from Configuration Hub in the Operations Hub 

new layout.

On this panel, you can navigate to other Proficy applications installed within your Configuration Hub 

environment. Under Operations Hub, you have access to the following areas:

• Applications  (on page 139)

• Plug-ins  (on page 141)

Applications

On the applications homepage, you can perform tasks as described in the following table.
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1 Creates a new application.

2 Imports an application.

3 Allows to perform the following actions:

• App Actions: A selection check box appears next to the applications 

and allows to perform related operations.

• Page Actions: A selection check box appears next to the pages and 

allows to perform page related operations. You must select the app 

to show page check box.

• Clear: Clears all selection check boxes.

4 Opens a Column Chooser  dialog, where you can select the columns you 

want to appear on the applications homepage.

5 Enter keywords to search for applications or pages.

6 Sorts columns in ascending or descending order. The status is indicated 

by the up/down arrow on each sortable column header.

7 Indicates whether the application is in a locked or unlocked state.

8 Allows to perform tasks on the selected application or page. You can ei

ther:

• Select this icon for the app/page to access task actions, (OR)

• Right-click the app/page to access task actions.

Existing app/page names are quickly editable on the homepage itself.
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Note:

Applications/pages created in the Operations Hub Classic version 

cannot be modified in the new Operations Hub layout. Such appli

cations are marked as legacy apps. You can only preview them.

Refer to these topics for step-by-step instructions:

• Create an Application  (on page 204)

• Modify Settings  (on page 404)

• Copy an Application  (on page 207)

• Export an Application  (on page 210)

• Delete an Application  (on page 220)

• Grant Group Access to Page within an Application  (on page 372)

• Create a Page  (on page 376)

• Copy a Page  (on page 381)

• Delete a Page  (on page 385)

9 Opens the end application.

Plug-ins

On the plug-ins homepage, you can perform tasks as described in the following table:

1 Enter keywords to search for plug-ins.

2 Expand System  to view the system plug-ins available in Operations Hub.

See also Visuals Tab  (on page 143).

3 Expand Custom  to view custom plug-ins.

If you have saved any customized plug-ins, then they appear under custom 

plug-ins.

4 Reloads the plug-ins screen.
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For a high-level panel layout, see Panels Layout  (on page 138).

Components Panel
This topic provides an overview of the components panel in the Operations Hub new layout.

On Operations Hub components panel, you can access the following tabs for designing application pages:

• Visuals  (on page 143)

• Data  (on page 147)

• Page Data  (on page 151)

• Page Visuals  (on page 152)

On Operations Hub components panel, you can access the following tabs while working with the SVG 

editor:

• Graphic Tree: On this tab, expand the tree-view structure to review the properties currently 

configured for the graphic.

• Graphics List: On this tab, you can access all the plug-ins listed under the custom category.
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For a high-level panel layout, see Panels Layout  (on page 138).

Visuals Tab
This tab provides access to system and custom plug-ins in Operations Hub.

You can configure the plug-ins to work with the components of an application, such as entities and 

queries.

1. Open an application page.

2. Select the Visuals  tab.

3. Drag-and-drop the plug-ins to design your page.

You can also double-click a plug-in to add to the page.

Following list of plug-in categories are available as System  plug-ins:

• Charts  (on page 144)

• Display  (on page 144)

• General  (on page 145)

• HMI  (on page 146)

• HMI Graphics  (on page 146)

• Inputs  (on page 146)

• Layout  (on page 147)

The Custom  plug-ins contains the list of plug-ins saved with custom functionality. Refer to About HMI 

Graphics  (on page 173).

Plug-in Enhanced Preview

Enhanced preview enables to access the real-time data preview within the page designer itself. Some 

of the plug-ins under Charts  (on page 144), Display  (on page 144), and Inputs  (on page 146)  are 

powered with an enhanced preview feature. This means that the plug-in preview (within the designer) is 

the same as the result that appears in the end application. Refer to the respective plug-in categories for a 

full list of plug-ins that support enhanced preview.

Currently, the enhanced preview feature works only when the data is bound to the plug-in using the 

manual  (on page 159)  option. Data binding via other methods does not support enhanced preview.
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Charts

Except Timeline  (on page 511), Spider Chart  (on page 508), Trend Card  (on page 610), and 

Histogram  (on page 605), the enhanced preview feature is available for all the charts category plug-ins.

Bullet Graph  (on page 

501)

Compares a single value to a target value. Available variants are bullet 

graph and bar graph.

Histogram  (on page 605) Creates a visual representation of data distribution.

Spider Chart  (on page 

508)

Visualizes data in a web-like pattern to compare and analyze multiple data 

sets.

Trend Card  (on page 610) Helps to analyze data trends over a time period.

Note:

Do not rotate the trend card plug-in in the page designer.

Variwide Chart  (on page 

515)

Each column in a variwide chart has a separate width to represent the 

third dimension. Helps to analyze multi-dimensional data.

Sparkline  (on page 506) Visualizes events over a time span. The chart displays each data point of a 

set of time series data as a separate event along a horizontal line. Creates 

tiny data charts that can fit into compact areas in your application.

Line Chart  (on page 497) Use a line chart to visualize data using data points.

Pareto Chart  (on page 

504)

Graphically summarize and display the relative importance of the differ

ences between groups of data.

Pie Chart  (on page 500) Visualize data using data points that belong to different categories.

Timeline  (on page 511) Create visual charts that help to monitor the progress of your events.

Display

Except DataGrid  (on page 559)  and Pivot Grid  (on page 574), the enhanced preview feature is 

available for all the display category plug-ins.

Gauge Bar  (on page 567) Presents data in simple bar format.

Gauge Circular  (on page 

569)

Measure data values on a radial scale.
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Gauge Linear  (on page 

570)

Measure data values on a linear scale.

Solid Gauge  (on page 

579)

Displays data in six different styles with alert and color limits.

DataGrid  (on page 559) Displays data in a tabular format. Supports grouping, filtering, and sorting 

column data. You can also animate the data cells.

Pivot Grid  (on page 574) Visualize data in a multi-dimensional format. You can apply conditions to 

format cells, filter rows/columns by value, and export data to a CSV file.

Image  (on page 588) Insert images in your application.

Indicator  (on page 635) Indicator with range limits and styling.

Simple Indicator  (on page 

590)

Simple indicator is a lighter version of the indicator plug-in.

List  (on page 590) Display data in bullet points.

Text Display  (on page 

591)

Create display-only text in your application.

Value Display  (on page 

583)

Displays data values with a variety of configurable properties.

General

Favorite Organizer  (on 

page 600)

Create folders and organize your favorite trend charts.

iFrame  (on page 572) Load information from external sources.

Breadcrumb  (on page 

594)

Shows the hierarchy to the current asset and allows the user to select any 

item in the list to trigger a change of context to that asset. Use a bread

crumb for easy navigation in your application.

Note:

Do not rotate the breadcrumb plug-in in the page designer.

HTML Editor  (on page 

639)

Helps to create and edit HTML code.
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HMI

Alarm Card  (on page 530) Provides details of the active alarms by their severity levels in the HMI/

SCADA system for the selected asset.

Alarm Count  (on page 

541)

Provides the total alarm count by their severity levels in the whole HMI/

SCADA system.

CIMPLICITY HMI Web

space  (on page 517)

Opens an instance of the Webspace remote access application.

Mimic Card  (on page 

541)

Displays mimics from the SCADA systems.

iFIX HMI Webspace Opens an instance of the Webspace remote access application.

HMI Graphics

Use the following list of graphics based on your specific application and industry requirements. See About 

HMI Graphics  (on page 173).

Gauge High performance HMI graphic to represent pressure, flow, temperature or 

level gauges.

Mixer High performance HMI graphic to represent agitators or batch mixers.

Motor High performance HMI graphic to represent AC/DC motors, etc.

Pump High performance HMI graphic can be configured to provide real-time 

feedback on the pump's status, such as flow rate, pressure, temperature, 

etc.

Tank High performance HMI graphic to represent storage, mixing, or pressure 

tanks.

Valve High performance HMI graphic to represent centrifugal, displacement, or 

gear pumps.

Inputs

The enhanced preview feature is available for all the input category plug-ins.

Button  (on page 491) Trigger an action in your application.

Check Box  (on page 493) Create mutually exclusive data options.
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Date Picker  (on page 

592)

Display date and time in a variety of formats.

Dropdown  (on page 598) Create a drop-down list from which operators can select between multiple 

choices.

DateTime Range Picker  (on 

page 597)

Display and edit beginning and ending date time pairs.

Radio Button  (on page 

493)

Create radio button selection list.

Slider  (on page 494) Generate a slider selection format.

Text Area  (on page 495) Create a text area in your application.

Text Input  (on page 495) Insert a text box wherein the operator can enter data that goes in to the 

database.

Toggle  (on page 496) Create a toggle switch.

Layout

Interactive Map  (on page 

170)

Create a coordinate/flex interactive map layout.

Repeater  (on page 172) Create a flex repeater layout.

Data Tab
This tab displays the data types you can apply to the plug-ins.

Select your data type from the Type  drop-down field.

Choose from the following data types:
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• Tag Browser  (on page 148)

• Query  (on page 148)

• Globals  (on page 149)

• Admin Functions  (on page 149)

• M2M Functions  (on page 150)

• Asset Management Functions  (on page 150)

Tag Browser

You can browse a data source and select the properties/tags.

1. From Type, select Tag Browser.

2. From Query, select an extension query.

The selected query is populated in Query Name.

3. Browse the data source and select the check box for the tag/s you want add.

4. Drag and drop the tags on the plug-in to bind data.

Query

To learn more about creating and working with queries in Operations Hub, refer to About Queries  (on page 

247).

1. From Type, select Query.

2. From Query Type, select the query type you want to use. The query types appear in the list box 

based on the queries you created in the Operations Hub classic version. For example, if you select 

Extension  or Entity, additional selection fields appear.

Extension Populates extension type of queries in the Query  field.

Select an extension query to add to the plug-in. The selected 

query is populated in Query Name.

Entity Populates entities in the Query  field.

Select an entity to add to the plug-in. The selected entity is 

populated in Query Name.

3. Select + Add.
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Globals

To learn more about global variables in Operations Hub, refer to Globals  (on page 658).

1. From Type, select Globals.

2. From Globals, select any of these options:

System Is associated to a computer's settings. Populates system date/

time variables.

Output Is associated to query data fields. Populates available queries 

in the Query  field.

a. Select a query to populate its date fields.

b. Select a data field from Outputs.

Custom Allows you create your own customized global variable.

a. Enter a name for the variable.

b. Choose from the available data types to define the vari

able.

URL Parameters Is associated to a URL address. Enter a name for the variable.

3. Select + Add Global. All added globals appear on the Page Data  tab.

4. Go to Page Data  tab and select the global. The global details appear on the details panel.

5. On the details panel, you can specify the Global Type  as App  or Page  global.

6. For custom and URL parameter global, enter the Initial Value.

Admin Functions

Use these functions to perform system administration tasks.

1. From Type, select Admin Functions.

2. Select from:

Send Email Sends an email to specified recipient/s using the email sender 

service.

DeleteAlertInstance Deletes the alert set for an asset object instance.

StartStopAlertInstance Starts and stops the alert set for an asset object instance.

Get all apps Retrieves a list of all applications in Operations Hub.
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Get all apps for user id Retrieves a list of all applications in Operations Hub that are 

associated with a specific user ID.

Delete image on hard disk Deletes the image file on the logged-in user's hard disk.

GetAllAlerts Retrieves a list of all alerts in Operations Hub.

appGetCurrentUser Retrieves the current user of the application.

GetEventByName Retrieves an event by its name.

3. Select + Add.

M2M Functions

Perform machine-to-machine functions to control and manage devices remotely.

1. From Type, select M2M Functions.

2. Select from:

Send_MQTT_Command Sends a command to a device using the MQTT (Message 

Queuing Telemetry Transport) protocol. The device must be 

configured with IQP MQTT.

Send_REST_Command Sends a command to a device using the REST (Representation

al State Transfer) protocol.

3. Select + Add.

Asset Management Functions

Use these functions to manage and track assets, such as devices and systems.

1. From Type, select Asset Management Functions.

2. Select from:

Add new device type Creates a new category to classify similar type of devices.

Add new metric to device type Adds a new measurement unit to the device type.

Add new device Adds a new device (for example, Pump).

Add new thing Adds a new thing (IoT devices)
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Add new group Creates a new group to gather and manage similar devices or 

things.

Add device or thing to group Assigns a device or thing to a group.

Add new device cloud Adds a new device cloud, which can be used to host and man

age devices remotely.

Add new cloud account Adds a new cloud account, which can be used to manage de

vices that are hosted on a cloud service.

3. Select + Add.

Page Data Tab
This tab displays the data applied to the page.

1 Enter keywords to search within the data (queries, globals, etc.) that is 

bound to the page.

2
When enabled, the icon turns blue . In this mode, you can drag and 

rearrange the order of queries. To move a query up/down in a ordered list, 

simply select and drag the query item, and then drop it on the new location 

(up/down).

3 A tree-view of the data that is bound to the page.

4 Option to delete the data bound to the page.
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Page Visuals Tab
This tab displays a visual overview of all the elements or objects on the page.

1. Open an application page.

2. Select Page Visuals  tab.

3. Select any object on the page to locate its hierarchy in the tree layout.

1 Enter keywords to search within the elements added to the page.

2 Elements added to the page appear in a tree data structure showing their 

hierarchical relationship.

To sort the elements in ascending/descending order, select the Element 

column header.

3 You can perform the following actions:

• Delete at card-level. The card and the plug-ins within the card are 

deleted from the page.

• Delete a plug-in added to the page.

• Show/Hide a plug-in on the page.

Display Panel
This topic provides an overview of the display panel in the Operations Hub new layout.

The display panel serves as the display area for working with applications and their pages within 

Operations Hub.
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Before you start to design your page, you can set up the page grid. Open the page and select anywhere 

outside of the card to access the settings for the page grid. Refer to Page Grid Details  (on page 159).

Select the data panel icon to show or hide the components panel  (on page 

142)  and increase the display panel work area.

Select this icon to show or hide the ruler. The ruler appears by default 

when you create a page.

Adds a card on the page. A card is a container that holds the plug-in ob

jects.

• See Coordinate Card  (on page 169)

• See Flexbox Card  (on page 161)

The page refresh icon appears when you edit a page. If the layout gets dis

torted, refresh the page.

During user interface operations (in particular when using Flexbox layout, 

or after Undo/Redo operations), the display panel's canvas area might get 

distorted or misaligned. To recover the page, select the refresh icon to re

load the view.

Select the full screen icon to display in the full screen mode.

Page Building Tools A tools menu that you can use to format plug-in objects on a page. See 

Page Building Tools  (on page 154).

Undo an action on the page.

Redo an action on the page.

Launches the end application.

For a high-level panel layout, see Panels Layout  (on page 138).

Keyboard Shortcuts Keys

These are the computer keyboard shortcut keys to perform UI operations:
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UI Operation Windows Mac

Copy Ctrl+C Command+C

Paste Ctrl+V Command+V

Duplicate Ctrl+D Command+D

Toggle line connector mode L L

Toggle ruler Ctrl+R Command+R

Redo Ctrl+Y Command+Y

Undo Ctrl+Z Command+Z

Page Building Tools
Use these tools to design visually appealing application pages.

Tool Description

Line Connector On/Off Activates or deactivates the line connector. Use the line connector tool 

to connect and draw a relationship between two plug-in objects on the 

page. See Line Connector  (on page 155).

Bring Front When objects overlap on the page, brings the selected object to the 

front.

Send Back When objects overlap on the page, sends the selected object to the back.

Group Groups two or more selected objects on the page.

Un Group Ungroups a grouped object.

Horizontal Flip Turns the object to create its mirror image.

Vertical Flip Turns the object upside-down.

Align Horizontally Center Horizontally aligns all the objects towards the center of the page.

Align Vertically Center Vertically aligns all the objects towards the center of the page.

Align Vertically Top Vertically aligns all the objects towards the top of the page.

Align Vertically Bottom Vertically aligns all the objects towards the bottom of the page.
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Tool Description

Align Left Aligns all the objects to the left side of the page.

Align Right Aligns all the objects to the right side of the page.

Distribute Horizontally Horizontally aligns the selected objects and evenly distributes the space 

between them.

Distribute Vertically Vertically aligns the selected objects and evenly distributes the space 

between them.

Guide On Shows the guidelines on the page.

Guide Off Hides the guidelines on the page.

Guide and Snap On Shows the page guidelines, and object snap points.

Guide and Snap Off Hides the page guidelines, and object snap points.

Line Connector
A line connector is a tool to show a connection between two or more objects.

Place two visual objects next to each other on a page, and draw a line connector to link them. You 

can draw straight line connectors or angle line connectors to link visual objects. You can use the line 

connector properties  (on page 156)  to:

• Customize line connector arrowheads to help explain the direction of the flow from one object to 

the other.

• Apply varied line styles.

• Add a unique color and thickness to the lines.

Draw Line Connector

To draw a line connector, follow these steps:

1. On the page designer toolbar  (on page 154), select  to activate the line connector.

2. Single-click/mouse-click on the page where you want to draw.

3. Start to draw the line by dragging the mouse in the direction you want the line to go. To add a 

vertex in line, single-click.
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4. To end the line connector, Shift-click. (On the keyboard, hold down the Shift  key and release the 

mouse-click.)

5. To deactivate the line connector, select  on the page designer toolbar  (on page 154).

Add Vertex

A vertex is a node/point on the line connector. You can add a vertex on the line connector to help 

demonstrate the relationships between multiple objects. To add a vertex to any line connector:

1. Select the line connector, for which you want to add a vertex.

2. Double-click to select the area on the line connector where you want to add a vertex.

3. Drag the vertex to create an angle.

Delete Line Connector

To delete a line connector:

1. Select the line connector you want to delete.

2. Select  that appears next to the line connector. You can also select the Delete  key on the 

keyboard to delete the line connector.

Line Connector Properties

Property Description

Color Use the color palette to apply a color to the line.

Width Enter a width to set the thickness of the line.

Stroke Type Define how you want the line to appear:

• solid: Creates a solid line.

• dots: Creates a dotted line.

• dashes: Creates a dashed line.

Start Marker

End Marker

Define a start/end line marker from these options:

• smallArrowMarker: Adds a small-sized arrowhead.

• mediumArrowMarker: Adds a medium-sized arrowhead.

• largeArrowMarker: Adds a large-sized arrowhead.
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Property Description

• vertexMarker: Adds a circle.

• none: No line marker is added.

Middle Marker Define a line marker for the points in the middle of the line:

• circle: Adds a circle.

• none: No line marker is added.

Layer These layers are defined for line connectors so that they appear either 

above or behind the plug-ins in the end application.

• back: The line connector is sent to the back, when overlapped by 

any object on the page.

• front: The line connector is brought to the front, when overlapped 

by any object on the page.

Rounded Corners Select this check box if you want a round corner instead of a pointed cor

ner.

Details Panel
This topic provides an overview of the details panel in the Operations Hub new layout.

All the properties/settings specific to your current selection appear on the details panel.

• Access application settings  (on page 404).

• Access page settings  (on page 372).

• You can modify and save plug-in properties.

• Select source/target data. See Bind Your Data to Plug-ins  (on page 157).

• Access animation properties in the SVG editor mode.

For a high-level panel layout, see Panels Layout  (on page 138).

Bind Your Data to Plug-ins
This topic describes the available options to configure source and target data.

In Operations Hub, you can select from the following options to pass values to the plug-in from your data 

source. You can also specify a target data source to receive data from a plug-in.
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• Query  (on page 158)

• Global  (on page 159)

• Manual  (on page 159)

• Formula  (on page 159)

• Fetch Data Property  (on page 159)

On the plug-in's details panel, you can choose the options from a drop-down menu.

Query

When using a query to configure source data, select at least one output field.

Alias Option to enter a temporary name for the query's output field.

Output Field Lists all the data fields available in the selected query.

On executing the query, data is retrieved from the data source for the se

lected output fields.

For example, a weather application might use a query to retrieve the cur

rent temperature, humidity, and precipitation levels for a particular location, 

and use these fields as the basis for its output.

+Add To include additional query output fields, select this option.

+Add All If you want to include all the query output fields, then select this option.

When using a query to configure target data, select at least one input field.

Input Field Lists all the data fields available in the selected query.

The selected input fields are used to execute the query to retrieve data.

For example, a weather application might include input fields where you 

can specify the location, temperature unit, or forecast duration.

+Add To include additional query input fields, select this option.
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To learn more about creating and working with queries in Operations Hub, refer to About Queries  (on page 

247).

Global

This option allows you to select a global variable to configure source data and target data.

To learn more about various types of global variables in Operations Hub, refer to Globals  (on page 658).

Manual

This option allows you to manually enter the values for the plug-in. You can also access enhanced 

preview  (on page 143)  of the real-time data within the page designer. The plug-in preview is the same as 

the result that appears in the end application.

Formula

Select Add Formula  to create a formula that returns values for the plug-in.

Fetch Data Property

This option is view-only. It applies when you drag-and-drop tag data on a plug-in. The drag-and-drop action 

automatically fetches the data from the data source, and updates values to a list of applicable properties.

On drag-and-drop, the Fetch Data Property  label appears for:

• Minimum and Maximum scale values

• Engineering unit

• Data range values

In case you drag-and-drop multiple tags on a plug-in, then values fetched from the first tag are applicable 

to the above listed properties.

Page Grid Details
This topic describes the page grid properties.

A page is divided into grids, wherein multiple card layouts can be added. Select outside of the card layout 

to access the page's grid properties. By default, the page grid has 12 rows and 12 columns.
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Properties

Field Name Description

Grid Type Choose from these grid types:

• fit: The grid fits to the size of the available space irrespective of the 

specified number of rows and columns.

• fixed: This is the default option. The grid appears in a fixed size based 

on the specified number of column and rows.

• verticalFixed: The grid's row height is fixed. Column width is ad

justable to fit to the size of the available space.

• horizontalFixed: The grid's column width is fixed. Row height is ad

justable to fit to the size of the available space.

Mobile Breakpoint This value determines the page grid layout adjustment on a mobile device.

Margin This value determines the size of the gap between the rows and columns.

Display Grid Choose how you want to display the grid on the page:

• always: Shows the grid lines on the page.

• onDrag&Resize: Allows to drag and resize grid columns and rows.

• none: Hides the grid lines on the page.

Fixed Col Width Appears when Grid Type  is fixed  and horizontalFixed.

Enter a value to set a fixed width for the grid columns.

Fixed Row Height Appears when Grid Type  is fixed  and verticalFixed.

Enter a value to set a fixed width for the grid rows.

Min Cols Appears when Grid Type  is fit  and verticalFixed.

Enter a value to set minimum width for the grid columns.

Max Cols Appears when Grid Type  is fit  and verticalFixed.

Enter a value to set maximum width for the grid columns.

Min Rows Appears when Grid Type  is fit  and horizontalFixed.

Enter a value to set minimum width for the grid rows.

Max Rows Appears when Grid Type  is fit  and horizontalFixed.
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Field Name Description

Enter a value to set maximum width for the grid rows.

Row Height Ratio Appears when Grid Type  is fit.

Outer Margin Appears when Grid Type  is fit, verticalFixed, and horizontalFixed.

Flexbox Card
This layout offers a flexible and responsive design structure.

A flexbox card aligns and distributes the items along a main axis. Objects placed within a flexbox card 

are laid out next to each other, row-wise or column-wise. When we drag and drop plug-in objects, they get 

rearranged to follow the one-dimensional layout concept.

The ideal way to use a flexbox card is when you have objects that require flexibility to grow and shrink, 

and fit within the layout. Use the flexbox properties to control the alignment and distribution of the objects 

(items).

Flexbox Properties

Field Name Description

Columns The card occupies the specified number of columns on the page grid  (on 

page 159).

Rows The card occupies the specified number of rows on the page grid  (on page 

159).

Position X Applies to the horizontal placement of the card on the page. When the value 

is 0, the card is placed on the left-most side of the page. As you increase the 

value, the card moves away from the left side of the page.

Position Y Applies to the vertical placement of the card on the page. When the value is 0, 

the card is placed at the top of the page. As you increase the value, the card 

moves away from the top of the page.

Flex Direction The objects are arranged next to each other based on these placement direc

tions:
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Field Name Description

• Row: The objects within the card are placed horizontally, from left to the 

right.

• Column: The objects within the card are placed vertically, from top to 

bottom.

• Row reverse: The objects within the card are placed horizontally, from 

right to left.

• Column reverse: The objects within the card are placed vertically, from 

bottom to top.

See Flex Row  (on page 165), Flex Row and Column  (on page 166).

Flex Wrap By default, objects within the card are not wrapped.

• Nowrap: All the objects within the card try to fit into a single line, as per 

the flex direction.

• Wrap: The objects are evenly spaced, and are arranged in multiple lines, 

as per the flex direction. The wrap orientation is from top to bottom.

• Wrap reverse: The objects are evenly spaced, and are arranged in mul

tiple lines, as per the flex direction. The wrap orientation is from bot

tom to top.

See Flex Wrap  (on page 167).

Justify Content You can choose from these options to align objects along the main axis (left 

to right):

• Flex start: Objects are pushed towards the start of the direction (left).

• Flex end: Objects are pushed towards the end of the direction (right).

• Center: Objects are pushed towards the center of the direction (hori

zontal center).

• Space between: Objects are evenly spaced on a single line.

• Space around: Objects are evenly spaced on a single line, with equal 

amount of space around them.

Align Items You can choose from these options to align objects along the cross axis (top 

to bottom):
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Field Name Description

• Flex start: Objects are pushed towards the start of the direction (top).

• Flex end: Objects are pushed towards the end of the direction (bot

tom).

• Center: Objects are pushed towards the center of the direction (vertical 

center).

• Baseline: Objects choose a baseline (for example, title of the object) 

and align accordingly.

• Stretch: Objects stretch to fill the card.

Layout Type Choose from the following card layouts before starting to design your pages:

• Coordinate: Objects dropped on this layout stay where they are on the 

page. See Coordinate Card  (on page 169).

• Flexbox: Objects dropped on this layout are automatically arranged on 

a single line.

Flex Grow Enter a value for the object to grow in size with the flexbox layout. The val

ue determines how much the object will grow in comparison to other objects 

within the layout.

Flex Shrink Enter a value for the object to shrink in size with the flexbox layout. The val

ue determines how much the object will shrink in comparison to other objects 

within the layout.

Flex Basis This default property is the initial size of the objects within the flexbox layout. 

You can grow/shrink this size.

Style Select these check boxes to format the objects:

• Rounded Corners: Adds a rounded corner instead of a pointed corner.

• Custom Colors: Adds color.

Function Layout functionalities:
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Field Name Description

• Card: This is the regular flexbox layout option without any additional 

functionalities.

• Interactive Map: This flexbox layout includes an interactive map func

tionality. See Interactive Map  (on page 170).

• Repeater: This flexbox layout includes a repeater functionality. You can 

create multiple instances of a plug-in dropped in a repeater layout. Re

fer to Repeater  (on page 172)  layout properties.

Show/Hide Select +Add Conditions  to create conditions to show or hide the card. See Ap

ply Conditions  (on page 657).
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Flex Row
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Flex Row and Column
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Flex Wrap
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Resizing the Flexbox Layout
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Coordinate Card
This layout offers an absolute layout design structure.

This is the default card layout when you start to design application pages. You can drag and drop plug-

in objects to an absolute position on the card. The end application reflects the same as in the coordinate 

card page design.

Field Name Description

Columns The card occupies the specified number of columns on the page grid  (on 

page 159).

Rows The card occupies the specified number of rows on the page grid  (on page 

159).

Position X Applies to the horizontal placement of the card on the page. When the value 

is 0, the card is placed on the left-most side of the page. As you increase the 

value, the card moves away from the left side of the page.

Position Y Applies to the vertical placement of the card on the page. When the value is 0, 

the card is placed at the top of the page. As you increase the value, the card 

moves away from the top of the page.

Layout Type Choose from the following card layouts before starting to design your pages:

• Coordinate: Objects dropped on this layout stay where they are on the 

page.

• Flexbox: Objects dropped on this layout are automatically arranged on 

a single line. See Flexbox Card  (on page 161).

Style Select these check boxes to format the objects:

• Rounded Corners: Adds a rounded corner instead of a pointed corner.

• Custom Colors: Adds color.

Function Layout functionalities:

• Card: This is the regular flexbox layout option without any additional 

functionalities.

• Interactive Map: This flexbox layout includes an interactive map func

tionality. See Interactive Map  (on page 170).
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Field Name Description

scale Line Connector This option is set at card level. With this setting, the line connector works 

similar to percentage %. All the other plug-ins that are connected using line 

connector need to be in % when user is expecting to scale based on broswer 

page dynamic height and width changes.

Show/Hide Select +Add Conditions  to create conditions to show or hide the card. See Ap

ply Conditions  (on page 657).

Scroll bars appear when the card size is smaller than the plug-in size.

Interactive Map
This topic describes properties for an interactive map layout.

The interactive map functionality is available in both coordinate and flexbox card layout types. For older 

version, see Interactive Map  (on page 465).

1. Upload an image.

2. Double-click the image areas where you want to create a marker.

3. Select the marker you want to update.

4. On the details panel, select +Add Marker State, and update the properties.

5. Similarly update all markers on the image.

6. You can also delete markers on the image.

If you selected an interactive map functionality for your layouts, then configure these details:

Field Name Description

Map Image Select Upload Image  to browse and select an image. The option to upload an 

image is also available within the interactive map card layout.

Coordinates Enter these coordinates to position the image within the card. The value 

should be less than or equal to 99.

• Top Offset: The margin between the top of the card and top of the im

age.

• Left Side Offset: The margin between the left side of the card and left 

side of the image.
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Field Name Description

You can also set the coordinates by moving the image on the layout. The val

ues in the text box are adjusted based on the set position.

Marker Type You can select one of the following options:

• Shape

• Image

Color If you selected Shape  as the marker type, specify a fill color.

Shape If you selected Shape  as the marker type, select one of the following options:

• Round

• Square

Marker Image If you selected Image  as the marker type, upload an image for the marker.

For example, if the marker identifies the position of a radiator fan, you can up

load the image of a fan instead of using a predefined round or square shape 

for the marker.

Size Enter the size to multiply the default size of the marker shape or image size.

For example, if you enter 2, the marker size is double the default size. By de

fault, the value in this field is 1. The marker size can have a value greater than 

or equal to 100.

Label If you want a label to appear for the marker, then enter the label name.

Label Color Choose a color for the label text.

Data Label You can choose to pass the data to the interactive map using a query, global, 

formula, or enter the value manually.

For example, suppose the interactive map plots the temperature of various 

components of a car. For a marker that identifies the position of a radiator 

fan in a car, you can map the data label with the output of the query that re

trieves the temperature of the fan. When you access the application, the tem

perature value retrieved from the query is displayed for the radiator fan.
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Field Name Description

Number Format • Use Raw Format: Select the check box to display numbers in raw for

mat. For example, a numeric value with 5 or more decimal places is 

shown as it is, and not rounded off.

• Number of decimals: This option appears if you do not want to display 

numbers in raw format.

In that case, enter the decimal places (0-7) to consider after the deci

mal point to format large numbers. Based on the decimals, the value is 

rounded off to the nearest whole number.

Data Label Color Identifies the color and opacity of the data label.

Show/Hide Select +Add Conditions  to create conditions that show or hide the interactive 

map. See Apply Conditions  (on page 657).

BEHAVIOR You can set actions to be performed when a marker is selected.

1. Select +Add.

2. Select from the list of available actions for the marker.

Delete Marker Select the marker you want to delete, and select the Delete  icon.

Repeater
A repeater layout displays a set of repeating objects.

The repeater functionality is available only in the flexbox card layout. For older version, see Repeater  (on 

page 470).

If you selected a repeater functionality for your flex layout  (on page 161), then configure these details:

Field Name Description

Repeater Source Select a query to retrieve data, which is displayed in the repeater.

Multi Select This property is used in combination with a map or a graph plug-in. Select 

this check box if you want to insert a check box for multi-selection.

In the end application, a check box appears in each row of the repeater, allow

ing you to select which items should appear on the map or the graph.

Checked This property applies only if you enabled multi-selection check boxes.
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Field Name Description

Select this check box if you want multi-selection check boxes selected by de

fault.

When you open the end application, the check box that appears in each row 

of the repeater remains selected by default.

Load Select this check box if you want to add rows that appear by default in the re

peater.

Page Size Enter the number of rows that should appear by default in the repeater.

Paging Style Choose from these options:

• Paging: Each page in the repeater will contain the number of rows that 

you specify. You can navigate to the other pages to access the rest of 

the rows.

• Load More: The repeater will initially contain the number of rows that 

you specify. A Load more  button appears in the application, which al

lows you to retrieve additional rows in the same page.

HMI Graphics

About HMI Graphics
HMI graphics are accessible only in the latest version of Operations Hub layout.

Use the HMI graphic plug-ins to design a pictorial setup of your industrial system. The plug-ins can be 

animated based on their configured tag data values. Operators can experience a real world layout while 

monitoring the changing status of the system. The HMI graphics are scalable, and can be resized to fit 

into your application design.

With the Operations Hub installation, you get a list of out-of-the-box HMI Graphics  (on page 146)  (not 

available in Operations Hub Classic). You can use the system HMI graphics to get started, and create 

custom graphics for varied applications.
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Refer to the following topics to work with HMI graphics.

• Duplicate Graphic  (on page 175)

• Create New Graphic  (on page 176)

• Rename Graphic  (on page 177)

• Edit Graphic  (on page 177)

• Export Graphic  (on page 179)

• Import Graphic  (on page 180)

• Delete Graphic  (on page 181)

Under custom, you can also create varied categories to efficiently organize your HMI graphics.

• Create Category  (on page 181)

• Rename Category  (on page 182)

• Delete Category  (on page 182)

With the in-built SVG graphic editor, you can configure and animate the HMI graphics to meet your specific 

requirements.

• Create Data Item  (on page 183)

• Add Datalink Animation  (on page 184)

• Add Color Animation  (on page 185)

• Add Fill Animation  (on page 186)

• Add Visibility Animation  (on page 188)

• Delete Animation  (on page 189)
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Add/Update Graphics to a Page

When designing application pages  (on page 376)  in Operations Hub, you can drag-and-drop graphics to 

the page designer area.

In case you modified animation for a graphic that is already used in an application, then you need to 

update those graphic instances to render the data accurately. For example, to update an instance of a 

graphic called speedometer, do the following:

1. Open the application page where the speedometer  is used.

2. Delete the speedometer. You have deleted the old instance of the speedometer.

3. On the Visuals  tab under custom graphics, drag-and-drop or double-click the speedometer  to add it 

back to the page. You have added the updated instance of the speedometer.

4. On the toolbar, select Save.

You don't need to update graphic instances if you modified color, size, position, or shape of a graphic.

Duplicate Graphic
This topic describes how to duplicate and create a new HMI graphic.

You cannot create a graphic with duplicate names in the same folder.

1. You can duplicate all HMI graphics under system and custom.

Go to System  > HMI Graphics  > High Performance.

Go to Custom  > HMI Graphics

A list of HMI graphics appear.

2. Right-click the graphic you want to duplicate, and select Duplicate Graphic.

A pop-up screen appears.

3. Do the following:
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a. Select a custom location path to save the new graphic.

b. Enter a new name for the graphic.

c. Select Duplicate.

You can access the newly created graphic under the custom plug-ins category.

Create New Graphic
This topic describes how to create a new HMI graphic.

Using the SVG editor, you can create new HMI graphics from scratch apart from duplicating existing 

graphics  (on page 175).

The following steps create a new SVG file. You can open the file in the editor to create interactive 

elements of an HMI graphic using the basic shapes, lines, etc.

1. Under custom graphics, select the folder category where you want to create and save the new 

graphic.

2. Right-click the folder and select Add New Graphic.

The Add Graphic  screen appears.

3. Enter a name for the new graphic.

4. Select Add Graphic.
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A blank SVG file is created with the name.

The newly created file is saved to the selected folder category.

1. Use the edit option  (on page 177)  to open the file in the SVG editor.

2. Use the SVG editor tools  (on page 190)  to create HMI graphics.

Rename Graphic
This topic describes how to rename a newly created HMI graphic plug-in.

Duplicate Graphic  (on page 175)

1. Under Custom  plug-ins, right-click the graphic you want to rename.

2. Select Rename Graphic.

A confirmation dialog appears.

3. Enter a new name for the graphic.

4. Select Rename  to save.

The graphic is updated with a new name.

Edit Graphic
This topic describes how to modify a HMI graphic plug-in.

You can modify custom HMI graphics only.
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1. Under Custom  plug-ins, right-click the graphic you want to modify.

2. Select Edit Graphic.

The graphic opens in an SVG editor.

3. On the components panel, access the following tabs to modify the graphic:

Graphic Tree On this tab, you can view the hierarchy of SVG elements and cor

responding animations. You can add or delete animations from 

this tree only. Refer to the following topics:

◦ Add Datalink Animation  (on page 184)

◦ Add Color Animation  (on page 185)

◦ Add Fill Animation  (on page 186)

◦ Add Visibility Animation  (on page 188)

◦ Delete Animation  (on page 189)

Graphics List On this tab, you can access all the plug-ins listed under the cus

tom category. Refer to the following topics:

◦ Create Category  (on page 181)

◦ Rename Category  (on page 182)

◦ Delete Category  (on page 182)

4. Save the changes made to the graphic.
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Export Graphic
This topic describes how to export a HMI graphic.

You can export and save graphics to re-use them across different systems. For example, a system 

integrator builds a valve graphic and implements it for various customers.

To import/export SVGs, refer to SVG Editor Tools  (on page 190).

1. Under Custom  plug-ins, right-click the graphic you want to export.

2. Select Export Graphic.
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The export graphic screen appears.

3. Select Export.

The file is exported and saved as a JSON file.

Import Graphic
This topic describes how to import a HMI graphic.

HMI graphics are a combination of SVGs (visual shapes/text, etc.) and animated content stored in a JSON 

file. This file can be distributed across different Operations Hub systems using the export/import feature. 

Invalid JSON files will not get imported to Operations Hub.

To import/export SVGs, refer to SVG Editor Tools  (on page 190).

1. Under Custom  plug-ins, right-click the folder where you want to import a graphic.

2. Select Import Graphic.

3. Browse the system and locate the JSON file you want to import.

4. Select Import.

The file is imported to the folder.
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Delete Graphic
This topic describes how to delete a HMI graphic plug-in.

1. Under Custom  plug-ins, right-click the graphic you want to delete.

2. Select Delete Graphic.

A confirm dialog appears.

3. Select Yes

The graphic is deleted from Operations Hub.

Create Category
This topic describes how to create folders and sub-folders to categorize custom graphics.

You can also create categories on the components panel while editing graphics  (on page 177).

1. To create a category for the first time under Custom, right-click HMI Graphics  and select Add New 

Category.

Hereafter, you can create categories at every level. Right-click the folder where you want to create a 

category and select Add New Category.

The Add Category  screen appears.
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2. Enter a name for the new category.

3. Select Add Category.

A folder with the given name is created.

Rename Category
This topic describes how to rename the folder categories.

Create Category  (on page 181)

1. Right-click the folder you want to rename and select Rename Category.

A screen appears with the current folder name.

2. Enter a new name and select Rename.

The folder category is saved with the new name.

Delete Category
This topic describes how to delete the folder categories.

Create Category  (on page 181)

If you want to delete any custom folder/sub-folder, first delete the graphics within the folder.

1. Right-click the folder you want to delete and select Delete Category.

A confirmation screen to confirm the delete action appears.
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2. Select Yes.

The folder category is deleted.

Create Data Item
This topic describes how to create data items for SVG graphics.

Data items are used to configure SVG graphic properties. You can create only one data item for each 

graphic. By default, every graphic has a data item attached to it. You can modify or delete the default data 

item. In the following steps, you can create a data item in case you deleted the default data item.

1. Open a graphic in the SVG editor.

Refer to Edit Graphic  (on page 177).

2. On the components panel > Graphic Tree  tab, select Data.

Data Items  appears on the details panel.

3. Select +  icon.

4. Enter a Name  and Description  for the data item.

5. Select Update.



Operations Hub for Windows  | 3 - User Guide  | 184

The data item is created with options to modify and delete the item.

Add Datalink Animation
This topic describes how to animate text for SVG graphics.

In SVG, you can create text elements and animate them. You can also use input data to create dynamic 

and interactive animations by linking data to the animation properties. At runtime, the animation is 

executed based on the data. For example, change in color of an element based on data values.

1. Right-click the element you want to animate.

2. Select Add DataLink Animation.

Adds an entry for text animation under the element.

3. On the Details panel, access the text animation properties for the entry.

4. Enter information in the following fields:

Field Name Description

Animation Name Provide a name for reference.

Data Type Choose from these data types to configure animation properties:

◦ Text

◦ Decimal

◦ Integer

Data Item Select the data item you want to apply to the element.

See Create Data Item  (on page 183).

Attribute The drop-down list contains several attributes, which can be associat

ed with the data item in order to animate the HMI Graphic. The anima

tion will apply to the selected attribute.

Default Value Enter a default value for the selected attribute.

This default value is used only when the data source is set to Manual 

in page designer. See Bind Your Data to Plug-ins  (on page 157).

Zero Fill Select this check box if you want to fill unused digits with zeroes.
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Field Name Description

For example, if the graphic can display a maximum of four digits and 

the current value is 25, it is displayed as "0025" when zero fill is en

abled.

Integer Digits If Zero Fill  is enabled, enter the number of digits for display.

Group Digits Select this check box if you want to group the digits in a graphic dis

play making it easy to read.

For example, 123456 can be grouped as "123,456".

Scientific Select this check box if you want to display numbers in scientific nota

tion. This option is useful for displaying very large numbers in a more 

compact and readable format.

Decimal Digits Enter the number of decimal places to display a number. This option 

helps to avoid displaying unnecessary decimal places or rounding er

rors.

5. On the toolbar, select Save.

Add Color Animation
This topic describes how to create color animation for SVG graphics.

You can animate to change the color of the SVG graphic element.

1. Right-click the element you want to animate.

2. Select Add Color Animation.

Adds an entry for color animation under the element.

3. On the Details panel, access the color animation properties for the entry.

4. Enter information in the following fields:
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Field Name Description

Animation Name Provide a name for reference.

Data Item Select the data item you want to apply to the element.

See Create Data Item  (on page 183).

Attribute The drop-down list contains several attributes, which can be associat

ed with the data item in order to animate the HMI Graphic. The anima

tion will apply to the selected attribute.

Default Value Enter a default value for the selected attribute.

This default value is used only when the data source is set to Manual 

in page designer. See Bind Your Data to Plug-ins  (on page 157).

Color Table Configure one or more colors to change the color based on a specific 

value.

To configure a color:

a. Select the + icon.

b. Select a logical Operator. For example, <

c. Enter a Value. For example, 50

d. Choose a Color. For example, green.

e. Select Update.

Result: If the value is less than 50, the color remains green.

Configured colors appear in a table with options to modify and delete 

the colors. You can also drag-to-reorder the list of colors in a table.

5. On the toolbar, select Save.

Add Fill Animation
This topic describes how to create fill animation for SVG graphics.

You can animate the fill color of the SVG graphic element.

1. Right-click the element you want to animate.

2. Select Add Fill Animation.
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Adds an entry for fill animation under the element.

3. On the Details panel, access the fill animation properties for the entry.

4. Enter information in the following fields:

Need to make distinction between level, min, and max. Each of these three properties have ability 

to define data item, attribute, and default

Field Name Description

Animation Name Provide a name for reference.

Color Select a color to fill the SVG element. For example, sets the color of 

the liquid or the substance represented by the SVG tank.

Fill Direction Select from these directional modes, in which a gauge or pump is filled 

with data:

◦ left-to-right

◦ right-to-left

◦ bottom-to-top

◦ top-to-bottom

Level The values entered in this section apply to an object's fill-level, such as 

the progress of a loading bar or the level of a liquid in a container.

Minimum The values entered in this section apply to minimum values of a range. 

For example, minimum levels of a gauge.

Maximum The values entered in this section apply to maximum values of a 

range. For example, maximum levels of a gauge.

Data Item Select the data item you want to apply to the element.

See Create Data Item  (on page 183).

Attribute The drop-down list contains several attributes, which can be associat

ed with the data item in order to animate the HMI Graphic. The anima

tion will apply to the selected attribute.
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Field Name Description

Default Value Enter a default value for the selected attribute.

This default value is used only when the data source is set to Manual 

in page designer. See Bind Your Data to Plug-ins  (on page 157).

5. On the toolbar, select Save.

Add Visibility Animation
This topic describes how to create visibility animation for SVG graphics.

Lets you control the visibility of graphical elements.

1. Right-click the element you want to animate.

2. Select Add Visibility Animation.

Adds an entry for visibility animation under the element.

3. On the Details panel, access the visibility animation properties for the entry.

4. Enter information in the following fields:

Field Name Description

Animation Name Provide a name for reference.

Data Item Select the data item you want to apply to the element.

See Create Data Item  (on page 183).

Attribute The drop-down list contains several attributes, which can be associat

ed with the data item in order to animate the HMI Graphic. The anima

tion will apply to the selected attribute.

Default Value Enter a default value for the selected attribute.

This default value is used only when the data source is set to Manual 

in page designer. See Bind Your Data to Plug-ins  (on page 157).
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Field Name Description

Visibility Table Configure one or more values to animate the visibility status of the ele

ment.

To configure visibility status:

a. Select the + icon.

b. Select a logical Operator. For example, <

c. Enter a Value. For example, 50

d. Select the check box for Visible.

e. Select Update.

Similarly, add another value to the table that is >= 50  with visible check 

box cleared.

Result: The element is visible only when the value is less than 50. If the 

value is greater than or equal to 50, the element is hidden.

The visibility configuration values appear in a table with options to 

modify and delete them. You can also drag-to-reorder the visibility list.

5. On the toolbar, select Save.

Delete Animation
This topic describes how to delete animation for SVG graphics.

You can delete text, color, fill, and visibility animation.

1. Right-click the animation you want to delete.

2. Select Delete Animation.

The animation is deleted.
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SVG Editor Tools
This topic describes SVG editor tools.

You can modify SVG files using the SVG editor's user-friendly interface.

Side Toolbar Options

Tool Description

Select Tool Allows you to select and move objects within the editing area.

Zoom Tool Zoom in/out to view objects at different levels of detail. It helps to per

form precise edits and adjustments.

Panning Helps to pan around when used along with the zoom tool.

Pencil Tool Use this tool to create any shape or design. You can draw and create 

custom shapes by dragging the mouse.

Line Tool To create a perfectly vertical or horizontal straight line, hold down the 

Shift key while drawing the line.

Path Tool Use the tool to draw a path creating additional points along the way. A 

path has a start point, end point, and curve parameters of the path. To 

create the shape you want, mouse-click and drag. To end the path, dou

ble-click.

Square/Rectangle Tool Create squares or rectangles of different sizes. Useful for creating basic 

geometric shapes. Hold down the Shift key while drawing to create a per

fect shape.

Ellipse/Circle Tool Create ellipses or circles of different sizes.

Text Tool Allows you to add and edit text within the editing area. Useful for adding 

labels, annotations, etc.
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Tool Description

Shape library Contains ready-to-use shapes such as geometric shapes, mathematical 

shapes, flowchart shapes, etc.

Polygon/Star Tool The polygon tool allows you to create polygon shapes.

The star tool allows you to create star shapes. You can resize these 

shapes without losing their sharpness and quality.

Eye Dropper Tool Use the tool to pick a color from an existing object. You can now use the 

picked color for other elements as well.

Top Toolbar Options

The options in the top toolbar may vary based on the selected objects.

Tool Description

Document Properties In the document properties dialog, you can modify the SVG document 

settings.

Import SVG Allows to select and import an SVG file containing shapes, text, and/or 

images to Operations Hub and add interactive animation using our SVG 

editor.
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Tool Description

This option allows you to use SVG files created using third party tools, 

such as Microsoft Powerpoint, Adobe Illustrator, Inkscape, Figma, etc. 

These are fixed SVG images and do not contain any animation. Such 

SVGs when imported may get slightly altered to match our SVG format. 

For example, tspan  elements are converted to <text>  elements.

You can also modify third party SVGs by editing its source code.

Export SVG Allows to export the SVG file and save as HMI graphic.

Import Image Allows to import an image file. For example, PNG, JPEG, etc.

Editor Preferences In the editor preferences dialog, you can modify the SVG background, 

units of measurement, and grid settings.

Edit Source Opens a code editor, wherein you can make changes to the source code 

and save it.

Wireframe Mode When you switch to the wireframe mode, visual distractions such as col

or, texture, and other design elements are removed. This helps to focus 

on the layout, positioning, and hierarchy of elements, and make adjust

ments as necessary. Once the basic structure is in place, you can switch 

back to the normal mode, and continue working on other design ele

ments.

Show/Hide Grid Shows/hides the grid layout.

Undo and Redo These buttons allow you to undo or redo changes you've made to the 

canvas.

Duplicate Element Duplicates the selected element.

Delete Element Deletes the selected element.

Bring to Front When objects overlap on the page, brings the selected object to the 

front.

Send to Back When objects overlap on the page, sends the selected object to the back.

Convert to Path You can convert an object to a path. This option is used along with the 

path editing tools to turn a simple shape/text into a complex vector 

shape. Consider these points when using the tool:
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Tool Description

• Once you convert an object to a path, you cannot easily convert it 

back to its original form.

• Converting an object to a path can make the file size larger.

Reorient Path Allows you to change the orientation or direction of a path for the select

ed object, either clockwise or counterclockwise. It is useful when you 

want to change the starting point or direction of a path without having to 

redraw it.

Identify the element When using multiple objects in SVG, this option identifies the selected 

object within the editing area.

Element class You can use defined classes to apply styles or behaviors to various ele

ments in SVG file.

Change rotation angle Rotates the selected object to the selected degrees.

Change gaussian blur value Increases the blur effect on the object based on the increasing value.

Align Use the alignment options to position objects within the editing area. 

Select one or more objects you want to align, and then choose the appro

priate alignment option.

Change X/Y coordinate Enter the X and Y coordinates of an object to move it to a new position 

within the editing area.

• X coordinate represents the horizontal position of the object.

• Y coordinate represents the vertical position of the object.

Link Control Points Applies to curved paths. You can link the control points to create com

plex curves and adjust the shape of a path.

Change node's X/Y coordi

nate

Applies to nodes in a path. Nodes are the points that define the shape of 

a path. This option allows you to select a node and set its X and Y coor

dinates within the path.

Clone Node Clones the selected node.

Delete Node Deletes the selected node.

Text formatting tools Select the text element to access tools to perform the following func

tions:
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Tool Description

• Choose from a variety of fonts available in the editor.

• Adjust the size of your text to make it larger or smaller.

• Change the style of your text to bold, italic, underlined, etc.

• Align your text.

• Adjust the spacing between letters and lines.

Bottom Toolbar Options

Tool Description

Change zoom Level Allows you to zoom in and out of the editing area for more precise edit

ing. Use the preset options to apply the zoom level.

Change fill Color To change the fill color, select the shape/object and from the color 

palette, choose a color to fill the shape/object.

Change stroke Color To change the stroke color, select the shape/object and from the color 

palette, choose a color to apply to the shape/object.

Change stroke width by 1, 

shift-click to change by 0.1

Allows to change the width of the stroke.

Change stroke dash style Select the line/shape to change its stroke dash style and apply a new 

style (dots, dashes, etc.) from the available preset options.

Linejoin You can set any of these linejoin options to set the corners of a shape/

line:

• Miter: At the meeting point of two lines, applies a pointed corner.

• Round: At the meeting point of two lines, applies a rounded cor

ner.

• Bevel: At the meeting point of two lines, applies a flat and beveled 

corner.

Linecap You can set any of these linecap options to set the ends of a line:
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Tool Description

• Butt: Applies a flat end to the line that is perpendicular to the di

rection of the line.

• Square: Applies a flat end to the line that is slightly wider than the 

line itself.

• Round: Applies a rounded end to the line.

Change selected item opaci

ty

Select the item (shape, line, group of objects, or any other element in 

your SVG file) for which you want to modify the opacity. Set the opacity 

percentage for the item.

Click to change fill color, 

shift-click to change stroke 

color

Allows to change the color.

Applications

About Applications
Operations Hub  provides a user-friendly interface to create application components such as database 

tables (called entities), queries, events, email templates, users, and so on, without the need to write code.

You can then develop applications using these components. To develop an application, you will perform 

the following tasks:

1. Create all the components that are required for the application.

2. Create the pages and dashboards for the application.

3. Apply themes, define the navigation details.

4. Access and test the application.

5. Provide users access to the application.

Note:

If you have installed only the Operations Hub  add-on for Historian, you cannot create an 

application or components of an application. You can only access the Historian analysis 

application.

Suppose you want to create an application that will send an email notification if the temperature recorded 

by a sensor exceeds 40 degrees Celsius. In this case, you will perform the following tasks:
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1. Create an email template, which will contain the text and event parameters that you want to send in 

the email.

2. Create an event that will be triggered when the temperature recorded by the sensor exceeds 40 

degrees Celsius.

3. Add an action to the event to define the recipients and send an email using the email template that 

you have created.

4. Create a page to display the sensor data. You can display the data using components such as text, 

gauges, or historical trend charts.

5. Add an event settings component to the page to allow application users to turn the event on or off.

Grant Access to an Application for an Individual User (Classic)
Steps for Operations Hub classic version.

Log in to Operations Hub.

By default, all the developers can access all the applications that they have developed. Application users, 

however, can access only the applications to which they are granted access. You can also grant access to 

a role.

Note:

A user must be a member of the iqp.user  group in order to be assigned to an App.

1. From the main navigation menu, select  APPS.

The APPS  workspace appears.
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2. In the Name  column, select the application to which you want to grant access.

The PAGES  workspace appears.

3. From the main navigation menu, select  APP USERS.

The APP USERS  workspace appears, displaying a list of application users created in the site.
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4. In each row containing an application user to whom you want to grant access, select the check 

box, and then select Submit changes.

The selected users can now access the application.

Grant Access to an Application for a Group (Classic)
Steps for Operations Hub classic version.

Log in to Operations Hub.

By default, all the developers can access all the applications that they have developed. Application users, 

however, can access only the applications to which they are granted access. You can also grant access to 

a role.

Note:

A user must be a member of the iqp.user  group in order to be assigned to an App.

1. From the main navigation menu, select  APPS.

The APPS  workspace appears.
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2. In the Name  column, select the application to which you want to grant access.

The PAGES  workspace appears.

3. From the main navigation menu, select  APP GROUPS.
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The APP GROUPS  workspace appears, displaying the list of UAA groups for the UAA connected to 

this instance Operations Hub.

4. In each row containing an application user to whom you want to grant access, select the check 

box, and then select Submit changes.

The selected groups can now access the application.

Access an Application (Classic)
Steps for Operations Hub classic version.

Log in to Operations Hub.

To access applications in the latest version of Operations Hub, refer to Navigation Panel  (on page 139).

1. From the main navigation menu, select  APPS.

The APPS  workspace appears.

2. In the row containing the application that you want to access, select .
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3. If you want to access the application in a web browser, select Open. If, however, you want to 

access the application on a mobile device, scan the QR code using the device.

The application appears in a new browser tab or on your mobile device.

If upgrading to Operations Hub 2.0, please note that every application can be referenced by an URL. All 

hardcoded links to applications must be updated with the new URLs.

Access a Recently Created Application (Classic)
Steps for Operations Hub classic version.

Log in to Operations Hub.

1. From the main navigation menu, select  APPS.

The APPS  workspace appears.

2. Select RECENTLY CREATED.



Operations Hub for Windows  | 3 - User Guide  | 202

A list appears with the ten most recently created applications.

Access a Recently Modified Application (Classic)
Steps for Operations Hub classic version.

Log in to Operations Hub.

1. From the main navigation menu, select  APPS.

The APPS  workspace appears.
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2. Select RECENTLY MODIFIED.
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A list appears with the ten most recently modified applications.

Create an Application
Steps to create an application in the latest version of Operations Hub.

Log in to Configuration Hub.

You can also create an application by copying an existing application. Refer to Copy an Application  (on 

page 207).

For steps to create applications in the Operations Hub classic version, refer to Create an Application 

(Classic)  (on page 205).

1. On the navigation panel, select Operations Hub  > Applications.
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The existing list of applications appear.

2. Select Add App.

The Create App  screen appears.

3. Enter the following field values:

Field Name Field Description

APP NAME Name of your application.

The name must contain at least one uppercase or lowercase 

letter.

DESCRIPTION Brief description of your application.

FIRST PAGE NAME Name of the your application's first page.

4. Select Add.

The application is created with a default page.

Create an Application (Classic)
Steps to create an application in the Operations Hub classic version.

Log in to Operations Hub.

You can also create an application by copying an existing application. Refer to Copy an Application  (on 

page 207).
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For steps to create applications in the latest version of Operations Hub, refer to Create an Application  (on 

page 204).

1. From the main navigation menu, select  APPS.

The APPS  workspace appears.

2. Select Add new app.

The Create App  window 

appears.
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3. In the App name  and Description  boxes, enter values, and then select Create. The name must 

contain at least one uppercase or lowercase letter.

The application is created.

Create a page  (on page 376).

Copy an Application
Steps to copy an application in the latest version of Operations Hub.

Log in to Configuration Hub.

You can also create new applications without copying one. Refer to create an application  (on page 204).

You can copy an application only if it was created within the same site. If you want to copy an application 

that belongs to a different site, you must export the application  (on page 210), and then import  (on page 

215)  it.

For steps to copy applications in the Operations Hub classic version, refer to Copy an Application 

(Classic)  (on page 209).

1. On the navigation panel, select Operations Hub  > Applications.

The existing list of applications appear.

2. Right-click the application you want to copy, and select Duplicate App.

You can also duplicate multiple applications at a time. To do so:
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a. Select , and then select App Actions.

A selection check box appears next to each application.

b. Select the check box for all the applications you want to duplicate.

Note:

To select/clear a check box, you must first select the application in the list.

c. Right-click and select Duplicate Apps.

A confirmation message appears.

3. Select Ok  to confirm the duplicate action.

The Create App  screen appears. The APP NAME  field contains a system-generated value added to 

the existing application name.

4. Optional:  Modify APP NAME  and DESCRIPTION.

5. Select Add.
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A duplicate copy of the original application along with its pages is created.

Copy an Application (Classic)
Steps to copy an application in the Operations Hub classic version.

Log in to Operations Hub.

You can also create new applications without copying one. Refer to create an application  (on page 204).

You can copy an application only if it was created within the same site. If you want to copy an application 

that belongs to a different site, you must export the application  (on page 210), and then import  (on page 

215)  it.

For steps to copy applications in the latest version of Operations Hub, refer to Copy an Application  (on 

page 207).

1. From the main navigation menu, select  APPS.

The APPS  workspace appears.

2. In the rows containing the applications that you want to copy, select the check boxes.
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3. In the workspace heading, select , and then select Duplicate apps.

A message appears, asking you to confirm that you want to duplicate the applications.

Tip:

Alternatively, in the row containing each application that you want to copy, select , and 

then select Duplicate app.

4. Select OK.

The Create App  window appears. The App name  box contains the name of the application that you 

want to copy, along with a system-generated value. The Description  box contains the description of 

the application that you want to copy.

5. For each application that you have selected, modify values in the App name  and Description  boxes 

as needed, and then select Create.

The applications are copied. The Pages  workspace for the first application that you have copied 

appears, displaying a list of pages copied from the original application.

Export an Application
Steps to export an application in the latest version of Operations Hub.

Log in to Configuration Hub.

To use or copy an application that was created on a different site, you must export the application, and 

then import  (on page 215)  it.
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Tip:

If you want to export multiple applications that use the same entities and queries, export them 

together (instead of exporting them individually).

Default applications in Operations Hub cannot be exported. If you want to export a default application, 

then make a copy of the application  (on page 207)  and export it.

For steps to export applications in the Operations Hub classic version, refer to Export an Application 

(Classic)  (on page 213).

1. On the navigation panel, select Operations Hub  > Applications.

The existing list of applications appear.

2. Right-click the application you want to export, and select Export App.

You can also export multiple applications at a time. To do so:

a. Select , and then select App Actions.

A selection check box appears next to each application.
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b. Select the check box for all the applications you want to export.

Note:

To select/clear a check box, you must first select the application in the list.

c. Right-click and select Export Apps.

A confirmation message appears.

3. Select Ok  to confirm the export action.

4. Required:  In case, the application being exported contains queries that work with multiple data 

sources, then a data source conflict appears. Do the following to resolve the conflict:

a. In the Select Datasources  screen, select the compatible data sources.

b. Select Export.

Each application is exported as a .zip file, which contains:

▪ a .zip file for each plug-in used in the application.

▪ an .xml file for the rest of the components used in the application.

Important:

To avoid system related errors, do not modify original exported zip files and 

repackage them for import.



Operations Hub for Windows  | 3 - User Guide  | 213

The exported application is saved to the default download location of the browser.

Export an Application (Classic)
Steps to export an application in the Operations Hub classic version.

Log in to Operations Hub.

To use or copy an application that was created on a different site, you must export the application, and 

then import  (on page 215)  it.

Tip:

If you want to export multiple applications that use the same entities and queries, export them 

together (instead of exporting them individually).

Default applications in Operations Hub cannot be exported. If you want to export a default application, 

then make a copy of the application  (on page 207)  and export it.

For steps to export applications in the latest version of Operations Hub, refer to Export an Application  (on 

page 210).

1. From the main navigation menu, select  APPS.

The APPS  workspace appears.
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2. In the rows containing the applications that you want to export, select the check boxes.

3. In the workspace heading, select , and then select Export apps.

A message appears, indicating that the application will be saved in the default download location 

of the browser.

Tip:

Alternatively, in the row containing each application that you want to export, select , and 

then select Export app.

4. Select OK.

5. Required:  In case, the application being exported contains queries that work with multiple data 

sources, then a data source conflict appears. Follow these steps to resolve the conflict:

a. In the Select Datasources  screen, select the compatible data sources.

b. Select Export.

Each application is exported as a .zip file, which contains:
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▪ a .zip file for each plug-in used in the application.

▪ an .xml file for the rest of the components used in the application.

Important:

To avoid system related errors, do not modify original exported zip files and 

repackage them for import.

Import the application  (on page 215).

Import an Application (Classic)
Import and save applications to Operations Hub.

When you import an application, a copy of the application and its components (that is, plug-ins, pages, 

entities, queries, events, themes, and settings) is created. If an application or a component with the same 

name exists in the current site, then a system-generated number is appended to the name of the imported 

application or component. However, if a plug-in with the same name exists, the plug-in is not imported. 

Instead, the plug-in that already exists in the site is used in the application.

Export the application  (on page 210)  that you want to import. Default applications are excluded from 

the import operation.

1. From the main navigation menu, select  APPS.

The APPS  workspace appears.
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2. Select Import App.

A message appears, indicating that if there is already an application or a component with the same 

name, the imported application or component will contain a new name.

3. Proceed to import the application.

4. Navigate to the application (stored as a .zip file) that you want to import, then select Open.

Important:

To avoid system related errors, do not modify original exported zip files and repackage 

them for import.

5. If the application being imported already exists in Operations Hub with the same name, a Confirm 

screen appears to resolve the import conflict. Select one of the following:

Option Description

Duplicate Creates a duplicate copy of the application and imports to Operations 

Hub.
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Option Description

Replace Deletes the existing application in Operations Hub and replaces with 

the one from the import file.

It is possible that some conflict items (Query, Datasource, Entity, 

Theme, etc.) detected during app import may have same name but a 

different configuration. If you choose Replace  in such cases, bindings 

may be lost. To fix the issue, you need to rebind that item with the page 

after import.

If duplicate data source records are found, you may be asked to confirm before importing the file to 

Operations Hub. Refer to Handling Duplicate OPC UA Data Sources  (on page 217).

6. If the system detects that the imported application has widgets/plug-ins eligible for upgrades, then 

they are automatically updated to their latest versions. See Configure Plug-in Upgrades  (on page 

218).

A copy of the selected application is created. The Pages  workspace appears, displaying a list of pages 

copied from the original application.

Handling Duplicate OPC UA Data Sources
OPC UA data sources are identified as duplicates if they contain identical server endpoint values.

If duplicate OPC UA data sources are detected during application import, select one of the following:

Option Description

Use Existing Maintains the data source record that currently exists in Operations Hub. 

Does not import the duplicate from the file.

Replace Deletes the data source record that currently exists in Operations Hub. Im

ports the duplicate from the file to replace the deleted record.

Note:

This option is enabled only for duplicate data source records shar

ing the same name and endpoint connection value (URI). Details 

such as security policy, authentication, etc. may vary in these 

records.
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Duplicate Apps in Operations Hub: During import conflict, if you opt for duplicating the application, the 

relevant data sources are also duplicated.

To resolve any OPC UA data source server endpoint (URI) conflict when duplicating apps:

• Select Use Existing  to avoid deleting the existing OPC UA record in Operations Hub. This record will 

not be imported from the file.

• Select Replace, to replace the existing OPC UA record in Operations Hub with the record from the 

import file.

The data source records that do not have a conflict get duplicated.

Replace Apps in Operations Hub: During import conflict, if you opt for replacing the application, 

Operations Hub data source records having the same name as the imported records, are deleted before 

being replaced with the imported ones.

Note:

Any OPC UA data source record in Operations Hub that shares the same name with a record from 

the import file will get replaced in this scenario. Such records are not considered to be duplicates.

To resolve any OPC UA data source server endpoint (URI) conflict when replacing apps:

• Select Use Existing  to avoid deleting the existing OPC UA record in Operations Hub. This record will 

not be imported from the file.

• Select Replace, to replace the existing OPC UA record in Operations Hub with the record from the 

import file.

The data source records that do not have a conflict get replaced.

Note:

Duplicate OPC UA data sources that existed in older versions are not removed after upgrading to 

2.1 or later. It is recommended to manually delete such duplicate records, or modify them to use a 

unique server endpoint connection.

Configure Plug-in Upgrades
A pre-requisite for successful custom plug-in upgrade in Operations Hub.

Plug-in developers can choose to write a specification, or use any transformation mechanism to get an 

EXE, JAR, or BAT file.
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1. Prepare a data transformation specification for plug-in upgrade using any of these methods:

Transforma

tion File Type

Description

Jolt Open-source JSON-to-JSON transformation library written in Java.

For more information, refer to https://github.com/bazaar

voice/jolt#Documentation

For Jolt spec, you can use http://jolt-demo.appspot.com/  as a play

ground to test your transformation.

JAR Java output using JSON transformation library such as https://mvn

repository.com/artifact/net.minidev/json-smart/2.4.7.

For JAR, the plug-in upgrade infrastructure looks for the class to load. 

For example, public class GEBreadcrumb_3_0_0to3_0_1  wherein,

◦ GEBreadcrumb  is the plug-in name

◦ 3_0_0  is the breadcrumb plug-in old version. The dot is replaced 

with an underscore.

◦ 3_0_1  is the breadcrumb plug-in new version. The dot is replaced 

with an underscore.

A transform instance is created for the class by invoking its static 

transform method: public static String transform(String input

JSON)

.EXE Windows® executable file. Create a transformation project with your 

choice of library (C++, Node, Python, etc.), which prints the trans

formed output json to console.

For this executable,

◦ 'FromVersion' schema input json is passed as command line ar

gument

◦ 'ToVersion' response JSON is read from its console output pro

duced by the executable

Note:

Naming convention for the transformation file is <PluginName>-<FromVersion>-

<ToVersion>-spec.json. For example GETrendCard-3.0.1-3.0.2-spec.json|jar|exe|bat.

https://github.com/bazaarvoice/jolt#Documentation
https://github.com/bazaarvoice/jolt#Documentation
http://jolt-demo.appspot.com/
https://mvnrepository.com/artifact/net.minidev/json-smart/2.4.7
https://mvnrepository.com/artifact/net.minidev/json-smart/2.4.7
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2. Log in to the machine where Operations Hub is installed.

3. Place the plug-in transformation files in this location folder ..\ProgramData\GE\Operations Hub

\iqp-config\plugin-transform-spec.

When Operations Hub administrator imports applications with old plug-ins, they are successfully 

upgraded to their latest versions.

• The transformation engine looks for an incremental path of intermediatory transformation 

that can migrate a plug-in from a specific version to a desired version. For instance, 

GETrendCard-3.0.1-3.0.2-spec.json  GETrendCard-3.0.2-3.0.4-spec.json  GETrendCard-3.0.4-3.0.5-

spec.json  are used consecutively to upgrade plug-ins.

• If incremental upgrades were not performed between Operations Hub versions, then the plug-in 

version may not remain subsequent for upgrade. For example, consider:

◦ Operations Hub 1.7 has 3.0.1 version of GETrendCard

◦ Operation Hub 2.5 has 3.0.5 version of GETrendcard

The GETrendCard-3.0.1-3.0.5-spec.json  file may not be available for upgrading plug-ins. In such 

cases, plug-in upgrades are not performed in Operations Hub.

Delete an Application
Steps to delete an application in the latest version of Operations Hub.

Log in to Configuration Hub.

• When you delete an application, only the application is deleted from Operations Hub. The 

components used by the application are not deleted.

• You cannot delete an application if it is locked.

• You cannot delete the default applications in Operations Hub.

For steps to delete applications in the Operations Hub classic version, refer to Delete an Application 

(Classic)  (on page 222).

1. On the navigation panel, select Operations Hub  > Applications.
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The existing list of applications appear.

2. Right-click the application you want to delete, and select Delete App.

You can also delete multiple applications at a time. To do so:

a. Select , and then select App Actions.

A selection check box appears next to each application.

b. Select the check box for all the applications you want to delete.

Note:

To select/clear a check box, you must first select the application in the list.
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c. Right-click and select Delete Apps.

A confirmation message appears.

3. Select Ok  to confirm the delete action.

The application along with its pages is deleted.

Delete an Application (Classic)
Steps to delete an application in the Operations Hub classic version.

Log in to Operations Hub.

• When you delete an application, only the application is deleted from Operations Hub. The 

components used by the application are not deleted.

• You cannot delete an application if it is locked.

• You cannot delete the default applications in Operations Hub.

For steps to delete applications in the latest version of Operations Hub, refer to Delete an Application  (on 

page 220).

1. From the main navigation menu, select  APPS.

The APPS  workspace appears.



Operations Hub for Windows  | 3 - User Guide  | 223

2. In each row containing an application that you want to delete, select the check box.

3. In the workspace heading, select , and then select Delete apps.

A message appears, asking you to confirm that you want to delete the applications.

Tip:

Alternatively, in the row containing each application that you want to delete, select , and 

then select Delete app.

4. Select OK.

The applications are deleted.

Upgrade an Application (Classic)
Steps to upgrade an application in Operations Hub classic version.

See also Configure Plug-in Upgrades  (on page 218).
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As a best-practice, always upgrade your applications after upgrading to a SIM version. This allows the 

existing plug-ins in applications to work properly.

1. From the main navigation menu, select  APPS.

The APPS  workspace appears.

2. In each row containing an application that you want to upgrade, select the check box.

3. In the workspace heading, select , and then select Upgrade apps.

A message appears to confirm whether to check if the selected applications require plug-in 

upgrades.

Tip:

Alternatively, in the row containing each application that you want to upgrade, select , 

and then select Upgrade app.

4. Select OK  to analyze and update the application plug-ins, if necessary.
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A message appears to confirm the upgrade.

5. Optional:  Select Show Details  in the message to review a summary of application plug-in 

upgrades.

Entities

About Entities
An entity is a database table, which you can use to store data.

You can create queries to retrieve and manage data stored in entities. You can create events to trigger 

actions when data in an entity is changed. The following list provides a few examples on using entities:

• Enhance data that is used in an asset monitoring application

• Create applications related to customer relationship management

• Manage the workflow of an event-handling or a parts-ordering application

• Sort data retrieved from a maintenance or an issue-reporting application

• Store contact details of employees

Operations Hub  provides a few baseline entities that you can use to manage your assets or collect 

machine data. You cannot modify or delete these entities; you can use them in your application directly. 

For baseline entities, the LAST UPDATED  column is blank in the ENTITIES  workspace.

When you create an entity, you must perform the following steps:

1. Define the entity structure. To do so, add fields  (on page 234)  and specify their data types (for 

example, Boolean, Number, String, and so on).

2. Add rows, and specify field values. To do so, enter values manually  (on page 235)  or import data 

from a Microsoft Excel workbook  (on page 237).

Pivot Entity

A pivot entity is used to automatically collect data from multiple sensors that belong to selected 

devices and groups of devices. You can use a pivot entity in a query, and plot it as a trend graph in your 

application.

For a pivot entity, one of the following icons appears in the ENTITIES  workspace:
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• : Indicates that the pivot entity is receiving data. If you want to stop collecting data in the 

pivot entity, you must deactivate the pivot entity. To do so, access the pivot entity, and then select 

.

• : Indicates that the pivot entity is not receiving data. If you want to start collecting data in the 

pivot entity, you must activate the pivot entity. To do so, access the pivot entity, and then select 

.

Important:

If you add or remove a device from a device type or group that is used in a pivot entity, you must 

deactivate the pivot entity, and then reactivate it for the changes to be applied.

Suppose 50 sensors are connected to a device type and 100 devices of that type send data to your 

application. Suppose you want to monitor the data from only five of the sensors and only 10 of the 

devices, which belong to a device group named EV group. You can create a pivot entity to collect data 

from only the selected sensors and the selected devices that belong to the EV group. This makes it 

easier to plot trend graphs or create tables with multiple sensor values in your application and improves 

performance when retrieving the data.

Relationship Between Entities

If you want to retrieve data from two or more entities in a single query, you must create a relationship (or 

a join) between them. When you create a relationship between entities, the two entities are joined by an 

inner join in SQL. The entity from which you create a relationship is called the source entity. The entity to 

which you create a relationship is called the target entity.

A single entity can be used both as a source entity and a target entity. A single entity can be used as a 

source entity in multiple relationships. A relationship can be bidirectional (that is, if there is a relationship 

from entity 1 to entity 2, you can also create a relationship from entity 2 to entity 1).

After you create a relationship, when you create a query, if you select the source entity in the Entity  box, 

you can retrieve data from fields in both the source and target entities. If, however, you select the target 

entity, you can retrieve data only from the target entity.

Important:

You cannot use a baseline entity or a pivot entity as a source entity; you can only use it as a target 

entity.
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Access an Entity (Classic)
Steps to access an entity in the Operations Hub classic version.

Log in to Operations Hub.

1. From the main navigation menu, select  ENTITIES.

The ENTITIES  workspace appears.

2. In the row containing the entity that you want to access, in the Name  column, select the link.

The entity appears, displaying a list of fields in the entity.
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Tip:

You can modify values in the available fields, and then select Save  or Save and Exit  to save 

your changes.

Create an Entity (Classic)
This topic describes how to create an entity in the Operations Hub classic version.

Log in to Operations Hub.

You can also create an entity by copying an entity  (on page 233).

1. From the main navigation menu, select  ENTITIES.

The ENTITIES  workspace appears.
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2. Select Add new entity.

The Create Entity  window appears.

3. In the Entity name  box, enter a name, and then select Create.

4. Select Edit Entity Structure.

A list of fields in the entity appears.
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5. Select Add Field.

A field is created in the entity. By default, the name of the field is Field_1 and the type is String.

6. Next to the field name, select , and then modify the name of the field. The name must contain at 

least one uppercase or lowercase letter.

7. In the drop-down list box in the Type  column, modify the type of the field if needed.

8. Select Save  or Save and Exit.

The entity is created.

Add a row  (on page 235)  or, if needed, import data in to the entity  (on page 237).

Create a Pivot Entity (Classic)
Steps to create a pivot entity in the Operations Hub classic version.

Register the device details and metrics that you want to use in the pivot entity using baseline entities.
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1. Register the device types and metrics using the supported_device_gateway  and the 

metrics_device_type  entities, respectively.

2. Register the device groups for the device type using the M2M_groups  entity. The group must belong 

to a device type that you want to use in the pivot entity.

3. Register the devices in a group that you created for their device type.

1. From the main navigation menu, select  ENTITIES.

The ENTITIES  workspace appears.

2. Select Add new pivot entity.

The Create Pivot Entity  window appears.
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3. In the Pivot entity name  box, enter a name, and then select Create. The name must contain at least 

one uppercase or lowercase letter.

The pivot entity is created. By default, a few fields such as timestamp, device_id, instance_name, and 

other fields are added to the pivot entity. You cannot modify or delete them. You can, however, add 

more fields for the metrics that you want to record in the pivot entity.

4. If you want to collect data from a specific device type:

a. In the Get Data By  box, select Device type.

A drop-down list box appears next to the Device type  box, displaying a list of device types 

that you have registered using the supported_device_gateway  entity.

b. Select the device type from which you want to collect data in the pivot entity.

5. If you want to collect data from a specific device group:

a. In the Get Data By  box, select Device group.

A drop-down list box appears next to the Device group  box, displaying a list of device groups 

that you have registered using the M2M_groups  entity.

b. Select the device group from which you want to send data to the pivot entity.

6. Create a field  (on page 234)  for each metric that you want to record (for example, pressure, 

temperature, and other metrics). The field name must match the metric name that you have 

registered using the metrics_device_type  entity and the metric name that the device uses to send 

data. This name is case-sensitive.

7. As needed, create additional fields in the pivot entity, and then select Save  or Save And Exit.

The changes made to the pivot entity are saved.

In the ENTITIES  workspace,  appears in the row containing the pivot entity that you have created.

Select  to start collecting data in the pivot entity.
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Copy an Entity (Classic)
This topic describes how to copy an entity.

Log in to Operations Hub.

You can also create a new entity  (on page 228)  without copying an existing entity.

1. From the main navigation menu, select  ENTITIES.

The ENTITIES  workspace appears.

2. Select the entity that you want to copy.

3. Select Edit Entity Structure.

4. As needed, add or remove fields.

Tip:

You can also modify the type of a field by selecting a value in the TYPE  column.

5. Select Save As New.
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The Please enter new name  window appears, displaying the name of the entity that you have 

selected, appended with a system-generated value.

6. As needed, modify the name of the entity, and then select OK.

The selected entity is copied.

Create a Field in an Entity (Classic)
Steps to create entity field in the Operations Hub classic version.

Log in to Operations Hub.

1. From the main navigation menu, select  ENTITIES.

The ENTITIES  workspace appears.

2. Select the entity in which you want to create a field. 

A list of fields in the entity appears, along with the data in each field.

3. Select Edit Entity Structure.

A list of fields in the entity appears.
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4. Select Add Field.

A field is created in the entity. By default, the name of the field is Field_1 and the type is String.

5. Next to the field name, select , and then modify the name of the field. The name must contain at 

least one uppercase or lowercase letter.

6. In the drop-down list box in the Type  column, modify the type of the field if needed.

7. Select Save  or Save and Exit.

The field is created in the entity.

Add a row  (on page 235)  or import data in to the entity  (on page 237).

Add a Row to an Entity (Classic)
Steps to add entity row in the Operations Hub classic version.

As needed, add fields to the entity  (on page 234).
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This topic describes how to add a row and enter data manually in an entity. You can also import data  (on 

page 237)  from a Microsoft Excel workbook. You cannot, however, add data to baseline entities or pivot 

entities manually. You can only insert data into these entities using an insert query in an application.

1. From the main navigation menu, select  ENTITIES.

The ENTITIES  workspace appears.

2. Select the entity in which you want to add a row.

3. Select Add row.

A blank row appears in the table.

Tip:

You can add multiple rows together by selecting Add row  multiple times.

4. Enter values in the blank row, and then select Save Changes.
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The values that you have entered in the row are saved.

Tip:

If you have entered values in multiple rows, but want to save values only for a single row, 

select  in the row.

Import Data in to an Entity (Classic)
This topic describes how to import data in to an entity from a Microsoft Excel workbook.

Log in to Operations Hub.

You can also add a row manually in the entity  (on page 235).

1. From the main navigation menu, select  ENTITIES.

The ENTITIES  workspace appears.

2. Select the entity in to which you want to import data.
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3. Select Import Excel, navigate to and select the workbook that you want to import, and then select 

Open.

The Set Column Mapping  window appears.

4. If you want to use the names in one of the rows of the workbook as field names: 

a. Select Use Header Row Names.

The Header Row Number  box appears.

b. Enter the row number in the workbook that you want to specify as the header row. By 

default, this box contains the value 1, which indicates that the first row is used as the header 

row.

5. In the Import data from row  and to row  boxes, enter the first and the last row numbers in the 

workbook that you want to import. For example, if you want to import data from rows 3 through 6, 

enter 3 and 6 respectively. By default, the Import data from row  box contains the row number that 

is immediately next to the header row that you have specified.

6. If the entity already contains data and you want to add to it, select Append to existing data. If, 

however, you want to delete existing data before importing, select Overwrite existing data.

7. Select Next.
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A list of fields in the entity appears. Next to each field, a text box appears in the Column Name in 

Spreadsheet  column.

8. For each field, specify the column name in the header row in the workbook that you want to map, 

and then select Import.

A message appears, stating that the process is irreversible and asking you to confirm that you want 

to import data.

9. Select OK.

A message appears, indicating that the data has been imported successfully.

10. Select OK.

The data is imported.

Create a Relationship Between Entities (Classic)
Steps to create an entity relationship in the Operations Hub classic version.

Log in to Operations Hub.

You cannot use a baseline entity or a pivot entity as a source entity. You can, however, use it as a target 

entity.

1. From the main navigation menu, select  ENTITIES.

The ENTITIES  workspace appears.
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2. Optional: Select the check boxes of the entities for which you want to create a relationship.

3. Select DESIGNER.

The DESIGNER  section appears, displaying all the entities created in the site. If, however, you have 

selected entities in the previous step, only the selected entities appear. If a relationship exists 

between two entities, a line connecting them appears.
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Tip:

You can arrange the entities in an order, minimize all entities, maximize all entities, or 

maximize only the entities in a relationship by selecting Auto Arrange, Minimize All, 

Maximize All, or Maximize linked Entities  respectively.

4. Next to each entity for which you want to create a relationship, select .

A list of fields in each entity appears.

5. Select Add Relationship, and then select a field from the source entity and then the target entity.

A relationship is created between the entities. A line connecting both the entities appears.

Delete a Relationship (Classic)
Steps to delete an entity relationship in the Operations Hub classic version.

Log in to Operations Hub.

1. From the main navigation menu, select  ENTITIES.

The ENTITIES  workspace appears.
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2. Select DESIGNER.

The DESIGNER  section appears, displaying all the entities created in the site. If a relationship exists 

between two entities, a line connecting them appears.
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3. On the line connecting the two entities whose relationship you want to delete, select .

A message appears, asking you to confirm that you want to delete the relationship.

4. Select OK.

The relationship is deleted.

Delete a Row from an Entity
Steps to delete entity row in the Operations Hub classic version

Log in to Operations Hub.

You cannot delete a row manually from a baseline entity or a pivot entity; you can delete rows only using a 

query in an application.

1. From the main navigation menu, select  ENTITIES.

The ENTITIES  workspace appears.

2. Select the entity from which you want to delete a row.

3. In the row that you want to delete, select .
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A message appears, asking you to confirm that you want to delete the row.

4. Select OK.

The row is deleted.

Delete a Field (Classic)
Steps to delete entity field in the Operations Hub classic version

Log in to Operations Hub.

An entity must contain at least one field. Therefore, if an entity contains only one field, you cannot delete 

it.

1. From the main navigation menu, select  ENTITIES.

The ENTITIES  workspace appears.

2. Select the entity from which you want to delete a field.

3. Select Edit Entity Structure.

A list of fields in the entity appears.
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4. In the row containing the field that you want to delete, select .

The field is deleted.

Delete an Entity (Classic)
This topic describes how to delete an entity in the Operations Hub classic version.

Log in to Operations Hub.

You cannot delete a baseline entity, an entity that is locked, or an entity that is used in a query.

Note:

In order to unlock an entity, you need to select the entity, click Edit Entity Structure, and then click 

the lock icon (in the upper right corner) of the Edit Entity Structure page. After you complete that 

task, you can go to entity list page to delete it.
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1. From the main navigation menu, select  ENTITIES.

The ENTITIES  workspace appears.

2. In the rows containing the entities that you want to delete, select the check boxes.

3. In the workspace heading, select , and then select Delete entities.

A message appears, asking you to confirm that you want to delete the entities.

Tip:

Alternatively, in the row containing each entity that you want to delete, select , and then 

select Delete entity.

4. Select OK.

The entities are deleted.
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Queries

About Queries
Using Operations Hub, you can create queries to access and manage data stored in Operations Hub, as 

well as data stored externally.

You can create the following types of queries:

• Entity

• SQL

• REST

• Extension

Entity Queries: Used to view and modify data stored in Operations Hub  entities. Refer to the following 

topics:

• Create Get Query (Classic)  (on page 250)

• Create Update Query (Classic)  (on page 256)

• Create Insert Query (Classic)  (on page 261)

• Create Delete Query (Classic)  (on page 263)

SQL Queries: Used to view and modify data stored in an external SQL database by executing existing 

stored procedures for that database. See Create SQL Query (Classic)  (on page 266).

REST Queries: Used to view and modify data stored in external sources by accessing their exposed REST 

APIs, such as Historian. See Create REST Query (Classic)  (on page 269).

Extension Queries: Can be used with Historian, OPC UA, and data from asset models. See Create 

Extension Query (Classic)  (on page 275).

On installing Operations Hub, you get a list of out-of-the-box (OOTB) extension queries. These are system 

queries and cannot be unlocked, modified, or deleted. You can duplicate such queries  (on page 280)  to 

modify and use them.

To access the list of OOTB extension queries, select QUERIES  in the main navigation menu.
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Current Value Use this query to retrieve the current values against Proficy Histori

an, Proficy iFIX, Proficy CIMPLICITY, and OPC UA data sources.

Historian Read Comment Use this query to read comments from a Proficy Historian data 

source.

Historian Write Comment Use this query to write comments to a Proficy Historian data 

source.

Historical By Count Use this query to retrieve historical values (by count) against a 

Proficy Historian data source.

Historical By Interval Use this query to retrieve historical values (by interval) against a 

Proficy Historian data source.

Historical By Interval-Calcu

lated Mode

Use this query to retrieve historical values (calculated mode) 

against a Proficy Historian data source.

OPC UA Write Use this query to perform write operations to Proficy iFIX and Profi

cy CIMPLICITY data sources.

OPC UA Write with Auth Use this query to perform OPC UA write operations with authentica

tion.

To troubleshoot errors returned for OOTB queries, refer to Error Codes  (on page 693).

Grant Group Access to Execute a Query (Classic)
Steps for Operations Hub classic version.
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Log in to Operations Hub.

1. From the main navigation menu, select  QUERIES.

The QUERIES  workspace appears, including a column summarizing the current query permissions. 

By default, newly created queries display “All users”, indicating all users have the ability to execute 

the query.

2. In the Permissions  column, select the query to which you want to grant query execution 

permissions.

The Query Permissions dialog box appears.

3. In the Query Permissions dialog box, if you want to grant query execution permissions to select 

groups only, select the Selected Group  option.

4. In the groups field, select the group or groups you would like to grant query execution permissions 

to and then select  Submit changes.

The selected groups can now execute the query.

Note:

It is possible to create a circular reference by nesting a parent group into its child. If there 

are circular references, the child groups will not display in the permissions dialog box.

Access a Query (Classic)
Steps for Operations Hub classic version.

Log in to Operations Hub.

To access queries in the latest version of Operations Hub, refer to Data Tab  (on page 147).

1. From the main navigation menu, select  QUERIES.

The QUERIES  workspace appears.
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2. In the row containing the query that you want to access, in the Name  column, select the link.

The query appears, displaying a list of fields in the query.

Tip:

You can modify values in the available fields, and then select Save  or Save and Exit  to save 

your changes.

Create Get Query (Classic)
This topic describes how to create a Get query.

Log in to Operations Hub.

You can also copy an existing get query  (on page 280).

1. From the main navigation menu, select  QUERIES.

The QUERIES  workspace appears.
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2. Select +Add new query.

The Create Query  screen appears.

3. Enter a Query name, and select Create.

The name must contain at least one uppercase or lowercase letter.

The available options for creating the query appear.

4. Enter a Description  for the query.

5. Select Get  as Query Type.

6. From the Entity  box, select an entity from which you want to get results.

The Output Data, Conditions, Role Conditions, and Advanced  sections appear.
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7. Under Output Data  section, select +Add field.

The FIELD, FUNCTION, and ACCESS  boxes appear.

Tip:

If you want to get values from all the fields in the query, select +Add all fields.

8. Enter or select values as specified in the following table.

Field Name Description

FIELD Select the field whose values you want to get using the query.

Tip:

If the entity that you have specified in the Entity  box is a 

source entity in a relationship, you can select from fields in 

the source and target entities.
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Field Name Description

FUNCTION Specify whether you want to get the maximum, minimum, average, 

sum, or count of the values in the field. By default, the value in this 

box is None, which indicates that the exact values will appear in the 

query results.

ACCESS If you want to provide access to the data in the field only to users as

signed to specific roles, select Permitted roles. By default, this box 

contains the value All users, which indicates that all users, regard

less of the roles assigned to them, can access the query results. In 

the PERMITTED ROLES  box that appears, navigate through the hierar

chy of roles, and then select the roles assigned to users who can ac

cess the data in this field.

9. In the Conditions  section, select +Add, and then enter or select values as specified in the following 

table.

Field Name Description

Required or Optional Select one of the following values:

◦ Required: Select this value if the field must always contain a 

value. For example, suppose you are creating a query to dis

play account details based on the account number. If you se

lect Required, when you run the query, if you have not speci

fied an account number, no records appear.

◦ Optional: Select this value if the field need not contain a val

ue. For example, suppose you are creating a query to display 

account details based on the account number. If you select 

Optional, when you run the query, if you have not specified an 

account number, all the records appear.

Field Select the entity field based on which you want to create a condi

tion.

Operator Select the conditional operator that you want to use to compare the 

value in the selected field.

Compare with Select one of the following values:
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Field Name Description

◦ Input field: Select this value if you want to allow application 

users to specify a value that you want to compare with the 

entity field value. After you select this value, enter a name for 

the input field in the text box that appears. For example, sup

pose you want to create a query to display a list of devices in 

a specific site, and you want to allow the user to specify the 

site name. In this case:

a. Select Input field, and then enter Site Name.

b. Modify the page in the application that contains the 

query to include an input component that allows the 

user to enter or select the site name.

c. Map the input component in the page with the input in 

the Page Data  section.

When the user enters a value in the Site Name  field in 

the application, the query results are filtered accord

ingly.

◦ Fixed Value: Select this value if you want to specify the value 

that you want to compare with the entity field value. After you 

select this value, enter a value in the text box that appears. 

For example, if you want to get data received from a device if 

the temperature exceeds 40 degrees Celsius:

▪ In the Field  box, select the field that stores tempera

ture.

▪ In the Operator  box, select >.

▪ Select Fixed Value, and then enter 40 in the text box.

◦ Query: Select this value to specify a query whose output you 

want to compare with the field values in the specified entity. 

After you select this value, a drop-down list box appears in 

which you can select a query. For example, if there is a query 

that returns the maximum temperature recorded by a device, 

you can create a query to get a list of devices that record a 

temperature higher than the maximum temperature.

10. In the Role Conditions  section, select Add role condition, and then enter or select values as 

specified in the following table.
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Field Name Description

Apply conditions to Select one of the following values:

◦ Specific Roles: Select this value if you want to apply the con

dition only to users assigned to specific roles. After you se

lect this value, navigate through the hierarchy of roles, and 

select the roles.

◦ All roles: Select this value if you want to apply the condition 

to all or most users. After you select this value, the Exclude 

check box appears. Select this check box if you do not want 

to apply the condition to users assigned to specific roles. Af

ter you select this check box, navigate through the hierarchy 

of roles, and select the roles.

For example, suppose the query returns sales data, and you 

want to apply the following conditions on who can access 

the query results:

▪ Users can access only the data that is related to their 

region.

▪ Regional officers can access data related to all re

gions.

In this case, select the Exclude  check box, and then select 

the Regional Officer role.

Row visibility Select one of the following values:

◦ Filter rows: Select this value if you want to filter rows based 

on a condition, and then specify the condition in the Entity 

field  and In user's role tree  boxes. For example, if the query 

returns sales data, and you want users to access only the 

data that is related to their region, then:

▪ In the Entity field  box, select the entity field that 

stores the sales region data.

▪ In the In user's role tree  box, select the category that 

stores the region roles.

◦ Show all rows: Select this value if you want users belonging 

to specific roles to access all the field values.

Entity field This field appears only if the value in Row visibility  is Filter rows.
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Field Name Description

Select the entity field that contains the value that you want to com

pare with the value in In user's role tree.

In user's role tree Select the group or category of users that will be used to filter data. 

This box appears only if the value in the Row visibility  box is Filter 

rows.

11. In the Advanced  section, enter or select values as specified in the following table:

Field Name Description

Distinct Select this check box if you do not want the query results to dis

play duplicate field values. For example, suppose a query returns 

a list of countries that users belong to, and you want to view on

ly the list of countries, you can select this check box so that each 

country appears only once.

Order By Select Add, and then select the entity field and the order in which 

the field values should be arranged in the query results.

Group By Select Add, and then select the entity field that you want to use to 

group the query results.

If the query results contain a list of users and the country that each user belongs to, and if you 

want to group the users based on their country and sort them alphabetically, perform the following 

steps:

a. From Order By, select the entity field that stores the user name, and then select Asc.

b. From Group By, select the entity field that stores the country.

12. Select Save  or Save And Exit.

The query is created.

Create Update Query (Classic)
This topic describes how to create an Update query.

Log in to Operations Hub.

You can also copy an existing update query  (on page 280).
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1. From the main navigation menu, select  QUERIES.

The QUERIES  workspace appears.

2. Select Add new query.

The Create Query  window appears.

3. In the Query name  box, enter a name, and then select Create. The name must contain at least one 

uppercase or lowercase letter.

The available options for creating the query appear.

4. In the Description  box, enter a value.

5. In the Query Type  box, select Update.

6. In the Entity  box, select an entity from which you want to update results.

The Conditions  and Set Data  sections appear.
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7. In the Conditions  section, select Add, and then enter or select values as specified in the following 

table.

Field Name Description

Entity Field Select one of the following values:

◦ Required: Select this value if the field must always contain a 

value. For example, suppose you are creating a query to up

date account details based on the account number. If you 

select Required, when the query is run from an application, 

if an account number is not specified, then a message ap

pears, stating that the field is required.

◦ Optional: Select this value if the field need not contain a val

ue. For example, suppose you are creating a query to update 

account details based on the account number. If you select 

Optional, when the query is run from an application, if an ac
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Field Name Description

count number is not specified, then all the fields will be up

dated. Therefore, use caution when selecting this value.

Important:

Exercise extreme caution while selecting Optional. If 

used incorrectly, it can corrupt the data.

Field Select the entity field based on which you want to create a condi

tion.

Operator Select the operator that you want to use to compare the value in 

the text box if Input Field  is selected.

Compare with Select one of the following values:

◦ Input field: Select this value if you want to allow application 

users to specify a value that you want to compare with the 

entity field value. After you select this value, enter a name 

for the input field in the text box that appears. For example, 

suppose you want to create a query to update all devices in 

a specific site, and you want to allow the user to specify the 

site name. In this case:

a. Select Input Type, and then enter Site Name.

b. Modify the page in the application that contains the 

query to include the query to add an input control that 

allows the user to specify or select the Site Name 

field. Using the drag-and-drop method, map the Site 

Name  field in the query with the site name control.

When the user enters or selects a value in the Site 

Name  field in the application, and runs the query, all 

the devices with the selected site name are updated.

◦ Fixed Value: Select this value if you want to specify the val

ue that you want to compare with the entity field value. Af

ter you select this value, enter a value in the text box that ap

pears. For example, if you want to update the status of all 

devices if the temperature exceeds 40 degrees Celsius:
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Field Name Description

▪ In the Field  box, select the field that stores tempera

ture.

▪ In the Operator  box, select >.

▪ Select Fixed Value, and then enter 40 in the text box.

◦ Query: Select this value to specify a query whose output you 

want to compare with the field values in the specified enti

ty. After you select this value, a drop-down list box appears 

in which you can select a query. For example, if you want the 

query to update the status of devices when the temperature 

recorded by them exceeds a specified maximum tempera

ture, you must create a query to get the maximum tempera

ture, and select that query in this field.

8. In the Set Data  section, select Add, and then enter or select values as described in the following 

table.

Field Name Description

Entity field Select the entity field whose values you want to update using the 

query.

Value Select one of the following values:

◦ Input field: Select this value if you want to update values 

specified by application users, and then enter a name in the 

Input Data Name  box. Add an input control for the field in the 

application, and map it to the input field in the query.

◦ Fixed value: Select this value if you want to insert a fixed val

ue, and then enter the value in the Name  box.

Input Data Name This field appears only if you select Input field  in the Value  box. En

ter the name of the field that you will add in the application. Appli

cation users can then provide the value by accessing the applica

tion.

Name This field appears only if you select Fixed value  in the Value  box. 

Enter the value that you want to update using the query.

9. Select Save  or Save And Exit.

The query is created.
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Create Insert Query (Classic)
This topic describes how to create an Insert query.

Log in to Operations Hub.

You can also copy an existing insert query  (on page 280).

1. From the main navigation menu, select  QUERIES.

The QUERIES  workspace appears.

2. Select Add new query.

The Create Query  window appears.

3. In the Query name  box, enter a name, and then select Create. The name must contain at least one 

uppercase or lowercase letter.

The available options for creating the query appear.

4. In the Description  box, enter a value.

5. In the Query Type  box, select Insert.

6. In the Entity  box, select an entity in which you want to insert results.

The Set Data  section appears.
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7. In the Set Data  section, select Add, and then enter or select values as described in the following 

table.

Field Name Description

Entity field Select the entity field whose values you want to insert using the 

query.

Value Select one of the following values:

◦ Input field: Select this value if you want to insert values 

specified by application users, and then enter a name in the 

Input Data Name  box. Add an input control for the field in the 

application and map it to the input field in the query.

◦ Fixed value: Select this value if you want to insert a fixed val

ue, and then enter the value in the Name  box.

Input Data Name This field appears only if you select Input field  in the Value  box. En

ter the name of the field that you will add in the application. Appli

cation users can then provide the value by accessing the applica

tion.

Name This field appears only if you select Fixed value  in the Value  box. 

Enter the value that you want to insert using the query.
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8. Select Save  or Save And Exit.

The query is created.

Create Delete Query (Classic)
This topic describes how to create a Delete query.

Log in to Operations Hub.

1. From the main navigation menu, select  QUERIES.

The QUERIES  workspace appears.

2. Select Add new query.

The Create Query  window 

appears.

3. In the Query name  box, enter a name, and then select Create. The name must contain at least one 

uppercase or lowercase letter.

The available options for creating the query appear.

4. In the Description  box, enter a value.

5. In the Query Type  box, select Delete.

6. In the Entity  box, select an entity from which you want to delete results.

The Conditions  section appears.
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7. In the Conditions  section, select Add, and then enter or select values as specified in the following 

table.

Field Name Description

Required or Optional Select one of the following values:

◦ Required: Select this value if the field must always contain 

a value. For example, suppose you are creating a query to 

delete account details based on the account number. If you 

select Required, when the query is run from an application, 

if an account number is not specified, a message appears, 

stating that the field is required.

◦ Optional: Select this value if the field need not contain a val

ue. For example, suppose you are creating a query to delete 

account details based on the account number. If you select 

Optional, when the query is run from an application, if an ac
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Field Name Description

count number is not specified, the all the records are delet

ed.

Important:

Exercise extreme caution while selecting Optional 

for a delete query. If the user does not specify a val

ue, all the data in the entity will be deleted.

Field Select the entity field based on which you want to create a condi

tion.

Operator Select the operator that you want to use to compare the value in 

the text box if Input field is selected.

Compare with Select one of the following values:

◦ Input field: Select this value if you want to allow application 

users to specify a value that you want to compare with the 

entity field value. After you select this value, enter a name for 

the input field in the text box that appears. For example, sup

pose you want to create a query to delete devices in a spe

cific site, and you want to allow the user to specify the site 

name. In this case:

a. Select Input Type, and then enter Site Name.

b. Modify the page in the application that contains 

the query to add an input control that allows users 

to specify the site name. Using the drag-and-drop 

method, map the input control in the query with the 

Site Name field.

When the user enters a value in the Site Name  field 

in the application, and runs the query, all the devices 

with the specified site name are deleted.

◦ Fixed Value: Select this value if you want to specify the val

ue that you want to compare with the entity field value. Af

ter you select this value, enter a value in the text box that ap

pears. For example, if you want to delete data received from 

a device if the temperature exceeds 40 degrees Celsius:
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Field Name Description

▪ In the Field  box, select the field that stores tempera

ture.

▪ In the Operator  box, select >.

▪ Select Fixed Value, and then enter 40 in the text box.

◦ Query: Select this value to specify a query whose output you 

want to compare with the field values in the specified entity. 

After you select this value, a drop-down list box appears in 

which you can select a query. For example, if there is a query 

that returns the maximum temperature recorded by a device, 

you can create a query to delete all the devices that record a 

temperature higher than the maximum temperature.

8. Select Save  or Save And Exit.

The query is created.

Create SQL Query (Classic)
This topic describes how to create a SQL query.

In order to proceed you must have a working SQL database, and the selected database must have stored 

procedures. You must also have created a data source for the relational database in Operations Hub.

To use a relational database in an Operations Hub  application, you must:

• Create a Data Source (Classic)  (on page 352)  with a Relational Database type and provide the 

details of the external database.

• Create a SQL Query, and specify the expected inputs and outputs of a Stored Procedure. (Described 

in this topic in the following steps.)

• Map the query in the page designer to use the query to fetch the data from the external database. 

See Use the Relational Database Query in the Designer  (on page 102).

1. From the main navigation menu, select  QUERIES.

The QUERIES  workspace appears.
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2. Select Add new query.

The Create Query  window appears.

3. In the Name  field, enter a name, and then select Create. The name must contain at least one 

uppercase or lowercase letter.

The available options for creating the query appear.

4. In the Description  field, enter a description for the query.

5. In the Type  field, select Relational Database .

6. In the Data Source  field, select the name of the data source from the list.

7. In the Query Type field, observe that the field defaults to ‘Stored Procedure’ when you select 

‘Relational Database’ as the Type.

8. In the Schema  field, select the database schema that you want to use. All the database schemas 

will be loaded for the selected data source. The default selection is dbo.

9. In the Stored Procedure  field, select the Stored Procedure that you want to use from the selected 

schema.

After you select all the required fields, the list of input parameters will be loaded if there are any, for 

the selected stored procedure.

Input Parameters: The value for the input parameters can be configured either while creating the 

query or while consuming the query in the page builder.

To assign the value for an input parameter while creating the query, select the type drop-down in 

the input parameter list. It has two options:
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◦ Fixed Value: If this option is selected, the value given will be taken as the input to the Stored 

Procedure. The input parameter will not be shown in the page builder page.

◦ Input Field: If this option is selected, the value given will be taken as the default input to the 

Stored Procedure. The input parameter will be shown in the page builder page and if there is 

any input provided to while execution, the default value will be overridden.

Specify the triggering/non-triggering options for the input parameters. See Triggering/Non-

triggering SQL Queries  (on page 268).

After the default values for input parameters are provided, select the Execute  button under the Test 

category. You will then be presented with the various fields in Result Sets and Output Parameters 

sent out of the Stored Procedure.

Note:

Currently we do not support dynamic responses from the Stored Procedures. This means 

while building the query, the fields that appear after selecting Execute, should match the 

fields returned by the stored procedure while using the application.

10. Add the required fields.

11. Select Save  or Save And Exit.

The query is created.

Triggering/Non-triggering SQL Queries
This topic describes the SQL triggering and non-triggering functionality.

This feature is currently available only in Operations Hub Classic version under Query definition and Page 

designer.

Note:

This functionality will be available in the Operations Hub new layout in an upcoming release.

When creating SQL queries in Operations Hub, you have the option to specify whether the SQL query 

should be triggered or not when a change occurs in its input value. You can also specify if the value is 

mandatory or optional to trigger a query. By default, the options are set to Triggering  and Optional  for all 

SQL queries. This is also the default behavior of Operations Hub page designer PAGE DATA  tab > Query 

option > Auto submit on input change.
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When you use the query in page designer, you can choose to modify the triggering/non-triggering settings. 

The page designer settings take precedence over the settings in query definition. Once the query is added 

to a page, any changes to the settings in query definition is not carried over to page designer.

Non-triggering

If the input parameter is set to Non Triggering, then at runtime any change to the input does not trigger 

the query.

Triggering

If the input parameter is set to Triggering, then at runtime any change to the input will trigger the query 

provided all the mandatory fields are set.

Optional

If the input parameter is set to Optional, then the input need not have any value for the query to trigger.

Mandatory

If the input parameter is set to Mandatory, then the input should contain a value for the query to trigger.

Create REST Query (Classic)
You can create a REST query for the GET, PUT, POST, and DELETE methods.

• Log in to Operations Hub.

• Create the data source  (on page 352)  that you want to use in the query.

• Create an entity  (on page 228)  to specify the query response. The entity fields that you want to 

map with the query output parameters must contain the same names as the parameters.

• It is recommended that you add the environment variable no_proxy  to the System Variables. You 

should also add references to localhost as well as nodes which are targets of REST Queries to the 

System Variables. Be aware that the case of the environment variables for the a data source target 

in Operations Hub should match the case of the ones used by the Historian Server; environment 

variables are case-sensitive.
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Note:

REST query will run even when system variable has no port number. A bad port leads to an error.

1. In the module navigation menu, select QUERIES.

The QUERIES  workspace appears.

2. Select Add new query.

The Create Query  window appears.

3. In the Query name  box, enter a name, and then select Create. The name must contain at least one 

uppercase or lowercase letter.

The available options for creating the query appear.

4. Provide values in the available boxes as specified in the following table.

Field Name Description

Description Enter a description for the query.

Type Select REST.

Method Select the method of the API you want to use in the query. Support

ed methods are GET, PUT, POST, and DELETE.

Entity Select the entity that will specify the query response fields.

Note:

When using a Historian data source, the Entity field will au

to-populate with the entity associated with the Available 

API selected.

Data Source Select the data source that you want to use for the query.

Available API Select the API that you want to use in the query. This box contains 

a list of APIs that are available in the data source that you have se

lected.

The list of available APIs will be filtered based on the method se

lected.

Note:

Pre-existing APIs are available only for Historian data 

sources. For more information see Historian API help.

https://www.ge.com/digital/documentation/historian/version80/c_historian_apis_overview.html
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Note:

The Base URL  and Query URL  boxes are populated with the base portion (that is, the host 

name or IP address of the data source server) and the remaining portion of the URL. The 

values in these boxes together identify the complete URL endpoint. The Base URL  box is 

always disabled. The Query URL  box is disabled if you select an API for a Historian data 

source. If, however, you are using a custom data source, you can enter a value in the Query 

URL  box.

5. In the Parameters  section, please create parameters as needed for the API you are querying. Each 

parameter will require a default or test value if you wish to run the query with the Execute button.

Field Name Description Example

Path parameters Identify the parameters in the path 

of the endpoint. These appear before 

the query string if query parameters 

are present.

For the endpoint https://

jsonplaceholder.typicode

.com/users/1/posts, the parameter 

between users  and posts, which is 

the user ID, is the path parameter. 

The value for this parameter is 1.

Query parameters Identify the parameters in the path 

of the endpoint that appear after the 

question mark (?).

For the endpoint https://json

placeholder.typicode.com/posts?

userId=1, userId  is the query para

meter. The value for this parameter 

is 1.

Header parameters Identify the parameters that you 

want to include in the request head

er. Typically, these parameters are 

related to authorization.

Body parameters Identify the parameters in the body 

of the request. Typically these will 

be required for PUT and POST meth

ods, although they are sometimes re

quired for DELETE as well.

Body parameters can be supplied 

in Operations Hub as a URL encod

Refer to the screenshot below.
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Field Name Description Example

ed format, raw JSON, or raw XML. 

In case JSON or XML is selected, 

the first parameter should be used 

to supply the full JSON body. Subse

quent parameters can be used for 

dynamic substitution into that JSON 

body.

◦ JSON: If selected, the subse

quent parameters should be 

JSON keys found in the body. 

The corresponding JSON val

ues will be substituted.

◦ XML: If selected, the subse

quent parameters should be 

strings found in the body. 

These strings will be substi

tuted. You can also supply 

curly braces to delineate the 

parameters from text with

in the body. For example, 

{{STRING_TO_SUBSTITUTE}}

Additionally, you have the option to 

preview the substitution for XML.



Operations Hub for Windows  | 3 - User Guide  | 273

Be aware that the following Historian REST queries require the multi-select input to be enabled on 

the EndApp page for output data to be displayed:

◦ Get > Raw Data

◦ Get > Calculated Data

◦ Get > Interpolated Data

◦ Post > Raw Data

◦ Post > Calculated Data

◦ Post > Interpolated Data

6. In the Query Outputs  section, provide values as specified in the following table.

Field Name Description

Raw Response Select this check box if you want to get either the entire JSON re

sponse or XML response mapped to a single entity field. You can 

then access the response by referencing that entity field while de

signing an application. If you clear this check box, individual com

ponents of the response are mapped to individual entity fields.

Entity Select the entity that will specify the query response fields.

Output fields Select the entity fields that you want to map to the query response. 

If the Raw JSON  check box is selected, only the first field that you 

select will be mapped to the query response, regardless of the field 

name. If the Raw JSON  check box is cleared, the JSON response 
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Field Name Description

components are mapped to the entity fields with matching names. 

In the case of nested responses, dot notation is used to map to in

ner fields.

Note:

All REST queries must have a defined response. You can save the query only if you specify 

at least one output. This is true even for Delete REST API calls which do not normally 

return a response. In this case, please select any entity and entity field, regardless of name.

7. In the Execute  section, select Run Request.

The query output fields, as well as the query appear in the Results  box.

Important:

Provide sample values leading to a successful response in order to properly test the REST 

endpoint. We strongly recommend using values you know will return a representative set 

of data; otherwise, an error occurs or the response may not return the field data that you 

need. For example: for Historian data queries, if the set of requested tags is different from 

the returned set of data (that is, if one or more tags does not have data), the call will fail. 

The user should modify the inputs to include only the tags for which they are confident 

there will be data in the response. For PUT/POST/DELETE, this action is not a test but an 

actual request which can change your data.

8. If required, select Create Entity  from Results. This will create an entity with the appropriate output 

fields generated from the previous Run Request.

9. Select Save  or Save and Exit.

The query is created.

Note:

While Operations Hub handles many response formats, there are some responses which 

it has difficulty mapping to output fields. In particular, embedded lists may be returned as 

strings rather than lists of objects.

Important:

When you have a large number of users (greater than 100) and each using an end app with 

multiple REST requests, coupled with a slow REST response, you can get into a situation 
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where the server is waiting for a long time for the previous responses to return, and is 

therefore unable to process new requests. To avoid this situation, reduce the number of 

REST calls in your App. Alternatively, you may adjust the Operations Hub timeout setting in 

the settings.conf file in the following folder: C:\ProgramData\GE\Operations Hub\iqp-config

\IQP\app. Use the following command so that the slower REST requests do not hold up the 

Operations Hub server. You can change the seconds value to increase the timeout setting 

further:

#REST client timeout (seconds)

rest_timeout=30

Create Extension Query (Classic)
This topic describes how to create an Extension query.

Log in to Operations Hub.

Extension type queries work with multiple data sources.

1. In the main navigation menu, select QUERIES.

The QUERIES  workspace appears.

2. Select Add new query.

The New Query  window appears.

3. Provide these details:

Field Name Description

Name Enter a name that contains at least one uppercase or lowercase let

ter.

Description Enter a brief description for the query.

Type Select Extension.

Method Select the type of query you want to create from these options:

◦ Read

◦ Write

◦ Add Comment

The Query Parameters  and Output Data  are loaded based on the 

method selected for the query.
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4. Provide the query parameter  (on page 276)  values for the required fields.

◦ Fixed Value: If this option is selected, the provided value is considered as a fixed value for 

the field. Fixed value fields are not shown in the application page builder.

◦ Input Field: If this option is selected, the provided value appears as a default value for the 

field in the page builder. Any value provided before executing the query overrides the default 

value.

5. Select  next to the parameters you do not want to include in your query.

To retrieve deleted query parameters and output data, select +Add All Query Params  and +Add All 

Outputs  respectively.

6. Save the query.

The extension query is created.

The saved query appears in the application page builder under PAGE DATA  > Query  > Entities.

Go to the application page builder to apply and execute the query.

Extension Query Parameters
Use these parameters in your extension query.

Parameter Description

Tag Source Specify a tag source.

Tag Allows to browse and select a tag.

Authentication Select how to authenticate when you submit a query:

• Logon User Token: Uses the user login token for authentication.

• Provide in Query Parameters: Uses User Name  and Password  input 

fields for authentication.

• Use Data Source Credentials: Uses the write credentials configured 

in the data source for authentication.

• Anonymous: No authentication.

Tag Display Format Select a display format for the tag name.

Sampling Mode Select a sampling mode for retrieving data.

Calculated Mode If the sampling mode is Calculated, specify the calculation mode.

Start Time Select the calendar icon to set a start time.
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Parameter Description

Duration Enter the duration.

End Time Select the calendar icon to set an end time.

Sampling Time Enter the sampling time.

Sampling Count Enter the sampling count.

Sampling Direction Direction of sampling, whether forward or backward.

Note:

This parameter is used only when the sampling mode is RawByNum

ber. You must also specify the sampling count for this parameter.

Show Comments Select/Clear the check box to show/hide comments.

Sort By Defines how a Data Distributor extension query result-set should be sort

ed. You must enter the syntax, which is a comma-separated list of Da

ta Distributor extension query fields. The result set is sorted by the fields 

specified in the list, in the given order.

Examples:

• timestamp,name  means to sort by timestamp first, then by name.

• name,timestamp  means to sort by name first, and then by time

stamp.

Each field in the syntax can optionally have a suffix of a plus +  or minus - 

symbol to indicate the sorting order for that field.

For example, timestamp-,name+  means to sort by timestamp first in a de

scending order, then by name in an ascending order.

The default sorting order for timestamp is descending, and rest of the 

fields are ascending.

Each field in the syntax can be denoted either by its full output field name, 

or a built-in one letter identifier. For example,

• t  for timestamp

• n  for tag name
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Parameter Description

• v  for value

• q  for quality

If you do not enter a syntax, or left this field blank, then the behavior is to 

sort by timestamp descending.

Currently, for auto sync queries, the sorting order only applies to the initial 

result set and not any subsequent new rows to the result set.

Update Preloaded REST Queries after Import (Classic)
Steps for Operations Hub classic version.

Log in to Operations Hub.

REST queries from the previous version of Operations Hub are supported. The upgrade process imports 

these queries to the latest version of the preloaded API. The queries will work with no need for interaction. 

The display fields need to be manually updated, however. The following steps describe how to update 

your display fields for a REST query using the Historian GET request.

1. From the main navigation menu, select  QUERIES.

The QUERIES  workspace appears.

2. In the row containing the query you want to access, in the Name  column, select the link.

The query appears, displaying a list of fields in the query.

3. In the API Name field, select the appropriate API from the drop-down list (the list will already be 

populated). Use the following tables as a guide on the renamed APIs.
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v1.5 API Name v1.6 API Name

1.5 1.6

Get Tag Properties Tag Properties

Get Tags Tags

Get Tags List Tag List

Get Raw Data Raw Data

Get Interpolated Data Interpolated Data

Get Current Value Current Value

Get Calculated Value Calculated Value

Get Sampled Data Sampled Data

Get Trend Data Trend Data

4. Select Save  or Save and Exit  to resave the query.

The query display field is updated.

Update Entity Display Fields After an Import (Classic)
Steps for Operations Hub classic version.

Log in to Operations Hub.

Entities defined in the previous version of Operations Hub are supported, and imported to the latest 

version. They will work with no need for interaction. The display fields need to be manually updated, 

however. The following steps describe how to update your display fields for entities.

1. From the main navigation menu, select  QUERIES.

The QUERIES  workspace appears.
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2. In the row containing the query you want to access, in the Name  column, select the link.

The query appears, displaying a list of fields in the query.

3. In the Entity Name field, select the appropriate Entity from the drop-down list (the list will already be 

populated). Use the following tables as a guide on the renamed Entities.

v1.5 Entity Name v1.6 Entity Name

1.5 1.6

historian_gettagproperties historian_tagproperties

4. Select Save  or Save and Exit  to save your changes.

The entity display field is updated.

Copy a Query (Classic)
Creates a duplicate copy of an existing query.

Log in to Operations Hub.

You can also create a new query  (on page 250).

1. From the main navigation menu, select  QUERIES.

The QUERIES  workspace appears.
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2. In the row containing the query that you want to copy, select , then select Duplicate query.

The Please enter new name  screen appears, displaying the name of the query that you have 

selected, appended with a system-generated value.

3. As needed, modify the name of the query, and select OK.

The name must contain at least one uppercase or lowercase letter.

The selected query is copied.

Delete a Query (Classic)
This topic describes how to delete a query.

Log in to Operations Hub.

• You cannot delete a query if it is locked or used in an application.

• You cannot delete a preconfigured query that came with the system installation.

1. From the main navigation menu, select  QUERIES.

The QUERIES  workspace appears.
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2. In the rows containing the queries that you want to delete, select the check boxes.

3. In the workspace heading, select , and then select Delete queries.

A message appears, asking you to confirm that you want to delete the selected queries.

Tip:

Alternatively, in the row containing the query that you want to delete, select , and then 

select Delete query.

4. Select Delete.

The queries are deleted.

Plug-ins

About Plug-ins

A plug-in is a widget that you can configure to work with the components of an application (such as 

entities and queries), and then use it in an application. You can thus add additional functionality to 

Operations Hub.

Using Operations Hub, you can embed plug-ins in an application. You can use plug-ins stored on your local 

machine or imported from a different site.

Note:

When configuring input targets for plugins, ensure that no other binding exists for the target query 

input. To remove a binding from the query input, select the unlink icon next to the binding.
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To create a custom plug-in, refer to Custom Plug-in structure  (on page 288)

Pump Temperature Plug-in

Suppose there is a plug-in that shows the trend graph of the highest temperature recorded in a pump.

Suppose you want to create an application that monitors the energy efficiency of the pump. In addition 

to the other parameters that you want to display in the application, you can use the plug-in to show the 

highest temperature recorded in the pump (instead of creating a trend graph from scratch).

Access a Plug-in (Classic)
This topic describes how to access custom plug-ins.

Log in to Operations Hub.

To access custom plug-ins in the latest version of Operations Hub, refer to Navigation Panel  (on page 

139).

From the main navigation menu, select  PLUGINS.

The PLUGINS  workspace appears, displaying a list of plug-ins that are imported.

Tip:

You can access the information related to a plug-in by selecting  in the corresponding row.

Import a Plug-in (Classic)
This topic describes how to import custom plug-ins.
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Log in to Operations Hub.

Follow these steps to import each custom plug-in to Operations Hub. Plug-ins also get imported when 

they are used in an application that you import to Operations Hub.

Note:

In case you imported a newer version of an existing plugin, you need to revisit the application 

pages (designer) wherever the old version was in use.

1. Delete the old plugin version from the container. All plugin configuration settings are lost 

when you delete the old version.

2. Add the new plugin version to replace the deleted one. Reconfigure the settings for the 

new version.

You can also use a third party client (for example, Postman) to import plug-ins. Send a post request to 

https://enter your machine name/site/ajax/plugin

1. From the main navigation menu, select  PLUGINS.

The PLUGINS  workspace appears.

2. Select Import.

3. Navigate to and select the plug-in that you want to import, and then select Open.

The plug-in is imported.
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Note:

If the plug-in name contains special characters, then the plug-in is not imported. You must 

fix the plug-in name to import it to Operations Hub. However, existing plug-ins containing 

special characters in their name are allowed in Operations Hub as long as they are not 

deleted.

In the page designer of an application, the imported plug-in appears in the CUSTOM  section.

Use the plug-in in an application  (on page 285).

Use a Plug-in in an Application (Classic)
Steps for Operations Hub classic version.

Import the plug-in  (on page 283)  that you want to use in an application.

1. From the main navigation menu, select  APPS.

The APPS  workspace appears.
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2. In the Name  column, select the application in which you want to use the plug-in.

The PAGES  workspace appears, displaying a list of pages created in the application.

3. In the Name  column, select the page in which you want to include the plug-in.

The page designer appears, displaying the elements in each container in the page. The plug-ins 

that are available in the site appear in the CUSTOM  section.

4. From the list of plug-ins in the CUSTOM  section, drag the plug-in to the container in which you want 

to include the plug-in.

5. Select Save App.

The plug-in is used in the application.
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Download a Plug-in (Classic)
This topic describes how to download a plug-in.

Log in to Operations Hub.

1. From the main navigation menu, select  PLUGINS.

The PLUGINS  workspace appears.

2. In the row containing the plug-in that you want to download, select .

The plug-in is downloaded as a .zip file.

Delete a Plug-in (Classic)
This topic describes how to delete a plug-in.

Log in to Operations Hub.

1. From the main navigation menu, select  PLUGINS.

The PLUGINS  workspace appears, displaying a list of plug-ins that are imported.
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2. In each row containing the plug-in that you want to delete, select .

A message appears, asking you to confirm that you want to delete the plug-in.

3. Select OK.

The plug-in is deleted.

Custom Plug-in structure
This topic describes how to use plug-in components.

A plug-in must contain the following components:

• index.html  (on page 290): Contains the plug-in html code.

• main.js  (on page 293): Contains the plug-in JavaScript code.

• manifest.json  (on page 290): Contains the plug-in configuration details.

• style.css: Contains the plug-in stylesheet details.

• The scripts folder: Contains external scripts.

Get started with the sample templates to build your own plug-in.

Template Type How to Use

Download  the sample template for simple plug-in

Includes examples using data source.

Use this template to build a simple plug-in.

1. Unzip the downloaded file. The unzipped file 

contains a folder called template  with com

ponents to build a simple plug-in.

2. Modify the plug-in components.

oxy_ex-1/file_downloads/template.zip
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Template Type How to Use

3. Rename the template  folder to match with 

the typeName  (plug-in name) in manifest.j

son.

4. Create a zip file of your modified folder (do 

not zip only plug-in components). The zip 

file name should be same as the plug-in 

name.

For example, if your plug-in name is table, 

then the zip file and the folder within should 

also be named as table.

5. Import  (on page 283)  the modified zip file 

to Operations Hub to load as a plug-in.

Download  the sample template for advanced plug-

in

• Includes examples using data source and 

data target.

• Loads external scripts (tools.zip) imported 

using webpack.

• Loads DevExtreme using manifest (scripts 

element).

• tools.js  contains color conversion script 

and connecting to data sources for manual, 

global, query, or formula.

Important:

Do not import the sample template file as 

a plug-in. Follow the instructions on how 

to use the downloaded template to build 

a plug-in, which can be imported to Opera

tions Hub.

Use this template to build an advanced plug-in.

1. Unzip the downloaded file.

2. Perform npm install  in the root folder to 

download dependencies.

3. Modify the plug-in components.

4. To generate a zip file of the modified tem

plate:

◦ Perform npm run build  to generate a 

development package.

◦ Perform npm run prodBuild  to gener

ate a production package (minified).

5. The generated zip file is saved to the dist 

folder in the project folder.

6. Import  (on page 283)  the zip file to Opera

tions Hub to load as a plug-in.

oxy_ex-1/file_downloads/template-adv.zip
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The index.html file

Each plug-in must contain an index.html file in the root folder of the plug-in.

Note:

If html code is not required, create a blank file.

The markup defined in the index.html file is included in the body of a page in an application. Therefore, 

tags such as html, head, meta will be omitted.

Important:

Do not use the script tag because of the asynchronous behavior of the tag outside of the html 

head.

JavaScript Dependencies

The easiest way to add external JavaScript dependencies is to place them in the scripts folder (in the root 

folder) and reference this dependency in the manifest.json  file.

Important:

When using this method, all JavaScript dependencies are included in the global scope of the 

application, which can create conflicts between different plug-ins. Therefore, we recommend that 

you use a build tool like Webpack to manage dependencies of plug-ins.

The manifest.json file

Every plug-in must contain a manifest.json  file in the root folder of the plug-in. This file provides the 

essential information about the plug-in to Operations Hub.

The following table provides the parameters that you must include in the manifest.json  file.

Parameter Description

typeName  [String] The unique name of the plug-in.

Does not support special characters. For example, comma, period, amper

sand, dollar sign, percent sign, parenthesis, asterisk, etc.

pluginId  [String] The unique ID of the plug-in. The value for this parameter must be a long, 

random one.
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Parameter Description

Type  [String] The type of the plug-in.

category  [String] The category of the plug-in.

description  [String] The description of the plug-in. This value appears in Operations Hub  when 

you design an application to include the plug-in.

info The following information about the plug-in:

• version

• update

• size

• developer

scripts  [Array] The array for the scripts that you want to use in the plug-in.

customIcon  [String] The icon that will appear next to the name of the plug-in in Operations Hub 

when designing an application to include the plug-in.

origin  [String] The origin of the plug-in. Provide the value custom for this parameter.

placeholder  [String] A placeholder for the plug-in, which will appear in Operations Hub  when de

signing an application to include the plug-in.

preview  [String] The picture preview of the plug-in that will appear in Operations Hub  when 

designing an application to include the plug-in.

fieldsDescription  [Ob

ject]

The plug-in description for informational messages.

isNotAllowToAddFields 

[Boolean]

Indicates whether to allow the user to add more data fields when designing 

an application to include the plug-in. If you do not want the user to add data 

fields, enter true.

schema{} An array of the following types of schema:

• JSONSchema{}

• UISchema{}

Schema

The schema is based on JSON. It is used in the manifest.json  file to specify the plug-in input and output.
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• Input: The input for a plug-in can be static or dynamic. Static data is available in any of the 

following JSON schema types:

◦ string

◦ number

◦ integer

◦ boolean

◦ null

◦ object

◦ array

The dynamic data is available in an Operations Hub  component such as a query, global variable, or 

manual entry of data.

• Output: The output of a plug-in is defined in the Operations Hub  target, such as a query with inputs 

or a global variable.

The schema defined in the manifest.json  is presented in Operations Hub  in the html format. This format 

is implemented using the react-jsonschema-form  library, which introduces the concept of UI schema to 

provide the information about the form behavior and to give an extensive API for the form customization. 

Customization is typically done using custom fields and widgets that become part of the default form 

registry. The library renders all form fields leveraging the Bootstrap semantics, so that it can be styled with 

bootstrap themes or custom CSS.

Tip:

The following websites provide information on creating plug-ins:

• React-JSON-Schema Documentation

• React-JSON-Scheme Playground

Supported Widgets

The following table provides the supported widgets for each field type.

Field Type Supported Widgets

Boolean • Check box

• Radio button

• Select

https://react-jsonschema-form.readthedocs.io
https://mozilla-services.github.io/react-jsonschema-form/
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Field Type Supported Widgets

String • Text

• Password

• Email

• URI

• Radio button

• Select

• Text area

• Datetime

• Color

Number • Text

• Select

• Range

• Radio button

The main.js file

The plug-in API is exposed through the global object EMBED. You can access this object when the plug-in 

source code is included in Operations Hub. The following table provides the methods used in EMBED.

Method Description

EMBED.getRootElement() Returns the jqLite  element, which must be used as the mounting point of 

the root element of the plug-in.

EMBED.onChangeDa

ta(callback)

This method is a general data change listener. callback - function, which is 

invoked with one argument every time when data change event is triggered.

EMBED.getData() Returns existing page data.

EMBED.getComponent() This method returns the plug-in information.

The following table provides the four main methods to work with the Data Source and Data Target fields.

Method Description

EMBED.subscribeField

ToQueryChange(field, 

callback)

Field object: Data Source

Callback: Function that is invoked when query change event received. Call

back is invoked with one argument, which is a data selection as per field 

configuration.
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Method Description

EMBED.subscribeField

ToGlobalChange(field, 

callback)

Field object: Data Source

Callback: Function that is invoked when global change event received. Call

back is invoked with one argument, which is a global data as per field config

uration.

EMBED.subscribeFieldTo

DataChange(field, call

back)

Field object: Data Source

Callback: Function that is invoked when global or query change event re

ceived.

EMBED.submitTar

get(field, value)

Field object: Data Target

Value: JavaScript primitives or Object/Array

This method targets the input of a query or a global variable, as per field 

configuration.

Upgrade Plug-in Schema
This topic describes how to update old plug-ins and use them in Operations Hub.

You must perform these steps if you are prompted to upgrade your custom plug-ins using old schema.

1. Migrate your old plug-in/s to the new React JSON schema  (on page 291).

2. Write a transformation specification for plug-in upgrade  (on page 219).

3. Place the plug-in transformation files in this location folder ..\ProgramData\GE\Operations Hub

\iqp-config\plugin-transform-spec.

4. Import the plug-in  (on page 283)  updated with the new schema to Operations Hub.

Plug-ins also get upgraded when you upgrade applications  (on page 223)  in Operations Hub.

Update Plug-in Version
This topic describes how to update the version number for custom plug-ins.

Use the following format to update a plug-in's version number: MAJOR.MINOR.PATCH. Suppose a version is 

updated from 1.0.0  to 1.0.2, then 1  stands for major version, 0  stands for minor version, and 2  refers to 

patch updates. For more information, refer to the versioning policy in the following table:
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Version Update When

MAJOR You made major schema changes, which are incompatible with the 

previous version. For example, modifying existing fields in a plug-in.

MINOR You added/removed a field. For example, inlcuding or deleting source/

target fields in a plug-in.

PATCH You resolved backward compatibility issues. For example, bug fixes 

for customer cases.

MAJOR or MINOR Update

If the MAJOR or MINOR version of the plug-in is changed, then do either of the following:

• Write a transformation specification for plug-in upgrade  (on page 219). (OR)

• Add version change in plug-in upgrade exempt list to ensure successful plug-in upgrade.

PATCH Update

If only the PATCH version of the plug-in is changed, then the plug-in is automatically upgraded to the latest 

version.

Events

About Events

In Operations Hub, you can create events that will trigger actions when specific conditions are satisfied. 

To create an event, you must create a trigger and then create an action.

• Trigger: When you create a trigger, you define the set of conditions that must be satisfied for the 

event to happen. You can create a trigger based on conditions on values added or updated in an 

entity or values received from a device.

• Action: When you create an action, you define what should happen if the conditions specified in 

the trigger are satisfied (that is, when the event is triggered). You can create one or more of the 

following actions:



Operations Hub for Windows  | 3 - User Guide  | 296

◦ Send an email: You can create an action to send an email when the event is triggered. You 

can enter the email addresses manually, fetch them from a query, or allow application users 

to specify the email addresses.

◦ Run a query: You can create an action to run a query when the event is triggered.

◦ Send a command to a device: You can create an action to send a command to a 

device when the event is triggered. Before you do so, you must configure IQP MQTT to 

communicate with the device to which you want to send a command.

Creating an event in the event editor only creates a template for the event. It does not activate the event. 

The event is activated when a notifier is added and turned on in an event settings widget in an application.

Access an Event (Classic)
Steps for Operations Hub classic version.

Log in to Operations Hub.

1. From the main navigation menu, select  EVENTS.

The EVENTS  workspace appears.

2. In the row containing the event that you want to access, in the Name  column, select the link.

The event appears, displaying a list of fields in the event.

Tip:

You can modify values in the available fields, and then select Save  or Save And Exit.

Create a Trigger Based on an Entity (Classic)
This topic describes how to create a trigger based on conditions on values stored in an entity.
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Log in to Operations Hub.

You can also create a trigger based on conditions on values received from a device  (on page 296).

1. Access the event  (on page 296)  for which you want to create a trigger.

2. Select Add Entity Condition.

The Entity  and Condition  sections 

appear.

3. In the Entity Name  box, select the entity based on which you want to create a trigger.

In the Entity Field  box, a list of fields in the selected entity appears.

4. In the Entity Field, Operator, and Value  boxes, select values that you want to use in the trigger.

If you want to create a trigger if the temperature recorded in the entity exceeds 40 degrees 

Celsius, then in the Entity Field, Operator, and Value  boxes, select or enter Temperature, >, and 40, 

respectively.

5. If you want to allow the end user to set the value manually, then select the Allow End User to set 

value  check box, and then enter a value in the Input Name  box.

If you want to create a trigger when the temperature stored in the entity field reaches a certain limit, 

and you want application users to specify that limit, then:

a. In the Input Name  box, enter Maximum Temperature.

b. In the application, add an event settings widget, and then select the event that you have 

created.

In the application, the widget contains an input field labeled Maximum Temperature, which 

allows the user to change the value that you have specified in the event.

6. If there is more than one condition, and if you want to create a trigger only if all the conditions 

are satisfied, select Meet ALL of the conditions. By default, this option is selected. If, however, 

you want to create a trigger if at least one of the conditions is satisfied, select Meet ANY of the 

conditions.
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Create an action  (on page 296).

Create a Trigger Based on a Device (Classic)
This topic describes how to create a trigger based on conditions on values received from a device.

Register the device details and metrics that you want to use in the trigger, using baseline entities.

1. Register at least one device type and metric using the supported_device_gateway  and the 

metrics_device_type  entities, respectively.

2. Register at least one device group and device for the device type using the M2M_groups  and 

device_gateway  entities, respectively.

You can, however, create a trigger that will cover only a single device, a group of devices, or all the devices 

of a given type.

You can also create a trigger based on conditions on values stored in an entity  (on page 296).

1. Access the event  (on page 296)  for which you want to create a trigger.

2. Select Add Device Condition.

The Device Gateway  and Condition  sections 

appear.

3. In the Device Type, Device Group, and Device Units  boxes, select the type, group, and unit of the 

device, respectively.

The following table provides values that you can select in these boxes, and which devices will be 

filtered accordingly.

Device Type Device Group Device Units Result

MyDeviceType Any Any All devices of the type 

MyDeviceType.

MyDeviceType MyGroup Any All devices in the 

group MyGroup.
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Device Type Device Group Device Units Result

MyDeviceType MyGroup MyDevice The device named My

Device.

In the Metric  box, a list of metrics registered for the device type appears.

4. In the Metric, Operator, Input Source, and Value  boxes, select or enter the metric, operator, input 

source, and value, respectively.

If you want to create a trigger when the temperature recorded by the device exceeds 40 degrees 

Celsius, in the Metric, Operator, Input Source, and Value  boxes, select or enter Temperature, >, 

Fixed Value, and 40, respectively.

5. If you want to allow the end user to set the value manually, select the Allow End User to set value 

check box, and then enter a value in the Input Name  box.

If you want to create a trigger when the temperature stored in the entity field reaches a certain limit, 

and you want application users to specify that limit:

a. In the Input Name  box, enter Maximum Temperature.

b. In the application, add an event settings widget, and then select the event that you have 

created.

In the application, the widget contains an input field labeled Maximum Temperature, which 

allows the user to change the value that you have specified in the event.

6. If there is more than one condition, and if you want to create a trigger only if all the conditions 

are satisfied, select Meet ALL of the conditions. By default, this option is selected. If, however, 

you want to create a trigger if at least one of the conditions is satisfied, select Meet ANY of the 

conditions.

Create an action  (on page 298).

Create an Action to Send an Email (Classic)
This topic describes how to create an action to send an email.

Create a trigger based on an entity condition  (on page 296)  or a device condition  (on page 298).

You can also create an action to:

• Run a query  (on page 301)

• Send a command to a device  (on page 303)
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1. Access the event  (on page 296)  for which you want to create an action.

2. Select Send e-mail.

The Send an E-mail  section 

appears.

3. Enter or select values as specified in the following table.

Field Name Description

Recipient's address Enter the email address of the user who will receive an email when the 

event is triggered. You can enter multiple email addresses separated by 

commas.

Allow End User to set e-

mail address

Select this check box if you want to allow application users to provide 

the email addresses of the users who will receive an email, and then 

enter the name of the input field that you will add in the application.

Add Query Recipients Select this button if you want to add email addresses of the recipients 

using a query. When you select this button, the Query Name  box ap

pears, displaying a list of Get queries created in the site.

Query Name Select the query that returns a list of email addresses to which you 

want to send the email. If the query that you have selected requires in

put values, then the corresponding fields appear. If that happens, enter 

values in the fields.

Email template Select the email template that you want to use. If, however, you want 

to create an email template  (on page 307), select Create Email Tem

plate, enter values as needed, and then select Save and Return.

Scheduler Select one of the following options:
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Field Name Description

◦ Take action only on initial trigger: Select this option if you want 

to run the query after switching from the state of not meeting 

the condition to meeting the condition. By default, this option is 

selected. For example, suppose you have created an action to 

send an email when the temperature recorded by a device ex

ceeds 40 degrees Celsius. Suppose the temperature recorded 

by the device is as follows: 35, 38, 41, 45, 39, 42. In this scenario, 

the email is sent when the temperature is 41 and 42.

◦ Take action on every trigger: Select this option if you want to 

send an email every time the event is triggered. For example, 

suppose you have created an action to send an email when the 

temperature recorded by a device exceeds 40 degrees Celsius. 

Suppose the temperature recorded by the device is as follows: 

35, 38, 41, 45, 39, 42. In this scenario, the email is sent when the 

temperature is 41, 45, and 42.

4. Select Save  or Save and Exit.

The event template is created.

When the event is triggered, an email is sent to the email addresses that you have specified.

Note:

Gmail integration is possible on allowing access to less secure apps for the account. 

Alternatively, you can enable a 2-Step verification for the account and use the Google account 

“App passwords” feature. This will generate a password to use in conjunction with the email 

address to configure email server in Operations Hub Admin Console.

Create an Action to Run a Query (Classic)
This topic describes how to create an action to run a query.

Create a trigger based on an entity condition  (on page 296)  or a device condition  (on page 298).

You can also create an action to:

• Send an email  (on page 299)

• Send a command to a device  (on page 303)
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1. Access the event  (on page 296)  for which you want to create an action.

2. Select Run a Query.

The Run a Query  section appears.

3. Enter or select values as described in the following table.

Field Name Description

Query Select the query that you want to run when the event is triggered. If the 

query that you have selected requires input values, the corresponding 

fields appear. If that happens, enter values in the available fields.

Scheduler Select one of the following options:

◦ Take action only on initial trigger: Select this option if you want 

to run the query after switching from the state of not meeting 

the condition to meeting the condition. By default, this option is 

selected. For example, suppose you have created an action to 

run a query when the temperature recorded by a device exceeds 

40 degrees Celsius. Suppose the temperature recorded by the 

device is as follows: 35, 38, 41, 45, 39, 42. In this scenario, the 

query is run when the temperature is 41 and 42.

◦ Take action on every trigger: Select this option if you want to 

run the query every time the event is triggered. For example, sup

pose you have created an action to run a query when the tem

perature recorded by a device exceeds 40 degrees Celsius. Sup

pose the temperature recorded by the device is as follows: 35, 

38, 41, 45, 39, 42. In this scenario, the query is run when the tem

perature is 41, 45, and 42.
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4. Select Save  or Save and Exit.

The event template is created.

When the event is triggered, the query that you have specified is run.

Create an Action to Send a Command to a Device (Classic)
This topic describes how to create an action to send a command to a device.

1. Configure IQP MQTT to communicate with the device to which you want to send a command.

2. Create a trigger based on an entity condition  (on page 296)  or a device condition  (on page 

298).

You can also create an action to:

• Run a query  (on page 301)

• Send an email  (on page 299)

1. Access the event  (on page 296)  for which you want to create an action.

2. Select Send Command to Device.

The Send a command to a device  section 

appears.

3. Enter or select values as described in the following table.

Field Name Description

Function Select Send_MQTT_Command  to send a command to a device that is 

configured with IQP MQTT. The Input Source  and Value  boxes appear 

for topic and payload.

Input Source Select Fixed value  if you want to send a fixed value to the device when 

the event is triggered.
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Field Name Description

Value Enter the fixed value that you want to send to the device when the event 

is triggered.

Allow End User to set 

value

Select this check box if you want application users to set the value, and 

then enter a name in the Input Name  box that appears.

Scheduler Select one of the following options:

◦ Take action only on initial trigger: Select this option if you want 

to send the command after switching from the state of not 

meeting the condition to meeting the condition. By default, this 

option is selected. For example, suppose you have created an 

action to send the command when the temperature recorded by 

a device exceeds 40 degrees Celsius. Suppose the temperature 

recorded by the device is as follows: 35, 38, 41, 45, 39, 42. In this 

scenario, the command is sent when the temperature is 41 and 

42.

◦ Take action on every trigger: Select this option if you want to 

send the command every time the event is triggered. For exam

ple, suppose you have created an action to send a command 

when the temperature recorded by a device exceeds 40 degrees 

Celsius. Suppose the temperature recorded by the device is as 

follows: 35, 38, 41, 45, 39, 42. In this scenario, the command is 

sent when the temperature is 41, 45, and 42.

4. Select Save  or Save and Exit.

The event template is created.

When the event is triggered, the command is sent to the MQTT broker.

Delete an Event (Classic)
This topic describes how to delete an event.

Log in to Operations Hub.

You cannot delete an event if it is locked or used in an application or a parameter.

1. From the main navigation menu, select  EVENTS.

The EVENTS  workspace appears.
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2. In the rows containing the events that you want to delete, select the check boxes.

3. In the workspace heading, select , and then select Delete Events.

A message appears, asking you to confirm that you want to delete the event.

Tip:

Alternatively, in the row containing each event that you want to delete, select , and then 

select Delete event.

4. Select Delete.

The events are deleted.

Email Templates

About Email Templates

Email templates store information about the default content and structure of an automated email, which 

can be sent when an event is triggered. The template allows you to include fixed or dynamic content so 

that the email is customized to the event that triggered it. You can define the default structure for the 

following sections in an email template:

• Subject

• Body

• URL

Access an Email Template (Classic)
Steps for Operations Hub classic version.
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Log in to Operations Hub.

1. From the main navigation menu, select  EMAILS.

The EMAIL TEMPLATES  workspace appears.

2. In the row containing the email template that you want to access, in the Name  column, select the 

link.

The email template appears, displaying the Subject, Body, and URL  sections.

Tip:

If needed, modify the email template, and then select Save  or Save and Exit.
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Create an Email Template (Classic)
This topic describes how to create an email template.

Log in to Operations Hub.

You can also copy an email template  (on page 308).

1. From the main navigation menu, select  EMAILS.

The EMAILS  workspace appears.

2. Select Add new email template.

The Create Email Template  window appears.

3. Enter a value in the Email Template Name  box, and then select Create. The name must contain at 

least one uppercase or lowercase letter.

The Subject, Body, and URL  sections of the email template appear.

4. In the Subject, Body, and URL  sections, select the options for which you want to add details.

Field Name Description

Add Text When you select Add Text, a text box appears in the corresponding sec

tion. You can enter the text that you want to include in the email tem

plate.
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Field Name Description

Add Parameter Parameters  (on page 310)  allow you to add dynamic content to the 

email based on values from the event. When you select Add Parameter, 

a drop-down list box appears in the corresponding section. You can se

lect the parameter that you want to include in the email template.

Add Paragraph When you select Add Paragraph, a resizeable text box appears in the 

corresponding section. You can enter the text that you want to include 

in the email template. You can add a paragraph only in the Body  sec

tion.

Add Newline When you select Add Newline, a line appears after the current element.

5. As needed, in the URL  section, enter a URL that you want to include in the email template.

6. Select Save  or Save And Exit.

The email template is created.

Copy an Email Template (Classic)
This topic describes how to copy an email template.

Log in to Operations Hub.

You can also create an email template  (on page 307).

1. From the main navigation menu, select  EMAILS.

The EMAILS  workspace appears.

2. In the row containing the email template that you want to copy, select the link.

The email template appears.
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3. Modify the email template as needed, and then select Save As New.

A window appears, asking you to enter a name for the email template. By default, the name 

contains the name of the original email template, appended with a system-generated value.

4. Modify the default name, and then select OK.

The email template is copied.

Delete an Email Template (Classic)
This topic describes how to delete an email template.

Log in to Operations Hub.

You cannot delete an email template if it is used in an event.

1. From the main navigation menu, select  EMAILS.

The EMAILS  workspace appears.
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2. In the workspace heading, select , and then select Delete email templates.

A message appears, asking you to confirm that you want to delete the email templates.

Tip:

Alternatively, in the row containing each email template that you want to delete, select , 

and then select Delete email template.

3. Select Delete.

The email template is deleted.

Parameters

About Parameters

Parameters store values that you can use in an email template. These values can be fixed or generated at 

runtime. You can create one of the following types of parameters:

• Fixed: Stores a fixed value that you specify when you create the parameter.

• Event Variable: Stores event time values from an entity field or a device field that is used in an 

event condition.

• From Query: Stores the results of a Get query with inputs from event time values. This allows you 

to retrieve additional data about the device or entity that triggered the event from another entity on 

the system.

Example: Suppose you want to send an automated email when the temperature recorded by a device 

exceeds 40 degrees Celsius. In the email, you want to include the temperature, date, and time recorded by 

the device. In this case:
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1. Create an event as follows:

◦ Create a condition such that the event is triggered when the temperature recorded by the 

device exceeds 40 degrees Celsius.

◦ Create an action such that an email is sent when the event is triggered.

2. Create a parameter to store the temperature recorded by the device.

3. Create another parameter to store the date and time recorded by the device.

4. Create an email template, and include both the parameters in the template.

5. Use the email template in the event that you have created in step 1.

Access a Parameter (Classic)
Steps for Operations Hub classic version.

Log in to Operations Hub.

1. From the main navigation menu, select  PARAMETERS.

The PARAMETERS  workspace appears.

2. In the row containing the parameter that you want to access, in the Name  column, select the link.

The parameter appears.
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Tip:

If needed, you can modify values in the available fields, and then select Save  or Save and 

Exit.

Create a Parameter (Classic)
This topic describes how to create a parameter.

Log in to Operations Hub.

You can also copy a parameter  (on page 314).

1. From the main navigation menu, select  PARAMETERS.

The PARAMETERS  workspace appears.
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2. Select Add new parameter.

The Create Parameter  window appears.

3. Enter a name in the Parameter name  box, and then select Create. The name must contain at least 

one uppercase or lowercase letter.

The parameter appears.

4. Enter or select values as described in the following table.

Field Name Description

Fixed Select this option if you want to create a parameter with a fixed value, 

and then enter the value. By default, this option is selected.

Event Variable Select this option if you want to create a parameter using an event vari

able, and then select values in the Select Event, Event Condition, and 

Condition Value  boxes that appear.
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Field Name Description

◦ Select Event: Select the event whose variable you want to use 

while creating the parameter. After you select the event, the 

Event Condition  box contains sequential numbers of conditions 

in the event. For example, if there are three conditions in the 

event, the Event Condition  box contains the values 1, 2, and 3.

◦ Event Condition: Select the sequential number of the condition 

that you want to use. If you select a number, the Condition Value 

box contains a list of entity fields or device fields depending on 

whether you have selected an event condition or a device condi

tion.

◦ Condition Value: Select the entity field or device field whose val

ues you want to store in the parameter.

From Query Select this option if you want to create a parameter using a query, and 

then select the query in the Select Query  box that appears. It contains 

a list of Get queries in the site. If the query that you have selected re

quires input values, the corresponding fields appear. If that happens, 

enter values as needed.

Note:

The query that you want to use in a parameter should return 

only a single value.

5. Select Save  or Save And Exit.

The parameter is created.

Copy a Parameter (Classic)
This topic describes how to copy a parameter.

Log in to Operations Hub.

You can also create a parameter  (on page 314).

1. From the main navigation menu, select  PARAMETERS.

The PARAMETERS  workspace appears.
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2. In the row containing the parameter that you want to copy, select the link.

The workspace for the parameter appears.

3. As needed, modify values in the available fields, and then select Save As New.

A window appears, asking you to enter a name for the parameter. By default, the name contains the 

name of the original parameter, appended with a system-generated value.

4. Modify the name of the parameter, and then select OK.

The parameter is copied.

Delete a Parameter (Classic)
This topic describes how to delete a parameter.

Log in to Operations Hub.
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1. From the main navigation menu, select  PARAMETERS.

The PARAMETERS  workspace appears.

2. In the rows containing the parameters that you want to delete, select the check boxes.

3. In the workspace heading, select , and then select Delete parameters.

A message appears, asking you to confirm that you want to delete the selected parameters.

Tip:

Alternatively, in the row containing each parameter that you want to delete, select , and 

then select Delete parameter.

4. Select Delete  or Delete All.

The parameters are deleted.

Users

About Users

Using Operations Hub, you can create the following types of users:

• Developers: Users who will develop an application. These users can access the pages for creating 

an application. When you create a developer, an application user is also created for the developer 

with the same credentials.

• Application users: Users who will use an application. These users can only access applications to 

which they have been granted access. They cannot access the pages for creating an application.

See Create a User (Classic)  (on page 318)

Access a User (Classic)
Steps for Operations Hub classic version.



Operations Hub for Windows  | 3 - User Guide  | 317

1. From the main navigation menu, select  MANAGE.

The Developers  workspace appears, displaying a list of users who are developers.

2. If you want to access an application user, in the module navigation menu, select App Users.

The App Users  workspace appears, displaying a list of application users.

3. In the row containing the user that you want to access, in the Username  column, select the link.

The Account <user name>  window appears, displaying the details of the user.
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Tip:

If needed, you can modify the first and last names of your user account, and then select 

Save  to save your changes. You cannot, however, modify the first and last names of any 

other user account.

Create a User (Classic)
Steps for Operations Hub classic version.

Only a tenant administrator can create and manage developers.

1. From the main navigation menu, select  MANAGE, and then select Developers  or App Users.

2. Select Add new user.

The New Account  window appears.
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3. Enter values in the available fields as described in the following table.

Field Name Description

Username Enter the user name that the user will use to log in to Operations Hub. 

The value must be unique.

E-mail Enter the email ID of the user. The value must be unique.

First Name Enter the first name of the user.

Last Name Enter the last name of the user.

Password Enter a password that the user will use to log in to Operations Hub. The 

password must meet the following criteria:

◦ Must contain between 8 and 15 characters

◦ Must include at least one number

◦ Must include at least one uppercase or lowercase letter

Repeat Password Enter the password that you have entered in the Password field.
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Field Name Description

Only GE Groups Select this check box if you only want to view groups associated with 

GE products in the Groups list box.

Groups Select the Proficy Authentication groups (UAA) you want to assign to 

this user.

◦ Developers: Must have following groups assigned to have ele

vated privileges to develop apps in Operations Hub: iqp.devel

oper, iqp.user  and webhmi.admin.

◦ App Users: Must have the iqp.user  group assigned to use apps. 

App users cannot develop apps due to restricted privileges.

4. Select Create.

The user is created. If you have created a developer, an application user is also created.

If you have created an application user, provide access to one or more applications to the user.

Grant Access to a Role (Classic)
This topic describes how to grant access to a role.

You can also grant access to an application  (on page 196).

1. From the main navigation menu, select  MANAGE, and then select App Users.

The App Users  workspace appears, displaying a list of application users.

2. In the row containing the user to whom you want to grant access, in the Username  column, select 

the link.

The Account <user name>  window appears, displaying the details of the user.
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3. In the Apps  box, select the applications to which you want to grant access to the user.

4. In the Role Groups  box, select the check boxes corresponding to the categories and groups to 

which you want to grant access to the user.

Tip:

When you select a category or a group, all the underlying groups in the hierarchy are 

selected. You can clear the check box corresponding to a category or a group if you do not 

want to grant access to it.

5. Select Save.

The user can now access the selected applications, categories, and groups.

Revoke Access to an Application (Classic)
Steps for Operations Hub classic version.

1. From the main navigation menu, select  APPS.

The APPS  workspace appears.
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2. In the Name  column, select the application for which you want to revoke access.

The PAGES  workspace appears.

3. From the main navigation menu, select  APP USERS.

The APP USERS  workspace appears, displaying a list of application users created in the site.
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4. In each row containing a user whose access you want to revoke, clear the check box, and then 

select Submit changes.

Access to the application is revoked for the selected users.

Delete a User (Classic)
Steps for Operations Hub classic version.

The logged in user cannot delete one's own user account.

1. From the main navigation menu, select  MANAGE, and then select App Users.

The App Users  workspace appears.

2. In the row containing the user that you want to delete, select the link in the USERNAME  column.

The Account <user name>  window appears, displaying the details of the user.
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3. Select Delete.

A message appears, asking you to confirm that you want to delete the user.

4. Select OK.

The user is deleted.

Change Your Password
Follow the steps to change your password in Operations Hub.

1. Log out of all instances of Operations Hub, and close your browser.

2. Reopen your browser, and go to this page: https://enter your machine name/uaa/login.

The following screen appears.
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3. In the upper right-hand corner of the screen, click Account Settings.
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The following screen appears. 

4. Select the Change Password  link.
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The next screen appears. 

5. In the Current Password field, enter the existing password.

6. In the New Password  field, enter the new password that you want to use to log in to Operations 

Hub.

The password must meet the following criteria:

◦ Must contain between 8 and 15 characters

Note:

For the 2.0 release, the password cannot be 15 characters long.

This rule applies only when setting up the password for the first time for the first 

user account (OphubAdmin). After the completion of iqp-provisioner, the initial 

password for OphubAdmin  can also be updated to a password of 15 characters 

length. Subsequent user accounts (including LDAP, external IDP accounts) can have 

a password length of 15 characters.

◦ Must include at least one number

◦ Must include at least one uppercase or lowercase letter
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7. In the Confirm New Password  field, enter the new password again.

8. Click Change Password to proceed.

Roles

About Roles

You can create roles to define which users can access specific information. When you create a role, you 

create a category and a group within that category. You can create multiple categories containing multiple 

levels of groups.

Managing Access to Data Fields
Suppose you have created an application that provides the following details of users, and you want only 

the Finance personnel to view the salary details:

• User name

• User ID

• Joining date

• Salary

In this case, you will perform the following tasks:

1. Create a category named Department.

2. In the Department category, create a group named Finance.

3. Modify the Roles Conditions  section of the query that fetches the user account details as follows:

a. In the Entity field  box, select the field that stores the salary details.

b. In the Access  box, select Permitted Roles.

c. In the Roles  box, expand the Department category, and select the check box corresponding 

to the Finance group.

d. Save the query.

When the query is run, the user name, user ID, and joining date details are returned to all 

users. However, users who belong to the Finance department will also see the salary details.

Managing Access to Data Rows
Suppose you have created an application that provides the following details of users, and you want all 

users to only see rows from their location:

• User name

• User ID
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• Joining date

• Salary

• Location

In this case, you will perform the following tasks:

1. Create a category named Locations.

2. In the Location category, create groups for each location.

3. Modify the Roles Conditions  section of the query that fetches the user account details as follows:

a. In the Apply conditions to  section, select All roles.

b. In the Row visibility  box, select Filter rows.

c. In the Entity field  box, select the field that stores the location of the user.

d. In the In user’s role tree  box, select the Locations category.

e. Save the query.

When the query is run, users will only see records where the Location field matches the 

Location role that has been allocated to them.

Access a Category or a Group (Classic)
Steps for Operations Hub classic version.

Log in to Operations Hub.

1. From the main navigation menu, select  MANAGE, and then select Roles.

The Roles  workspace appears, displaying a list of categories and groups.
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2. In the row containing the category that you want to access, select .

The category expands, displaying a hierarchical view of groups.

Tip:

You can select Expand All  to expand all categories and groups.

3. If you want to access a group, navigate to the group in the hierarchy.

Tip:

If needed, you can modify the name of a category or a group by selecting  next to the 

name.

Create a Category (Classic)
Steps for Operations Hub classic version.
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Log in to Operations Hub.

1. From the main navigation menu, select  MANAGE, and then select Roles.

The Roles  workspace appears, displaying a list of categories.

2. Select Add New Category.

A window appears, asking you to enter a name for the category.
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3. Enter a name, and then select OK. The name must contain at least one uppercase or lowercase 

letter.

The category is created.

Create a group  (on page 330).

Create a Group (Classic)
Steps for Operations Hub classic version.

Create a category  (on page 330).

1. From the main navigation menu, select  Roles.

The Roles  workspace appears, displaying a list of categories.

2. In the row containing the category in which you want to create a group, select Add New Group.

A window appears, asking you to enter a name for the group.
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3. Enter a name, and then select OK. The name must contain at least one uppercase or lowercase 

letter.

The group is created.

Delete a Category or a Group (Classic)
Steps for Operations Hub classic version.

Log in to Operations Hub.

1. From the main navigation menu, select  MANAGE, and then select Roles.

The Roles  workspace appears.
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2. In the row containing the category or group that you want to delete, select . 

A message appears, asking you to confirm that you want to delete the category or group.

Tip:

To access a list of groups in a category, select  in the row containing the category.

3. Select OK.

The category or group is deleted.

Administration

Runtime Model
Create a model to build the runtime structure and content.
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You can set up the types of equipment to use, the instances of equipment to appear in the runtime 

context, the information to display about the equipment, and the data sources for supplying data. The 

Model Editor user interface helps you create and modify your model.

Model Editor
Use the Model Editor to create and modify asset object types and asset objects in your model.

To begin building a model, perform these tasks:

• Create Data sources  (on page 352)

• Configure Data Distributor Settings (Classic)  (on page 337)

• Set Up the Data Model Structure  (on page 338)

• Define Objects  (on page 339)

• Set Up Runtime Navigation  (on page 341)

Supported Characters for the Model
Before creating object types, objects and data variables, review the following tables to see which 

characters are supported as well as restricted.

Supported Characters

Character Description

! Exclamation Point

@ At sign

^ Caret

$ Dollar Sign

() Parentheses

| Pipe

. Period

` Grave Accent

~ Tilde

- Hyphen

_ Underscore
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Note:

A single space is allowed but a succession of spaces is not.

Unsupported Characters

Character Description

# Number Sign

% Percent Sign

\ Backslash

, Comma

? Question Mark

; Semicolon

+ Plus Sign

: Colon

" Quotation Marks

' Apostrophe

< > Greater than/Less than Symbols

{} Braces

/ Slash

= Equal Sign

* Asterisk

& Ampersand

Manage Data Source Servers (Classic)
Access the details for the data source servers that are used to populate data in your model.

This is a view-only section in Operations Hub.

To access the data source server details:



Operations Hub for Windows  | 3 - User Guide  | 337

1. In the Administration environment, select Set Up  and then Server.

2. The Server Details Management  screen appears with a list of servers set up in your system along 

with their details:

Column Description

Name The server name.

Connection Type The connection type, whether OPC UA or Historian.

Datasource Name The data source name associated to the server.

Refresh Rate (Seconds) The time set for refreshing the application, for example, every 5 sec

onds.

To configure data sources for Historian and OPC UA, refer to Create a Data Source (Classic)  (on page 

352).

Configure Data Distributor Settings (Classic)
Steps for Operations Hub classic version.

Create a Data Source (Classic)  (on page 352).

Data distributor is a component in Operations Hub  that communicates with the Historian servers 

configured with Operations Hub. It performs the following tasks:
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• Fetches a list of Historian tags.

• Fetches Historian data based on the parameters that you have specified.

• Reads and updates notes.

• Subscribes for updates on Historian tag value changes.

Using the data distributor settings, you can specify the log level of the data distributor. For example, you 

can choose a verbose log level to help you troubleshoot issues with fetching data from the Historian 

server.

1. In the administrative environment, select Set Up  > Data Distributor.

2. In the Logging level  box, select one of the following log levels:

◦ Info

◦ Error

◦ Warn

◦ Debug

◦ Verbose

The data distributor settings are configured.

Set Up the Model Structure (Classic)
Object types define the structure of the equipment pieces within your model. For each object type, such as 

a StorageTank, you set up all the data variable names, such as TankLevel, that any asset object associated 

with this type can reuse in its own definition.

Log in to Operations Hub.

Using the Contained Types  area, you set up the parent/child relationship of asset object types 

in the model. For example, StorageTank1  and SuctionValve2  are the children that comprise the 

FinishedWaterPumpStation. At runtime, the children appear under the parent in the navigational context.

1. In the Administration environment, navigate to Assets  > Object Types  > New.

The Object Type Information  screen appears.

2. Enter a unique name for the new object type and provide a description.

3. Select Save.

4. Select Data Variables  to add variable names whose data will come from the data sources.

5. To add a variable name for this object type, do the following: 

a. Select +  above the table.

b. In Variable, enter the name of the data variable, such as Pressure.

c. In Data Type, select the type of data this variable stores: Boolean, String, or Number.

d. In Description, explain the purpose of the data variable.
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6. Repeat the above steps for each new object type.

7. To define an asset object type as a parent of other types, do the following:

a. Select Contained Types.

b. Choose the parent by selecting an object type on the left panel.

c. Select +  above the table to add children to the parent.

d. Select the object type to become a child and provide an alias name.

8. Select Save.

Define Objects (Classic)
Asset objects are the instances of equipment pieces, such as StorageTank1, to appear in the model. For 

each object, you determine which data variables derived from its object type to reuse, and then define 

them accordingly.

Log in to Operations Hub.

• Objects appear alphabetically.

• Always use a unique object name.

1. In the Administration environment, navigate to Assets  > Objects.

If objects are already defined, the left panel lists them.

2. To add a new object, select New.

The New Object  screen appears.

3. Select the object type for this object.

The children of the object type appear under Contained Objects  if defined. The system 

automatically generates a contained object name from the alias and appends an instance number 

to it, such as DPump1_1. The next time another asset object reuses the object type with this 

contained object, the instance number is increased by one, which in this example is DPump1_2.

4. Type a unique name for the new object and provide a description.

5. Select Save.

The new object appears with the data variables of its object type.

6. Define each data variable that you want to use for this object by doing the following:

Column Description

RealTime Data Alias You receive real time data from data sources such as iFIX, CIMPLICITY, 

IGS, or any other third party OPC UA server.

Select  to choose a data source from the list of available data 

sources.
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Column Description

RealTime Data Source
Select  to browse the data source and select items that feed live 

data to this variable, which can appear in the trend chart or a widget 

that is configured with this model property.

Refer to Browse Data Sources (Classic)  (on page 368).

Historical Data Alias You receive historical data from the Historian data source.

Select  to choose a data source from the list of available Historian 

data sources.

Historical Data Source
Select  to select Historian tags that feed Proficy Historian data 

to this variable, which can appear in the trend chart or a widget that is 

configured with this model property.

Refer to Browse Data Sources (Classic)  (on page 368).

7. Select Save.

Duplicate Objects (Classic)
When an object uses similar data variables and contained objects as a configured object, you can 

duplicate the configured object to create new objects for your model.

Log in to Operations Hub.
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1. In the Administration environment, navigate to Assets  > Objects.

2. Select Duplicate.

The duplicated object appears highlighted in the left panel with Copy appended to its name.

3. Change the name in the Name  field and select Save.

The renamed asset object appears in the left panel. You cannot rename the asset after selecting 

Save.

4. To duplicate more instances of the same object, continue to select Duplicate  and repeat step 3.

The duplicated objects appear highlighted in the left panel with Copy and a number appended to 

their names, such as pump1_copy(1), pump1_copy(2), and so on.

Set Up Runtime Navigation (Classic)
Use the Navigation app to visually structure the runtime hierarchy of objects.

Log in to Operations Hub.

Changing the root of an existing runtime navigation hierarchy requires that you clear the entire hierarchy 

and then rebuild it.

1. In the Administration environment, navigate to Visualizations  > Navigation.

All objects appear in the left panel with check boxes.

2. Select the parent check box and then select +  at the top of the left panel. 

The parent object instance appears in the app area. The following shows the 

FinishedWaterPumpStation  parent.

3. Select the parent object in the app area, select its children in the left panel and select +.

4. In the app area, expand the parent object to show its children by selecting its filled circle.

In this example, the FinishedWaterPumpStation  has three DisplacementPump 

children.

5. To add object instances to a child, select the child in the app area and select its descendants in the 

left panel.
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In this example, SpindleA1, B1, C1 are descendants of MC460A, B, C. 

6. You can also drag and drop objects within the hierarchy to change their order, as shown in this 

example. SunctionValveA  is now a child of FinishedWaterPumpStation.

7. Optional: To delete an object from the hierarchy, select its check box and then -  at the top of the 

left panel.

8. Optional: At any time, you can remove the hierarchy and start with a blank app area by selecting 

Clear Hierarchy.

9. To save the runtime hierarchy that you created, select Save.

Modify Object Types (Classic)
You can remove an asset object type and delete and modify its data variable names but you cannot 

change the name of an object type. All changes made to an object type are reflected in its object 

instances.

Log in to Operations Hub.

You cannot delete an asset object type that has existing objects using its data structure.
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1. In the Administration environment, navigate to Assets  > Object Types.

The Object Type Information  screen appears listing the object types.

2. In the left panel, select the object type to modify.

3. Make changes as needed and select Save.

4. To remove an object type, select it in the left panel, select Delete, and confirm the delete.

Remove Contained Types (Classic)
When you delete a child from an asset object type, it is also removed from all objects using it.

Log in to Operations Hub.

1. In the Administration environment, navigate to Assets  > Object Types.

The Object Type Information  screen appears listing all the asset object types.

2. In the left panel, select the asset object type whose children you want to modify.

3. Select the Contained Types  tab.

4. To remove children from a parent, select the check box next to each child you want to remove, and 

select -  above the table.

5. Select Save.

Replace Contained Objects (Classic)
You can quickly replace contained objects by browsing through a list of similar objects that are assigned 

to the same object type.

Log in to Operations Hub.

1. In the Administration environment, navigate to Assets  > Objects.

2. Select the object type.

3. Select Contained Objects.

4. Select the arrow next to the contained object that you want to replace. A list appears with similar 

objects that are associated with the selected object type, as shown in the following image:
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5. Select the object to replace the contained object. This selected object is now a contained object for 

the object type.

6. Optional: To view the details of a contained object, such as its data variables, select its hyper-

linked name in the Name  column.

7. Select Save.

Modify Objects (Classic)
You can remove an asset object as well as change its data sources.

Log in to Operations Hub.

If an object has contained objects, you can change their auto-generated names but not their aliases.

1. In the Administration environment, navigate to Assets  > Objects.

The Object  screen appears.

2. In the left panel, select the object to modify.

3. Make the changes as needed and select Save.
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You cannot modify data variables.

4. To remove an object, select it in the left panel, select Delete, and confirm the delete.

Export a Model (Classic)
Steps for Operations Hub classic version.

Log in to Operations Hub.

Model configuration is exported and saved to a CSV format for later use.

1. Go to ADMIN  > Import/Export.

The Model Import/Export  screen appears.

2. You have the option to export the complete model, or only a part of it.

To export the complete model, do the following:

a. Enter a file name for the model you want to export.

b. Select Export.

The model data is exported to a .csv file.

To partially export the model, do the following:

a. Select the check box for Export Partial Model.

b. From the dropdown list, select a node to serve as a starting point for the export.

The dropdown list contains all the objects within a hierarchy. For more information on 

navigation hierarchy, refer to Set Up Runtime Navigation (Classic)  (on page 341).

c. Select Navigation  or Containment.

In Navigation export file, the objects are arranged according to their navigation hierarchy.

In Containment export file, the objects are arranged according to their parent-child 

relationship.

d. Enter a file name for the model you want to export.



Operations Hub for Windows  | 3 - User Guide  | 346

e. Select Export.

The model data is exported to a .csv file.

Note:

The data source connectivity information in the model is not preserved during export. As 

an alternative, export the application  (on page 210).

3. Retrieve the model file from the Windows Downloads folder.

Import a Model (Classic)
Steps for Operations Hub classic version.

Log in to Operations Hub.

If you want to replace an existing model, you must first delete  (on page 347)  the old one before 

importing the new one. You can also merge the new model with the existing model during import.

Note:

Data source connectivity information is not preserved in the model you import to your system. 

After importing the model, reconfigure the data source properties in the model.

1. Go to ADMIN  > Import/Export.

The Model Import/Export  screen appears.

2. Select Browse  to navigate to the .csv model file, and then select Import.

3. Follow these instructions to view and download the log file in these browsers:
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Browser What To Do

Chrome ◦ To view the log file, right-click [log]  to open it in a new tab.

◦ To download and then view the log file, click [log]. You can view 

the file in the Downloads folder.

Microsoft Edge ◦ To view the log file, click [log], and then Open.

◦ To download and view the log file, click [log], and then Save. You 

can then view the log file by selecting View downloads.

4. To view the model in runtime, select Runtime  from the user icon drop-down list at the top right of 

the screen.

By default, the highest asset point in the model hierarchy appears.

5. To navigate through the asset objects in the hierarchy model, select the Asset Context Selector, .

The model displays the relevant data in context to each asset object selected in the navigation 

scheme.

Define Trend Data (Classic)
You can view trend-line analysis of variable data for a selected time frame in Historian. You select which 

historical variables to view.

Log in to Operations Hub.

1. In the Administration environment, navigate to Visualizations  > Designer.

2. Select Types.

3. In the left pane, select the asset object type containing the data variables to display in trend lines.

4. Select Trend Card.

5. Select the check box next to each variable containing the data to use as a trend point.

6. Select Save.

Delete a Model (Classic)
Steps for Operations Hub classic version.

Log in to Operations Hub.

If importing a model fails or you want to replace a model with a new one, you may choose to delete the 

model. Before deleting the model, we recommend that you export  (on page 345)  it for a backup. You 

can then import it again or import a new model.
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1. In the main navigation menu, select ADMIN.

The ADMIN  workspace appears.

2. Select Delete Model.

A message appears, asking you to confirm that you want to delete the model.

3. Select Delete.

The model is deleted.

Import Mimics (Classic)
HMI graphics are imported as mimics to Operations Hub.

Verify iFIX pictures or CimEdit screens were exported as JSON files.

• In Proficy iFIX, go to Tools  > Publish Picture  to export pictures.

• In Proficy CIMPLICITY, export CimEdit screens.

Process diagrams created in an HMI/SCADA system are imported and used as mimics in Operations Hub.

1. Go to ADMIN  > Visualizations  > Mimic Management.

2. Select Import.

3. In the Import Mimics  screen, browse and select the JSON zip file you want to import to Operations 

Hub, then select Import.

The zip files contain exported iFIX pictures or CimEdit screens.

4. Repeat the steps to import more files.

All the imported files are listed on the Mimic Management  screen.

Assign Mimics to Assets (Classic)
Assign a mimic to object types and objects.

Import Mimics (Classic)  (on page 348).

When you assign a mimic to an object type, the mimic is assigned to all the objects that belong to the 

object type.

1. Go to ADMIN  > Visualizations  > Designer.

2. Select an item under the Object Types  tab and perform these tasks:
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Details  tab a. Select a Mimic  from the drop-down list to associate with 

this object type.

b. Select Save.

Mimic Card  tab Mimic fields represent animation sources within a mimic. For ex

ample, @Flow@  and @OpenClose@  are mimic fields for displaying data 

for the Suction Value  object type.

Choose any of these:

◦ On the Mimic Binding  tab, for each Mimic Field, select a 

Data Variable  from the drop-down list.

◦ Select Autobind  tab to allow automatic binding of data by 

matching the data variables to the mimic fields.

For example, the TPump  object type with Flow  variable 

is auto binded to a picture representing a pump with the 

@Flow@  animation.

3. Repeat the steps to assign a mimic to another object type.

The selected mimic is assigned to the object type and their objects. You can choose to override and 

assign a different mimic  (on page 349)  for a particular object.

Override an Assigned Mimic (Classic)
Assigning a new mimic to an object overrides the mimic assigned at the object type level.

A mimic is already assigned at the object type level, which applies to all the objects belonging to that type.

At runtime, the newly assigned mimic appears for the object instead of the mimic assigned for the object 

type.

1. Go to ADMIN  > Visualizations  > Designer.

2. Under Objects, select the object for which you want to modify the assigned mimic.

3. On the Details  tab, for the Mimic  field, select a different mimic from the drop-down list.

4. Select Save.

A new mimic is assigned to the object. The original mimic appears in the list with 'default' before its name, 

such as Default - FWPS, Pump.
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Set Up Mimic Target Zones (Classic)
Target zones represent areas on a mimic that were set as selectable in the HMI/SCADA system. You set 

the navigation of these target zones for an operator.

You define a target zone to navigate to any asset in the model and view historical data.

Note:

These steps are also applicable for mimics bound at the asset level.

• In iFIX, set regions on a picture as Is Selectable to appear as clickable targets on the Mimic Card.

• In CIMPLICITY, only groups with the mouse-up or mouse-down event show as selectable targets on 

the Mimic Card. When defining a mouse-up or mouse-down event for a group, you must specify the 

script action, and then create an empty script.

• Assign the mimic to an asset type.

1. Go to ADMIN  > Visualizations  > Designer.

2. Under Object Types, select an object type.

3. For the selected item, go to Mimic Card  > Click Target Binding.

4. To enable an operator to navigate to a particular asset object in the model, do the following:
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a. In the Referenced Object  column and next to the target name, select or search for the asset 

object in the model hierarchy tree. You can do a partial search, such as Sto, and Operations 

Hub highlights all assets containing Sto, as shown in this example.

b. Select the related Action  field and then Navigate.

In Runtime, the background of a target zone changes to blue when an operator hovers over it. After 

an operator selects a target on the mimic card, the target asset becomes the active one, changing 

the mimic and content in the trend and alarm cards accordingly.

5. Select Save.

Data Sources

About Data Sources

To create applications in Operations Hub, you can fetch data from the following sources:

• Data stored in Operations Hub: This data is created and stored in entities, which are database 

tables. To create data, you can:

◦ Manually enter the data in an entity.

◦ Import data using a Microsoft Excel spreadsheet.

◦ Insert data into entities using insert queries, which you can create using Operations Hub.

◦ Send data from an MQTT client to an M2M entity. In addition, you can also use pivot tables 

to send data dynamically.

◦ Create an API that will work with the Operations Hub  APIs to send data to an entity.
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• Data stored externally: This data is stored in an external database, such as a Historian server. You 

can use this data in an Operations Hub  application. To do so:

1. Create a data source to provide the details of the external database whose data you want to 

use.

2. Create a REST or SQL query to specify the expected inputs and outputs of a REST endpoint 

(as defined in the REST API) .

3. Run the query to fetch the data from the external database.

Note:

The data will still be stored only in the external database; it will not be stored in 

Operations Hub.

Access a Data Source (Classic)
Steps for Operations Hub classic version.

Log in to Operations Hub.

1. From the main navigation menu, select DATASOURCES.

The DATASOURCES  workspace appears, displaying a list of data sources.

2. Select the data source that you want to access.

The data source appears.

Create a Data Source (Classic)
Steps for Operations Hub classic version.

Log in to Operations Hub.

1. From the main navigation menu, select DATASOURCES.

The DATASOURCES  workspace appears, displaying a list of data sources.

2. Select Add New Data Source, and then enter values as specified in the following table.

Field Name Description

Name Enter a unique name for the data source.

Product Select one these products for the data source:

◦ Proficy CIMPLICITY

◦ Proficy Historian

◦ Proficy iFIX
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Field Name Description

◦ OPC UA

◦ Relational Database

◦ REST API

◦ Proficy Workflow

◦ Proficy Batch

Description Enter a brief description of the new data source.

3. For relational database, refer to Add Relational Database Data Source (Classic)  (on page 353).

4. For Historian and REST API, refer to Add Historian or Custom REST Data Source (Classic)  (on page 

355).

5. For CIMPLICITY, iFIX, and OPC UA, refer to Add a Data Source with OPC UA Configuration (Classic) 

(on page 360).

You can also use MQTT as an OPC UA translator. The OPC UA client can read or write the data that 

has been translated from MQTT. For more information, refer to MQTT documentation.

6. For Batch, refer to Add a Batch Data Source (Classic)  (on page 366).

7. Save the data source.

Save Select to save the data source details and remain on the screen.

Save As New Select to copy the details and save as a new data source.

Save And Exit Select to save the data source details and exit the screen.

Add Relational Database Data Source (Classic)
Creates a relational database data source.

Provide a name, product, and description for your data source  (on page 352).

1. Select the check box for Enable Relational Database Connection  and enter these details:

Field Name Description

Database Type Currently, Microsoft SQL Server is the only supported database type.

Host Enter the IP address or host name of database server. For example: 

10.181.213.211 or databaseserver01.

https://www.ge.com/digital/documentation/confighub/version2023/mqtt/
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Field Name Description

Note:

If using a SQL named instance, enter the host name in the for

mat ServerName\InstanceName. For example: databaseserv

er01\SQLEXPRESS.

Port Enter the port number to connect to the SQL Server.

Note:

If using a SQL named instance, enter the exact port of the SQL 

named instance.

Database Enter the database name to connect.

Certificate Required Select the check box if connecting to the data source requires SSL cer

tificates.

Select Choose Certificate  to browse to your system and add certifi

cates.

2. Provide SQL server authentication details:

Field Name Description

User Name Enter the user name for the database you want to access.

Password Enter the password of the user configured in the database.

Test Select to check whether the database connection is established using 

the server and authentication details.

A message confirms on a successful connection to the database.

If test fails, the message provides more details on the failure.
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A successful SQL Database 

connection.

3. Select Save.

Add Historian or Custom REST Data Source (Classic)
Creates a Historian or Custom REST data source.

Provide a name, product, and description for your data source  (on page 352).

1. Select the check box for Enable System Connection  and provide these details to authenticate the 

Historian system API:

Field Name Description

Hostname Enter the hostname of the Historian data source.

Authentication Required Select the check box if connecting to the data source requires authenti

cation.

Enter the Username  and

Password  of the user who can access the APIs.

Test Select to verify the authentication details. A message appears, confirm

ing whether connection to the system API is established.

2. Select the check box for Enable REST Connection  and provide these details:
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Field Name Description

Base URL Enter the URL of the data source in the following format: https://<host 

name or IP address of the data source>:<port number>

Note:

The port number should not be used if your data source is His

torian 8.x.

REST Authentication Re

quired

Select the check box if authentication to a REST API is required. If se

lected, Operations Hub  sends authorization details along with a re

quest while connecting to a data source.

Auth Type Appears when the REST Authentication Required  check box is select

ed.

Select one of the following types of authentication:

◦ Basic Auth: Sends a verified user name and password along 

with the request.

◦ Bearer Token: Sends an access key along with the request.

◦ OAuth: Retrieves an access key to access an API, and then uses 

the key to authenticate future requests.

Important:

For connecting to a Custom REST data source such as eAn

don, select OAuth  for authentication.

Depending on the authentication type you select, a few boxes appear.

Auth Token Appears when the Bearer Token  authentication type is selected.

Enter the access key required to authenticate the APIs. The access key 

is included in the request header.

Auth Grant Type Appears when the OAuth  authentication type is selected.

Select one of the following types of granting the authentication:

◦ client_credentials

◦ password
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Field Name Description

Auth URL Enter the URL for the endpoint of the authentication server. This value 

is used to exchange the authorization code for an access token.

Auth Client Id Appears when the OAuth  authentication type is selected.

The client identifier issued to the client during the application registra

tion process.

Auth Client Secret Appears when the OAuth  authentication type is selected.

The client secret issued to the client during the application registration 

process.

Ignore TLS/SSL Select the check box if verifying SSL certification can be ignored. Nor

mally, this check box is cleared when using the data source in a pro

duction environment, which implies that SSL certification will be veri

fied while connecting to the data source. If, however, you want to trou

bleshoot issues with connecting to a data source, you may select this 

check box to isolate certification issues.

Certificate Required Select the check box if connecting to the data source requires SSL cer

tificates.

Select Choose Certificate  to browse to your system and add certifi

cates.

Auth Certificate If you want to provide a certificate for authentication, select Choose 

Certificate  and navigate to the certificate. Alternatively, you can select 

the Use Datasource Certificate  check box if you want to use the same 

certificate that is used by the data source.

Note:

You can use certificates only in the base-64-encoded format. A 

DER-encoded certificate is not supported.

Test Select to test the connection. A message appears, confirming whether 

token from the OAuth data source is retrieved. The connection is test

ed using the authentication details of the REST APIs, including the au

thentication URL; the data source base URL is not used.
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Field Name Description

Note:

You can create multiple data sources with the same URL. Af

ter you restart the services, the Data Distributor service uses 

the most recently saved System API authentication settings for 

the URL. Therefore, if the most recently saved credentials do 

not work, you cannot connect to the data source. To fix this is

sue, modify the data source to specify working credentials, and 

then test the data source. We recommend that you do not save 

the data sources that do not pass the test or data sources with 

the same URL.

3. Select Save.

Look at the following examples for configuring a data source for Historian 7.x and Historian 8.x.

Historian 7.x requires entry of port used – in this instance, port 8443 – whereas Historian 8.x does 

not require any port to be specified.

The Auth Client ID is admin for Historian 7.x, whereas Historian 8.x requires the Auth Client ID to be 

of the form MachineName.admin, where MachineName is case sensitive.

Example of Historian 7.2 Data Source:
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Example of Historian 8 Data Source:
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Note:

The Auth Client ID field is case sensitive. For example, if the Historian server name 

is hist8Server, the user must use hist8Server.admin  and not HIST8Server.admin  or 

Hist8Server.admin, otherwise REST authentication will fail.

Add a Data Source with OPC UA Configuration (Classic)
Creates a data source with OPC UA configuration.

Provide a name, product, and description for your data source  (on page 352).

You cannot add multiple data sources to use the same database connection. Make sure that the Endpoint 

URL and Application URI configuration is unique to every data source.



Operations Hub for Windows  | 3 - User Guide  | 361

1. If you selected Proficy iFIX, Proficy CIMPLICITY, or OPC UA as the product, provide these details to 

Enable OPC UA Connection.

Field Name Description

Endpoint URL Enter the machine name and port number to connect to an OPC UA 

server. For example: opc.tcp://MyServer:51400.

In iFIX, you can copy the URL from here:

◦ Applications  > OPC UA Configuration  screen.

In CIMPLICITY, you can copy the URL from here:

◦ Project  > Properties  screen.

Discover policies Select to discover and display all the security profiles supported by 

the OPC UA server to establish a secure connection. The display list is 

based on the entered endpoint URL; the security modes and policies 

supported by either iFIX, CIMPLICITY, or IGS.

From the discovered list for the endpoint URL, select the security pro

file you want to use for this connection, then select Apply.

Application URI This field is auto populated after defining a security profile for the OPC 

UA server.

Security Mode This field is auto populated after defining a security profile for the OPC 

UA server.
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Field Name Description

Note:

If security mode is None, the connection is not secured. This is 

acceptable if you simply want to test a connection. Make sure 

to change this setting later to ensure that you have adequate 

security enabled for your connections.

Security Policy This field is auto populated after defining a security profile for the OPC 

UA server.

View Certificate For a secured connection, security certificates must be exchanged be

tween Operations Hub and the OPC UA server.

Select to view the OPC UA server certificate, and if Untrusted, select 

Trust.

The server certificate gets added to the C:\ProgramData\GE\Operations 

Hub\pki\trusted\certs  folder in your machine running Operations Hub.

The certificate status now appears as Trusted.



Operations Hub for Windows  | 3 - User Guide  | 363

Field Name Description

Select Cancel  to close the trusted server certificate screen.

Important:

Operations Hub client certificate must also be trusted on the 

OPC UA server (iFIX, CIMPLICITY, IGS) to establish a secured 

connection.

◦ To trust the certificate on the CIMPLICITY server,

a. Start the CIMPLICITY project.

b. Attempt to connect via the Data source dialog 

box.

c. Trust the certificate on the Data source dialog 

box.

d. Go to the CIMPLICITY project's \pki\reject

ed\certs  folder, and copy the rejected certificate 

to the \pki\trusted\certs  folder.

e. Test the connection again; it should now work.

◦ To trust the certificate on the iFIX server,

a. Access the iFIX OPC UA Server Configuration 

Tool dialog box.

b. On the Trust List  tab, select the failed entry and 

trust it.
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Field Name Description

The failed entry appears when you attempt to 

test the connection in Operations Hub client.

Another option is to directly copy the Operations Hub certifi

cate from the client location (C:\ProgramData\GE\Operations 

Hub\pki\own\certs) to server location (\pki\trusted\certs).

Ensure that you modify the certificate file name if you plan to 

copy more than one Operations Hub certificate to the CIM

PLICITY trusted folder, to avoid replacing the already trusted 

clients.

2. Select the authentication type for read and write access to the database.

It is recommended that you select Username/Password to provide the highest level of encryption. 

Anonymous does not provide any protection for accessing data or login.

Field Name Description

Read To authenticate read access:

◦ Select User Name/Password  and enter the credentials in the 

text field.

◦ Enter the user name to connect to the OPC UA server (iFIX, CIM

PLICITY, IGS).

◦ Enter the password for the user name to connect to the OPC UA 

server.

Write To authenticate write access:
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Field Name Description

◦ Select Logged On User Token  if you want to use token-based 

authentication.

Note:

To validate tokens, make sure to configure the OPC UA 

server with Proficy Authentication (UAA).

◦ Select User Name/Password (provided by user)  if you want to 

enter credentials to authenticate.

◦ Select the check box for Use Read Credentials for Write  to use 

the same user name and password that you provided for read 

access.

Test Connection Select to test the OPC UA connection. If the details provided to estab

lish the connection are correct, a message appears confirming the suc

cessful connection.

To troubleshoot connection related issues, refer to Error Messages  (on 

page 710).

3. Select Save.
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Add a Batch Data Source (Classic)
Steps for Operations Hub classic version.

Provide a name, product, and description for your data source  (on page 352).

1. Select the check box for Enable Batch Connection.

2. Enter the Endpoint URL  of the Batch server you want to access.
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Only REST URLs are allowed. For example, https://perfbatch2vm:4867/BatchRESTAPI. The host 

name is the machine where you installed the Proficy Batch application.

3. Select Save And Exit.

Rename a Data source (Classic)
Data source aliasing is necessary for renaming a data source.

• After upgrading from Operations Hub 2.0, resave all the queries and their respective pages. This 

practice directs them to use the data source aliasing instead of the machine name. This also 

ensures that the queries and pages created in 2.0 are compatible with renaming data sources in 

the current version.

• If importing an application  (on page 215)  that was exported from version 2.0, resave all the 

queries and pages after importing to the upgraded version of Operations Hub.

1. From the main navigation menu, select DATASOURCES.

The DATASOURCES  workspace appears, displaying a list of data sources.

2. Select the data source that you want to rename.

The data source appears.

3. Enter the new name for the data source in the Name  text box.

The new name must be a unique name.

4. Select Save.

The data source is successfully renamed.

In case you want to export an application  (on page 210)  after renaming a data source, save all the 

associated queries and pages before application export. The application and the queries have references 

to the renamed data source.

Delete a Data Source (Classic)
Steps for Operations Hub classic version.

Log in to Operations Hub.

1. From the main navigation menu, select DATASOURCES.

The DATASOURCES  workspace appears.

2. Select , and then select Delete.

A message appears, asking you to confirm that you want to delete the data source.

3. Select Delete.
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The data source is deleted.

Browse Data Sources (Classic)
Allows to browse a data source and select the properties or tags.

Log in to Operations Hub.

1. From the select  drop-down, select a server alias and its data source to browse through the server 

properties and tag IDs.

Data Source Description

Assets / Objects This is the asset model configured in the system. You can browse 

through the asset hierarchy, and add properties to the trend chart from 

any hierarchy level. You can add or remove data variables of the asset 

from the trend chart.

Historian The Historian servers configured in the system. You can browse 

through the servers for tags that you want to add to the widgets.

Proficy iFIX The iFIX servers configured in the system. You can browse through the 

servers for tags that you want to add to the widgets.

Proficy Cimplicity The Cimplicity servers configured in the system. You can browse 

through the servers for tags that you want to add to the widgets.

OPC UA The OPC UA servers configured in the system. You can browse through 

the servers for tags that you want to add to the widgets.

A list of server nodes appear in a tree structure. For the Historian data source, a list of native tags 

from the data source appear.

2. Expand the tree structure and select the check box for only value  to pull data from the data 

source.

The tree structure is made up of nodes, each with a unique NodeID.

Icon Description

Objects are assets from a data source.

The Alarms folder contains alarm area nodes.
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Icon Description

Servers

Data arrays

The Tags folder provides access to the tag types and fields. Each tag 

has a value node, which represents the current value of the tag.

3. For Historian, you can search and select  (on page 371)  from the list of native tags.

4. Save or close the screen.

The selected properties or tags are applied.

Create a SQL Data Source (Classic)
Steps for Operations Hub classic version.

Log in to Operations Hub.

1. From the main navigation menu, select DATASOURCES.

The DATASOURCES  workspace appears, displaying a list of data sources.

2. Select Add New Data Source, and then enter values as specified in the following table.

Field Name Description

Name Enter the unique name of the data source.

Description Enter the description of the data source.

Datasource Type Select Relational Database.

Database Type Observe that this field defaults to Microsoft SQL Server, currently the 

only supported database type.

Host Enter the IP address or host name of database server. For example: 

10.181.213.211 or databaseserver01.

This field only appears if you select Relational Database as the Data

source Type.

Port Enter the port you want to use to connect to the SQL Server.

This field only appears if you select Relational Database as the Data

source Type.
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Field Name Description

Database Enter the database name that you want to connect to.

This field only appears if you select Relational Database as the Data

source Type.

Certificates Required Select the check box if connecting to the data source requires SSL 

certificates. If you select this check box, the Choose Certificate  but

ton appears, allowing you to select the certificate.

User Name In the SQL Authentication section, provide the user name for the data

base you want to access.

Password In the SQL Authentication section, provide the password of the user 

configured in the database.

Test button After the required fields are filled in, click the Test  button.

On a successful connection check, a message is shown beside the 

Test button as "Successfully connected to the Database” indicating 

that test connection to database can be established using the above 

details.

If it fails, it reads: “Failed to connect to the Database. More Details.” 

Click the “More Details ”link to view detailed reason in a pop-up.

3. Select the Test  button.

The following example shows a successful SQL Database connection.
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If it fails, a message appears stating: Failed to connect to the Database. Click on More Details  link 

to view detailed reason in a popup.

4. Select Save.

Search for Tags (Classic)
Allows to search for tags by tag name and description.

Log in to Operations Hub.

1. Enter a keyword in Search  and select .

Tip:

You can also perform a wild card search by entering *.

By default, only tags that match the keyword in their name and description are displayed.

2. To streamline your search, use these options:

Field Name Description

Tag name This is the default search filter. Select the check box to match the key

word only to tag names.
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Field Name Description

Additionally, to view the description for tags returned in keyword 

search, select  next to Description.

Description Select the check box to match the keyword only to tag descriptions.

Additionally, to view the names of tags returned in keyword search, se

lect  next to Tag name.

Both Select the check box to match the keyword with tag name or descrip

tion, and return results.

Pages

About Pages

Using Operations Hub, using the application editor, you can create pages that appear in an application. 

You can use pages in multiple ways, such as:

• Display information to users in the application. Information can be displayed in plain text or using 

multiple components, such as tables, images, graphs, and other components.

• Display a form to allow application users to enter or modify data. Forms can include items such as 

text, numbers, dates, times, and uploaded images from a mobile device.

• Allow application users to control assets by sending commands via MQTT or REST services.

Grant Group Access to Page within an Application
Steps to grant group access to a page in the latest version of Operations Hub.

Log in to Configuration Hub.

For steps to grant group access to a page in the Operations Hub classic version, refer to Grant Group 

Access to Page within an Application (Classic)  (on page 373).
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1. On the navigation panel, select Operations Hub  > Applications.

The existing list of applications and their pages appear.

2. Select the page to which you want to grant access.

The page details appear on the details panel.

3. On the details panel, pop open GROUPS.

The Manage Page Permissions  screen appears.

4. Select group/s and apply to the page.

Field Name Description

Search Enter keywords to search for specific group/s.

Only GE Groups Select to show only GE groups.

Selected Groups You can do the following:

◦ Sort groups by ascending/descending order.

◦ Select individual groups, or all groups at once.

Child Group Displays the child group, if exists.

The selected groups can now access the page. Please note these users must already have the 

ability to access the app.

Grant Group Access to Page within an Application (Classic)
Steps to grant group access to a page in the Operations Hub classic version.

Log in to Operations Hub.

For steps to grant group access to a page in the latest version of Operations Hub, refer to Grant Group 

Access to Page within an Application  (on page 372).

1. From the main navigation menu, select  APPS.

The APPS  workspace appears.
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2. In the Name  column, select the application to which you want to grant access.

The PAGES  workspace appears, including a column summarizing the current page permissions. 

By default, newly created pages display “All users”, indicating all users who have access to the 

application will have access to the page.

3. In the Permissions  column, select the page to which you wish to grant access.

The page permission dialog appears.

4. In the Manage Page Permissions  dialog box, if you wish to grant visibility to select groups only, 

select the “Selected Groups” option.

5. In the groups field, select the group or groups you would like to grant access to this page and then 

select Submit changes.

The selected groups can now access the page. Please note these users must already have the 

ability to access the app.

6. In each row containing an application user to whom you want to grant access, select the check 

box, and then select Submit changes.
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The selected users can now access the application.

Note:

It is possible to create a circular reference by nesting a parent group into its child. If there 

are circular references, the child groups will not display in the permissions dialog box.

Access a Page (Classic)
Steps to access a page in the Operations Hub classic version.

Log in to Operations Hub.

To access application pages in the latest version of Operations Hub, refer to Navigation Panel  (on page 

139).

1. From the main navigation menu, select  APPS.

The APPS  workspace appears, displaying a list of applications created in the site.

2. In the Name  column, select the application that contains the page that you want to access.
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The PAGES  workspace appears, displaying a list of pages created in the 

application.

3. In the Name  column, select the page that you want to access.

The page designer appears, displaying the elements in each container in the page.

Tip:

If needed, you can add or remove components from a container in the page, or modify the 

properties of a container  (on page 653), and then select Save App  to save your changes.

Create a Page
Steps to create a page in the latest version of Operations Hub.
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Log in to Configuration Hub.

When you create an application in the latest version of Operations Hub, a deafult first page is also 

created. The following steps show you how to create additional pages for an application.

For steps to create pages in the Operations Hub classic version, refer to Create a Page (Classic)  (on page 

378).

1. On the navigation panel, select Operations Hub  > Applications.

The existing list of applications appear.

2. Right-click the application for which you want to create a new page, and select Add New Page.

The Create Page  screen appears.

3. Enter the following field values:

Field Name Description

PAGE NAME Name of your application page.

The name must contain at least one uppercase or lowercase 

letter.

DESCRIPTION Brief description of your page.

4. Select Add.
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The page is created and a blank page designer screen appears. Refer to Panels Layout  (on page 

138).

5. From the components panel Visuals  tab, drag-and-drop or double-click the plug-ins you want to add 

to the page designer area, and configure their properties.

See Visuals Tab  (on page 143)

6. From the components panel Data  tab, bind data to the plug-ins.

See Data Tab  (on page 147)

7. On the toolbar, select Save.

Create a Page (Classic)
Steps to create a page in the Operations Hub classic version.

Log in to Operations Hub.

For steps to create pages in the latest version of Operations Hub, refer to Create a Page  (on page 376).

1. From the main navigation menu, select  APPS.

The APPS  workspace appears, displaying a list of applications created in the site.
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2. In the Name  column, select the application in which you want to create a page.

The PAGES  workspace appears.

3. Select Add new page.

The Create Page  window appears.
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4. Provide values as described in the following table.

Field Name Description

Page name Enter a name for the page. The name must contain at least one 

uppercase or lowercase letter.

Page description Enter a description for the page.

Include in app navigation Select this check box if you want this page to be included in the 

application navigation. By default, this check box is selected.

5. Select Create.

The page is created, and the page designer appears.
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The container and the left/right panels on the page designer are flexible to use.

◦ Drag the left/right sides of the container to resize for a wider view.

◦ Select  and  to show or hide left/right panels.

6. As needed, add components to the page  (on page 653).

7. As needed, add queries to the page. Set options for the query, including query submission options.

Several queries require the multi-select parameter to be selected on the App Page, otherwise no 

output data will be displayed.

The following Historian REST queries require the multi-select input to be enabled on the EndApp 

page for output data to be displayed:

◦ Get > Raw Data

◦ Get > Calculated Data

◦ Get > Sampled Data

◦ Post > Calculated Data

◦ Post > Interpolated Data

8. Bind the inputs and outputs of widgets to page data, such as manually entered values, queries, 

formulas, and globals.

9. Select Save App.

The changes made to the page are saved.

Note:

At any point in time, if you attempt to navigate away from the page, a confirmation 

message appears to confirm whether you want to stay on the page, and finish your work.

Copy a Page
Steps to copy a page in the latest version of Operations Hub.

Log in to Configuration Hub.

For steps to copy pages in the Operations Hub classic version, refer to Copy a Page (Classic)  (on page 

383).
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1. On the navigation panel, select Operations Hub  > Applications.

The existing list of applications and their pages appear.

2. Right-click the page you want to copy, and select Duplicate Page.

You can also duplicate multiple pages at a time. To do so:

a. Select , and then select Page Actions.

A selection check box appears next to each page.

b. Select the check box for page you want to duplicate.

Note:

To select/clear a check box, you must first select the page in the list.

c. Right-click and select Duplicate Pages.

A confirmation message appears.

3. Select Ok  to confirm the duplicate action.

The Select an Application  screen appears.

4. From the drop down list, select the application to which you want to copy this page.

You can copy page/s from one application to another, and also within the same application.

5. Optional:  You can modify New Page Name.
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The New Page Name  field is already populated with a unique system-generated value.

6. Select Ok.

Copy a Page (Classic)
Steps to copy a page in the Operations Hub classic version.

Log in to Operations Hub.

For steps to copy pages in the latest version of Operations Hub, refer to Copy a Page  (on page 381).

1. From the main navigation menu, select  APPS.

The APPS  workspace appears.

2. In the Name  column, select the application that contains the page that you want to copy.

The PAGES  workspace appears.
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3. Select the check box for the page you want to copy and choose one of these options.

Option Description

Copy a single page
Select  in the row, then select Duplicate page.

Copy multiple pages
Select  in the header, then select Duplicate 

Pages.

A confirmation message appears.

4. Select OK  to proceed to duplicate the page/s.

Select an Application  screen appears.

5. From the drop down, select the application to copy this page.

You can copy page/s from one application to another, and also within the same application.

6. Provide a name for the page.

Option Description

Copy a single page Enter a name for the duplicate page. The name 

must contain at least one uppercase or lower

case letter.

Copy multiple pages By default, unique names are assigned to each 

duplicate page.

7. Copying page/s from one application to another requests for handling globals.
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◦ Duplicate Globals: Creates page globals with a different name. Recommended when globals 

have the same name but are of different types.

◦ Attempt to reuse Globals: Reuses the page globals. Does not create new globals with the 

same or duplicate name.

8. Select OK.

The pages, along with the UI components, queries, and global variables used in them, are copied.

Delete a Page
Steps to delete a page in the latest version of Operations Hub.

Log in to Configuration Hub.

When you delete a page, the global variables applied to the page also get deleted.

For steps to create pages in the Operations Hub classic version, refer to Delete a Page (Classic)  (on page 

386).

1. On the navigation panel, select Operations Hub  > Applications.

The existing list of applications and their pages appear.

2. Right-click the page you want to delete, and select Delete Page.

You can also delete multiple pages at a time. To do so:

a. Select , and then select Page Actions.

A selection check box appears next to each page.

b. Select the check box for page you want to delete.
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Note:

To select/clear a check box, you must first select the page in the list.

c. Right-click and select Delete Pages.

A confirmation message appears.

3. Select Ok  to confirm the delete action.

Delete a Page (Classic)
Steps to create a page in the Operations Hub classic version.

Log in to Operations Hub.

When you delete a page, the global variables applied to the page also get deleted.

For steps to create pages in the latest version of Operations Hub, refer to Delete a Page  (on page 385).

1. From the main navigation menu, select  APPS.

The APPS  workspace appears.
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2. In the Name  column, select the application that contains the page that you want to delete.

The PAGES  workspace appears.

3. In the workspace heading, select , and then select Delete Pages.
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A message appears, stating that the global variables used in the page will also be deleted.

Tip:

Alternatively, in each row containing a page that you want to delete, select , and then 

select Delete page.

4. Select OK.

The pages are deleted.

Navigation

About Navigation

Using navigation, you can configure the navigation menu of an application by performing the following 

tasks:

• Add a page to the navigation menu of the application.

• Remove a page from the navigation menu of the application.

• Specify the name of the page that should appear in the navigation menu of the application.

• Specify the sequence of the pages that should appear in the navigation menu of the application.

• Select the icon that should appear for each page in the navigation menu of the application. By 

default,  is selected.

When you access the application, a list of pages that you have added appear in the navigation menu of 

the application, displaying the icon that you have specified for each page. You can expand the navigation 

menu of the application by selecting . It will then display the name of each page along with the icon.

Using navigation, you can configure the navigation menu of an application by performing the following 

tasks:

• Add a page to the navigation menu of the application.

• Remove a page from the navigation menu of the application.

• Specify the name of the page that should appear in the navigation menu of the application.

• Specify the sequence of the pages that should appear in the navigation menu of the application.

Add a Page to the Navigation Menu of an Application (Classic)
Steps to enable page navigation in the Operations Hub classic version.
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Log in to Operations Hub.

By default, when you create a page, it is included in the navigation menu of the application. This topic 

describes how to add a page to the navigation menu of an application in case it has been removed from 

the navigation menu.

1. From the main navigation menu, select  APPS.

The APPS  workspace appears, displaying a list of applications in the site.

2. In the Name  column, select the application for which you want to add a page to the navigation 

menu.

The PAGES  workspace appears.
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3. From the main navigation menu, select  NAVIGATION.

The NAVIGATION  workspace appears, displaying a list of pages that have been added to the 

navigation menu of the application.

4. Select Add Pages.

The Add Pages  window appears, displaying a list of pages that have been created in the 

application, but have not been added to the navigation menu.

5. Select each check box that corresponds to a page that you want to add to the navigation menu of 

the application, and then select Add.

The selected pages are added to the navigation menu of the application.
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Tip:

◦ You can modify the display name of a page by selecting  in the DISPLAY NAME 

column.

◦ You can modify the name of a page by selecting  in the Page Name  column.

◦ You can select the icon that should appear for the page in the navigation menu of 

the application by selecting an icon in the Page Icon  column.

◦ You can change the sequence of pages in the navigation menu of the application by 

dragging each page to the required location.

◦ You can preview the application by selecting Preview App.

Remove a Page from the Application Navigation Menu (Classic)
Steps to disable page navigation in the Operations Hub classic version.

Log in to Operations Hub.

1. From the main navigation menu, select  APPS.

The APPS  workspace appears, displaying a list of applications in the site.
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2. In the Name  column, select the application in which you want to change the application navigation 

menu.

The PAGES  workspace appears.

3. From the main navigation menu, select  NAVIGATION.
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The NAVIGATION  workspace appears, displaying a list of pages that have already been added to 

the application navigation menu.

4. In the row containing the page that you want to remove, select .

The page is removed from the application navigation menu.

Note:

The page is removed only from the application navigation menu; it is not deleted. You can 

still access it in the application by performing an action such as selecting a button or an 

image.

Explorer

About Explorer (Classic)

Explorer provides a hierarchical view of the following items:

• Containers and UI elements used in each page in the application, which appear in the Pages 

hierarchy.

• Variables defined in the application, which appear in the Globals hierarchy.

Using Explorer, you can view the links between variables and UI elements on application pages, which will 

help you follow the application structure.

The variables defined in an application are classified as follows:

• System

• Output

• UI

• Custom

• URL



Operations Hub for Windows  | 3 - User Guide  | 394

When you expand a variable in the hierarchy, one of the following options appears:

• app global: true: Indicates that the variable is visible in every page of the application.

• app global: false: Indicates that the variable is visible only in the page where it is defined.

If a variable contains an initial value, that value also appears in the hierarchy.

Themes

About Themes (Classic)

Themes are used to specify the default background color, font color and type, border color, style, width, 

and other attributes. These attributes are used in the headings, tables, containers, and other elements in 

an application. Themes help you create a common look and feel across all the pages in your application.

Operations Hub  contains a few baseline themes. You cannot modify or delete them. You can, however, 

copy them.

Access a Theme (Classic)
Steps for Operations Hub classic version.

Log in to Operations Hub.

1. From the main navigation menu, select  APPS.

The APPS  workspace appears.
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2. In the Name  column, select an application.

The PAGES  workspace appears.

3. From the main navigation menu, select  THEME.



Operations Hub for Windows  | 3 - User Guide  | 396

The THEME  workspace appears, displaying a list of themes. The theme that is applied to the 

application is indicated by .

4. In the row containing the theme that you want to access, select .

The workspace for the theme appears, displaying the settings for each attribute.

Tip:

If needed, modify the settings, and then select Save theme  to save your changes. You 

cannot, however, modify a baseline theme.

Create a Theme (Classic)
When you create a theme, it is automatically used in the application that you have selected. You can, 

however, use a different theme in the application.

Log in to Operations Hub.

1. From the main navigation menu, select  APPS.

The APPS  workspace appears.
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2. In the Name  column, select an application.

The PAGES  workspace appears.

3. From the main navigation menu, select  THEME.
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The THEME  workspace 

appears.

4. Select Create new theme.

The Create new theme  window appears.

5. Enter a name for the theme, and then select Save. The name must contain at least one uppercase 

or lowercase letter.

The workspace for the theme appears, displaying the default settings for each attribute.

6. As needed, modify the settings, and then select Save theme.

A message appears, asking you to confirm that you want to use the theme for the application.
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7. Select Yes.

The theme is created and used in the application.

Copy a Theme (Classic)
Steps for Operations Hub classic version.

Log in to Operations Hub.

1. From the main navigation menu, select  APPS.

The APPS  workspace appears.

2. In the Name  column, select an application.

The PAGES  workspace appears.
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3. From the main navigation menu, select  THEME.

The THEME  workspace appears.

4. In the row containing the theme that you want to copy, select , and then select Duplicate theme.
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The Create new theme  window appears, asking you to enter a name for the theme that you want to 

copy.

5. Enter a name for the theme, and then select Save. The name must contain at least one uppercase 

or lowercase letter.

The theme is copied.

Delete a Theme (Classic)
You cannot delete a baseline theme or a theme that is used in an application.

Log in to Operations Hub.

1. From the main navigation menu, select  APPS.

The APPS  workspace appears.
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2. In the Name  column, select an application.

The PAGES  workspace appears.

3. From the main navigation menu, select  THEME.

The THEME  workspace appears.
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4. In each row containing a theme that you want to delete, select the check box.

5. In the workspace heading, select , and then select Delete themes.

A message appears, asking you to confirm that you want to delete the themes. If, however, a theme 

is used in an application, a list of applications that use the theme appears, and you cannot delete 

the theme.

Tip:

Alternatively, in each row containing a theme that you want to delete, select , and then 

select Delete theme.

6. Select Delete.

The themes are deleted.
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Settings

About Settings

You can configure the following settings for an application:

• Display brief or detailed error information in the error messages

• Display or hide a button for accessing trace information

• Display or hide a busy indicator to indicate that a page is loading data from a query

• Display or hide the title of the application

• Display or hide the user pages, which are used to change the password of the user and access user 

settings from the application

• Automatically close error pop ups without manual intervention

Modify Settings
Steps to modify application settings in the latest version of Operations Hub.

Log in to Configuration Hub.

For steps to modify application settings in the Operations Hub classic version, refer to Modify Settings 

(Classic)  (on page 406).

1. On the navigation panel, select Operations Hub  > Applications.

The existing list of applications appear.

2. Select the application you want to modify.

The following fields appear under GENERAL SETTINGS  on the details panel.

Field Name Field Description

Show extended error information Select this check box if you want detailed error information 

to appear in error messages. You can use this information to 

troubleshoot issues in the application.
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Field Name Field Description

Show trace button Select this check box if you want to display a button that al

lows you to access information on the data retrieved from 

queries, functions, and global variables that are used in the 

application. It also includes data that is inserted or updat

ed using queries. When you select this check box (and save 

your changes), a Trace  appears in the application. You can 

select this button to view the trace information.

Hide loading in application Select this check box if you do not want to display a busy in

dicator to indicate that a page is loading data from a query.

Hide application title Select this check box if you do not want the title of the appli

cation to appear when you access the application.

Show User Pages Select this check box if you want to display user pages in 

the application navigation menu. These pages are used to 

change the password of the user and access user settings 

using the application. If you select this check box, the option 

to access the user pages appears in the application title. If, 

however, the Hide application title  check box is selected, the 

option is moved to the navigation menu of the application.

Auto-dismiss errors after 10 sec

onds

Select this check box to automatically dismiss error mes

sages after 10 seconds if they pop up in the end application. 

Recommended for hands-free environments.

Show navigation icons for applica

tion history
Select this check box to show  navigation icons on 

the banner of your application. The back/forward navigation 

icons work within the scope of an individual application.

Use the navigation icons to Go to previous page  or Go to 

next page. The icons are activated based on the entries for 

the current application session history.

3. To enable the settings for an application, turn on the respective toggle switch.
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4. Select Save  on the toolbar.

Modify Settings (Classic)
Steps to modify application settings in the Operations Hub classic version.

Log in to Operations Hub.

For steps to modify application settings in the latest version of Operations Hub, refer to Modify Settings 

(on page 404).

1. From the main navigation menu, select  APPS.

The APPS  workspace appears.
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2. In the Name  column, select the application whose settings you want to modify.

The PAGES  workspace appears.

3. From the main navigation menu, select  SETTINGS.

The SETTINGS  workspace appears.
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4. As needed, modify values as described in the following table.

Field Description

Show extended error information Select this check box if you want detailed error information 

to appear in error messages. You can use this information to 

troubleshoot issues in the application.

Show trace button Select this check box if you want to display a button that al

lows you to access information on the data retrieved from 

queries, functions, and global variables that are used in the 

application. It also includes data that is inserted or updat

ed using queries. When you select this check box (and save 

your changes), a Trace  appears in the application. You can 

select this button to view the trace information.

Hide loading in application Select this check box if you do not want to display a busy in

dicator to indicate that a page is loading data from a query.

Hide application title Select this check box if you do not want the title of the appli

cation to appear when you access the application.

Show User Pages Select this check box if you want to display user pages in 

the application navigation menu. These pages are used to 
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Field Description

change the password of the user and access user settings 

using the application. If you select this check box, the option 

to access the user pages appears in the application title. If, 

however, the Hide application title  check box is selected, the 

option is moved to the navigation menu of the application.

Auto-dismiss errors after 10 sec

onds

Select this check box to automatically dismiss error mes

sages after 10 seconds if they pop up in the end application. 

Recommended for hands-free environments.

Show navigation icons for applica

tion history
Select this check box to show  navigation icons on 

the banner of your application. The back/forward navigation 

icons work within the scope of an individual application.

Use the navigation icons to Go to previous page  or Go to 

next page. The icons are activated based on the entries for 

the current application session history.

5. Select Save.

The settings are modified.

Widgets

About Widgets

When you design a page for an application, you can add widgets to the page to display the required 

information.
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Native Widgets

INPUTS DISPLAY LAYOUTS TOOLS

• Check Box  (on 

page 411)

• Radio Button  (on 

page 413)

• Dropdown  (on 

page 414)

• Input  (on page 

416)

• Slider  (on page 

419)

• Toggle  (on page 

420)

• Button  (on page 

421)

• Camera  (on page 

423)

• Text Area  (on 

page 424)

• Text  (on page 

424)

• Header  (on page 

425)

• Image  (on page 

426)

• Graph  (on page 

427)

• Visualization  (on 

page 430)

• Big Data  (on page 

434)

• Grid  (on page 

438)

• Map  (on page 

440)

• Table  (on page 

444)

• List  (on page 

446)

• Gauge  (on page 

447)

• Html  (on page 

452)

• Interactive Map 

(on page 465)

• New Line  (on 

page 468)

• Separator  (on 

page 468)

• Container  (on 

page 469)

• Repeater  (on 

page 470)

• Event Settings 

(on page 485)

• Upload Excel  (on 

page 486)

• Upload Devices 

(on page 488)

Integration Plugins

Category Widgets

INPUTS Button  (on page 491), Check Box  (on page 493), Radio Button  (on page 

493), Slider  (on page 494), Text Area  (on page 495), Text Input  (on page 

495), Toggle  (on page 496).
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Category Widgets

CHARTS Line Chart  (on page 497), Pie Chart  (on page 500), Bullet Graph  (on page 

501), Pareto Chart  (on page 504), Sparkline  (on page 506), Spider Chart 

(on page 508), Timeline  (on page 511), Variwide Chart  (on page 515).

HMI CIMPLICITY HMI Webspace  (on page 517), Alarm Card  (on page 530), 

Alarm Count  (on page 541), Mimic Card  (on page 541).

DISPLAY DataGrid  (on page 559), Gauge Bar  (on page 567), Gauge Circular  (on 

page 569), Gauge Linear  (on page 570), Solid Gauge  (on page 579), 

Value Display  (on page 583), iFrame  (on page 572), Pivot Grid  (on page 

574), Image  (on page 588), Simple Indicator  (on page 590), List  (on 

page 590), Text Display  (on page 591).

GENERAL Date Picker  (on page 592), Breadcrumb  (on page 594), Histogram  (on 

page 605), Trend Card  (on page 610), Task Client  (on page 629), Indi

cator  (on page 635), Dropdown  (on page 598), DateTime Range Picker 

(on page 597), Favorite Organizer  (on page 600), HTML Editor  (on page 

639).

BATCH  (on page 640) Batch Menu, Batch List, Batch SFC, Batch Prompt, Batch Binding Prompts, 

Batch Alarms, Batch Phase Control, Batch Control, Batch Parameter, Batch 

Recipe Info, Batch Reports, Batch Step Control, Batch Step List.

Custom Plugins

Custom plugins can be added to Operations Hub  through use of the Plug-in infrastructure. To learn more 

about plug-ins, refer to the About Plug-ins  (on page 282)  section.

Native

Inputs

Check Box

A check box widget is used to allow application users to choose between two mutually exclusive options. 

For example, you can use a check box to allow the application user to specify whether the user has read 

the license agreement. You can also use a check box to display or hide other widgets on the page. To use 

the new version, refer to Check Box  (on page 493).
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Check Box Properties

When you use a check box widget, in addition to providing values for the default fields for a widget, you 

must define the following settings:

Field Name Description

Target Data If this check box only represents input to a single query, you can select the 

target input from the list of inputs to the queries that have been added in 

the Page Data  section.

Source Identifies the source of the check box value. You can specify one of the fol

lowing types of sources:

• Data: Select the source of data from the list of outputs from the 

queries that have been added in the Page Data  section.

• Manual: Select this option if you want to set true and false as the 

check box options.

Use the Check Box to Display or Hide a Camera Button

To use a check box widget to display or hide a Camera  button, perform the following steps:

1. Add the check box and camera widgets to the page.

2. In the CHECKBOX PROPERTIES  section, enter values in the Label  and Id  boxes, and then select the 

Global Data  check box.

3. In the CAMERA PROPERTIES  section, select Add conditions.

4. In the Camera Conditions  window, select Add condition, and then enter or select values as shown 

in the following image.

Note:

In this case, CB was the ID specified for the check box widget.
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5. Select Done, and then save the application.

In the application, the Camera  button appears only if you select the check box.

Radio Button

A radio button is a graphical user interface element that allows a user to select one option out of a set of 

predefined options. Unlike check boxes, which allow multiple selections, radio buttons require that only 

one option is selected. To use the new version, refer to Radio Button  (on page 493).

Radio Button Properties

Field Name Description

Target Data The target data defines where the information will be sent.

Options Radio buttons require multiple options that are mutually exclusive. Use 

these available options to create items for each radio button:

• Select Hard Coded  to manually create items for radio buttons.

1. Select + Add Option.

2. Enter Option text.

3. Enter Option value.

• Select Dynamic  to create items using queries.

1. Select a Value  from the database.

2. Select the Displaytext.

Data Select this option if you want to provide data by means of a query output or 

a global parameter.

Manual Select this option if you want to manually provide data.

Submit on change Select the check box if you want to submit the query whenever the input 

value is updated.

Possible Uses

Radio buttons require only one selection out of multiple options. If there are only two options, a 

radio button is unlikely to be the best widget choice. One example could be selecting an answer on a 

questionnaire where the choices are: Agree, Neutral, and Disagree. Only one of these answers can be 

selected, because they are mutually exclusive.

Example
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1. Add a radio button and a header on a page.

2. Specify the name in the Id  box.

3. Select the Global Data  check box to set the selected value to global.

4. In the Options  box, select Hard Coded.

5. Select + Add Option  three times, and enter Agree, Neutral, and Disagree, and the corresponding 

values of 1, 2, 3.

6. For the header, in the Data  box, select the global value of RB  that was set in step 3.

7. Save the application, and preview it.

The corresponding values appear in the header.

Dropdown
Allows to use standard features of a dropdown.

A dropdown is a graphical user interface element that allows a user to select one option out of a set of 

predefined options. Dropdowns are characterized by a wider set of options than that of a radio button. 

Radio buttons rarely have more than three options, while dropdowns can contain many more options. For 

advanced features, use the multi-feature Dropdown  (on page 598).

Dropdown Properties

Field Name Description

Required Select the check box to send the input to the query.

Target Data The target data defines where the information will be sent.

Options Dropdowns require multiple options that are mutually exclusive. Use these 

available options to populate dropdown list items:

• Select Hard Coded  to manually enter and fill items for the dropdown.

1. Select + Add Option.

2. Enter Option text.

3. Enter Option value.

• Select Dynamic  to populate dropdown list items using queries.

1. Select a Value  from the database.

2. Select the Display  text.

Data Select this option if you want to provide data by means of a query output or 

a global parameter.
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Field Name Description

Manual Select this option if you want to manually provide data.

Submit on change Select the check box if you want to submit the query whenever the input 

value is updated.

First Option By default, the first option in a dropdown is blank. It is recommended to 

manually enter option text such as please select, instead of a dropdown 

that appears empty. Enter its option value to be none.

Possible Uses

Dropdowns are similar in nature to radio buttons in that they require a mutually exclusive selection. 

However, while radio buttons are generally used for options between only a few choices, dropdowns 

can include hundreds of choices. One example of a drop-down list box could be selecting a country of 

residence. Every country in the world will take up too much space if displayed as radio buttons, while in a 

drop-down list box, the information can be more elegantly contained. The information selected could be 

converted to other information depending on the target data. For example, the country could be changed 

to a telephone prefix by setting the value to be telephone prefix and the display as the country name.

Example: An entity named Wiki has been already defined to store the prefecture names in Japan. 

The direct option value entering of 47 prefecture names is not productive. This entity value usage is 

productive. The necessary steps are just to specify this entity in the property after allocating dropdown 

on a page. In this sample, an entity field called PREF is specified both for Display and Value, where the 

prefecture names are stored.

1. Drag-and-drop the dropdown widget to a container.

2. Select the dropdown widget in the container to access the DROPDOWN PROPERTIES  tab

3. Under the GENERAL  section, provide the details as specified in the table:

Field Name Description

Label Enter Select an option.

4. Under the DATA  section, provide the details as specified in the table:

Field Name Description

Target Data Select a query.

Options Select Dynamic.
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Field Name Description

Value Select PREF.

Display Select PREF.

Submit on change Select the check box.

In the practical application, a query can be executed based on the option selection in dropdown and the 

facility or company status in the prefecture can be displayed on a map as markers.

Input
The input widget is a graphical user interface element that contains a text box.

The input widget differs from a standard text box in that its purpose is to allow the end user to insert 

information into a database.

Properties

Field Name Description

Type There are several options for the type of data that can be added via an in

put widget. Depending on the data type set, the system will automatical

ly validate and confirm specific data sets. For example, while a Text type 

can be anything written in the input, an email address may have specific re

quirements such as the use of an at sign character (@). If the data type is 

set for email, the user must include an at sign character (@). If not, an error 

message appears. The following options are available:

• Text

• Password

• Number

• Hidden

• Date

• Time

• DateTime

• URL

• E-mail
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Field Name Description

Note:

This DateTime output is not compatible with Historian queries. Use 

Date Picker  (on page 592)  instead.

Target Data Check boxes can alter information in an entity via a query. Target Data in

dicates where this information will change and how depending on which 

query inputs are attached.

Source The data source can be selected based on which queries have been added 

in the Page Data section. It is also possible to manually insert the data 

source or to use a formula.

Required Specify if an input must be sent to the query.

Disabled If selected, the data input is not allowed.

Possible Uses

The input has a wide variety of uses. One basic example is that of a login or registration form. Such a 

form requires specific information to be stored in a database including data such as an email address, 

name, birthday, password, and other information. The input allows an end user to enter information in 

various forms in to a database.

In this example, we will create a simple input form using an entity and a query.

1. Add two input widgets to a page for address and name.

2. Add a button to indicate to add the information entered by the input widgets.

3. Create an entity named Wiki Form, and add the following entity fields: ADDR and NAME (data type: 

string).

4. Create an Insert query named Wiki Form Add to insert data into the entity, as shown in the 

following image.
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5. Add the query to the application in the Data Page  section, as shown in the following image.

6. Drag and drop the query input fields to the connect them to the input widgets.



Operations Hub for Windows  | 3 - User Guide  | 419

7. In the Button Properties section for the button widget, specify the action to execute the insert 

query, as shown in the following image.

8. Save the application, and preview it.

In the application, when you enter values and submit, the information is stored in the entity.

Slider

A slider is a graphical user interface element that is used to indicate an amount or value by means of an 

indication hash marker that can move on a horizontal plane that has a value indication. To use the new 

version, refer to Slider  (on page 494).

Slider Properties

Field Name Description

Source The data source can be based on which queries have been added in the 

Page Data  section. It is also possible to manually insert the data source or 

to use a formula.
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Field Name Description

Required Specify if an input must be sent to the query.

Submit on Charge If selected, changing the value of the input submits the query to which this 

input is assigned.

Step The spacing between variables on the horizontal plane of the slider.

Minimum Sets the minimum variable on the horizontal plane of the slider. This num

ber appears on the left side of the plane.

Maximum Sets the maximum variable on the horizontal plane of the slider. This num

ber appears on the right side of the plane.

Possible Uses

A slider can be used for any of the following purposes:

• To provide a number selector.

• To indicate the volume on an audio recorder or a maximum/minimum price.

• To allow a user to select a price they would be willing to pay as part of a filter system for search 

results.

Toggle

A toggle button contains two opposing, binary states based on Boolean logic. On/Off is the default for the 

button, because this is the most common use. To use the new version, refer to Toggle  (on page 496).

Toggle Properties

When you use a check box widget, in addition to providing values for the default fields for a widget, you 

must define the following settings.

Field Name Description

Source The data source can be based on which queries have been added in the 

Page Data  section. It is also possible to manually insert the data.

Required Specify if an input must be sent to the query.

Submit on Change If selected, changing the value of the input submits the query to which this 

input is assigned.
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Field Name Description

True Label There are two states on a toggle button. The True Label  setting refers to 

the label of the active state.

False Label There are two states on a toggle button. The False Label  setting refers to 

the label of the inactive state.

Width The width of the toggle button.

Possible Uses

Toggle buttons are generally used for on/off actions. For example, if a setting or feature is active/inactive, 

this can be controlled with a toggle button.

This example describes the device on/off switching using a Toggle button.

Note:

Without an actual device or a simulator, the real action result cannot be seen.

1. In the page designer, add a toggle widget and two input widgets.

2. In Page Data  section, add a function to the page, such as IQAW Set Immobilizer State.

3. Drag the function parameters to connect to the input widgets and the toggle widget. Note that 

function (command) itself (IQAW Set Immobilizer State) should be connected to the toggle widget.

Button

Buttons are used to start any action. By default, the text Submit appears on a button. It indicates that it is 

used to submit information that an application user provides using other widgets. To use the new version, 

refer to Button  (on page 491).

Buttons can perform a variety of actions, and can even perform multiple actions. Each specific action has 

its own choices. For example, if the action of selecting a button is to go to a specific page, that page can 

be selected after the action is selected in the same grey box.

In addition, you can arrange actions in a sequence. For example, if the selecting a button will both hide a 

component and submit data entered by a user, the action can first hide the component, and then submit 

the data, or vice versa.
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Button Properties

Field Name Description

Submit Sends information to an entity.

Go to page Redirects to a different page in the application (for example, from the home 

page to a different page in the navigation).

Go to previous page Redirects to one page back in history based on the entries created for the 

current application session.

In the absence of previous session entries, the button does not redirect to 

any page.

Go to next page Redirects to one page forward in history based on the entries created for 

the current application session.

In the absence of forward (next) session entries, the button does not redi

rect to any page.

URL Redirects a user to a URL outside the application.

Set global value If selected, the data here will be available globally. Global data means that 

an entity changed in one part of the application will change across the ap

plication.

Show Component Displays a hidden component.

Hide Component Hides a component.

Toggle Show/Hide Some widgets are marked as shown or hidden and the Toggle Show/Hide 

action will switch between hidden and shown views of a component.

Visual

Button types are design presets that can help create a better hierarchy and a better look and feel for an 

application. It is recommended to use button types to fit a button to its use. For example, a delete button 

might be a Negative type. The following button types are available:

• Primary

• Secondary

• Positive

• Negative

• Link



Operations Hub for Windows  | 3 - User Guide  | 423

Possible Uses

Buttons can be used for a variety of purposes. In general, buttons are used in conjunction with other 

widgets. For example, if a user makes a series of selections with drop-down list boxes, check boxes, and 

radio buttons, they can then select a Submit  button that will record the user’s choices in an entity. Buttons 

can also be used to refresh a page, send a user to another page, set a global value, or show/hide content 

depending on how the button is configured.

This example shows how to create a window.

1. Add a button widget in the page designer.

2. Add a container below the button widget, and provide an ID for the container.

3. In the container, add several input widgets, and set the display condition of the container to Hidden.

4. In the Button Properties  section of the button, set the action of Show Component, and specify the 

container ID.

5. Save the application, and preview it.

In the application, if you select the button, the container appears.

Camera
This widget is available only in Operations Hub Classic version.

The camera widget is a button that will open a default camera based on the device used by the 

application user. If a camera does not exist, you can select an image. For example, if you use an iPhone 

to access the application, and they select the camera button, the default iPhone camera options page 

appears. After you capture an image with the default camera, the image is held in the local memory of 

the application until you perform an action (such as linking the image display so the image appears in the 

application).

Camera Properties

When you use a camera widget, in addition to the default settings, the following settings are available.

Field Name Description

Max Width The maximum width of the uploaded image in pixels. This setting is option

al.

Max Height The maximum height of the uploaded image in pixels. This setting is op

tional.
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Possible Uses

You can use the camera widget to allow an application user to add images to an application or database. 

Example:

• If an application deals with selling goods, a user can upload an image of the goods that they want 

to sell.

• If an application deals with car rentals, a user can capture a photo to report a car accident, and 

then save it to the database. The rental agency can then view the image.

Text Area

The text area widget allows a user to provide large amount of text using an application. This widget 

contains a scroll bar. To use the new version, refer to Text Area  (on page 495).

Text Area Properties

To use a text area widget, in addition to the default settings, the following settings are available.

Field Name Description

Source The source of data based on which queries have been added in the Page 

Data  section. You can also enter the data source manually or use a formu

la.

Required Identifies if an input must be sent to the query.

Submit on Charge If selected, changing the value of the input submits the query to which this 

input is assigned.

Possible Uses

A standard text box can handle large amounts of text, but it may not be user-friendly because not all of 

the text can be seen or edited at once. If a user wants to submit a comment, for example, a text area 

allows them to write several sentences and view the text as a paragraph (for example, license agreement 

or privacy policy, which usually contains a large amount of text).

Display

Text

The text widget allows you to display text in an application. An application user can read the text, but 

cannot modify it. To use the new version, refer to Text Display  (on page 591).
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Text Properties

To use a text area widget, in addition to the default settings, the following settings are available.

Field Name Description

Source The source of data based on which queries have been added in the Page 

Data  section. You can also enter the data source manually or use a formu

la.

Format You can select one of the following values:

• Text: Default value

• DateTime

• Date

• Time

Possible Uses

Since this widget can be connected to a query in the Page Data  section, updated information can be 

displayed in the application. For example, if the application is used to display sports scores, the text box 

can be connected to an entity via a query that will display the score in a sport. The user can read the text, 

but cannot modify it.

Using a Text Widget to Display the Current Date and Time

1. In the Page Data  section, select Global.

2. In the System Globals  section, select Date time (Local), and then select Add. System globals are 

provided as standard functions.

3. Add a text widget, and enter an label.

4. Drag the system global that you have added to connect to the text widget. Or, select the system 

global in the Data  box.

5. Save the application, and preview it.

The application displays the current date and time.

Header
This widget is available only in Operations Hub Classic version.

Headers are generally larger amounts of text that are used to create titles to divide an application in to 

different areas depending on their content.
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Header Properties

To use a header widget, in addition to the default settings, the following settings are available.

Field Name Description

Type You can create three different sizes of headers: Header 1 (largest) to Head

er 3 (smallest) so that a hierarchy can be created based on text size.

Format You can select one of the following values:

• Text: Default value

• DateTime

• Date

• Time

Possible Uses

If an application has several different areas, you can use a header to create order and hierarchy.

For example, a food application for a grocery store may divide food in to several categories such as dairy, 

meat, and produce. These larger topics (Header 1) can then be divided in to smaller parts. For example, 

the produce header can contain two smaller headers (Header 2) underneath for fruits and vegetables. 

Within the category of vegetables, there may be an additional category of root vegetables that may have a 

smaller sized header (Header 3) with a list of different root vegetables underneath.

Image

Using the image widget, you can insert an image in to an application. Application users can see the 

image, but cannot manipulate it, since it is display-only. Images can be attached to the entities via queries 

and then shown to application users. To use the new version, refer to Image  (on page 588).

Image Properties

When you use an image widget, in addition to the default settings, the following setting is available:

Field Name Description

Source The data source can be based on which queries have been added in the 

Page Data  section. It is also possible to provide a URL or select a file from 

the local machine.
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Possible Uses

You can add an image gallery in an application by adding several image widgets. Additionally, if 

application users use the camera widget, they can take an image, and then upload the image in to their 

application with a button. The button can send the image to an entity, and a query of that entity can use 

the image widget to display the picture.

Suppose you want to insert an image in an application, and want to direct the user to the home page when 

the image is selected. In that case, perform the following steps:

1. In the page designer, add an image widget to a page other than the home page.

2. Select the File  option, and select Choose File.

3. Select the image that you want to insert in the application.

4. In the Image Properties  section, in the Actions  box, select the action to go to the home page.

5. Save the application, and preview it.

When you select the image, the home page appears.

Graph
Graphs are data visualizations that you can add to display data in an application.

This widget is available only in Operations Hub Classic version.

Note:

You need external Internet access to use the graph widget.
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Graph Properties

To use a graph widget, in addition to the default settings, you must specify one of the following types of 

graphs.

Bars: Bar graphs show comparison among categories vertically. Specify the following settings for a bar 

graph:

Field Name Description

X-axis Label Displayed below the graph horizontally.

Y-axis Data The data source for the bars.

Y-axis Label Displayed on the left side of the bar graph.

Add All Fields This will add all the columns from the chosen entity. Each column can be 

labeled independently.

Sort By Since an entity can contain several different types of data, it is possible to 

sort the data depending on the data in an entity.

Columns: Column graphs are similar to bar graphs but are shown vertically instead of horizontally. Specify 

the following settings for a column graph:

Field Name Description

X-axis Label Displayed below the graph horizontally.

X-axis Data The data source for the columns.

Y-axis Label Displayed on the left side of the graph.
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Field Name Description

Add All Fields This will add all the columns from the chosen entity. Each column can be 

labeled independently.

Sort By Since an entity can contain several different types of data, it is possible to 

sort the data depending on the data in an entity.

Lines: Line graphs show how data changes over specific intervals of time. Specify the following settings 

for a line graph:

Field Name Description

X-axis Label Displayed below the graph horizontally.

X-axis Data The data source for the lines.

Y-axis Label Displayed on the left side of the graph.

Add All Fields This will add all the columns from the chosen entity. Each column can be 

labeled independently.

Sort By Since an entity can contain several different types of data, it is possible to 

sort the data depending on the data in an entity.

Pie: In a pie graph, rather than axis points, there is a value that can be set to a query to post data on the 

pie graph. Specify the following settings for a pie graph:

Field Name Description

Value The data source for the pie graph.

Title The title of the graph.

Y-axis Label Displayed on the left side of the bar graph.

Sort By Depending on the data, sorting may be necessary in order to highlight cer

tain information. Once the sort feature has been selected, it is possible to 

select ascending or descending order.

Possible Uses

Graphs are a way to show data visually. For example, if 50 students enrolled for a course, you can use 

a graph widget to show how their grades have changed over time or it may be beneficial to show what 

grades the students received by percent.
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When you plot the data stored in the M2M Entities using a graph widget, timestamp values are displayed 

in the following format: hh:mm

Downloading Data from a Graph

You can download data from an entity in a Microsoft Excel worksheet using a graph widget. To do so, in 

the Graph Properties  section, select the Allow Download  check box. The download button appears in the 

upper-right corner of the widget in the application.

Note:

• Downloading occurs based on the query last executed as shown in the graph.

• If the query is executed for the specific date range using Input boxes, for example, data is 

downloaded based on the condition specified.

• The entity data connected to the graph is downloaded, not the graph itself.

• If multiple queries are connected to the graph, a separate Microsoft Excel worksheet is 

generated for each query, and it is downloaded in a single worksheet.

• In the time_stamp  related fields of the M2M_data Entity, the values of milliseconds are also 

stored. However, only hour, minute, and second values can be displayed when you use the 

graph widget.

Visualization
This widget is available only in Operations Hub Classic version.

A visualization widget is a graph with additional features. The following features are available in a 

visualization widget:

• Line chart

• Area chart

• Bar chart

• Stacked bar chart

• Donut chart

• Multiple charts

• Additional y-axis

• Zooming in or out

• Grid lines

• Rotation
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• Support of negative values

• Improved look and feel of tooltips

• Ability to focus on a specific field on the chart

• Grouping using a query field

Important:

Due to the format of the data returned by Historian REST calls, the Visualization widget cannot 

display data from Historian sources.

Visualization Properties

When you use a visualization widget, in addition to the default settings of a widget, the following settings 

are available.

Field Name Description

Flow Select the query (from the ones added in the PAGE DATA  section) that 

should be used to retrieve information in the graph.

Switch Row/Column Select this check box if you want to switch the x-axis and y-axis data.

X-axis Provide values in the following boxes for x-axis settings:

• Data: Select the query field whose data should be plotted on the x-

axis.

• Label: Enter a label for the x-axis.

• Rotate Ticks: Select this check box to rotate ticks and avoid overlap

ping of data. The x-axis ticks might overlap if the data is large.

• Grid lines: Select this check box if you want to show grid lines.

Y-axis Provides values in the following boxes for y-axis settings:

• Label: Enter a label for the y-axis.

• Grid Lines: Select this check box if you want to show grid lines.

• Range: Select whether the range of the y-axis should be set automat

ically or manually. If you select Manual, the Min  and Max  boxes ap

pear, in which you must enter values.

Data Provide values in the following boxes for the data settings:
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Field Name Description

• Name: Enter the name of the graph.

• Type: Select the type of the graph: Bars, Lines, Area, or Donut.

• Data: Select the data source of the graph.

• Stacked: Select this check box if the graph should be plotted as a 

stacked bar chart. This option is available only for a bar chart.

• Color: Select whether the color of the graph should be selected auto

matically or manually.

Add Field Select this button if you want to plot another field on the graph.

Add All Fields Select this button if you want to plot all the entity fields.

Using a Visualization Widget

Suppose you want to plot the following information on a graph:

• Sales amount for two branches - Tokyo and Tel Aviv, plotted as a line chart and an area chart, 

respectively.

• Sales amount for two products - V26 and V27, plotted as a stacked bar chart.

• Breakdown of sales amount per branch - plotted as a donut chart.

To do so, perform the following steps:
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1. Create an entity to store the sales amount for the two branches and the two products.

2. Create a Get query to retrieve the sales amount.

3. In the page designer, in the PAGE DATA  section of the container, add the query.

4. Add two visualization widgets to the container.

5. Add the following headers for the visualization widgets:

◦ Lines/Area and Stacked

◦ Donut

6. For the Lines/Area and Stacked chart, provide values as described in the following table for the x-

axis.

Setting Description

Flow Select the query that you have created.

Data Select the daily field of the query.

Rotate Ticks Select the check box.

Grid Lines Select the check box.

7. Select Add Field.

An additional Data  section appears for the other y-axis.

8. Provide values as specified in the following table for the two y-axes.

Setting Description for the First Y-Axis
Description for 

the Second Y-Axis

Label Enter Amount. Enter Product.

Grid Lines Select the check box. Not applicable

Type Select Lines. Select Area.

Data Select the field that stores the 

sales amount for the Tokyo 

branch.

Select the field that stores the 

sales amount for the Tel Aviv 

branch.

Y-axis side Select Left. Select Left.

9. Select Add Field  twice. Two additional Data  sections appear for the two y-axes.

10. Provide values as specified in the following table for the two y-axes.
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Setting Description for the First Y-Axis
Description for 

the Second Y-Axis

Type Select Bars. Select Bars.

Data Select the field that stores the 

sales amount for the product 

V27.

Select the field that stores the 

sales amount for the product 

V26.

Stacked Select the check box. Select the check box.

Y-axis side Select Right. Select Right.

11. For the Donut chart, select Add Field twice, and provide values as specified in the following table.

Setting Description

Flow Select the query that you have created.

Donut Title Enter Breakdown Per Branch.

Type Select Donut  for both the boxes.

Data Select the field that stores the sales amount for 

V26 and V27, respectively.

12. Save the application, and preview it. The first graph displays a line chart and an area chart for the 

sales amount of Tokyo and Tel Aviv, respectively. It also displays a stacked bar chart for the sales 

amount of the two products, V26 and V27. The second graph displays a donut chart for the sales 

amount of V26 and V27.

Big Data
This widget is available only in Operations Hub Classic version.

The bid data widget is a visualization widget that supports big data. Compared to the visualization widget, 

the big data widget allows you to specify the range more accurately.

Note:

You cannot plot a donut chart or change the format of a date-time variable on x-axis for a big data 

widget.
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Important:

Due to the format of the data returned by Historian REST calls, the Big Data widget cannot display 

data from Historian sources.

Big Data Properties

When you use a big data widget, in addition to the default settings of a widget, the following settings are 

available.
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For instructions on configuring these settings, refer to Visualization  (on page 430).

About Zooming In and Zooming Out

Since the data displayed using a big data widget is huge, you can zoom in a selected area on the graph. 

To do so, you must specify the area precisely by dragging the mouse pointer on the area.

You can drag the mouse pointer in horizontal, vertical, or diagonal directions.

• If you drag the mouse pointer in a horizontal direction, the zoom-in area is set for only the x-axis.

• If you drag the mouse pointer in a vertical direction, the zoom-in area is set for only the y-axis.

• If you drag the mouse pointer in a diagonal direction, the zoom-in area is set for both x-axis and y-

axis.
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You can perform the following actions to zoom in or zoom out the widget:

• Zoom in a selected area by selecting .

• Pan across the widget by selecting .

• Zoom in from the center of the widget by selecting .

• Zoom out from the center of the widget by selecting .

• View the complete range of the graph by selecting .

• Reset the zoom level by selecting .

Grid
This widget is available only in Operations Hub Classic version.

A grid widget functions similar to a table widget. In addition, you can perform the following tasks:

• Change the width of a grid dynamically.

• Rearrange or remove the columns of a grid from an application.

• Export the data displayed in a grid to a .csv file. In addition, you can export data from selected 

columns.

• Sort the data displayed in a grid.

• View the data in a tree structure.

• Scroll till the end of the grid regardless of the number of rows the grid contains.

Grid Properties

When you use a grid widget, in addition to the default settings of a widget, the following settings are 

available.

Field Name Description

Allow Export Select this check box if you want to provide an option to application users 

to export the data in the grid to a .csv file.

Note:

This option is not available on iOS.
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Field Name Description

Tooltips Select this check box if you want tooltips to appear in the application.

Flow Select the query that should be used to retrieve information in the grid.

Tree View Select this check box if you want to display data in a hierarchical view. 

When you select this check box, the Nested flow  box appears, allowing you 

to select the query that fetches the data for the child level in the hierarchy.

Name Enter the name of the grid column.

Data Select this option if you want data in the column to be retrieved from an en

tity field using a column, and then select the field in the drop-down list box.

Formula Select this option if you want data in the column to be displayed based on 

a formula. For example, if an entity stores the marks scored by students 

for individual courses, you can create a formula to display the aggregate 

marks scored by each student.

Show <number> rows at a 

time

Identifies the number of rows that should appear by default in the grid. By 

default, the value in this box is 10. After you enter a value, the following op

tions are available:

• Load all: If you select this option, the grid will contain all the rows on 

the same page. However, if you access the application on a mobile 

device, each page in the grid will contain the number of rows that 

you specify. You can navigate to the other pages to access the rest 

of the rows.

• Infinite scroll: If you select this option, the grid will contain all the 

rows on the same page.

• Paging: If you select this option, each page in the grid will contain 

the number of rows that you specify. You can navigate to the other 

pages to access the rest of the rows.

Using a Grid

Suppose you want to use a grid to display a list of managers in an organization and the employees 

reporting to each manager. To do so, perform the following steps:
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1. Create an entity named Wiki Manager, add the fields Manager ID and Manager Name, and add the 

IDs and names of managers.

2. Create a Get query named Wiki Get All Managers to get all the records from the Wiki Manager 

entity.

3. Create an entity named Wiki Employee, add the fields Manager ID, Employee ID, and Employee 

Name, and add the respective details.

4. Create a Get query named Wiki Get Employee by Manager ID with settings as specified in the 

following image:

5. Create an application, and add a grid using the page designer.

6. In the PAGE DATA  section, add the Wiki Get All Managers query, and connect all the fields to the 

grid.

7. Select the Auto submit (as soon as data is available)  check box.

8. In the GRID PROPERTIES  section, select the Tree View  check box.

9. In the Nested flow  box, select the Wiki Get All Employee by Manager ID query. Two boxes named 

Row Limit  and Manager ID  appear.

10. In the Manager ID  box, select Wiki Get All Manager.Manager ID.

11. In the Flow  box, select Wiki Get All Managers.

12. In the Name  box, enter Manager Name.

13. In the Data  box, select the field that stores the names of managers.

14. Select Add Field, and then provide values as specified in the following table.

Field Name Description

Name Enter Manager ID.

Data Select this option, and then select Wiki Manager  in the drop-down list 

box that appears.

Mapping Select Wiki Employee.

15. Save the application, and preview it. A grid appears, displaying two sections. The first section 

contains a list of IDs and names of managers. The second section contains a list of employees 

that report to each manager.

Map
This widget is available only in Operations Hub Classic version.

A map widget is used to display a map in an application. It uses the Google Maps feature. You can use 

the map widget to display the location of a place on a map (for example, the location of each site of a 

company).
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Note:

You need external Internet access to use the map widget.

To display asset locations on the map, you must access the API key generated by Google  (on page 66).

Map Properties

When you use a map widget, in addition to providing values for the default fields for a widget, you must 

define the following settings.

Field Name Description

Label Identifies the title of the map.

Display Identifies the type of the map. You can select one of the following values:

• Roadmap: Displays the streets of an area. By default, this value is se

lected.

• Satellite: Displays a satellite view of the Earth.

• Terrain: Displays the geographical features of an area.

Layers Identifies the layer that you want to display on the map. You can select one 

of the following values:

• Transit: Displays the public transit network of an area.

• Traffic: Displays real-time traffic information on the map.

• Bicycling: Displays the bicycling paths of an area.

• None: Does not display any layer.

CENTER Identifies the center point of the map. You can specify the center point us

ing one of the following sources:

• Data: Select a query output or a global parameter whose value is the 

center point of the map.

• Manual: Enter the address or the latitude and longitude details of 

the center point manually, separated by a comma (for example, 

35.681168, 139.767059).

• User Location: Select this option to specify that the location of the 

device used by the application user is the center point of the map. If 

you select this option, the Update Center  check box appears. If you 
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Field Name Description

select this check box, the map center is automatically updated when 

the user moves.

Note:

If you select the User Location  option, when you access the 

map for the first time in the application, a message appears, 

asking you to allow the application to access your location.

• Automatic by Markers: Select this option to specify that the center 

point of the map is positioned such that all the markers are visible 

on the map. This option is enabled only after you add a marker.

Note:

The Zoom  box contains a value that determines the zoom 

level of the map. This box is disabled when you select the 

Automatic by Markers  option.

MARKERS Identifies the markers that should appear on the map. Select Add Marker, 

and then enter or select values in the following sections or boxes that ap

pear. See Markers table  (on page 442).

SHAPES Identifies the circle that covers the area of a location. For example, if the 

map displays the locations of sensors that capture the radio signals within 

a radius of 1 km, you can add a shape to each marker to indicate the area 

covered by each sensor.

Select Add Shape, and then enter or select values in the following sections 

or boxes that appear. See Shapes table  (on page 443).

Markers:

Field Name Description

Position Select one of the following options:
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Field Name Description

• Data: Select this option if you want to specify the position of the 

marker by means of a query or a global parameter.

• Manual: Select this option if you want to specify the position of the 

marker manually, and then enter the address or the latitude and lon

gitude details.

Label Select one of the following options:

• Data: Select this option if you want to specify the label of the mark

er by means of a query or a global parameter. This option is enabled 

only if you select Data  in the Position  section.

• Manual: Select this option if you want to specify the label of the 

marker manually, and then enter the label.

Marker Icon Select the icon and color of the marker.

Condition Select Add conditions, and then specify the conditions for displaying the 

marker.

Tip:

You can add multiple markers. For example, if you want one mark

er to represent sites whose overall plant efficiency is above 95 per

cent and another marker to represent sites below 95 percent, you 

can add the two markers with the same position data, and specify 

the conditions appropriately on each one.

Actions Select Add Action, and then specify the action that should be triggered 

when the marker is selected (for example, display more details about the 

location).

Shapes:

Field Name Description

Position Select one of the following options:
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Field Name Description

• Data: Select this option if you want to specify the position of the 

shape by means of a query or a global parameter.

• Manual: Select this option if you want to specify the position of the 

shape manually, and then enter the address or the latitude and longi

tude details.

Radius Select one of the following options:

• Data: Select this option if you want to specify the radius of the shape 

by means of a query or a global parameter.

• Manual: Select this option if you want to specify the radius of the 

shape manually, and then enter the radius in km.

Note:

The radius can also be used as a visual indicator of other parame

ters, such as signal strength.

Color Select the color of the shape. You can also specify the opacity.

Condition Select Add conditions, and then specify the conditions. For example, if you 

want the marker to represent the signal strength received by a sensor, you 

can add multiple shapes with different colors and the same position data, 

and then specify different signal strength conditions on each shape.

Table
This widget is available only in Operations Hub Classic version.

A table displays information, which can include text, links, and/or images. Each column in the table 

represents an entity field. The information that appears in a table cell is defined by selecting a query 

output or by using a formula.

Table Properties

When you use a table widget, in addition to the default settings for a widget, the following settings are 

available.
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Field Name Description

Allow Download Select this check box if you want to provide an option to application users 

to download the data displayed in the table.

Note:

The download feature is available only for entity data.

Flow Select the query or function that should be used to retrieve information for 

the table. Without a flow, a table will not display any data.

Name Enter the name of the table column.

Data Select this option if you want data in the column to be displayed from an 

output field of the selected flow, and then select the field in the drop-down 

list box.

Formula Select this option if you want data in the column to be displayed based on 

a formula. For example, if the data retrieved by a query represents a test 

score, you can use a formula to display the score as a percentage of the to

tal score.

Output data type Select the data type of the data displayed in the column.

Add Action Select this button if you want an action to be performed when a user se

lects a cell in this column.

Add Field Select this button if you want to add another column to the table.

Add All Fields Select this button if you want to add columns for all the output fields from 

the selected flow.

Load <number> rows at a 

time

Identifies the number of rows that should appear in the table. By default, 

the table displays all the rows retrieved by the query. If you select this 

check box, the Paging  and "Load more" button  options appear to allow the 

user to view more data.
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Field Name Description

• Paging: If you select this option, each page in the table will contain 

the number of rows that you specify. You can navigate to the other 

pages to access the rest of the rows.

• "Load more" button: If you select this option, the table will initially 

contain the number of rows that you specify. A Load more  button 

appears in the application, which allows the application user to re

trieve additional rows in the same page.

Possible Uses

Tables are a way to display information in an organized way. For example, if application users fill in their 

name and phone number in an application, a table can display the information in an easily understandable 

format. A more advanced example may be that employees in a company with a hundred employees enter 

the time they arrive and the time they leave each day. Each employee has a name, entry time, exit time, 

and ID in an entity. Using a table, you can display each employee's attendance record.

List

A list is a representation of data in bulleted points. To use the new version, refer to List  (on page 590).

List Properties

When you use a list widget, in addition to the default settings of a widget, the following setting is 

available.

Field Name Description

Source Identifies the source of the list values. You can specify one of the following 

types of sources:

• Hard Coded: Select this option to enter the list items manually.

• Dynamic: Select this option to generate the list items dynamically 

from a query output field.

Possible Uses

You can use a hard-coded list to display prerequisites to perform a task. You can use a dynamic list to 

display a list of asset IDs returned by a query.
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Using a List

Suppose you want to display a list of features available in an application by dynamically fetching the list 

from an entity. To do so, perform the following steps:

1. Create an entity named Features to store the list of features.

2. Create a query to get the list of features from the entity.

3. In the page designer, add a List widget.

4. In the PAGE DATA  section, add the query that you have created.

5. In the LIST PROPERTIES  section, in the Source  box, select Dynamic.

6. In the Value  box that appears, select the query output that fetches the list of features.

7. Save the application, and preview it.

The list of features stored in the entity appear in the application.

Gauge
Using a gauge widget, you can plot data on a visual display. Some of the gauge widgets use a color-coded 

scale. The color of the reading indicates the risk level associated with the value.

Types of Gauge Widgets

The following types of gauge widgets are available:

• Battery: In this gauge type, the value is plotted on a horizontal scale. This is the default gauge type. 

For example, the following image can represent a gauge that plots the speed of a vehicle in kph. 

The color-coded scale highlights whether the speed of the vehicle is safe or risky.

• Meter - Arc: In this gauge type, the value is plotted on a curved scale. For example, the following 

image can represent the percentage of unplanned power outage events out of the total number 

of power outage events. The color in which the plotted value appears indicates whether the 

percentage is acceptable.
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• Meter - Radial: In this gauge type, the value is plotted on a circular scale. The gauge can be an 

internal radial or an external radial depending on whether the scale appears inside the radial or 

outside. For example, the following image represents an external radial meter gauge that plots the 

temperature inside an engine combustion chamber.

The following image represents an internal radial meter gauge that plots the pressure inside an 

engine combustion chamber.
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• Tank: In this gauge type, the value is plotted on a vertical scale. For example, the following image 

can represent the amount of remaining lubricant in a tank with a capacity 300 liters. The color in 

which the plotted value appears indicates whether the lubricant level is safe or risky.

Also refer to Gauge Bar  (on page 567), Gauge Circular  (on page 569), and Gauge Linear  (on page 

570).

Gauge Properties

When you use a gauge widget, in addition to providing values for the default fields for a widget, you must 

define the following settings:
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Field Name Applicable 

Gauge Type

Description

Type All gauges Identifies the type of the gauge. You can select Battery, Meter, 

or Tank.

Style Meter Identifies the meter style. You can select one of the following 

values:

• Internal radial: This is the default option. If you select 

this style, the markings appear on the dial.

• External radial: If you select this style, the markings ap

pear outside the dial.

• Arc Meter: If you select this style, the meter appears as 

a color-coded semi-circle (instead of a dial). In addition, 

the Scale  and Needle  settings appear.

Source All gauges Identifies the source of the values plotted on the gauge. You 

can specify one of the following types of sources:

• Data: Select a query or a global parameter whose out

put you want to plot on the gauge.

• Manual: Enter a value manually that you want to plot on 

the gauge.

• Formula: Enter a formula to calculate the value that you 

want to plot on the gauge.

Sector Battery, Tank, Me

ter - Arc

Identifies the start position, color, and range for each sector in 

the gauge. See example  (on page 451).

Range All gauges Identifies the minimum and maximum values of the widget 

range, and units of measure of the gauge. You can also speci

fy the color for the first sector of the gauge. In the previous ex

ample, you will enter the values 0, 200, kph, and green in the 

Minimum, Maximum, Units, and Default Color  boxes, respec

tively.

Scale Meter - Arc Indicates whether you want to show the marking for each sec

tor or just the minimum and maximum markings of the gauge. 

In the Scale settings, select one of the following options:
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Field Name Applicable 

Gauge Type

Description

• Full: Select this option if you want to show the mark

ings for each sector of the gauge. By default, this op

tion is selected. In the previous example, if you select 

Full, the following markings appears: 0, 101, 161, 200

• Min/Max: Select this option if you want to show only 

the minimum and maximum markings of the gauge. In 

the previous example, if you select Min/Max, the follow

ing markings appear: 0, 200

Needle Meter - Arc Indicates whether you want to show or hide the needle for the 

reading. By default, this check box is selected.

Visual All gauges Identifies the color for the markings and the background of the 

widget. The following settings are available:

• Custom Colors: Select this check box if you want to use 

custom colors for the markings and the background. 

If you select this check box, the Color  and Background 

Color  boxes appear.

• Color: Select the color for the markings.

• Background color: Select the background color of the 

widget.

• Palette: Select the background color of the dial of the 

radial meter gauge. This box appears only if you want 

to use a meter gauge.

Example: Suppose you want to plot the speed of a vehicle. You want to categorize the speed range as 

follows:

Speed Range (in kph) Category

0 - 100 Acceptable

101 - 160 Slightly risky

161 - 200 Risky

200 - 260 Highly risky
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In this case, you will create four sectors and define the following settings:

Sector number Start position Color Label

1 0 Green Acceptable

2 101 Yellow Slightly risky

3 161 Orange Risky

4 200 Red Highly risky

Tip:

In the Color  box, you can enter a color name or the hexadecimal code of the color.

Html
Available in Operations Hub Classic only.

For the latest updated version, refer to HTML Editor  (on page 639).

The html widget is used to provide html code to create an application. For example, to add a drop-down 

list box to an application, instead of using the dropdown  (on page 414)  widget, you can use html code, 

along with css code, to create the drop-down list box with a customized look and feel.

Note:

The interaction of the html code can change based on how the responsive design works for some 

elements.

Html Properties

When you use the html widget, in addition to the default properties of a widget, the following properties 

are available.

Field Name Description

Flow Select the query  (on page 247)  that should be used to retrieve informa

tion for the widget. Without a flow, the widget will not display any data.

To populate values here, bind the html widget to a query on its PAGE DATA 

tab.
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Field Name Description

Select Data Select an entity field  (on page 234). Values in this drop-down list are 

populated based on the entities  (on page 225)  available in the selected 

query. Using these fields, you can connect data to components that you 

create using the html widget.

Next, select + Add Field  to add the selected entity field to the application 

for which you can add the html code.

Tip:

You can select + Add All Fields  to add all the entity fields at once.

Name Provide a name for the added entity field.

Data Select this option if you want to retrieve information from an output field.

Next, select the output field from Output data type. This drop-down list con

tains the output fields available in your selected query.

Note:

Select Data  value must be set to single  to update the output 

fields.

Manual Select this option if you want to provide manual values to retrieve informa

tion. Enter the value.

Formula Select this option if you want to retrieve information based on a formula. 

Build a formula.

Edit Code Select this button to access a code editor for html, css, and javascript. You 

can enter the custom code in the code editor.

Tip:

The javascript code editor contains instructions on how to use the 

javascript API.

Scoped css? Indicates whether the css code must be applied only to the html widget or 

globally.
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Field Name Description

• If you want the css code to be applied only to the elements in the 

html widget, select this check box.

• If you want the css code to be applied globally, clear this check box.

Using the Html Widget

Example 1:  Suppose you want to stream videos from YouTube based on values selected in a drop-down 

list box. To do so, perform the following steps:

1. When designing application pages  (on page 376), drag-and-drop the html and dropdown widgets 

to a container.

2. Select the dropdown  (on page 414)  widget in the container to access the DROPDOWN 

PROPERTIES  tab.

a. Under the GENERAL  section, provide the details as specified in the table:

Field Name Description

Label Enter Select an option.

Id Enter ytID.

Global Data Select the check box.

3. Select the html widget in the container to access the HTML PROPERTIES  tab.

a. Under the DATA  section, provide the details as specified in the table:

Field Name Description

Flow Select a query.

Select Data Select an entity field from the query, and do the following:

▪ Name: Enter ytID.

▪ Select Data.

▪ Output data type: Select the global variable (ytID) that 

stores the drop-down list box values.

A relationship is created between the dropdown and html widgets as shown in the following image.
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Example 2:  Suppose you want to create an application with the following pages:

• Compass: Displays a compass with the needle indicating the angle that an application user enters.

• Stylish Header: Displays text in a header with special effects.

• Tiles: Displays tiles of various colors.

• Marquee: Displays text that moves from one end to the other of the page.

To do so create the application pages  (on page 376)  for compass, stylish header, tiles, and marquee. 

Design the page layout for each as follows:

For Compass:
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1. Add an input  (on page 416)  widget to a container, and provide INPUT PROPERTIES  as specified 

in the table:

Field Name Description

General  > Label Enter Enter Angle:

General  > Id Enter direction

General  > Global Data Select the check box.

2. Add a html widget below the input widget, add a field, and provide values as shown in the image.

Field Name Description

General  > Id Enter compass

Data  > Name Enter angle

Data  > Select Data Select compass - direction  from the list.

Data  > Output data type Select Text field  from the list.

3. Select Edit Code  to access the code editor, and save these lines of code:

Html Enter these lines of code as shown in the following image:

<div class="compass">

  <div class="compass-inner">

    <div class="north">N</div>

    <div class="east">E</div>

    <div class="west">W</div>

    <div class="south">S</div>

    <div class="main-arrow">

      <div class="arrow-up"></div>

      <div class="arrow-down"></div>

    </div>

   </div>

  </div>
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Css Enter the following lines of code:

compass {

 

 width: 150px;

 height: 150px;

 font-size: 10px;

 background-color: transparent;

 border-radius: 100%;

 position: relative;

 margin: 0 auto;

 font-family: 'Lobster Two', Comic Sans MS;

 color: #2d2d2d;

} .compass-inner {

 

 width: 85%;

 height: 85%;
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 background-color: transparent;

 border-radius: 100%;

 position: relative;

 left: 6.9%;

 top: 6.9%;

 border: 2px solid #2d2d2d;

} .main-arrow {

 

 height: 100%;

 width: 7.5%;

 left: 46%;

 position: relative;

 padding-top: 3%;

 box-sizing:border-box;

 -webkit-transform: rotate(50deg);

 -moz-transform : rotate(50deg);

 -o-transform: rotate(50deg);

 -ms-transform: rotate(50deg);

 transform: rotate(50deg);

} .arrow-up, .arrow-down {

 

 width: 0;

 height: 0;

 border-bottom: 57px solid red;

 border-left: 4px solid transparent;

 border-right: 4px solid transparent;

 position: relative;

} .arrow-down {

 

 border-bottom-color: #2d2d2d;

 -webkit-transform: rotate(180deg);

 -moz-transform : rotate(180deg);

 -o-transform: rotate(180deg);

 -ms-transform: rotate(180deg);

} .north {

 

 position: absolute;



Operations Hub for Windows  | 3 - User Guide  | 459

 left: 45%;

 top: 2.5%;

} .east { position: absolute;

 

 left: 88%;

 top: 44%;

} .west {

 

 position: absolute;

 left: 7%;

 top: 44%;

} .south {

 

 position: absolute;

 left: 45%;

 top: 82%;

} @media (max-width: 600px) {

 

 .compass {

   width: 150px;

   height: 150px;

   font-size: 11px;

 }

.arrow-up, .arrow-down {

 

 border-bottom: 57px solid red;

 border-left: 4px solid transparent;

 border-right: 4px solid transparent;

} .arrow-down {

 

 border-bottom-color: #2d2d2d;

} } @media (max-width: 769px) {

 

 .compass {

   width: 150px;

   height: 150px;

   font-size: 11px;
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 }

.arrow-up, .arrow-down {

 

 border-bottom: 57px solid red;

 border-left: 4px solid transparent;

 border-right: 4px solid transparent;

} .arrow-down {

 

 border-bottom-color: #2d2d2d;

} } @media (max-width: 400px) {

 

 .compass {

   width: 100px;

   height: 100px;

   font-size: 11px;

 }

.arrow-up, .arrow-down {

 

 border-bottom: 38px solid red;

 border-left: 3px solid transparent;

 border-right: 3px solid transparent;

} .arrow-down {

 

 border-bottom-color: #2d2d2d;

} }

Javascript Enter the lines of code as shown in the following image:
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4. Save the compass page.

For Stylish Header:

1. Add a html widget, select Edit Code, and save these lines of code:

Html Enter the following lines of code:

<h1>3d text effect</h1>

Css Enter the following lines of code:

body{

  text-align:center;

  background:#dfdfdf;

}

h1{

  text-transform:uppercase;
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  font-size:72px;

  font-family:'Verdana';

  padding:30px;

}

Javascript Enter the following lines of code:

jQuery(document).ready(function(){

   $('h1').mousemove(function(e){

     var rXP = (e.pageX - this.offsetLeft-$(this).width()/2);

     var rYP = (e.pageY - this.offsetTop-$(this).height()/2);

     $('h1').css('text-shadow', +rYP/10+'px '+rXP/80+'px rgba(227,6,19,.8), 

 '+rYP/8+'px '+rXP/60+'px rgba(255,237,0,1), '+rXP/70+'px '+rYP/12+'px 

 rgba(0,159,227,.7)');

   });

});

2. Save the stylish header page.

For Tiles:

1. Add a html widget, select Edit Code, and save these lines of code:

Html Enter the following lines of code:

 <div class="tile"></div>

Css Enter the lines of code as shown in the following image:
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2. Save the tiles page.

For Marquee:

1. Add a html widget, select Edit Code, and save these lines of code:

Html Enter the lines of code as shown in the following image:
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Css Enter the lines of code as shown in the following image:
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2. Save the marquee page.

Save and preview the application. The application has four pages built using a html widget.

Interactive Map

An interactive map widget is used to display interactive markers or icons on a static background (for 

example, an image representing an asset or a static map). The position of a marker on the image is 

defined by the offset from the top and left borders.

In addition, using an interactive map, you can create an application that will:

• Provide an overview of the current state of an asset.

• Allow you to access a page to view more information.

• Send a command to control the asset.
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Interactive Map Properties

To configure settings for an interactive map, you must add an image, and then configure the settings for 

each marker. To do so:

1. In the page designer, add the interactive map widget to the page.

2. Select Upload Image, and then select the background image file.

Note:

◦ If you want to change the background image, you can upload a new image without 

affecting any markers that you have added.

◦ Background image file name must not exceed 40 characters.

3. Double-click the image where you want to add a marker.

A marker is created at the position at which you clicked.

4. Select the marker.

The settings for the marker appear in the INTERACTIVE MAP PROPERTIES  section. The 

coordinates are populated automatically; they identify the position of the marker.

Tip:

To fine-tune the position of the marker, you can drag the marker to the required position or 

modify the coordinates manually.

5. Select Add Marker, and then enter values as specified in the following table.

Field Name Description

Marker Type Identifies the type of the marker. You can select one of the following 

options:

◦ Shape: If you select this option, you can select one of the pre

defined shapes available in Operations Hub. By default, this op

tion is selected.

◦ Image: If you select this option, you can upload an image for 

the marker.

Color Identifies the color of the marker. This setting appears only if you have 

selected Shape  in the Marker Type  setting.



Operations Hub for Windows  | 3 - User Guide  | 467

Field Name Description

Shape Identifies the shape of the marker. This setting appears only if you 

have selected Shape  in the Marker Type  setting. You can select one of 

the following options:

◦ Round

◦ Square

Image Identifies the image for the marker. This setting appears only if you 

have selected Image  in the Marker Type  setting.

For example, if the marker identifies the position of a radiator fan, you 

can upload the image of a fan instead of using a predefined round or 

square shape for the marker.

Size Identifies the multiplier for the marker shape or image size. For ex

ample, if you enter 2, the marker size is double the default size. By de

fault, the value in this box is 1.

Label Identifies the text for the marker label if you want to display the label.

Label Color Identifies the color of the label as it appears in the application.

Data Label Identifies the data that is associated with the marker.

For example, suppose the interactive map plots the temperature of 

various components of a car. For a marker that identifies the position 

of a radiator fan in a car, you can map the data label with the output of 

the query that retrieves the temperature of the fan. When you access 

the application, the temperature value retrieved from the query is dis

played for the radiator fan.

You can select one of the following types of data labels:

◦ Data: Select this option if you want to display the data retrieved 

by a query, and then select the query output that you want to 

display.

◦ Manual: Select this option if you want to enter the data manual

ly, and then enter the value.

◦ Formula: Select this option if you want to display the data 

based on a formula.

Data Label Color Identifies the color and opacity of the data label.



Operations Hub for Windows  | 3 - User Guide  | 468

Field Name Description

Conditions Identifies the condition to show or hide the marker. For example, you 

can add a condition to show the marker only if the temperature of the 

component reaches 50 degrees Celsius.

Actions Identifies the actions to be performed when the marker is selected.

Note:

You can add multiple markers to a single position. Each marker can have a different shape, 

icon, or color to indicate different conditions. For example, if the temperature of a radiator 

fan in a car exceeds a certain limit, the green marker can be replaced with a red marker 

to indicate that the temperature is high. You can also configure a set of actions for each 

marker when selected.

Layouts

New Line
This widget is available only in Operations Hub Classic version.

A new line widget is used to add a line to separate the components of a page.

Possible Uses

If widgets are placed too close to one another, adding a new line creates a blank space between the 

widgets to enhance readability.

Separator
This widget is available only in Operations Hub Classic version.

A separator widget is used to add a line between widgets, thus creating a better or clearer order between 

the widgets.

Possible Uses

If an application displays a questionnaire, you can use a separator to divide the individual questions. This 

will arrange and group the questions together.
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Container
This widget is available only in Operations Hub Classic version.

A container widget is a layout element that creates a specific area for widgets within an application. A 

container is similar to the div element used in html. It is used as a box (invisible in the application) that 

helps organize the widgets in the application.

Container Settings

When you use a container widget, in addition to the default settings of a widget, the following settings are 

available.

Field Name Description

Show/Hide You can show or hide a container from the application for each of the fol

lowing device types:

• Mobile

• Tablet

• Desktop

Conditions When you specify conditions to a container, they are applied to all the wid

gets added to that container. For example, you can add a check box to the 

application to allow application users to show or hide the container.

Performance By default, this check box is cleared, indicating that data within the contain

er is loaded only when the container is shown in the application. If you se

lect the check box, the data within the container is loaded, regardless of 

whether the container is shown or hidden. Selecting this check box can re

duce the performance of the application.

Possible Uses

Container are used for the following purposes:

• Organization of content: You can use containers to organize widgets in rows and columns. You 

can then set information on varying planes to indicate the importance or sequence of information 

provided by the individual widgets in the container.

For example, suppose you want to create an application to allow application users to enter their 

user account details. In that case, add a container with two columns. The first column can contain 



Operations Hub for Windows  | 3 - User Guide  | 470

fields for the user's first name, last name, and phone number, whereas, the second column can 

contain fields for the user's email address and personal website address, along with a Submit 

button.

• Conditional content: You can use container to apply conditions to all the widgets in the container.

Repeater
A repeater is a widget that is used to repeat the content layout for each item in a list returned by a query.

For example, if a query returns a list of assets, the repeater can display the state of multiple parameters 

associated with each asset type using a combination of different widgets. Using a repeater has the 

following advantages:

• You can create a dashboard-type application that monitors multiple assets at the same time.

• You can use different layouts and styles for each widget in the repeater to match the data type of 

an asset parameters and to enhance visibility.

• The layout of the content only needs to be defined once in the designer and it will be repeated for 

each item in the list that you want to monitor.

• The content that is repeated is automatically updated when the underlying query is updated (for 

example, new assets are added or the list of assets is updated by means of conditions in the 

query).

For example, if an entity stores the temperature recorded by assets, you can use a repeater to display not 

only the temperature recorded by each device, but also a gauge to indicate whether each value is in the 

acceptable range, as shown in the following image.

This widget is available only in Operations Hub Classic version.
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Repeater Properties

When you use a repeater, in addition to providing values to the default fields for a widget, you must define 

the following settings.

Field Name Description

Flow Identifies the query to use to fetch data displayed in the repeater.

Multi-select This setting is used in combination with a map or a graph widget. If you se

lect this check box, a check box appears in each row of the repeater in the 

application, allowing the user to select which items should appear on the 

map or the graph. By default, this check box is cleared.

Checked If you have configured the Multi-select setting, this setting indicates the ini

tial state of the check box in each row of the repeater in the application. By 

default, this check box is cleared. If you select this check box, all the check 

boxes in the application are selected.

Action Identifies the action that should be performed when the repeater is select

ed. For example, suppose you want to allow the application users to select 

an asset, and then retrieve more information about the asset. In that case, 

select Set global value, and then select the global variable that stores the 

asset ID. The value set in this global variable is then used as an input to an

other query to retrieve data about the asset.

You can add multiple actions.

Load <number> rows at a 

time

Identifies the number of rows that should appear by default in the repeater. 

By default, the value in this box is 10. If you select this check box, the Pag

ing  and "Load more" button  options appear.

• Paging: If you select this option, each page in the repeater will con

tain the number of rows that you specify. You can navigate to the 

other pages to access the rest of the rows.

• "Load more" button: If you select this option, the repeater will initially 

contain the number of rows that you specify. A Load more  button ap

pears in the application, which allows the application user to retrieve 

additional rows in the same page.

Item Horizontal Alignment Identifies the number of repeater instances that will appear horizontally 

next to one another before moving to the next row.
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Field Name Description

For example, suppose you want to display the following information in the 

repeater.

De

vice ID

Latest Time Stamp

Device 1 2019/12/22 8:04:37:037

Device 2 2019/12/22 22:14:31:545

Device 3 2019/12/22 8:04:40:040

Device 4 2019/12/21 5:28:59:059

If you enter 2 in this box, the table is split as follows in the repeater.

De

vice ID

Latest Time Stamp De

vice ID

Latest Time Stamp

Device 1 2019/12/22 8:04:37:037 Device 2 2019/12/22 22:14:31.545

Device 3 2019/12/22 8:04:40:040 Device 4 2019/12/21 5:28:59:059

Refer to the following examples on how to use a repeater:

• Use Repeater for Basic Operation  (on page 472)

• Use Repeater for Multi-Select Operation  (on page 479)

Use Repeater for Basic Operation
The following steps are an example of using a repeater for a basic operation.

Suppose you want to use a repeater to display temperature recorded by multiple sensors, which is stored 

in the M2M_data entity. In addition to displaying the temperature, you can use a gauge widget in the 

repeater to highlight whether the temperature is in the acceptable range, as shown in the following image.
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1. Create the following queries:

a. GetDistinctDeviceIDs: To fetch a distinct list of device IDs from the M2M_data entity. Enter 

or select values as shown in the following image.
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b. GetLastDeviceTemperature: To fetch the measurement time (that is, time stamp) and the 

measured value of the temperature for each device. Enter or select values as shown in the 

following image.

2. Create an application, and then add a page.

3. Add a container to the page for the heading row, and perform the following steps:

a. Split the container into four columns.

b. In each column, add a header widget to contain the column headings.
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c. Specify the following column headings:

▪ Device ID

▪ Last Reading

▪ Temperature

▪ Gauge

d. In the Visual  section for each heading, select the Custom Colors  check box, and in the Color 

box, select the white color.

4. In the Visual  section, select the Custom Colors  check box, and in the Background Color  box, select 

the dark blue color.

5. Add a repeater for the data rows, and perform the following tasks:

a. Split the repeater into four columns.

b. In the first column, add a text widget and an input widget.

c. In the second column, add a text widget.

d. In the third column, add two text widgets.

e. In the fourth column, add a gauge widget.

The widget appears as shown in the following 

image.

6. Select PAGE DATA, and then perform the following steps:

a. Add the two queries that you have created.

b. For the GetDistinctDeviceIDs query, configure the settings as shown in the following image.
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c. For the GetLatestDeviceTemperature query, configure the settings as shown in the following 

image.

7. In the REPEATER PROPERTIES  section, in the Flow  box, select the query GetDistinctDeviceIDs.

8. In the PAGE DATA  section, from the the GetDIstinctDeviceIDs query, drag M2M_data.device_id to 

the text widget and the input widget in the first column of the repeater.

9. In the INPUT WIDGET PROPERTIES  section, select the Disabled  and Hidden  check boxes.

10. In the PAGE DATA  section, from the GetLastDeviceTemperature query:

a. Drag DeviceID to the input widget in the first column of the repeater.

b. Drag M2M_data.timestamp to the text widget in the second column of the repeater.

c. Drag M2M_data.data to the two text widgets in the third column and the gauge widget in the 

fourth column of the repeater.
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11. Select the text widget in the second column, and in the TEXT PROPERTIES  section, in the Format 

box, select DateTime.

12. Select the first text widget in the third column, and in the TEXT PROPERTIES  section, select Add 

Conditions, and then specify values as shown in the following image.

13. Select the second text widget in the third column of the repeater, and in the TEXT PROPERTIES 

section, perform the following steps:

a. In the Visual  section, select the Custom Colors  check box, and then in the Color  box, select 

red.

b. Select Add Conditions, and then specify values as shown in the following image.

14. Select the gauge widget in the repeater, and in the GAUGE PROPERTIES  section, perform the 

following steps:

a. Delete two of the color sections.

b. In the Start Position  and Label  boxes for the remaining color section, enter 50.

c. In the Maximum  box, enter 100.

d. In the Units  box, enter degrees Celsius.

The repeater widget appears as shown in the following 

image.
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15. Save the application, and preview it.

The application appears as shown in the following 

image.

Use Repeater for Multi-Select Operation
The following steps are an example of using repeater for a multi-select operation.

Suppose you want to use a repeater to plot a trend graph of temperature recorded by selected devices. 

You want to allow application users to select the devices whose temperature you want to plot in real time, 

as shown in the following image.
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1. Create the following queries:

a. GetDistinctDeviceIDs: To fetch a distinct list of device IDs from the M2M_data entity. Enter 

or select values as shown in the following image.
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b. GetLatestDeviceTemperature: To fetch the measurement time (that is, time stamp) and the 

measured value of the temperature for each device. Enter or select values as shown in the 

following image.

2. Create an application, and then add a page.

3. Add a container with six columns.

4. Except for the first column, merge the other five columns.

5. Add a repeater and a graph widget to the container, and add a header widget to the repeater, as 

shown in the following image.
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◦ The repeater provides a list of devices that the application users can select.

◦ The graph plots the temperature recorded by the selected devices.

6. Select PAGE DATA, and perform the following steps:

a. Add the two queries that you have created.

b. For the GetDistinctDeviceIDs query, configure the settings as shown in the following image.
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c. For the GetLatestDeviceTemperature query, configure the settings as shown in the following 

image.

7. In the REPEATER PROPERTIES  section, in the Flow  box, select the query GetDistinctDeviceIDs, and 

then select the Multi-select  and Checked  check boxes.

8. In the GRAPH PROPERTIES  section:

a. In the Type  box, select Lines.

b. In the X-axis Data  box, select M2M_data.timestamp from the GetLatestDeviceTemperature 

query.

c. In the X-axis Label  box, enter Time.

d. In the Y-axis Label  box, enter Temperature.

e. In the Data  box, select M2M_data.data from the GetLatestDeviceTemperature query.
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f. In the Label  box, select M2M_data.device_id from the GetLatestDeviceTemperature query.

9. In the GRAPH PROPERTIES  section, in the Responsive  subsection, set the height to 50 percent.

10. Select the header widget, and then in the HEADER PROPERTIES  section, select Data, and then 

select M2M_data.device_id from the GetDistinctDeviceIDs query.

11. Select PAGE DATA, and then perform the following steps:

a. For the GetDistinctDeviceIDs query, point to the row containing M2M_data.device_id, and 

then select . This will create a global variable for the ID.

b. For the GetLatestDeviceTemperature query, drag the input DeviceID to the global variable 

that you have created.

12. Save the application, and preview it.

The application appears as shown in the following image. You can 

use the check boxes to display or hide the temperature curve for each 

device.
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Tools

Event Settings
An event settings widget is used to allow users to turn on or off event notifications using the application.

This widget is available only in Operations Hub Classic version.

Using the Event Settings Widget to Control an Event

Suppose you want to trigger an event to send email notifications when the temperature recorded by a 

device reaches a certain limit, and you want users to specify the limit using the application. To do so, 

perform the following steps:

1. Create an email template named Temperature_Warning, which you will use to send email 

notifications.

2. Create an event named Temperature_Warning. In the event:

◦ Create a trigger based on a device.

◦ Create an action to send an email using the email template that you have created.

Tip:

For information on creating an event, refer to the Events  (on page 295)  section of the 

documentation.

3. Using the page designer, add the event settings widget to the relevant page of the application.

4. In the EVENT SETTINGS PROPERTIES  section, in the Event  box, select the event 

High_Temperature.

5. Save the application, and then access it.

The event settings widget appears in the application.

6. Select Add new notifier  to add an instance of the event.

The Event notifier  section appears, displaying the settings that you have configured.
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7. Change the settings as needed, switch the ON  toggle, and then select Create.

The event is now active and will be triggered when the temperature reaches the specified limit.

Upload Excel
The upload excel widget is used to upload data from a Microsoft Excel workbook. This data is used to 

update an entity that has been created in Operations Hub.

This widget is available only in Operations Hub Classic version.

When you use an upload excel widget, in addition to providing values for the default fields for a widget, 

you must define the settings as described in the table below.

Important:

Only workbooks with a single worksheet are supported in the upload excel widget.

Upload Excel Properties

Field Name Description

Label Identifies the name of the button that users will select in the application to 

upload data (for example, Upload Employee Data). By default, the value in 

this box is Upload Excel.

Entity Identifies the entity to be updated with the data from the Microsoft Excel 

workbook. When you select the entity, the entity fields appear along with a 

check box next to each field. These check boxes are selected by default, in

dicating that the data for the corresponding fields will be included in the Mi
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Field Name Description

crosoft Excel workbook. If you do not want to include data for a field, clear 

the corresponding check box.

Actions Identifies the actions to be performed after the data is uploaded. For exam

ple, you can add a table to the application to display the data that has been 

uploaded, and then use a submit query action to update the table.

Updating Data of Sales Representatives

Suppose you want to update the data of sales representatives that is stored in the SalesRep entity. It 

contains the following fields:

• Rep_Code

• Rep_Name

• Department

• Car_No

To update the entity using the upload excel widget, perform the following steps:

1. Create a Microsoft Excel workbook with the data that you want to update. It is recommended that 

the column names match the field names in the entity.

2. Using page designer, add the upload excel widget to the application.

3. In the Upload Excel Properties  section:

a. In the Label  box, enter Upload Sales Rep Data.

b. In the Entity  box, select SalesRep.

4. Save the application, and preview it.

A button labeled Upload Sales Rep Data  appears in the application.

5. Select Upload Sales Rep Data, and then select the workbook that you created.

The Select Column Mapping  window appears.

6. Enter or select values as specified in the following table.

Setting Description

Use Header 

Row Names

Select this check box if you want to use the names specified in the heading row in 

the workbook. When you select this check box, the Header Row Number  box ap

pears.
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Setting Description

Header Row 

Number

Enter the row number that contains the column names. Suppose the column 

names appear in the first row of the workbook. In that case, enter 1.

Import da

ta from row 

<number> to 

row <num

ber>

Enter the starting and ending rows in the workbook whose data you want to up

load. Suppose the data for the four fields that you want to upload appears in the 

first four rows in the workbook. In that case, enter 1 and 4.

Tip:

If you want to import data in all the rows in the workbook, leave the to row 

box blank.

Append Da

ta to existing 

data

Select this option if you want data from the workbook to be appended to the exist

ing data in the entity. By default, this option is selected.

Overwrite 

existing data

Select this option if you want data from the workbook to overwrite the existing da

ta in the entity.

Specify Col

umn Map

pings

For each field in the entity, select the column name in the workbook that you want 

to map. Suppose you want to map the Rep_Name field in the entity with the Repre

sentative Name column in the workbook. In that case, select Representative Name 

in the box that appears next to Rep_Name.

7. Select Import.

The SalesRep entity is updated with the data from the workbook.

Upload Devices
Using the upload devices widget, you can upload a list of assets to Operations Hub. This data is stored in 

the baseline M2M entities.

This widget is available only in Operations Hub Classic version.

To use an upload devices widget, save the asset data in a CSV file with the following columns.

Column Heading Purpose Usage Mapped to Entity Mapped to 

Entity Field

device_unique_name Identifies the 

unique ID of the 

This column is re

quired.

device_gateway device_id
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Column Heading Purpose Usage Mapped to Entity Mapped to 

Entity Field

device gateway 

or asset. This is 

the ID that the de

vice will use when 

sending data us

ing REST APIs or 

MQTT APIs.

M2M_groups_de

vice_thing

gateway_thing_id

device_type Identifies the type 

of the device gate

way or asset.

This column is re

quired.

device_gateway

supported_device_

gateway

device_type

device_type

unique_address Identifies the 

unique address of 

the device gateway 

(for example, imei 

number, mac ad

dress, unit ID).

If there is no 

unique address, en

ter None. This col

umn is required if 

the url column is 

blank.

device_gateway unique_address

url Identifies the URL 

for the device gate

way.

If there is no URL, 

enter None. This 

column is required 

if the unique_ad

dress column is 

blank.

device_gateway url

thing_unique_name This parameter is 

obsolete.

This column is re

quired and must be 

blank.

thing_type This parameter is 

obsolete.

This column is re

quired and must be 

blank.

group_name Identifies the 

name of the device 

group. If the group 

does not exist in 

This column is re

quired. If devices 

are not grouped, 

we recommend 

M2M_groups

M2M_groups_de

vice_thing

group_name

group_name
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Column Heading Purpose Usage Mapped to Entity Mapped to 

Entity Field

Operations Hub, it 

will be created.

that you enter the 

same value as in 

the device_type 

column.

group_type Identifies the group 

type. The support

ed group type is 

gateway.

This column is re

quired.

M2M_groups group_type

In addition, the CSV file can contain the following columns:

• Columns mapped to the device_gateway  entity:

◦ device_location

◦ device_altitude

◦ device_latitude

◦ device_longitude

◦ device_latlong

◦ device_username

◦ device_password

◦ device_firmware_ver

◦ device_description

◦ device_generic_1

◦ device_generic_2

• Columns mapped to the supported_device_gateway  entity:

◦ supported_description

◦ supported_manufactor

◦ supported_product_code

◦ supported_generic_1

◦ supported_generic_2

• Columns mapped to the M2M_groups  entity:

◦ group_generic_1

◦ group_generic_2

◦ group_description
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Integration

Integration Overview

The integration plugins are distributed under the following categories:

• Inputs  (on page 491)

• Charts  (on page 497)

• HMI  (on page 517)

• Display  (on page 558)

• General  (on page 592)

• Batch  (on page 640)

You can also use a list of native widgets  (on page 409)  available in Operations Hub.

Inputs

Inputs Overview

The following list of plugins are available under the inputs category:

• Button  (on page 491)

• Check Box  (on page 493)

• Radio Button  (on page 493)

• Slider  (on page 494)

• Text Area  (on page 495)

• Text Input  (on page 495)

• Toggle  (on page 496)

Button
Use a button to trigger an action in your application.

The plugin is available under INTEGRATION  > INPUTS. When designing application pages  (on page 

376), drag-and-drop button  to a container. To use the old version, refer to Button  (on page 421).
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Button Properties

Field Name Description

BEHAVIOR > Click Event Provide an action for the button plugin. For example, if you select Go to 

next page, the button will lead to the specified page in the end application. 

To add more actions, select +Add Action.

You can choose from these available actions:

• Submit: This action submits the data to the selected entity.

• Go to page: This action leads to the specified page within the appli

cation.

• Go to previous page: Use this action to navigate between historical 

entries created for the current application session. In the end app, 

selecting the button leads to a previously visited page from history. 

If there is no previous history, then the button remains idle.

• Go to next page: Use this action to navigate between historical en

tries created for the current application session. In the end app, se

lecting the button leads to the next page. In the absence of next ses

sion entries, the button remains idle.

• URL: This action leads to the specified (external) URL.

• Set global value: This action enables the data to be available glob

ally.

• Show Component: This action displays a hidden component in the end 

app.

• Hide Component: This action hides a component.

• Toggle Show/Hide: This action allows to switch between hidden and 

shown views of a component.

Label The label name that appears on the button.

Icon If you want to use an icon for your button, choose icons from DevExtreme 

or Font Awesome icon libraries.

Label Styling Formats the label: Font Family, Font Size, and Font Color  formats the label 

text. Background Color  adds a color to the label background. Background 

Hover Color  appears when you move your mouse over the label.

Hidden
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Check Box

The widget is available under INTEGRATION  > INPUTS. When designing application pages  (on page 

376), drag-and-drop checkbox  to a container. To use the old version, refer to Check Box  (on page 411).

Check Box Properties

Field Name Description

Target > Output Value Selecting the check box in the end app sends value to the target. Use a 

query or a global to specify the target data source.

Source > Input Value Provides input for the check box from a data source.

Source > Label 

(unchecked)

This is the label that appears when the check box is not selected.

Source > Label (checked) This is the label that appears when the check box is selected.

Label Styling Formats the label: Font Family, Font Size, and Font Color  formats the label 

text.

Check State Colors Select colors that appear in the background of the check box.

• Unchecked Background Color: This color appears when the check 

box is not selected.

• Checked Background Color: This color appears when the check box 

is selected.

Hidden

Radio Button

The widget is available under INTEGRATION  > INPUTS. When designing application pages  (on page 

376), drag-and-drop radio  to a container. To use the old version, refer to Radio Button  (on page 413).

Radio Button Properties

Field Name Description

Label A label name that appears as a header for the radio button.

Target > Output Value Provide the target data source to send information.

Source > Input Value Provide the input data source to receive values for the radio button.
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Field Name Description

Items Radio button requires multiple options. Select +Add Item  to add multiple 

options. For each item, specify a display text and value.

Label Styling Formats the label: Font Family, Font Size, and Font Color  formats the label 

text. Background Color  adds a color to the label background.

Hidden

Slider

The widget is available under INTEGRATION  > INPUTS. When designing application pages  (on page 

376), drag-and-drop slider  to a container. To use the old version, refer to Slider  (on page 419).

Slider Properties

Field Name Description

Label A label name that appears as a header for the slider.

Source > Input Value Provide the input data source to receive values for the slider. See Bind Your 

Data to Plug-ins  (on page 157).

Minimum Value Sets the minimum scale value.

Maximum Value Sets the maximum scale value.

Use Raw Format Select the check box to display numbers in raw format.

For example, a numeric value with 5 or more decimal places is shown as it 

is, and not rounded off.

Number of decimals This option appears if you do not want to display numbers in raw format.

In that case, enter the decimal places (0-7) to consider after the decimal 

point to format large numbers. Based on the decimals, the value is rounded 

off to the nearest whole number.

Target > Output Value Provide the target data source to send information.
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Field Name Description

Label Styling Formats the label: Font Family, Font Size, and Font Color  formats the label 

text.

Hidden

Text Area
Use this plug-in to create a text area to include large text.

The widget is available under INTEGRATION  > INPUTS. When designing application pages  (on page 

376), drag-and-drop textarea  to a container. To use the old version, refer to Text Area  (on page 424).

Text Area Properties

Field Name Description

Target > Output Value Provide the target data source to send information.

Source > Input Value Provide the input data source to receive values for the text area.

Use Raw Format Select the check box to display numbers in raw format.

For example, a numeric value with 5 or more decimal places is shown as it 

is, and not rounded off.

Number of decimals This option appears if you do not want to display numbers in raw format.

In that case, enter the decimal places (0-7) to consider after the decimal 

point to format large numbers. Based on the decimals, the value is rounded 

off to the nearest whole number.

Height (px, %, etc) Enter the size of the text area in pixels.

Hidden

Text Input
Use this plug-in to add a text box in your application.

The widget is available under INTEGRATION  > INPUTS. When designing application pages  (on page 

376), drag-and-drop Text Input  to a container.
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Text Box Properties

Field Name Description

Target > Output Value Provide the target data source to send information.

Source > Input Value Provide the input data source to receive values for the text box.

Use Raw Format Select the check box to display numbers in raw format.

For example, a numeric value with 5 or more decimal places is shown as it 

is, and not rounded off.

Number of decimals This option appears if you do not want to display numbers in raw format.

In that case, enter the decimal places (0-7) to consider after the decimal 

point to format large numbers. Based on the decimals, the value is rounded 

off to the nearest whole number.

The decimals will apply to Input Value, Minimum Value, and Maximum Val

ue  properties.

Display Mode Specify the input type for the taxt box, whether password, email or URL.

Enable Clear Field Action Select the check box to add a delete option in the end app to clear any data 

in the text box.

Label Styling Formats the text: Font Family, Font Size, and Font Color  formats the text 

entered in the text box.

Hidden

Toggle

The widget is available under INTEGRATION  > INPUTS. When designing application pages  (on page 

376), drag-and-drop toggle  to a container. To use the old version, refer to Toggle  (on page 420).

Toggle Properties

Field Name Description

Label A label name that appears as a header for the toggle.

True State The text that appears when the toggle is in true state. For example, On.

False State The text that appears when the toggle is in false state. For example, Off.
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Field Name Description

Target > Output Value Provide the target data source to send information.

Source > Input Value Provide the input data source to receive values for the toggle.

Label Styling Formats the toggle text: Font Family, Font Size, and Font Color  formats the 

label text and true/false state text.

Toggle Width Enter a width for the toggle.

Hidden

Charts

Charts Overview

The following list of plugins are available under the charts category:

• Line Chart  (on page 497)

• Pie Chart  (on page 500)

• Bullet Graph  (on page 501)

• Pareto Chart  (on page 504)

• Sparkline  (on page 506)

• Spider Chart  (on page 508)

• Timeline  (on page 511)

• Variwide Chart  (on page 515)

Line Chart
In a line chart, data points are connected by a line to help visualize the changes in data trends over a 

period a time.

The widget is available under INTEGRATION  > CHARTS. When designing application pages  (on page 

376), drag-and-drop Line Chart  to a container.
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Line Chart Properties

Field Name Description

Line Type Select from the available list of chart line types.

Source > Data Source Provide the input data source to receive values for the chart.

Use Raw Format Select the check box to display numbers in raw format.

For example, a numeric value with 5 or more decimal places is shown as it 

is, and not rounded off.

Number of decimals This option appears if you do not want to display numbers in raw format.

In that case, enter the decimal places (0-7) to consider after the decimal 

point to format large numbers. Based on the decimals, the value is rounded 

off to the nearest whole number.

Title Title name for the chart.

Subtitle Subtitle name for the chart.

Y Axis Title Title name for y-axis.

X Axis Title Title name for x-axis.

X Axis Mode Format the x-axis:

• Standard: Uses the standard format.

• Stagger: Staggers the labels on the x-axis.

• Rotate: Rotates the labels on x-axis.

X Axis Rotation If you choose to rotate labels, enter the degree of rotation.

Enable Line Limits Select/Clear the check box to show/hide line limits.

If you choose to show line limits at runtime, then enter the HiHi, Hi, Lo, LoLo 

limit values.

Labels External Enables external labels for the limits.

HiHi Label Enter a label name for HiHi limit.

HiHi Use the available options to configure the source values. Refer to Bind Your 

Data to Plug-ins  (on page 157).

HiHi Color Select a HiHi line color.
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Field Name Description

Hi Label Enter a label name for Hi limit.

Hi Use the available options to configure the source values. Refer to Bind Your 

Data to Plug-ins  (on page 157).

Hi Color Select a Hi line color.

Lo Label Enter a label name for Lo limit.

Lo Use the available options to configure the source values. Refer to Bind Your 

Data to Plug-ins  (on page 157).

Lo Color Select a Lo line color.

LoLo Label Enter a label name for LoLo limit.

LoLo Use the available options to configure the source values. Refer to Bind Your 

Data to Plug-ins  (on page 157).

LoLo Color Select a LoLo line color.

Legend Select the Visible  check box if you want to show the chart legend.

You can also use the vertical/horizontal options to position the legend in 

the chart.

Crosshair Select the check box if you want to show the crosshairs in the chart.

Show Points Select the check box if you want to show data points in the chart.

Point Symbol Select from the available list of symbols to represent the points in the 

chart.

Stacking • Stacked: Lines do not intersect in this chart.

• Full Stacked: Lines reach a total of 100% of the axis range at each 

point.

• None: No stacking.

Truncate X-Axis Select the check box to truncate the x-axis labels.

Hidden

Chart Line at Runtime

For timestamps to appear in an ascending order (oldest datetime comes first, latest comes last), the 

extension query  (on page 276)  Sort By  parameter should contain +  for timestamp.
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For timestamps to appear in a descending order (latest datetime comes first, oldest comes last), the 

extension query  (on page 276)  Sort By  parameter should contain -  for timestamp.

Chart showing line limits:

Note:

When exporting a chart to JPEG or PDF at runtime, make sure your browser's zoom is set to 100% 

or above.

Pie Chart

The widget is available under INTEGRATION  > CHARTS. When designing application pages  (on page 

376), drag-and-drop Pie Chart  to a container.

Pie Chart Properties

Field Name Description

Pie Type Select from the available list of pie charts.

Source > Data Source Provide the input data source to receive values for the chart.
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Field Name Description

Title Title name for the chart.

Subtitle Subtitle name for the chart.

Legend Select the Visible  check box if you want to show the chart legend. You can 

also use the options to position the legend in the chart.

Show Labels Select the check box if you want to show labels in the chart.

Show Tooltips Select the check box if you want to show tool tips in the chart.

Show Name Select the check box if you want to show label name.

Show Value Select the check box if you want to show values in the tooltip.

Show Percentage Select the check box if you want to show percentages in the tooltip.

Hidden

Note:

When exporting a chart to JPEG or PDF at runtime, make sure your browser's zoom is set to 100% 

or above.

Bullet Graph
Use bullet graphs to compare the performance of any two values.

The horizontal bar in a bullet graph represents the actual value, while the vertical line represents the target 

value. You can add color-coded range limits to visualize the progression status of the actual value to the 

target value.

The bullet graph widget is available under Integration  > Charts. When designing application pages  (on 

page 376), drag-and-drop GEBulletGraph  to a container.

The following list of properties are specific to this widget. For common properties, refer to Page 

Components (Classic)  (on page 653).

Bullet Graph Properties

Field Name Description

Title Enter a title name for the bullet graph. This name appears at runtime.
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Field Name Description

Engineering Unit Enter the unit of measurement for values.

Display Engineering Unit 

On Graph

If you select the check box, the specified unit appears next to the horizon

tal bar that represents the actual value in the graph. Clear the check box to 

hide the unit.

Target

Value

Use any of these options to specify the target and actual values in the 

graph:

• Query: Allows to select a query.

• Global: Allows to select a global parameter.

• Manual: Allows manual entry of values.

• Formula: Allows to create data formulas.

The bullet graph always compares only a single value against the target 

value. To compare multiple values, create multiple graphs.

When you drag and drop a query on the bullet graph, only the source value 

field gets updated. By default, the source target is set to 500.

Min Enter the minimum axis value for the graph.

Max Enter the maximum axis value for the graph.

Variant You have an option to use a bar graph instead of the bullet graph.

• Bullet: The default bullet graph displays a background progress bar.

• Bar: Displays a single bar graph.

Number Of Decimals Enter the number of decimal places to format actual and target values in 

the graph. The decimals do not apply to ticks.

For example, enter 1  to round off value to the nearest tenths, 2  to round off 

value to the nearest hundredths, so on.

Width (px) - 0 equals dy

namic

Enter the width of the graph in pixels. For example, 600.

If set to 0, the bullet graph widget occupies 100% of its container.

Height (px) - 0 equals dy

namic

Enter the height of the graph in pixels. For example, 130.
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Field Name Description

Orientation • Horizontal: This is the default display orientation for the graph.

• Vertical: If you select a vertical orientation, re-adjust the width and 

height of the graph.

Display EGU on Axis Ticks Select the check box if you want the engineering unit to appear next to each 

tick mark value.

Display Axis Ticks On Op

posite Side

Select the check box if you want the tick marks to appear above the graph.

By default, ticks appear below the graph.

Ticks Choose how to display the tick marks on the graph scale.

• Dynamic: Dynamically selects the tick mark range to display.

• Min/Max: Displays only min and max tick mark values.

• Hidden: Hides the tick marks.

Font Color Select a font color for the graph text.

Color Select a color for the horizontal bar in the graph that represents the actual 

value.

Target Color Select a color for the vertical line in the graph that represents the target val

ue.

Color Background Select a color to apply as a background for the graph.

Custom Limit(s) Select (+Add Item)  to set up custom range limits and add plot bands to 

your bullet graph. The plot bands appear in the background providing a vi

sual display of performance status.

1. Choose a Plot Band Option.

Manual Select this option if you want to enter from  and 

to  values to set up a range limit.

Percentage of 

Total

To set up a range limit, calculates the percent

age of the total value (maximum axis value) 

provided in the bullet graph.

Percentage of 

Target

To set up a range limit, calculates the percent

age of the target value provided in the bullet 

graph.
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Field Name Description

2. Select a unique color to help identify the range in the graph.

3. Use  and  to re-arrange the order of the range limits.

The order of the custom range limit impacts the graph. In the example fig

ure, the green band represents the first applied range limit (90 -100 % tar

get) followed by the rest of the range limits as per the order.

In bar variant graphs, whenever the value satisfies a specified range (plot 

band), the horizontal bar will reflect the color set for that range.

Historian REST Options Use this property to configure Historian REST queries. You can define 

which index of the result set to use as input data. The default Result Set 

Index  is 0, wherein the widget uses the first tag data from the query result 

set. Enter 1  to consider the second tag data, 2  for third, so on.

Select the Reverse Sorting Order  check box to reverse the query result set. 

The bottom record value is provided as input to the widget. Clear the check 

box to provide the top record value as input to the widget.

Hidden

Bullet Graph at Runtime

Pareto Chart
Plot a pareto chart for qualitative analysis of your data.



Operations Hub for Windows  | 3 - User Guide  | 505

You can use this widget to run a pareto analysis on your data. A pareto chart is a combination of colums/

bars and a line graph. The columns/bars represent individual values, and are arranged in a descending 

order. The pareto line represents the cumulative total of the values. This visual arrangement helps to 

identify the most important factors in a given dataset in order to make critical decisions.

The pareto chart widget is available under INTEGRATION  > CHARTS. When designing application pages 

(on page 376), drag-and-drop GEParetoChart  to a container.

The following list of properties are specific to this widget. For common properties, refer to Page 

Components (Classic)  (on page 653).

Pareto Chart Properties

Title Configuration

Field Name Description

Name Enter a title name for the pareto chart. This name helps to identify the pare

to chart at runtime.

Font Size (px) Set the font size for the title text in pixels.

Font Color Select a font color for the pareto chart text.

Width (px) - 0 equals dy

namic

If set to 0, the pareto chart occupies 100% of its container.

Height (px) Set a height for the pareto chart in pixels.

Label Configuration

Field Name Description

Y-Axis Label Enter a label name for the y-axis.

X-Axis Label Enter a label name for the x-axis.

X-Axis Rotation Enter the degree of rotation for the x-axis labels.

Axis Label Font Size (px) Enter the font size for the axis labels.

Line Configuration

Field Name Description

Width (px) Enter a value that defines the thickness of the pareto line in the chart.
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Field Name Description

Color Select a color for the pareto line.

Hidden

Series Configuration

Field Name Description

Variant Both variants are used to compare two or more values, wherein the length 

of the column/bar is proportional to the data value. Select between:

• Column: Inserts vertical columns to represent data in the chart. Use 

this variant for larger data sets.

• Bar: Inserts horizontal bars to represent data in the chart. Use this 

variant if your chart titles are long.

Color Select a color for the columns/bars in the chart.

Source - Data Source To provide values for the pareto chart, select the Query  tab to choose from 

queries that return output fields for the x-axis and y-axis data:

1. Reason (String)

2. Frequency/Occurrence (number)

Note:

Currently you can pass values to the widget using a query only.

Sparkline
Generate simple sparkline charts to visualize data trends.

Use the sparkline widget to create compact and easy to understand line charts. Configure sparkline 

properties to insert inline lightweight charts. The sparkline widget is available under INTEGRATION  > 

CHARTS. When designing application pages  (on page 376), drag-and-drop GESparkline  to a container.

The following list of properties are specific to this widget. For common properties, refer to Page 

Components (Classic)  (on page 653).
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Sparkline Properties

Field Name Description

Title Enter a title name for the sparkline. This name helps to identify the 

sparkline chart at runtime.

Engineering Unit Enter the engineering unit of measurement for values.

Height - 0 equals 100% Set the height in pixels. If set to 0, the sparkline chart occupies 100% of its 

container.

Font Color Select a font color for the title name, current value, and engineering unit.

Font Size (px) (0 equals 

Dynamic)

Set the font size in pixels. If set to 0, the font size becomes dynamic, which 

means the font is resized based on the height of the widget.

Line Color Select a color for the line.

Line Width Enter a value in pixels that defines the thickness of the line in the chart.

Number of decimals Enter the number of decimal places to format values.

For 1 decimal place, the value is rounded off to the nearest tenths; for 2 

decimal places, the value is rounded off to the nearest hundredths, so on.

Source - Value Select any of these options to provide values from a data source. The only 

output field should be Value.

• Query: Allows to select a query that returns Value as output.

• Global: Allows to select an output field value that is available as a 

global parameter.

• Manual: Allows to enter the value (to feed the plug-in) in the text 

field.

• Formula: Allows to build a formula that returns a Value as output.

• Fetch Data Property: Is activated when you drag and drop  (on page 

120)  tag data on the plug-in.

Result Set Index This property is applicable for Historian REST queries only. It allows to de

fine which index of the result set the widget should use as input data. De

fault is 0.

For example, consider a Historian REST query that returns data for three 

tags.
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Field Name Description

• If you want the widget to use the first tag data from the query result 

set, then set the index value as 0.

• To direct the widget to use the second tag data, enter the index val

ue as 1.

• Similarly, you can set index values as 2, 3, 4, etc. based on the data 

to provide as input to the widget.

Reverse Sorting Order This property is applicable for Historian REST queries only. It helps to re

verse the query result set.

Select the check box to provide the bottom record value as input to the wid

get.

Clear the check box to provide the top record value as input to the widget.

When you apply this property to REST queries that return more than one 

record for each input tag, the records of the selected tag (use Result Set In

dex  to select the tag) are reversed.

For example, consider a Historian REST query with two input tags (tag1 and 

tag2); each with 100 records as result. Set the Result Set Index  as 0  and 

verify the following:

• If you selected the Reverse Order  check box, then the 100th record 

(last) value of tag1 is displayed on the sparkline.

• If you cleared the Reverse Order  check box, then the first record val

ue of tag1 is displayed on the sparkline.

Hidden

Spider Chart
Use spider charts to compare and analyze multiple data sets.

With the spider chart widget, you can:

• Create visually appealing spider graphs.

• Apply unique color coding for efficient comparison of data.

• Analyze values that change over a period of time.

• Use the resultant information for better decision-making.
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The spider chart is available under INTEGRATION  > CHARTS. When designing application pages  (on page 

376), drag-and-drop GESpiderChart  to a container.

The following list of properties are specific to this widget. For common properties, refer to Page 

Components (Classic)  (on page 653).

Spider Chart Properties

Field Name Description

Title Enter a title name for the spider chart. The title appears at runtime.

Font Color Select a font color  (on page 660)  for the spider chart text.

Line Color Select a line color  (on page 660)  for the spider chart axes.

Default Min Enter the minimum axis value.

• This value is set as default.

• Applies to all the available axes on the spider chart.

Default Max Enter the maximum axis value.

• This value is set as default.

• Applies to all the available axes on the spider chart.

Legend Select:

• Bottom: Legend appears at the bottom of the chart.

• Right: Legend appears on the right side of the chart.

• None: Hides the legend.

Max-width Enter the maximum width the spider chart can occupy in an application.

Axis Labels Add items to create multiple axes in a spider chart. Enter the following in

formation for each item (axis):

• Label: A label name to identify the axis.

• Alt. Min: Alternate minimum axis value if you want to override the 

Default Min  value.

• Alt. Max: Alternate maximum axis value if you want to override the 

uiDefault Max  value.

Series Add items to set up a data series for the spider chart.
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Field Name Description

• Name: Enter a name for the data set.

• Color: Select a line color  (on page 660)  for the data set.

• Fill: If you select the check box, the data set area is filled with the se

ries color.

• Source Value: To get values for the data set, choose any of these op

tions:

◦ Query: Select a query to get output values from a data source.

◦ Global: Select a global value that returns an array as output.

◦ Manual: Enter semicolon separated values.

• Reverse Sorting Order: This property applies to Historian REST 

queries only. It helps to reverse the query result set.

◦ If you select the check box, the bottom record value is taken 

as input.

◦ If you clear the check box, the top record value is taken as in

put.

Hidden

Spider Chart at Runtime



Operations Hub for Windows  | 3 - User Guide  | 511

Timeline
Use the timeline widget to visually monitor the progress of your events.

Generally used for time-based events, the timeline widget can monitor the status of a machine and update 

the events that occurred over a time period. It can capture data on how long a machine was running, or 

remained in an idle state. To visualize multiple events against a single time period, add multiple timelines 

aligned to the same X-axis on a chart.

The timeline widget is available under Integration  > Charts. When designing application pages  (on page 

376), drag-and-drop GETimeline  to a container.

The following list of properties are specific to this widget. For common properties, refer to Page 

Components (Classic)  (on page 653).

Timeline Properties

Field Name Description

BEHAVIOR  > Event Select

ed

Trigger actions on the timeline selected event.

Title Enter a title to help identify the timeline at runtime.

Font Color Select a font color  (on page 660)  for the widget text.

Show Border Select the check box to add a border to the timeline widget. A border 

frames the widget and provides a clean look.

Border Color Select a color  (on page 660)  for the border.

Show X-axis Labels Select the check box to show the X-axis ticks on the widget at runtime. 

Clear the check box to hide the ticks.

Width Enter a width for the timeline widget.

Height Enter a height for the timeline widget.

Event Table Datasource The event table helps to match the colors and labels. It enables the widget 

to assign a specific color and label to an incoming event.

When a value from the result set  (on page 513)  matches a value from the 

event table, then the configured color and label applies to that entry. You 

can configure an event table either manually  (on page 512), or get data 

from a data source.



Operations Hub for Windows  | 3 - User Guide  | 512

Field Name Description

Select the output fields in this order:

• Value

• Label

• Color

Use any of these options to get data from a data source:

• Select a query output.

• Select a global parameter.

• Enter source data manually.

• Add a formula.

Note:

Currently, we only support the option to use a query output to re

trieve data.

Point Primary Color Serves as the first color in the zebra striped color pattern. Select a prima

ry color  (on page 660)  to apply to the timeline event table if not retrieving 

values from a datasource.

Point Secondary Color Serves as the second color in the zebra striped color pattern. Select a sec

ondary color  (on page 660)  to apply to the timeline event table if not re

trieving values from a datasource.

Event Table Manual You can create event table entries manually. In the absence of an Event Ta

ble Datasource, these entries are used for retrieving data for the timeline 

events.

• Select +Add Item  to create an event table entry.

• For each event table entry, enter these details:

◦ Value

◦ Label

◦ Color

Events that do not match an entry from the event table are assigned the 

Point Primary Color  or Point Secondary Color.
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Field Name Description

Datasource Values Configure one or more data sources to get values for the timeline widget. 

When you add multiple data sources, you get a single view for multiple 

timelines all aligned to the same X-axis. It allows you to compare data at 

different time intervals. To configure a data source:

1. Select +Add Item.

Note:

You must add an item even if you want to drag and drop the 

data to bind to the widget.

2. Enter a Name  to identify the data source at runtime.

The name is shown next to the timeline and on the tooltip. If you do 

not provide a name for the data source, the query name appears on 

the tooltip.

3. Use any of these options to get data from a data source:

◦ Select a query output.

◦ Select a global parameter.

◦ Enter source data manually.

◦ Add a formula.

You must select timestamp as the first value followed by other val

ues. Select the output fields in this order:

◦ Datetime

◦ Value

Note:

• Currently, we only support the option to use a query output 

to retrieve data.

• If you drag-and-drop  (on page 120)  multiple tags on the 

timeline widget, only the last selected tag is bound to the 

output. Only one data source value can be bound per query.
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Field Name Description

Input Datetime Format Select from local or UTC.

Start Sample Select the Enable  check box to insert an event at the start of the timeline. 

Then, specify the start timestamp.

Datasource Start Time

stamp

Use any of these options to provide start timestamp values from a data 

source:

• Select a query output.

• Select a global parameter.

• Enter source data manually.

• Add a formula.

Note:

When using multiple REST query data sources, ensure that the 

start time for all the REST query data sources closely match with 

one another.

Datasource Start Value Use any of these options to provide event value at the start (after time

stamp) from a data source:

• Select a query output.

• Select a global parameter.

• Enter source data manually.

• Add a formula.

End Sample Select the Enable  check box to insert an end time for the last event on the 

timeline. Then specify the end timestamp.

Datasource End Time

stamp

This is the final timestamp for the last event in the query. It is required to 

specify an end timestamp to get all the values from last queried batch on 

display.

Use any of these options to provide end timestamp values from a data 

source:

• Select a query output.

• Select a global parameter.
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Field Name Description

• Enter source data manually.

• Add a formula.

Output Targets You can configure output targets for a selected event. At runtime, these tar

gets trigger only on selecting the respective event.

• Select +Add Item  to configure an output target.

• Select an Output Value. The available values are Start Local Time, 

Start Local Time ISO, Start UTC Time, Start UTC Time ISO, End Local 

Time, End Local Time ISO, End UTC Time, End UTC Time ISO, Value, 

and Label.

• To specify a target source/tag, use a query or global.

You can add one or more output targets for an event.

• Use  and  to reorder output targets. The output targets are 

implemented in the specified order.

• Select  to delete an output target.

Hidden

Timeline at Runtime

Variwide Chart
A variwide chart is a column chart where each column has a separate width to represent the third 

dimension.

The variwide chart is available under INTEGRATION  > CHARTS. When designing application pages  (on 

page 376), drag-and-drop GEVariwideChart  to a container.
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The following list of properties are specific to this widget. For common properties, refer to Page 

Components (Classic)  (on page 653).

Variwide Chart Properties

Field Name Description

Title Configuration Set a title for your variwide chart.

• Name: Enter a title name.

• Font Size (px): For the title text, enter the font size in pixels.

• Font Color: Select a font color for the title.

• Width (px) - 0 equals dynamic: Enter a width for the variwide chart. 

If set to 0, the chart occupies 100% of its container, and fills the area 

in the application.

• Height (px): Enter the height of the chart in pixels.

Label Configuration Configure the axes labels in your variwide chart.

• Y-Axis Label: Enter a label name that appears on the chart's y-axis.

• X-Axis Label: Enter a label name that appears on the chart's x-axis.

• Font Size (px): For the label text, enter the font size in pixels This val

ue applies to both the x and y axis labels.

Series Configuration Select query output values from a data source to define a data series for 

your chart.

Only three inputs from the query are considered for mapping in the follow

ing order:

• first output field maps to category (x-axis)

• second output field maps to value (y-axis)

• third output field value represents the width of the column chart (z-

axis)

Series color configuration 

- manual

Add items to configure colors in your chart. Use this property to override 

the default chart series color.

• Label: Enter the label name if you want to apply a specific color for 

the respective label.

• Color: Choose a color to apply to a label (if label name is specified), 

or a column.
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Field Name Description

If you configure both label and color, the column with the label name al

ways appears in the specified color.

If you configure only color, the color is applied to a column in a sequential 

order.

Columns with no color configuration adopt the default highcharts  configu

ration.

Hidden

Variwide Chart at Runtime

In the illustrated example, pump pressure is represented by the width of each column for the respective 

category.

HMI

HMI Overview

The following list of plugins are available under the HMI category:

• CIMPLICITY HMI Webspace  (on page 517)

• Alarm Card  (on page 530)

• Alarm Count  (on page 541)

• Mimic Card  (on page 541)

CIMPLICITY HMI Webspace
Use the widget to access CIMPLICITY CimView screens.

https://www.highcharts.com/docs/chart-and-series-types/variwide-chart
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Employ the Webspace widget with other Operations Hub widgets for better consolidation and 

visualization of data. This provides you with an end-to-end solution for better data analysis, visualization 

and monitoring. Refer to Integrating Webspace with Operations Hub  (on page 520).

The Webspace widget is available under Integration  > HMI. When designing application pages  (on page 

376), drag-and-drop the widget to a container, and configure its properties.

Note:

Only a single instance of the CIMPLICITY HMI Webspace widget per app is supported. If using 

multiple instances of webspace widgets across multiple pages, you may encounter access error 

messages when navigating between pages that contain webspace instances. After confirming 

the message, the widget loads as expected.

Webspace Properties

Field Name Description

Height offset Webspace frame will take the proportion specified in Relative height of the 

browser window minus this offset. It is useful when there are other widgets 

on the page above or below the Webspace frame.

Relative height (%) Webspace frame will take this proportion of the height of the browser win

dow minus the Height offset. It is useful when there are multiple Webspace 

widgets placed vertically on the page.

Screen Variables A list of name/value pairs that correspond to the variables used on a CIM

PLICITY screen. For non-manual configuration this list is expected to be a 

JSON string:[{ "name":"..", "value": ".."}, ...]

Webspace server Specify the machine that has CIMPLICITY Webspace running on it.

CIMPLICITY screen path Specify the path to the CimView screen to load. This path is where the file 

resides on the Webspace system:

C:\ProjectsFolder\screens\ScreenName.cim

Project for unqualified 

points

CimView will use this project name to provide values for unqualified points.

Zoom to best fit If the CimView screen sizes are different, zoom to best fit provides auto

matic consistency in the Webspace frame.
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Field Name Description

Disable point targets Prevents point targets, e.g. Point Control Panel and quick trends, from be

ing available.

Disable setpoints Prevents point values from being set on the CIMPLICITY screen.

Port for the Webspace 

Session Manager

The port configured on the Webspace system for the Webspace Session 

Manager service. 9443  is the default port setting.

Start maximized Select the check box if you want to open CimView screen in a maximized 

window filling the whole Webspace frame.

Always maximized Select the check box if you want the screen will always be maximized in the 

Webspace frame.

Restrict screen opening Select the check box if you want to open only the CimView screens that are 

explicitly mentioned in Open Screen and Overlay Screen actions.

Disable window resizing Select the check box if you do not want to allow resizing the CimView 

screens within the Webspace frame.

Don't show caption and 

menu

Select the check box if you want to hide the CimView menu bar and caption 

in the Webspace frame.

Time without input till qui

escent update rate

Webspace will continue to send updates to the client at the normal rate for 

the number of seconds entered after the user stops using the keyboard 

and/or mouse.

Time between updates 

when quiescent

When the number of seconds to wait after the user stops using the key

board and/or mouse have been reached, Webspace will begin sending the 

updates at this rate.
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CIMPLICITY HMI Webspace at Runtime

The first time a strong encrypted session is loaded, a message appears stating that the Proficy Webspace 

Strong Encryption license has been updated and needs a restart. If this error occurs, then restart these 

services in the following order (on the Webspace node):

1. Proficy WebSpace License Manager

2. Proficy WebSpace Application Publishing Service

3. Webspace Session Manager Microservice

Integrating Webspace with Operations Hub
This topic describes the setup and configuration of Operations Hub with CIMPLICITY WebSpace.

Install the following applications:

• CIMPLICITY 11.1

• WebSpace 6.0 (with update 6.0.3, and Strong Encryption License)
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• Operations Hub 2.0 (with SIM 4)

• Google Chrome (installed on each node)

You must have the following account information:

• Operations Hub secret (from installation)

• Operations Hub Administration Username/Password (default usually ‘ophubadmin’)

1. Add Operations Hub root certificate to the root certificate store on Operations Hub machine  (on 

page 41).

2. Enable the encrypted transport for communications via the Webspace server  (on page 521).

3. Set up the IIS to listen on port 443  (on page 522).

4. Configure the Windows firewall  (on page 524).

5. Export the CIMPLICITY self-signed certificate  (on page 525).

6. Import the CIMPLICITY self-signed certificate to Operations Hub  (on page 526).

7. Set up CIMPLICITY project properties  (on page 526).

8. Set up CIMPLICITY project user security  (on page 528).

9. Configure CIMPLICITY options  (on page 528).

Webspace - Enable Encrypted Transport
You must enable the encrypted transport for communications via the WebSpace server.

1. Open the WebSpace Administrator on the server running WebSpace.

2. Go to Tools  > Host Options  > Security.

3. For Transport, select Encrypted.

4. Browse to the CIMPLICITY installation\ScadaConfigPki  folder, then select the server_cert.crt  file.

For a default installation, the certificate location would be: C:\Program Files (x86)\Proficy

\Proficy CIMPLICITY\ScadaConfigPki\server_cert.crt
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5. Select OK  to save and close Host Options.

IIS Configuration - Set up HTTPS Binding for port 443
You must set up the Microsoft Internet Information Services to listen on port 443 so that it can be used 

for https requests, which are necessary for the Operations Hub integration.

1. Log in to the CIMPLICITY/Webspace machine.

2. Go to Start  > Control Panel  > Administrative Tools.



Operations Hub for Windows  | 3 - User Guide  | 523

3. Open Internet Information Services (IIS) Manager.

4. On the left-hand pane, select the root of the IIS Server, usually listed as the computer name.

5. Select Server Certificates.

6. On the right-hand pane, select Create Self-Signed Certificate.

7. Enter name as ProficyWebspace, and select Personal  as the certificate store.

8. Select OK  to save.

9. On the left-hand pane, select the root of the IIS Server, usually listed as the computer name.

10. On the left-hand pane, select Default Web Site.
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11. On the right-hand pane, go to Edit Site  > Bindings.

12. Select Add  to open Edit Site Binding.

13. Select https  as type.

14. Select All Unassigned  as the IP address.

15. Enter 443  for port.

16. Enter the computer name of the Webspace system as host name.

17. Select ProficyWebspace  as the SSL Certificate.

18. Select OK.

19. On the Site Bindings  dialog, select Close.

20. On the left-hand pane, select the root of the IIS Server, usually listed as the computer name.

21. On the right-hand pane, select Restart  to restart the IIS Server.

Configure Windows Firewall
Open the Windows Firewall ports on each system so that the two nodes (WebSpace/Operations Hub) can 

communicate properly.

Open Windows Powershell as an administrator to run the commands.
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1. On the Operations Hub system, run the following commands to open the firewall ports.

a. Open Operations Hub port 443 (Operations Hub reverse proxy port):

New-NetFirewallRule -DisplayName "my_port_443" -Direction Inbound

-Action Allow -Protocol TCP -LocalPort 443

2. On the CIMPLICITY/WebSpace system, run the following commands to open the firewall ports.

a. Open CIMPLICITY port 9443 (Public external REST port for NGINX):

New-NetFirewallRule -DisplayName "my_port_9443" -Direction

Inbound -Action Allow -Protocol TCP -LocalPort 9443

b. Open CIMPLICITY port 443 (the WebSpace/IIS port):

New-NetFirewallRule -DisplayName "my_port_443" -Direction Inbound

-Action Allow -Protocol TCP -LocalPort 443

c. Open CIMPLICITY port 491 (the WebSpace server port):

New-NetFirewallRule -DisplayName "my_port_491" -Direction Inbound

-Action Allow -Protocol TCP -LocalPort 491

Export CIMPLICITY Self-Signed Certificate
Export this certificate that was created when CIMPLICITY was installed on the system.

The certificate is exported and then imported into the Trusted Certificate store on the Operations Hub 

computer.

1. Open Windows Run, and enter certmgr.msc.

2. Go to Trusted Root Certification Authorities  > Certificates.

3. Select the certificate named CIMPLICITY<computer_name><datetime>@SelfsignedRootCA.

4. Right-click CIMPLICITY self-signed certificate, then select All Tasks  > Export.

The Certificate Export Wizard  appears.

5. Select Next.

6. When prompted for the Export File Format, select DER encoded binary X.509 (.CER).

7. Select Next.
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8. Select Browse, enter file name of CIMPLICITY_Self_Signed and choose to save on the Desktop.

9. Select Next.

10. Select Finish.

Import CIMPLICITY Self-Signed Certificate
Import the CIMPLICITY self-signed certificate to the Operations Hub computer.

Export CIMPLICITY Self-Signed Certificate  (on page 525).

1. Copy the exported certificate on the Operations Hub computer.

2. Right-click the certificate, and select Install Certificate.

The Certificate Import Wizard  appears.

3. Select Local Machine, then select Next.

4. Select Place all certificates in the following store.

5. Select Browse  to access the Select Certificate Store.

6. Select Trusted Root Certification Authorities  at the store, then select OK.

7. Select Next  in the import wizard.

8. Select Finish.

The certificate is imported successfully.

Set up CIMPLICITY Project Properties
Configure CIMPLICITY to interact with the Webspace widget in Operations Hub.

1. Open the CIMPLICITY project that you have access via Operations Hub, in the CIMPLICITY 

workbench.

2. Go to Project  > Properties

The Project Properties  dialog appears.

3. Select the Operations Hub  tab, and provide these details:
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Field Description

Server name Enter the computer name of the Operations 

Hub server.

Port Enter 443.

User name Enter the administrator account for the Opera

tions Hub Server, i.e. OpHubAdmin.

SSL Security If (Not Trusted), follow these steps:

a. Select the check box for Require trusted 

connection.

b. Select View Certificate. The certificate 

fields should be populated.

Note:

The certificate retrieved from 

the Operations Hub server is 

placed in the <project>/da

ta/WebHMIPki/server_certs  fold

er.

c. Go to <project>/data/WebHMIPki/serv

er_certs/  folder, and copy the certifi

cate called <opshub servername> Root CA 

<datetime>.cert

d. Paste the certificate in <project>/da

ta/WebHMIPki/trusted_issuers/  folder.

e. Verify if SSL Security is updated to 

(Trusted).

Test Connection After updating all the details, test the connec

tion.

Connected successfully to the Operations Hub server.
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Set up CIMPLICITY Project User Security
To avoid having to login on the Webspace container to the project, for each user that is configured in 

Operations Hub, a matching user must be configured in the CIMPLICITY project.

1. Open the CIMPLICITY Project in the CIMPLICITY Workbench.

2. Go to Security  > Users.

3. For each user in the Operations Hub configuration, create a CIMPLICITY user of the same name 

with a security type of CIMPLICITY.

Note:

The passwords for the user between Operations Hub and the CIMPLICITY project do not 

need to match.

Configure CIMPLICITY Options
Set up CIMPLICITY options to ensure that sessions are properly created.

1. On the CIMPLICITY/WebSpace node open CIMPLICITY Options.

2. Select the Webspace  tab.

3. On the left pane, select General.

4. Select the check box for Autostart Webspace Session Manager.

5. Verify the port is 4957, then select Apply.

A message appears to restart the Webspace Session Manager service.

6. Select Yes  to restart the service.

7. On the left pane, select Server.

8. Provide these details:

Field Description

Windows Server Credentials a. Enter a valid User name  and Password 

for the Webspace system.

Note:

The user must be authorized to 

launch CimView.exe, as well as 
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Field Description

access the screens directory for 

the screens that are accessed 

via the Webspace widget.

b. Select Test. If successful,

▪ Trust UAA appears as Untrusted

▪ Generate UAA Client appears as 

Not generated

Operations Hub UAA/OAuth2 Setup a. Enter the Server URL  for the Operations 

Hub server. For example, https://opshub

system:443/uaa.

b. Test for a successful connection.

c. Select Trust UAA  to change its status 

from untrusted to trusted.

Note:

When trusted, the UAA certifi

cates are copied to the <CIM

PLICITY installation>\web

space-session-manager\pki

\trusted  directory.

d. Select Generate UAA Client  to enter the 

credentials for UAA Administrator.

i. Client Id: admin

ii. Client Secret: Enter the Opera

tions Hub secret, which was en

tered during installing Operations 

Hub.

iii. Select Generate.

The status changes to Generated  on 

successful generation of the UAA Client.

Single/Relay Server Provide the session manager credentials, and 

select Apply.

https://opshubsystem:443/uaa
https://opshubsystem:443/uaa
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Field Description

◦ WSM Admin User: Enter a user name 

(example: Administrator)

◦ Admin Password: Enter a password (ex

ample: pass1234)

◦ Confirm Password: Enter the same pass

word to confirm.

Note:

This can be any user name/password 

and does not have to match any specif

ic windows user name or password.

A message appears to restart the Webspace Session Manager service.

9. Select Yes  to restart the service.

Alarm Card
Use the alarm card to monitor your industrial assets. Get information from the HMI/SCADA system on 

alarms generated by their severity levels.

The alarm card widget is available under Integration  > HMI. When designing application pages  (on page 

376), drag and drop GEAlarmCard  to a container.

Alarm Card Properties

Field Name Description

View All Alarms by de

fault (Disabling this option 

will display context based 

alarms)

This is a default setting to show all alarms irrespective of context when the 

page loads at runtime.

If using the bread crumb widget along with the alarm card, then alarms are 

displayed according to the context.

If an alarm contains an OPC UA tag that is not associated with a model 

property, then the source server of the tag is displayed in the alarm grid.

Asset Name (Optional 

Override)

Select your own asset to display alarms. The selected asset overrides the 

default asset name at runtime.
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Field Name Description

Data Source (default da

ta source used to filter 

alarms on page load)

Select a data source to set as default for filtering alarms on page load at 

runtime.

Page Size - Number of 

alarms to display per page

Enter a number to specify the number of alarms that appear on a page at 

runtime. The maximum number of alarms you can display per page is 100.

Auto Hide Columns Select to automatically hide the table columns if screen space is a con

straint.

Note:

This option is enabled by default. To hide any of the other columns 

at runtime, you must clear the check box for this option.

Hide Acknowledge Col

umn

Select to hide the Ack.  column at runtime. This column contains the status 

to indicate whether the alarm is acknowledged in the HMI/SCADA system 

or not. A check mark in this column indicates that the alarm is acknowl

edged.

Hide Severity Column Select to hide the Severity  column at runtime. This column contains the 

icon that indicates the alarm severity status.

Hide Start Time Column Select to hide the Start Time  column at runtime. This column contains the 

start time and date for the alarm.

Hide Source Column Select to hide the Source  column at runtime. This column contains the tag 

associated to the alarm.

Hide Current Value Col

umn

Select to hide the Current Value  column at runtime. This column contains 

the query value such as whether the alarm is running or stopped.

Hide Asset Column Select to hide the Asset  column at runtime. This column contains the asset 

name associated to the alarm.

Hide Property Column Select to hide the Property  column at runtime.

Hide Description Column Select to hide the Description  column at runtime.

Hide State Column Select to hide the State  column at runtime. This column contains the 

alarm's current status.

Hidden
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Alarm Card at Runtime

To acknowledge alarms  (on page 540), you must have the permission to do so in the supporting HMI/

SCADA system.

Select  to filter alarms  (on page 538)  based on specific conditions.

Each icon has a corresponding number to indicate the number of alarms currently active for that severity 

level. The alarm count  (on page 541)  in the banner shows the number of alarms per severity level for 

all assets in the model, whereas the alarm card displays the number of alarms per severity level for the 

selected context.

The severity of an alarm is based on the priorities set in the HMI/SCADA system (iFIX or CIMPLICITY). 

Each alarm icon is color-coded and contains a specific number of dots to indicate its severity level, as 

shown in this table.

Note:

The alarm severity ranges are hard-coded in the application. Access the application.properties 

file to modify alarm severity ranges.

You can modify the property rank.ranks  in C:\Program Files\GE\Operations Hub\webhmi-tomcat

\webapps\alarm-microservice\WEB-INF\classes\application.properties  and restart webHMI 

tomcat service.

Icon Description

Alarm is critical.

Alarm is high priority.

Alarm is medium priority.
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Icon Description

Alarm is low priority.

Alarm information is not displayed if data sources are disconnected. Select  to get more information.

Note:

Currently, if a data source is deleted from Operations Hub, the alarms configured to the deleted 

data source are still displayed at runtime. To clear such alarms, restart the data distributor 

service.

Configure iFIX for Alarms
When using the iFIX  HMI/SCADA system as your data source, follow this quick walkthrough to 

successfully get data and alarms flowing for the first time into Operations Hub.

First install iFIX, and then install Operations Hub  on the same server.

1. Start the iFIX application.

2. Log in to iFIX with a default/guest account.

3. Go to Applications  > Security  > Security Configuration Utility.

Security is available in the System & Security group.

4. On the Security  toolbox, select User Account.

5. Select Add  to create a user account.

The User Profile  dialog appears.

6. Provide iFIX security for the user account:

Field Description

Full name Enter a name for the new user account.

Login name Enter a login name for the user account.

Password Enter a password for the user account.

Group Membership Select Modify  to add any/all available groups to 

the user account, then select OK.

Security Areas Select Modify  to add any/all security areas to 

the user account, then select OK.
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Field Description

Application Features Select Modify  to add any/all application fea

tures to the user account, then select OK.

7. Select OK  to save the user profile.

The Password Confirmation  dialog appears.

8. Enter the password again and select OK.

The user account is saved with the credentials and added to the Current Users  list.

9. On the Security toolbox, select Configuration and select Enabled.

10. Go to Applications  > OPC UA Configuration.

The iFIX OPC UA Server Configuration Tool  screen appears.

11. On the Server  tab, select the check box for Server Enabled.

12. On the Alarms  tab, select the check box for Alarms Enabled.

13. Select Save and Exit  to save the selections, and close the screen.

14. Go to Applications  > Database Manager.

The iFIX Database Manager  spreadsheet appears.

15. Open an existing database, or select Create New  on the spreadsheet toolbar to save a new 

database.

16. On the spreadsheet toolbar, select Add  to add blocks to your database.

The Select a block type  screen appears.

17. Select any block type, then select OK.

The selected block type screen appears.

18. On the Basic  tab:

a. Enter Tag Name.

b. Enter I/O Address.

c. Select Save.

19. On the Alarm  tab:

a. Select the check box for Enable Alarming.

b. In the Alarm Options  table, enter the alarm values.

For example:

High High 60

High 40

Low 20

https://www.ge.com/digital/documentation/ifix/version65/index.html#opc-ua-server/opcua_opc_ua_server_configuration_tool.htm
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Low Low 10

c. Select Save.

20. On the Advanced  tab:

a. Select the check box for Enable Output.

b. Select Save.

The tag name configured with an alarm is added to the spreadsheet.

21. Repeat steps 8-12 to add more blocks to your database.

• Create a data source with OPC UA configuration  (on page 360)  in Operations Hub.

• Use the alarm card  (on page 530)  and alarm count  (on page 541)  widgets in your application.

• Acknowledge Alarms  (on page 540).

• Apply Filters to View Alarms  (on page 538).

• Configure CIMPLICITY for Alarms  (on page 535).

Related information

Configure iFIX for Mimics  (on page 543)

Configure CIMPLICITY for Alarms
When using the CIMPLICITY  HMI/SCADA system as your data source, follow this quick walkthrough to 

successfully get data and alarms flowing for the first time into Operations Hub.

• Install the latest versions of CIMPLICITY  and Operations Hub on different servers or on the same 

server.

• Create an administrative user that you can use for both CIMPLICITY and Operations Hub. The user 

IDs must match in order to connect and manage communications and operations between the two 

systems, but the passwords must be different.

1. Start the CIMPLICITY Workbench application.

2. From the Workbench toolbar, go to File  > New  > Project.

The Create User for New Project  dialog appears.

3. Provide these details for the new user account:

Field Description

Username Enter the user name for the new account.

Password Enter a password.
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Field Description

Confirm password Enter the password again to confirm.

Note:

You will use the credentials to establish a secure connection with authentication for the 

CIMPLICITY data source in Operations Hub.

4. Select Next.

The Create As  dialog appears.

5. Enter the name and location for the new project.

Note:

For write operations to work, the project name and the CIMPLICITY data source name in 

Operations Hub should be the same.

6. Select product options and protocols that will be included in the project.

7. Select Create.

8. After creating the project, go to Project  > Properties.

The Project Properties  screen appears.

9. On the OPC UA Server  tab, perform these steps.

a. Select the check box for Enable Server.

b. Select Security Configuration, then select the check box for all the security options you want 

to enable for the OPC UA server.

10. On the Operations Hub  tab, perform these steps.

a. Provide the following details:

Field Description

Server name Enter the name of the Operations Hub serv

er to connect.

Port Enter the port number for Operations Hub 

UAA. For example, 443.

User name Enter the account username that is used to 

log in to the Operations Hub application.

b. Select the check box for Require trusted connection.
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c. If (Not Trusted), go to the CIMPLICITY project's \data\WebHMIpki\server_certs  folder and 

copy the root certificates.

d. Paste the copied certificates in the CIMPLICITY project's \data\WebHMIpki\trusted_issuers 

folder.

e. On the Operations Hub  tab, select Test Connection.

A success message appears updating the connection status as (Trusted).

11. From the CIMPLICITY Workbench project directory, right-click Points  > New, to create a new device 

point.

12. Provide the following information for the new point and select OK.

Field Description

Point ID Provide a unique name that identifies the CIM

PLICITY point.

Type Select Virtual.

Class Select Analog.

The Point Properties  screen appears.

13. On the Virtual  tab, provide these details:

Field Description

Initialization Select Initialized.

Initial value Enter 0.

Calculation Select Equation  and build an expression. For 

more information on calculation types, refer to 

the Configure Virtual Calculations  topic in the 

CIMPLICITY help guide.

14. On the Alarm  tab, provide these details:

Field Description

Alarm message Select Point ID. For more information on alarm 

message variables, refer to the Enter an Alarm 

Definition  topic in the CIMPLICITY help guide.

https://www.ge.com/digital/documentation/cimplicity/version111/oxy_ex-2/project_setup/topics/g_cimplicity_project_setup_step32_configure_virtual_calculations.html
https://www.ge.com/digital/documentation/cimplicity/version111/oxy_ex-2/project_setup/topics/g_cimplicity_project_setup_step411_enteran_alarm_definition.html
https://www.ge.com/digital/documentation/cimplicity/version111/oxy_ex-2/project_setup/topics/g_cimplicity_project_setup_step411_enteran_alarm_definition.html


Operations Hub for Windows  | 3 - User Guide  | 538

Field Description

Alarm limits Enter the alarm limits. For example:

◦ HiHi: 60

◦ Hi: 40

◦ Lo: 20

◦ LoLo: 10

15. Select OK  to save and close the Point Properties  screen.

16. Repeat steps 6-10 to create more device points.

17. Run the CIMPLICITY project.

• Create a data source with OPC UA configuration  (on page 360)  in Operations Hub.

• Use the alarm card  (on page 530)  and alarm count  (on page 541)  widgets in your application.

• Acknowledge Alarms  (on page 540).

• Apply Filters to View Alarms  (on page 538).

• Configure iFIX for Alarms  (on page 533).

Related information

Configure CIMPLICITY for Mimics  (on page 551)

Apply Filters to View Alarms
Apply conditions to filter and display alarms.

You can use filters to narrow down your search for the exact alarm information you want to view.
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Table  5. Filter Criteria for Alarms

Field Description

View Alarms By Use the toggle to switch between these states:

• Set to All  if you do not have an asset model. 

You can filter alarms from all the available 

data sources.

• Set to Context  if you have an asset model. 

From the breadcrumb, navigate to your as

set context to filter respective alarms.

Condition Select any of these conditions to filter and display 

alarms:

• Acknowledged: Displays only the list of ac

knowledged alarms.

• Severity: Displays alarms based on a select

ed severity value - critical, high, medium, or 

low.

• Start Time: Displays alarms based on a se

lected date and time.

• Source: Displays only alarms from the se

lected tag/source.

• Data Source: Displays only alarms from the 

selected data source.

Operator Select an operator to describe the relationship be

tween the condition and the value. Based on the 

selected condition, the following operators are 

available: Equal, NotEqual, GreaterThan, GreaterOr

Equal, LessThan, LessOrEqual, Contains, NotCon

tains, etc.

Value Select the value you want to filter. Values for filter

ing alarms are populated based on the selected 

condition and operator.

If condition is data source, it takes about 30 sec

onds to initially populate the list of available OPC 
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Table  5. Filter Criteria for Alarms  (continued)

Field Description

UA data sources in your system. In case you delet

ed a data source from your system, the deleted da

ta source still appears in the Value  drop-down list. 

To clear deleted data sources, restart these ser

vices in the following order:

1. GE Operations Hub WebHMI Tomcat Web 

Server

2. GE OpHub Data Distributor

+ Add Filter Select to insert a new filter criteria. Use the And, Or 

operators to describe the relationship between two 

or more filter criteria.

Reset Select to clear all the filters. To clear individual fil

ters, select  next to the filter you want to delete.

Apply Select to apply the filters and display only alarms 

that match the filter criteria.

Acknowledge Alarms
Alarms are acknowledged in the HMI/SCADA system.

Alarms are displayed based on the applied filter conditions  (on page 538). You have the option to 

acknowledge,

• all the alarms at once

• only the specific number of alarms listed per page

• only the selected alarms

Configure iFIX  (on page 533)  or CIMPLICITY  (on page 535)  to be able to acknowledge alarms.

1. To acknowledge only selected alarms:

a. Select the rows for the alarms in the table.

To unselect, select the row again.

b. Select Acknowledge Selected.
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A confirm dialog appears.

c. Select Acknowledge  to confirm.

2. To acknowledge all the alarms listed on a page:

a. Select Acknowledge Page.

A confirm dialog appears.

b. Select Acknowledge  to confirm.

Only alarms on the specific page are acknowledged.

3. To acknowledge all the alarms at once:

a. Select Acknowledge All.

A confirm dialog appears.

b. Select Acknowledge  to confirm.

All the displayed alarms for the applied filter condition are acknowledged.

A check mark  appears for the acknowledged alarm in its Ack  column. The alarm severity icon also 

indicates a check mark  if successfully acknowledged in the HMI/SCADA system.

Alarm Count
This widget provides only the count of alarms per severity level for all the assets in a model.

You can use the alarm count widget when you want to provide only a summary of alarms in your 

application.

The alarm count widget is available under Integration  > HMI. When designing application pages  (on page 

376), drag and drop GEAlarmCount  to a container. The alarm count is displayed as a banner at runtime 

with the number of alarms currently active for the severity level.

Mimic Card
A mimic card provides a specific view of a process diagram associated with an asset. This allows you to 

monitor and control production equipment and processes.
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The mimic card widget is available under Integration  > HMI. When designing application pages  (on page 

376), drag and drop GEMimicCard  to a container.

The mimic card also allows you to update values during runtime  (on page 557), and get results 

immediately.

You can use the mimic card with or without a model. When not using a model, create pages and assign 

direct tags.

Mimic Card Properties

Field Name Description

Asset Name (Optional 

Override)

Provide the asset name for which you want to replace its currently as

signed mimic.

Note:

You can opt to override either an asset name or a mimic name. If 

you attempt to override both, only the asset name is considered.

Mimic Name (Optional 

Override)

Provide the mimic name to replace the currently assigned mimic. The new 

mimic must use only direct tags (not model-based) for its data sources. Al

so, the new mimic cannot use click-target navigation as the mimic has no 

context for navigation when loaded in this manner.

Note:

If you do not specify an override for both the asset name or mimic 

name, then the mimic from the selected asset context in a bread
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Field Name Description

crumb is considered. When not using the breadcrumb in an appli

cation, it is mandatory to provide an override either for the asset 

name or the mimic name.

Height Allows to set the height of the widget at runtime. You can set the values in 

percent or pixels. For example, 100%, 50%, 300, etc.

Override Mimic Back

ground Color

Overrides the mimic's background color.

Background Color Adds a background color.

Show Border Displays a border.

Border Color Adds a border color.

Hidden

Configure iFIX for Mimics
When using the iFIX  HMI/SCADA system as your data source, follow this quick walkthrough to 

successfully get mimics into Operations Hub.

Install iFIX  and Operations Hub on different servers or on the same server.

Note:

You can display booleans and enumerations as strings in your mimics. When creating the mimic, 

use the A_CV  attribute on your data sources. If you use F_CV, numeric values are rendered. For 

inline edits, only booleans currently support selecting a value via a dropdown box.

1. Log in to Proficy iFIX and perform these tasks:

a. Go to C:\Program Files (x86)\GE\iFIX  and open the secmgr.clr.dll.config  file in a 

notepad.

b. Save the dll file after verifying and updating these details:

Ensure that uaa_oauthHost  points to the UAA server that provides the authentication 

services. If default UAA server is installed with Operations Hub, this will generally be the 

hostname (short or FQDN) used during Operations Hub installation.
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c. Create pictures supporting the Operations Hub objects. To make an object a click target in a 

Operations Hub mimic, set its is selectable  property to true.

d. To enable an operator to update an iFIX  data source tag on a picture and answer an update 

confirmation question, access the Datalink  screen and select the source tag. In the Data 

Entry  section, select In-Place in the Type  field, and then select the Confirm  check box, as 

shown below.
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e. In the iFIX  Tools Ribbon, select Publish to Operations Hub  to export selected pictures in GRF 

format in to a Picture folder as shown below. These GRF files are exported in to JSON ZIP 

files. These pictures become mimics (process diagrams) that you associate with asset 

object types in Operations Hub.

f. Verify the values in the Advanced  section of the Configure iFIX OPC AE Server  screen 

conform to the OPC A&E specification guidelines and use the Operations Hub default 

dividing point values to separate the alarm severity ranges, as explained in Alarm 

Microservice.

https://www.ge.com/digital/documentation/webhmi/r_wh_alarm_microservice.html
https://www.ge.com/digital/documentation/webhmi/r_wh_alarm_microservice.html
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The following provides a sample Configure iFIX OPC AE Server  screen.

2. Log in to Operations Hub.

3. Create a data source with OPC UA configuration  (on page 360)  in Operations Hub.

Note:

The datasource name should match the iFIX node name.

4. Import the mimic  (on page 348).

5. Create an application  (on page 204).

6. Create application pages  (on page 376)  for Alarm card  (on page 530)  and Mimic Card  (on page 

541).

7. Run the application and check to see if mimics are working.

Related information

Reference a Model Property in an Animation  (on page 547)

Using the Operations Hub Toolbox  (on page 547)
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Controlling Data Sources in a Picture by Group Selection  (on page 548)

Automatically Binding Child Assets to Click Zones using Group Names  (on page 549)

Reference a Model Property in an Animation
You can reference a model property within an animation.

To reference a model property in an animation, you must type @ (at sign) at the beginning and at the end 

of the property name. This allows the Operations Hub software to differentiate the property name from 

ordinary text.

Example:

To enter a reference in an animation to the pump1.speed property in the model:

1. Enter the following in the Fill Expert as the Fill Data Source: @pump1.speed@

2. Export the picture using the Export Web HMI Picture utility. The following line appears in the JSON 

file: "tag": "@pump1.speed@"

Using the Operations Hub Toolbox

The Operations Hub Toolbox contains buttons for objects and picture composition tools that allow you 

to quickly create high performance HMI pictures. You can click and drag the Operations Hub Toolbox to a 

position anywhere on your picture, or click and drag one of its edges to resize it.

The Operations Hub Toolbox automatically appears by default when high performance HMI graphics are 

enabled under User Preferences  > General.

You can disable the Operations Hub Toolbox by toggling the Toolbox button on the Tools tab in the 

Operations Hub group of the WorkSpace ribbon.

The following table lists the names of the Operations Hub Toolbox buttons. The layout of the cells in this 

table mimics the layout of the corresponding buttons in the Operations Hub Toolbox. A description of 

each button can be found in the Creating Pictures  ebook.

Pointer 

Selec

tion

Cut Copy Paste Rectan

gle

Rounded 

Rectan

gle

Oval Chord Polygon Pie

https://www.ge.com/digital/documentation/ifix/version65/index.html#creating-pictures/drwcover.htm?TocPath=Creating%2520Pictures%257C_____0
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Arc Line Polyline Line 

Connec

tor

Right 

Line 

Connec

tor

Text Datalink 

Stamper

Bitmap Set Col

or

Toggle 

Grid

Space 

Evenly 

Vertical

Space 

Evenly 

Horizon

tal

Align 

Top

Align 

Left

Align 

Bottom

Align 

Right

Align 

Horizon

tal Cen

ter

Align 

Vertical 

Center

Group Ungroup

Bring to 

Front

Send to 

Back

Set Lay

er

Display 

Layer

Fill Ex

pert

Rotate 

Expert

Fore

ground 

Color Ex

pert

Visibility 

Expert

Undo --

Controlling Data Sources in a Picture by Group Selection

Operations Hub allows you to write to tag values associated with an asset’s properties in the Asset 

Model. It is possible to define a group of objects in a picture that can be selected at runtime, resulting in a 

control card appearing in which the operator can write to controllable properties of a given asset. This is 

accomplished with the IsSelectable  property in the exported picture JSON file, which is only exported for 

iFIX Group objects that have Enable Select  enabled in iFIX pictures.
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With traditional iFIX pictures, selecting the Enable Select  property allows an object to be selected in the 

runtime environment.

With iFIX pictures that are intended for export to Operations Hub, selecting the Enable Select  property of 

a group designates that group as a "click zone" in that picture. A click zone allows properties of a certain 

asset to be controlled or modified by writing to the associated iFIX tags. When you click on a selectable 

group that has an asset associated with it, a control card opens to show the current values for a specified 

set of properties for that asset. Both controllable and non-controllable properties display, based on the 

configuration of the properties. (Controllable properties are indicated with a gear icon.) Clicking on the 

control card changes it to Edit view. Edit view allows you to enter new values for those properties. The 

new values are written to the iFIX database tags when the Confirm button is selected.

Automatically Binding Child Assets to Click Zones using Group Names

When creating the iFIX picture for a certain asset type, specifying a selectable group’s name in a 

certain way results in the click zone being automatically associated with a child asset without further 

configuration once the exported iFIX picture is associated with an asset type.
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In order to take advantage of this automatic click zone binding, the group name must be the same as 

the child asset’s property name in the GE Operations Hub Asset Model. Each child asset in the model 

hierarchy is represented as a property of a parent asset. In order for the automatic binding to associate 

a click zone with a certain child asset, the group name must exactly match the name of the desired child 

asset property and the exported iFIX picture must be associated with the parent asset.

Example:

For example, say you have an asset type named StorageTank, which has two child asset properties 

defined in the model, – InletPump and OutflowPump, of asset type Pump. When creating an iFIX picture 

for the StorageTank asset type to use with GE Operations Hub, you can automatically enable the control 

card for each of these child assets by:

1. Creating a selectable group of objects within the iFIX picture for each of the child assets.

2. Naming these groups InletPump and OutflowPump. These are the child asset property names 

as defined in the asset model, (not the child asset instance names for a certain instance of 

StorageTank).

3. Exporting the iFIX picture from WorkSpace.

4. Importing the exported picture to GE Operations Hub and associating it with the StorageTank asset 

type (assuming that the asset model has already been created/imported).

After doing this, navigating to any StorageTank in GE Operations Hub at runtime and viewing the HMI 

display allows an operator to click on either of these groups of objects to display the control card for that 

child asset – without the need to navigate to that child asset. This allows control of child assets while in 

the context of a parent asset.

Rules for Automatic Binding of Group Names

• You must name the group the same as the child asset property of an asset type.

• Only child or other descendant assets of a given asset type can be bound to a click zone in a 

picture associated with that asset type.

• You can access the control card for grandchild assets and below by using double underscores 

(__) in the group name to separate each asset level. For example, if the above Pump asset type 

had a child asset property named RestrictionValve, a click zone could be auto-bound to this 

grandchild asset from the StorageTank picture by defining a selectable group with the name 

InletPump__RestrictionValve or OutflowPump__RestrictionValve. This shows the control card for 

one of these RestrictionValves, depending upon which name you used.
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• You can display the control card for the asset type that is associated with the IFIX picture, rather 

than one of its descendants, by naming the selectable group the same as the asset type. In the 

previous example, naming a selectable group StorageTank would result in the click zone displaying 

the control card for the StorageTank itself when that group is selected at runtime.

Note:

It is not necessary to name the selectable groups in a certain way for them to be able to show the 

control card for an asset. It is only necessary in order to take advantage of the automatic binding 

feature. If you do not name them in this way, the click zones will still be selectable at runtime in 

GE Web HMI, but will require further configuration in GE Operations Hub Administration in order to 

associate them with the desired assets for control at runtime.

Configure CIMPLICITY for Mimics
When using the CIMPLICITY  HMI/SCADA system as your data source, follow this quick walkthrough to 

successfully get mimics into Operations Hub.

• Install the latest versions of CIMPLICITY  and Operations Hub on different servers or on the same 

server.

• Create an administrative user that you can use for both CIMPLICITY and Operations Hub. The user 

IDs must match in order to connect and manage communications and operations between the two 

systems, but the passwords must be different.

By integrating Operations Hub and CIMPLICITY, you can view CIMPLICITY data in Operations Hub using 

screens called mimics that were created in CimEdit.

Note:

You can display booleans and enumerations as strings in your mimics. When creating the 

mimic, use the .Value  attribute on your data sources. If you use .$RAW_VALUE, numeric values 

are rendered. For inline edits, both booleans and enumerations display a dropdown box with the 

possible values.

1. Start the CIMPLICITY Workbench application.

2. From the Workbench toolbar, go to File  > New  > Project  and create a new project.

3. After creating the project, go to Project  > Properties.

The Project Properties  screen appears.

4. On the OPC UA Server  tab, perform these steps.

https://www.ge.com/digital/documentation/cimplicity/version111/oxy_ex-2/project_setup/topics/g_cimplicity_project_setup_createa_new_project.html
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a. Select the check box for Enable Server.

b. Select Security Configuration, then select the check box for all the security options you want 

to enable for the OPC UA server.

5. On the Operations Hub  tab, perform these steps.

a. Provide the following details:

Field Description

Server name Enter the name of the Operations Hub serv

er to connect.

Port Enter the port number for Operations Hub 

UAA. For example, 443.

User name Enter the account username that has per

mission to access the Operations Hub appli

cation.

b. Select the check box for Require trusted connection.

c. Select View Certificate  and if Untrusted, select Trust.

The certificate gets added to the CIMPLICITY project's \data\WebHMIpki\server_certs  folder. 

The certificate status now appears as Trusted.

d. Copy the certificate files from the CIMPLICITY project's \data\WebHMIpki\server_certs 

folder, and paste them to the project's \data\WebHMIpki\trusted_issuers  folder.

6. In the CIMPLICITY project, create a TPump  class with an alarm enabled.

7. Create a Pump01  object that corresponds to the class.

8. Create a visual representation (PumpMimic) of the TPump  on the CimEdit screen.

9. On Properties, enter $Object  in the Variable  column. CIMPLICITY  uses this value to reference the 

context in the Operations Hub model, which is the TPump in this example.
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10. On Text, type ($Object).OnOff  in the Display value Expression  field. This value represents the 

OnOff  value on the TPump  object type in the Operations Hub  model.
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11. To export or publish the mimic, right-click on the CIMPLICITY screen and select Publish to 

Operations Hub.

12. In Operations Hub, do the following:

a. Create a data source with OPC UA configuration  (on page 360)  in Operations Hub.

b. Import the mimic  (on page 348).

c. Associate the mimic to the TPump  object type  (on page 348).

d. Create an application  (on page 204).

e. Create application pages  (on page 376)  for Alarm card  (on page 530)  and Mimic Card 

(on page 541).

f. Run the application and check to see if mimics are working.

Related reference

Referencing Data in CimEdit Screen Animations  (on page 554)

Referencing Data in CimEdit Screen Animations

You can use the following two methods to reference data in CimEdit screens that will work in Operations 

Hub mimics.

Important:

The CIMPLICITY OPC UA Server does not support enterprise points; therefore, they are not 

supported in exports for Operations Hub.  If you use enterprise points in your CIMPLICITY 

screens, they will not be available in the imported Operations Hub mimic.
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Method Description

Method 1 Continue to directly reference your CIMPLICITY point database in your anima

tions – This method retrieves data directly from CIMPLICITY and shows the val

ues of the points in the database. This is often useful when referencing data 

that is global to or outside of the model context you build in Operations Hub. For 

example, OverallPartCount.

Method 2 Reference model context-based data that resolves in accordance with the mod

el context you are in when you display the mimic in Operations Hub. This is the 

most powerful way to use Operations Hub mimics because it allows you to cre

ate screens as templates using CIMPLICITY’s existing local variable mecha

nisms that resolve at Operations Hub runtime. For example, if you have creat

ed a Operations Hub object type to represent a pump and created 2 pumps ob

jects from that type, you can build one screen in Operations Hub to represent 

the pump object type, and then have the data resolve and appear in that screen/

mimic based on the Pump instance that is selected.

You can reference both direct CIMPLICITY database points and context references in the same screen.     

Use the $OBJECT local variable to reference context-based data. You must define this variable at the 

screen level and leave the value blank when you export the screen as a mimic for Operations Hub. 

You can use this local variable to represent the model context with which this screen is displayed. For 

example, a pump screen is shown when in the Pump01 or Pump02 context.

Note:

You should build the model in Operations Hub before you build Operations Hub mimics in 

CimEdit. If you reference model object variables using the same names, Operations Hub can 

automatically map your model context references in your animations to the model when you 

import the mimic into Operations Hub.
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Example 1: Referencing Contained/Child Model Object Variables

When in the Inlet pump context, the animation shown below displays the value of Inlet Pump’s flow. If on 

the Outflow Pump context, this same screen will show Outflow Pump’s flow.

$Object.Flow

Example 2: Referencing Contained/Child Model Object Variables

You can also reference contained object properties in your Operations Hub mimics that will be exported 

from CimEdit.  For example, if I want to build an overview screen to show two pumps in my pump station, 

then I  can build a CimEdit screen where the $Object  represents PumpStation01 and I reference my 

animations to show the individual pump values as follows:

{$Object}.InletPump.Flow

{$Object}.OutflowPump.Flow

Example 3: Referencing CIMPLICITY Point Attributes in Operations Hub Example

You can continue to reference CIMPLICITY attributes like engineering units, description, alarm limits, and 

so forth, in Operations Hub screens on direct point references and model context references as follows:

{$Object}.Flow.Description or

{$Object}.InletPump.Flow.EU_LABEL

Using Linked Objects to Generate Operations Hub Screens

In order to build Operations Hub screens using linked objects, any Linked Object local variables that 

are used to reference Operations Hub Object variables must eventually resolve back to the screen 

$Object variable in which they are placed. When you create the source of a linked object, you create a 
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public “$Object” local variable in your source group object. Use this $Object local variable to reference 

Operations Hub model variables.

For example:

{$Object}.Flow

When you create a linked object from this source group object, you set the value of the inherited $Object 

local variable to point to the screen $Object defined in the screen in which you created the linked object 

using local variable syntax like  {..\$Object} or {..\$Object}.InletTank”

Update Values on Mimic Cards
When configured, you can modify values in the HMI/SCADA data source directly on mimic cards.

You must have permissions in the HMI/SCADA data source to perform this task.

1. Hover over the value you want to update on the mimic card.

If the background of the value changes to blue, you can update the value.

2. Enter the new value in its entirety and press Enter  or select the value from a drop-down list. 

If you specify an invalid value in any entry box on the mimic card, the box becomes outlined in red.

3. Optional: For mobile devices:
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a. Select the entry field whose value you want to update. If its background changes to blue, you 

can edit this value, as shown below:

b. Select the entry field again and specify the new value or select it from a drop-down list.

c. Optional: Click outside the field if you do not want to update the current value.

d. If an update confirmation window appears, answer accordingly.

4. If an update confirmation window appears, answer accordingly.

An error can occur when you are not connected to the data source, you do not have permissions to 

write to your data source, or you entered a numeric value not within the acceptable minimum and 

maximum range for that value.

Display

Display Overview

The following list of plugins are available under the display category:

• DataGrid  (on page 559)

• Gauge Bar  (on page 567)

• Gauge Circular  (on page 569)
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• Gauge Linear  (on page 570)

• iFrame  (on page 572)

• Pivot Grid  (on page 574)

• Solid Gauge  (on page 579)

• Value Display  (on page 583)

• Image  (on page 588)

• Simple Indicator  (on page 590)

• List  (on page 590)

• Text Display  (on page 591)

DataGrid
Use this widget to access advanced features of a table.

The datagrid widget is available under INTEGRATION  > DISPLAY. When designing application pages  (on 

page 376), drag-and-drop DataGrid  to a container.

The following list of properties are specific to this widget. For common properties, refer to Page 

Components (Classic)  (on page 653).

Datagrid Properties

Field Name Description

BEHAVIOR > Selected 

Items Changed

BEHAVIOR > Edited Rows 

Updated

Use this property to define the action to be taken when a value is modified in 

the datagrid. For this behavior to work, you must also configure the Add Ta

ble Column  for the modified value.

Source - Input Use any of these options to provide values from a data source.

• Select the Query  tab. Choose a query and select output fields to view 

data on the grid. The data grid table displays the output field names 

as column headers. If Alias  is provided for any output field, then the 

alias name overrides the column header name.

• Select the Global  tab. Choose an output field value that is available 

as a global parameter.

• Select the Formula  tab. Add a formula that returns columns as out

put.
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Field Name Description

Note:

Currently we do not support manually passing values to the widget.

Use Raw Format Select the check box to display numbers in raw format.

For example, a numeric value with 5 or more decimal places is shown as it 

is, and not rounded off.

Number of decimals This option appears if you do not want to display numbers in raw format.

In that case, enter the decimal places (0-7) to consider after the decimal 

point to format large numbers. Based on the decimals, the value is rounded 

off to the nearest whole number.

The decimals will apply to all the datagrid columns that contain numeric val

ues.

Height (px) - 0 equals dy

namic

Set the height in pixels. If set to 0, the datagrid table occupies 100% of its 

container.

Border, Row and Column 

Lines Width (px)

Set the line width for the datagrid table border, rows, and columns.

Border Color Select a color for the datagrid table border.

Show Borders Select the check box to apply a border to the datagrid table. To remove the 

border, clear the check box.

Show Column Lines Select the check box to display column gridlines. To remove gridlines, clear 

the check box.

Show Row Lines Select the check box to display row gridlines. To remove gridlines, clear the 

check box.

Enable Search Select the check box to add a search field above the datagrid widget to 

search the entire table.

Allow Grouping Select the check box to allow grouping of columns at runtime.
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Field Name Description

• The message Drag a column header here to group by that column 

is displayed at the top of the table.

• Select the column you want to group by, drag and drop on the mes

sage.

• You can also group data by multiple columns. Drag and drop columns 

on the message one after the other to group data accordingly.

To undo grouping, drag the columns back to their previous position.

Allow Filtering Select the check box to allow filtering of data in every column.

At runtime, to filter values:

1. Select the filter icon from the respective column header.

2. Select the check box for the data you want to filter out.

3. Select OK.

Allow Edit Select the check box if you want to modify grid data. An edit option appears 

at runtime next to each row.

The modified data value must be sent to a target data source. To use the ed

it option successfully, configure the Add Table Column  and Output Target 

properties.

Changes are written to the target, and not to the input data source. Hence, 

you may lose edits on refreshing the page.

Allow Export Select the check box to allow exporting data at runtime.

Allow Show/Hide 

Columns

If you select this check box, a column chooser icon appears on top of the 

datagrid at runtime.

A column chooser dialog appears, wherein you can drag-and-drop the data

grid columns you want to remove from the table. Similarly, you can also add 

the removed columns back to the table.
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Field Name Description

Allow Column Filtering If you select this check box, a filter icon appears in every column to filter out 

datagrid rows.

At runtime, to filter values:

1. Select the filter icon from the respective column header.

2. Select the check box for the data you want to filter out.

3. Select OK.

Pages or scroll If the number of rows exceed page size, then specify whether you want to 

browse through pages, or scroll through data.

• Select Pages  to divide and display grid data in separate pages. Enter 

the number of rows to display per page in Page Size.

• Select Scroll  to add a scroll bar to the datagrid.

Rows Use these properties to configure datagrid table rows:

• Header Alignment: Align the data in the header either left, right, or 

center. Default alignment is based on the data type, whether numeric 

or string.

• Header Font Family: Select a font family for the header text.

• Header Font Size: Set a font size in pixels for the header text.

• Header Font Weight: Choose whether the header text should appear 

as Normal, Bold, or Italic.

• Header Font Color: Select a font color for the header text.

• Header Background Color: Select a background color for the table 

headers.

• Body Font Family: Select a font family for the body text.

• Body Font Size: Set a font size in pixels for the body text.

• Body Font Weight: Choose whether the body text should appear as 

Normal, Bold, or Italic.

• Body Font Color: Select a font color for the body text.

• Body Background Color: Select a background color for the table cell 

body.
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Field Name Description

• Icon or Image size (px): Set the icon/image size in pixels. The default 

value is 40px.

• Selection Mode: Single  allows to select a single row in the grid. Mul

tiple  allows to select multiple rows using a check box. None  disables 

row selection.

Add Animation Use this property to highlight a row when a condition is met. Boolean values 

are represented with 1  or 0.

This property is similar to Add Cell Animation  (on page 565).

Add Table Column Use this property to customize the datagrid columns  (on page 559). 

Select +Add Column  to show configuring options.

Note:

Add only the columns you want to customize. It is not required to 

add all the columns.

• Configure column  (on page 563)

• Configure output target  (on page 564)

• Add image/icon  (on page 565)

• Add cell animation  (on page 565)

To organize table columns:

• Use  and  to rearrange order of columns in the datagrid.

• To delete a column, select  next to it.

Column Use these properties to configure a column:

• Data Field: Provide the column header name. This value must match 

the output field name (returned by query).

If an Alias  is configured for the output field for the specific column, 

then the value must match the alias name.
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Field Name Description

• Data Type: Specify the type of data in the column. For example, se

lect Picture  if the column contains image URLs and images will be 

retrieved from the data source.

• Min Width (px): Set a default minimum width for each column. The 

column will not decrease beyond this minimum width if the volume of 

data is less.

• Alignment: Align the data in the column either left, right, or center. 

Default alignment is based on the data type, whether numeric or 

string.

• Visible: Select/Clear the check box if you want to show/hide the col

umn in the datagrid.

• Show Header Name: Select/Clear the check box to show/hide the 

header text in the datagrid column header.

• Allow Filtering: Select/Clear the check box to enable/disable filtering 

on column.

• Allow Sorting: Select/Clear the check box to enable/disable sorting 

by this column.

• Allow Edit: Select/Clear the check box to enable/disable editing the 

column data.

• Enable Summary: Select/Clear the check box to enable/disable 

showing the summary totals for the column.

• Summary Type: If you enabled summary, you must select a summary 

type. The summary type depends on the type of data in the column.

◦ sum: Calculates a total for all values in the column.

◦ Minimum: The smallest value in the column.

◦ Maximum: The largest value in the column.

◦ Average: Calculates an average of all values in the column.

◦ count: Counts the total number of values present in the col

umn.

Output Target Select + Add Output Target  to specify the target data source for column da

ta. At runtime, when column data is selected/modified, the target specified 

in this property is triggered.

• Choose a query input value as target. (OR) Add or choose a global 

value as target.

• Select Unix timestamp  format to represent all time zones at once.
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Field Name Description

Add Image Use this property to deliver an image when a condition is met. Boolean val

ues are represented with 1  or 0.

Select +Add Image  to add a condition. You can add as many conditions as 

required.

• Condition: Create a condition for the column data. For example, if col

umn value is >  than 150, then update an image.

• Image or Font Awesome Icon: Select whether you want to load an im

age, or icons from the Font Awesome Free library.

• URL or Icon name: For image, enter its URL address. Also ensure that 

the column  (on page 563)  Data Type  is Picture. For font awesome 

icon, enter the icon name.

• Icon Color: Select a color for the icon.

Add Cell Animation Use this property to highlight a cell when a condition is met. Select +Add 

Cell Animation  to add as many conditions as required. Boolean values are 

represented with 1  or 0.

• Column: Select a column and create a condition for it. For example, if 

the value in Column 1  is =  to Alarm 1, then trigger these changes.

• Font Color: Change cell text color to the selected font color.

• Background Color: Change cell color to the selected background col

or.

Group By Set the default grouping of data by column.

• Columns: Select a column for default grouping.

• Expanded: Select/Clear the check box to expand/collapse data by de

fault.

Sort By Set the default sorting for data grid columns. For example, you can add mul

tiple items to configure default sorting first by column X, then by column Y, 

etc in an ascending/descending order. The sequence of sorting order ap

pears at runtime indicated by a number.
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Field Name Description

At runtime:

• Hold the Shift  key and select column headers to sort in a sequential 

order.

• Hold the Ctrl  key and select column headers to clear any column in a 

sequence.

Selected Rows Output Specify the target data source for a selected row data. A separated string or 

array can be written to a global variable.

1. Choose a query input value as target. (OR) Add or choose a global 

value as target.

2. Select the column to which you want to write data, and in which for

mat.

3. Specify an output separator if format is separated string.

Hidden
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DataGrid at Runtime

You have the option to export and download the datagrid table data. Select  icon that appears at 

runtime at the top of the table to export the data to an Excel file.

Gauge Bar

The plugin is available under INTEGRATION  > DISPLAY. When designing application pages  (on page 

376), drag-and-drop gaugeBar  to a container.

Gauge Bar Properties

Field Name Description

Source > Input Value To get values for gauge bar from a data source, use any of these options:

• Select a query output.

• Select a global parameter.
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Field Name Description

• Enter source data manually.

• Add a formula.

Source > Minimum Value Sets the minimum scale value.

Source > Maximum Value Sets the maximum scale value.

Use Raw Format Select the check box to display numbers in raw format.

For example, a numeric value with 5 or more decimal places is shown as it 

is, and not rounded off.

Number of decimals This option appears if you do not want to display numbers in raw format.

In that case, enter the decimal places (0-7) to consider after the decimal 

point to format large numbers. Based on the decimals, the value is rounded 

off to the nearest whole number.

Advanced Settings • Select the Show Label  check box to display a label name, if provided.

• Select the Show Animation  check box to display animation.

• Select the Show Legend  check box to display a legend.

Angles • Start Angle: Defines the point on the circumference of the gauge at 

which the bar will begin to appear in displaying the input value.

• End Angle: Defines the point on the circumference of the gauge at 

which the bar will complete its appearance in displaying the input 

value.

Hidden
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Bar Gauge at Runtime

Note:

If you choose to show legend on a graph with large amounts of data values, the graph may 

become unreadable.

Gauge Circular

The plugin is available under INTEGRATION  > DISPLAY. When designing application pages  (on page 

376), drag-and-drop gaugeCircular  to a container.

Gauge Circular Properties

Field Name Description

Source > Input Value To get values for gauge circular from a data source, use any of these op

tions:

• Select a query output.

• Select a global parameter.

• Enter source data manually.

• Add a formula.

Source > Minimum Value Sets the minimum scale value.

Source > Maximum Value Sets the maximum scale value.

Use Raw Format Select the check box to display numbers in raw format.
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Field Name Description

For example, a numeric value with 5 or more decimal places is shown as it 

is, and not rounded off.

Number of decimals This option appears if you do not want to display numbers in raw format.

In that case, enter the decimal places (0-7) to consider after the decimal 

point to format large numbers. Based on the decimals, the value is rounded 

off to the nearest whole number.

Advanced Settings • Select the Show Label  check box to display a label name, if provided.

• Select the Show Animation  check box to display animation.

• Select a Needle Color.

• Choose a Needle Style  from available options - rectangle needle, tri

angle needle, range bar, marker, text.

Range(s) You can specify one or more ranges to display in different colors.

1. Select +Add Item.

2. Start of Range

3. End of Range

4. Select a color  (on page 660)  Color in Range.

Hidden

Circular Gauge at Runtime

Gauge Linear

The plugin is available under INTEGRATION  > DISPLAY. When designing application pages  (on page 

376), drag-and-drop gaugeLinear  to a container.
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Gauge Linear Properties

Field Name Description

Source > Input Value To get values for gauge linear from a data source, use any of these options:

• Select a query output.

• Select a global parameter.

• Enter source data manually.

• Add a formula.

Source > Minimum Value Sets the minimum scale value.

Source > Maximum Value Sets the maximum scale value.

Use Raw Format Select the check box to display numbers in raw format.

For example, a numeric value with 5 or more decimal places is shown as it 

is, and not rounded off.

Number of decimals This option appears if you do not want to display numbers in raw format.

In that case, enter the decimal places (0-7) to consider after the decimal 

point to format large numbers. Based on the decimals, the value is rounded 

off to the nearest whole number.

Advanced Settings • Choose an orientation for the linear gauge:

◦ Horizontal: Data values appear on a horizontal scale.

◦ Vertical: Data values appear on a vertical scale.

• Select the Show Range Bar  check box to dynamically show the high

est and lowest value on the linear gauge scale.

• Select a default color for the range bar.

Range(s) You can specify one or more ranges to to display in a different color.

1. Select +Add Item.

2. Specify a value range by entering values for Start of Range  and End 

of Range.

3. Select a unique color  (on page 660)  for the specific range.

Hidden
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Linear Gauge at Runtime

Example of a horizontal orientation:

Example of a vertical orientation:

iFrame
Use the iFrame widget to load content from another website within Operations Hub.

The iFrame widget is available under INTEGRATION  > DISPLAY. When designing application pages  (on 

page 376), drag-and-drop GEIFrame  to a container.

The following list of properties are specific to this widget. For common properties, refer to Page 

Components (Classic)  (on page 653).

iFrame Properties

Field Name Description

Source - URL Use any of these options to provide the URL address of the website you 

want to load in the iFrame widget.
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Field Name Description

• Select the Query  tab to choose from queries that return an URL as 

output.

Note:

If the query output returns an array with multiple URLs, then 

the first URL value is taken into consideration.

• Select the Global  tab to choose from URL outputs available as global 

parameters.

• Select the Manual  tab, and enter the URL address in the text field.

• Select the Formula  tab to add a formula that returns an URL as out

put.

◦ Select Add Formula  > Add text.

◦ Enter the URL address in the text field.

◦ Select Done  to save and add the formula to the iFrame wid

get.

Hide Scrollbars If selected, hides the scroll bar. The horizontal and vertical scroll bars ap

pear only when the content in the iFrame widget extends beyond the wid

get's width and height.

Enable Full Width If selected, the iFrame widget occupies 100% of the width of the container. 

Enabling this property overrides the Width (px)  set for the widget.

Width (px) If you do not select Enable Full Width, then set a width for the iFrame wid

get in pixels.

Height (px) Set a height for the iFrame widget in pixels.

Border Style To apply a border to the iFrame widget, select from any of the available 

styles, or select None  for no border.

• Solid: Applies a solid border

• Inset: Applies a 3D inset border

• Outset: Applies a 3D outset border

Border Width (px) Enter a value that defines the thickness of the iFrame border.

Border Color Select a color to apply to the four borders of the iFrame widget.

Hidden
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iFrame at Runtime

Note:

• When you print preview a webpage, it may not look like the actual web page. The print 

stylesheet formats the web page to print in a user-friendly format.

• Some website URLs may not load within an iFrame due to their security policies.

• To load YouTube videos within an iFrame, use the video’s embed URL.

Pivot Grid
Pivot grid allows to visualize data in a multi-dimensional format.

Use the pivot grid to arrange your data in a two-dimensional table, and compare tag names and their 

columns against timestamps. With the pivot grid, you can:

• Rename rows/columns to replace lengthy tag names

• Apply conditional formatting to rows/columns based on values

• Calculate values quickly using totals

• Sort, filter, and summarize data

• Export pivot data to Excel

The pivot grid is available under INTEGRATION  > DISPLAY. When designing application pages  (on page 

376), drag-and-drop GEPivotGrid  to a container.

The following list of properties are specific to this widget. For common properties, refer to Page 

Components (Classic)  (on page 653).
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Pivot Grid Properties

Field Name Description

Source - Input To enable the pivot grid, provide values from a data source.

1. Select a query.

2. Select the query output fields you want to use to get data for the piv

ot grid.

Use Raw Format Select the check box to display numbers in raw format.

For example, a numeric value with 5 or more decimal places is shown as it 

is, and not rounded off.

Number of decimals This option appears if you do not want to display numbers in raw format.

In that case, enter the decimal places (0-7) to consider after the decimal 

point to format large numbers. Based on the decimals, the value is rounded 

off to the nearest whole number.

The decimals will apply to all the pivot grid columns that contain numeric 

values.

Height (px) - 0 equals dy

namic

Set a height for the pivot grid in pixels. If set to 0, the widget occupies 100% 

of its container.

Row Header Width (px) - 0 

equals dynamic

Set a width for the header row in pixels.

Show Borders Select the check box to apply a border to the pivot grid table. To remove the 

border, clear the check box.

Allow Sorting Select the check box to sort the rows and columns alphabetically by de

fault.

Allow Sorting by Summary Select the check box to provide an option to sort the rows by column.

At runtime, right-click the column you want to sort by and select the sorting 

option.

Allow Filtering Row/Col

umn Values

Select the check box to provide an option to filter data at runtime.

Allow Expand/Collapse All Select the check box to enable expand/collapse data levels at runtime.
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Your pivot grid should have multiple data levels to use this property. For val

ue-based table cell data, you can expand and collapse data details to ag

gregate values.

Allow Export Select the check box to allow exporting data at runtime.

Show Row Totals Select the check box to show totals for each row.

Show Row Grand Totals Select the check box to show the grand totals for each row.

Show Column Totals Select the check box to show totals for each column.

Show Column Grand To

tals

Select the check box to show the grand totals for each column.

Field Configuration Configure pivot grid rows, columns, and data. Map all the three areas (rows, 

columns, data).

1. Enter the tag names under Data Field.

2. Select the Data Type  for the entered tag names. For example, 

string.

3. Enter a Caption.

Use this option to add user-friendly captions to your row/column/da

ta fields. Avoid lengthy captions with special characters.

4. Select the Area  for the tags to appear. For example, if you select col

umn, then the respective tags appear in the column at runtime.

5. When area is data, define additional properties for data values.

Formatting: Set default colors  (on page 660)  for the pivot grid.

Field Name Description

Cell Color Select a color for the pivot grid table cells.

Cell Font Color Select a font color for the pivot grid table cell text.

Column Header Font Color Select a font color for the pivot grid table column header text. This helps to 

differentiate the header text from the cell text.

Totals Background Color Select a unique cell color for the row/column totals.

Totals Font Color Select a font color for the row/column totals text.
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Field Name Description

Hidden

Item Configuration: Allows to customize the pivot grid table to override the default settings. Select +Add 

Item  for configuring options.

Field Name Description

Item Display • Row/Column Value: Enter the value that is displayed in a row or col

umn.

For example, if you’re viewing OPCUA tags and their values, you can 

enter a tag name such as FIX.FWT_FWP_DPUMP_1A_FLOW.F_CV.

• Display Value (optional): Use this option to display more user-friend

ly values instead of tag names. This display value overrides the 

Row/Column Value.

For example, enter Pump1A Flow  to replace the OPC UA tag name 

FIX.FWT_FWP_DPUMP_1A_FLOW.F_CV  entered under Row/Column Value. 

At runtime, the column displays values for Pump1A Flow  in the pivot 

chart.

Conditional Formatting Apply conditions to format cells based on values. You can create more 

than one condition for a Row/Column Value. The conditions are applied ac

cording to their order of display. If more than one rule matches a particular 

cell, the first condition in the list to match takes effect and rule processing 

for that cell will stop.

Select +Add Item  for options to create conditions. For example, format a 

cell if its value is less than 9000:

• Comparison: Select <  from the list of comparison operators.

• Value: Enter 9000.

• Cell Color: Select a color for the cells with values less than 9000.

• Cell Font Color: Select a color for the cell text with values less than 

9000.
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Field Name Description

Tip:

If you want to format a row/column with a color that does not 

change based on value, apply the Always  comparison operator.

Pivot Grid at Runtime

Select  to export the data to an Excel file.

Select  to show the Field Chooser  option.

• You can switch the position of row and column fields. To switch a field position, drag and drop the 

field in the desired row/column.

• You can apply multiple filters to the data to get focused results.

• You can sort fields by ascending/descending order.
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Note:

In Field Chooser, row/column/data fields may get misplaced if you remove and add fields to the 

pivot chart. This is a DevExtreme control behavior. For example (refer screenshot):

1. Under All Fields, clear the check box for Name. The field is removed from Row Fields.

2. Under All Fields, select the check box again for Name.

The Name  field may not show up under Row Fields. It may show up under column or data 

fields. In such cases, drag and drop the field to the appropriate location.

Solid Gauge
Use the widget to insert circular charts and monitor the status of industrial systems.

You can use both thin and thick gauges of these types:

• Half

• Three-fourths

• Full

The solid gauge widget is available under INTEGRATION  > DISPLAY. When designing application pages 

(on page 376), drag-and-drop GESolidGauge  to a container.
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Solid Gauge Properties

Field Name Description

Title Enter a title to help identify the solid gauge at runtime.

Value To get values for the widget from a data source, use any of these options:

• Select a query output.

• Select a global parameter.

• Enter source data manually.

• Add a formula.

Min Enter the minimum value for the solid gauge scale.

Max Enter the maximum value for the solid gauge scale.

Use Raw Format Select the check box to display numbers in raw format.

For example, a numeric value with 5 or more decimal places is shown as it 

is, and not rounded off.

Number of decimals This option appears if you do not want to display numbers in raw format.

In that case, enter the decimal places (0-7) to consider after the decimal 

point to format large numbers. Based on the decimals, the value is rounded 

off to the nearest whole number.

The decimals will apply to Value, Min, and Max  properties.

Engineering Unit Enter the unit of measurement for the values on the gauge.

Width (px) (0 equals Dy

namic)

Enter a width for the solid gauge. If set to 0, the widget occupies 100% of its 

container, and fills the area in the application.

Background Color Select a background color  (on page 660)  to fill the widget.

Font Color Select a font color  (on page 660)  for the widget text.

Font Size (px) (0 equals 

Dynamic)

Specify a font size in pixels for the solid gauge display text. If set to 0, the 

font resizes to match with the width of the widget.

Sparkline The sparkline data is created based on the query applied to the widget. We 

can see a sparkline only if the query returns multiple records from the da

ta source. The sparkline is not displayed for a single record even if it is en

abled.
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Field Name Description

Select the check box to enable the sparkline for the selected Gauge Variant 

at runtime.

Gauge Variant List of different types of gauges you can use in your application.

Text position Select a position to display text for the solid gauge at runtime.

• Top Left  is the default position.

• You can choose to position the text at the Center  of the gauge.

Range(s) You can specify one or more ranges to display in different colors.

1. Select +Add Item.

2. Enter a value for limit. At runtime, the gauge is displayed in the se

lected color on reaching this value.

3. Select a color  (on page 660)  for the range limit.

4. Use  and  to reorder ranges. The ranges are implemented in 

the specified order.

5. Select  to delete a range.

Alert Limit(s) You can add one or more alerts on a gauge, each with unique values.

1. Select +Add Item.

2. Enter a value for limit. At runtime, a line alert is displayed on the 

gauge on reaching this value.

3. Select a color  (on page 660)  to identify the line alert.

4. Use  and  to reorder alerts. The alerts are implemented in the 

specified order.

5. Select  to delete an alert.

Result Set Index This property is applicable for REST queries only. It allows to define which 

index of the result set the widget should use as input data. Default is 0.

For example, consider a Historian REST query that returns data for three 

tags.
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Field Name Description

• If you want the widget to use the first tag data from the query result 

set, then set the index value as 0.

• To direct the widget to use the second tag data, enter the index value 

as 1.

• Similarly, you can set index values as 2, 3, 4, etc. based on the data 

to provide as input to the widget.

Reverse Order This property helps to reverse the query result set.

Select the check box to provide the bottom record value as input to the wid

get.

Clear the check box to provide the top record value as input to the widget.

When you apply this property to REST queries that return more than one 

record for each input tag, the records of the selected tag (use Result Set In

dex  to select the tag) are reversed.

For example, consider a Historian REST query with two input tags (tag1 and 

tag2); each with 100 records as result. Set the Result Set Index  as 0  and 

verify the following:

• If you selected the Reverse Order  check box, then the 100th record 

(last) value of tag1 is displayed on the gauge.

• If you cleared the Reverse Order  check box, then the first record val

ue of tag1 is displayed on the gauge.

Hidden

Solid Gauge at Runtime

The change in values are indicated with changing colors.
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Value Display
Use this widget to display any type of data value.

The value display widget is available under INTEGRATION  > DISPLAY. When designing application pages 

(on page 376), drag-and-drop GEValueDisplay  to a container.

The following list of properties are specific to this widget. For common properties, refer to Page 

Components (Classic)  (on page 653).
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Value Display Properties

Field Name Description

Title Enter a title for the widget, which is displayed at runtime.

Engineering Unit Enter the engineering unit of measurement for the values, which is dis

played at runtime.

Height Set a height for the value display widget in pixels.

Width Set a width for the value display widget in pixels.

Padding Enter a value that defines the space between the content and the widget's 

borders.

Background Configuration 1. Options:

◦ Select Transparent  to apply a transparent background for the 

widget.

◦ Select Color  to apply a colored background for the widget.

2. Color: If you opted for a colored background, specify a color for the 

background.

Border Configuration • Width: 0  implies that the widget has no border. 1  implies that the 

widget has a border. With every increasing value, the thickness of 

the widget's border is determined.

• Radius: 0  implies that the widget has no round corners. 1  implies 

that the widget has a round corner. With every increasing value, the 

curve at the corners are determined.

• Color: Applies a color to the widget's border.

Font Size Enter a font size for the widget's Title  and Current value and EGU.

Font Color Select a font color for the widget's Title  and Current value and EGU.

Font Style Select a font style for Title  and Current value and EGU, whether normal, 

bold, or italic.

Rotate Allows to rotate the widget based on the selected degree of rotation.

Align • Text: Allows to align the text left, right, or center within the widget.

• Horizontal: Allows to align the widget left, right, or center within its 

container.

• Vertical: Allows to align the text either at the top, middle, or bottom 

of the widget.
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Field Name Description

State Configuration You can configure how the widget should appear whenever there is a 

change in its status. Use any of these options:

• Select the Query  tab to specify a query, which returns output values 

that indicate the status change. The query should include these out

put fields - value, operator, textColor, borderColor, background, back

groundColor, and blinking.

• Select the Global  tab to choose from values that are available as 

global parameters.

• Select the Manual  tab, and enter the values for all fields in the text 

field. However, if you are manually entering values, then it is recom

mended to use the Manual State  property.

• Select the Formula  tab to add a formula that returns output values to 

indicate the status change.

◦ Select Add Formula  > Add text.

◦ Enter the values for all fields in the text field.

◦ Select Done  to save and add the formula to the value display 

widget.

Example: For Global, Manual, and Formula, you can paste the following 

sample code in the text field:

[

   {

      "value": "130000",

      "operator": ">=",

      "textColor": "red",

      "borderColor": "green",

      "background": "color",

      "backgroundColor": "blue",

      "blinking": true

   }

]

Manual State You can manually configure each field (instead of applying a query) how 

the widget should appear on reaching a specified value. Select +Add Item 

and provide these field values that help to indicate the change:
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• Enter a threshold Value, and select an Operator  for comparison. For 

example, consider the value is 100  and operator is =. It means that 

when the widget value is equal to 100, the following changes apply to 

the widget.

• Selected Text Color  and Border Color  are applied.

• Background, if not transparent applies the selected Background 

Color.

• If selected, applies Blinking  animation on the widget when the value 

is equal to 100.

You can configure several manual states using +Add Item.

• Use  and  to reorder manual states.

• Select  to delete a configured manual state.

Value Configuration You can configure the values on how they should appear at runtime.

Select a Format  for the value, whether the value should be a number or 

string.

•

• If value is a number, specify the Number of decimals  for the value. If 

value is a string, decimals do not apply.

Number Format • Use Raw Format: Select the check box to display numbers in raw for

mat. For example, a numeric value with 5 or more decimal places is 

shown as it is, and not rounded off.

• Number of decimals: This option appears if you do not want to dis

play numbers in raw format.

In that case, enter the decimal places (0-7) to consider after the dec

imal point to format large numbers. Based on the decimals, the val

ue is rounded off to the nearest whole number.

Value Use any of these options to provide data source values for the widget.
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• Select the Query  tab to choose from queries that return data source 

values as output.

• Select the Global  tab to choose values that are available as global 

parameters.

• Select the Manual  tab, and enter the value in the text field.

• Select the Formula  tab to add a formula that returns data source val

ues as output.

Historian REST Options > 

Result Set Index

This property is applicable for Historian REST queries only. It allows to de

fine which index of the result set the widget should use as input data. De

fault is 0.

For example, consider a Historian REST query that returns data for three 

tags.

• If you want the widget to use the first tag data from the query result 

set, then set the index value as 0.

• To direct the widget to use the second tag data, enter the index val

ue as 1.

• Similarly, you can set index values as 2, 3, 4, etc. based on the data 

to provide as input to the widget.

Historian REST Options > 

Reverse Sorting Order

This property is applicable for Historian REST queries only. It helps to re

verse the query result set.

Select the check box to provide the bottom record value as input to the wid

get.

Clear the check box to provide the top record value as input to the widget.

When you apply this property to REST queries that return more than one 

record for each input tag, the records of the selected tag (use Result Set In

dex  to select the tag) are reversed.

For example, consider a Historian REST query with two input tags (tag1 and 

tag2); each with 100 records as result. Set the Result Set Index  as 0  and 

verify the following:
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Field Name Description

• If you selected the Reverse Order  check box, then the 100th record 

(last) value of tag1 is displayed on the value display.

• If you cleared the Reverse Order  check box, then the first record val

ue of tag1 is displayed on the value display.

Hidden

Image
Allows to insert images in your application.

When designing application pages  (on page 376), navigate to INTEGRATION  > DISPLAY  and drag-and-

drop Image  to a container.

Operations Hub also provides an older version of Image  (on page 426).

Image Properties

Field Name Description

BEHAVIOR > Click Event You can choose from these available actions:

• Submit: This action submits the data to the selected entity.

• Go to page: This action leads to the specified page within the appli

cation.

• Go to previous page: Use this action to navigate between historical 

entries created for the current application session. If there is no pre

vious history, then the plugin remains idle.

• Go to next page: Use this action to navigate between historical en

tries created for the current application session. In the absence of 

next session entries, the plugin remains idle.

• URL: This action leads to the specified (external) URL.

• Set global value: This action enables the data to be available glob

ally.

• Show Component: This action displays a hidden component in the end 

app.

• Hide Component: This action hides a component.

• Toggle Show/Hide: This action allows to switch between hidden and 

shown views of a component.
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Source > Input Value Provide the input data source to receive values for the image.

Note:

This property applies only when you select Data  as the image 

source.

Image Source Use these options to set a background image for the widget.

Type: Select from these image types:

• Data: When you select this option, specify the input data source.

Note:

If you want to use a global variable as the data source, make 

sure the variable value points to an image URL. For example, 

https://<machine-name>/custom/images/myimage.png

• File: Browse and select the file you want to use.

• URL: Allows to retrieve an image from a URL. Provide the source im

age URL. For example, you can also upload your image to any third 

party (such as imgur), and get its URL.

Note:

Applies to importing applications from an older version of 

Operations Hub Classic to Operations Hub 2023.

When you import an App to v2023, the Image plug-in’s 

Image Source  > Type  is altered in the new system.

To rectify in the imported App, go to the Designer and select 

the Image plug-in to access its properties. Change the Type 

back to the originally set type. The original source informa

tion (if exists) is retrieved.

Image Fit: Determines how the image fits into its container, whether to 

align horizontal (or) vertical.
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Image Height Enter the height in pixels.

Hidden

Simple Indicator

The widget is available under INTEGRATION  > DISPLAY. When designing application pages  (on page 

376), drag-and-drop simpleindicator  to a container. For advanced features, use Indicator  (on page 

635).

Simple Indicator Properties

Field Name Description

Source > Input Value Provide the input data source to receive values for the simple indicator.

Source > Label (False) The label that appears when the indicator is in false state. For example, 

Off.

Source > Label (True) The label that appears when the indicator is in true state. For example, On.

Legacy Support (act like 

original widget)

Icon Size (px) Enter the icon size in pixels.

Label Styling Formats the label: Font Family  and Font Size  formats the label text.

State Colors Select colors that appear in the background for true/false status.

• False Background Color: This color appears when the simple indica

tor is in false state.

• True Background Color: This color appears when the simple indica

tor is in true state.

State Icons Choose from font awesome icons to represent true and false states.

Hidden

List
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The widget is available under INTEGRATION  > DISPLAY. When designing application pages  (on page 

376), drag-and-drop list  to a container. To use the old version, refer to List  (on page 446).

List Properties

Field Name Description

Source > Input Value Provide the input data source to receive values for the list.

Target > Selected Item Provide the target data source to send information.

Prefix Icon (Font Awe

some)

Adds a prefix icon. Choose icons from Font Awesome icon library.

Hidden

Text Display
Use this plug-in to add display-only text in your application.

The widget is available under INTEGRATION  > DISPLAY. When designing application pages  (on page 

376), drag-and-drop Text Display  to a container. To use the old version, refer to Text  (on page 424).

Text Properties

Field Name Description

Source > Label Provide the input data source to receive label names for the text plugin.

Source > Input Value Provide the input data source to receive values for the text plugin.

Use Raw Format Select the check box to display numbers in raw format.

For example, a numeric value with 5 or more decimal places is shown as it 

is, and not rounded off.

Number of decimals This option appears if you do not want to display numbers in raw format.

In that case, enter the decimal places (0-7) to consider after the decimal 

point to format large numbers. Based on the decimals, the value is rounded 

off to the nearest whole number.

The decimals will apply to Input Value, Minimum Value, and Maximum Val

ue  properties.

Label Styling Formats the label: Font Family, Font Size, and Font Color  formats the text.
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Hidden

General

General Overview

The following list of plugins are available under the general category:

• Date Picker  (on page 592)

• Breadcrumb  (on page 594)

• DateTime Range Picker  (on page 597)

• Dropdown  (on page 598)

• Favorite Organizer  (on page 600)

• Trend Card  (on page 613)

• Task Client  (on page 629)

• Indicator  (on page 635)

Date Picker
Add a calendar to display date and time in a variety of formats.

The calendar allows you to select specific date and time to use with queries and other data in the end 

application. All time related queries can make use of the date and time selection.

The date picker widget is available under INTEGRATION  > GENERAL. When designing application pages 

(on page 376), drag-and-drop GEDatePicker  to a container.

Specify these plug-in properties:

Note:

When configuring input targets for plugins, ensure that no other binding exists for the target query 

input. To remove a binding from the query input, select the unlink icon next to the binding.

The following list of properties are specific to this widget. For common properties, refer to Page 

Components (Classic)  (on page 653).
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DatePicker Properties

Field Name Description

Title Provide the text that appears as a label above the plug-in in the end applica

tion.

Type Select from these options for display in the end application:

• date: displays only date

• time: displays only time

• datetime: displays both date and time

Display Format Select the format for the date and time display.

Note:

If date picker output is used as an input for any of the extension 

type queries  (on page 247), then choose only these display for

mats:

• yyyy-MM-dd HH:mm:ss  (24 hour)

• yyyy-MM-dd hh:mm aa  (12 hour)

Timezone Select the timezone as local or UTC.

Note:

For Historian sources, use 'local' for timezone.

Source Input Value Set this value to allow the plug-in to start displaying a specific date and/or 

time when it loads in the end application.
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Input Target This is the value the plug-in provides as an output in the end application. 

For example, you can choose a date/time/datetime that is passed to the 

query, which requires a date time.

Hidden

Date Picker at Runtime

Breadcrumb
With the GEBreadcrumb plug-in, you can navigate through the asset model.

The purpose of a breadcrumb is to allow you to access an asset's information located anywhere in the 

asset model hierarchy. A breadcrumb navigation also defines the relationship between different assets in 

a model.

The breadcrumb navigation is available for all the widgets in Operations Hub. You can navigate in the 

trend card using breadcrumb.

In the end application UI, to access the breadcrumb, select  and browse your model.
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To use the plug-in in the page designer, drag GEBreadcrumb  from Integration  > General  to a container on 

the page.

You must specify these breadcrumb properties:

Note:

When configuring input targets for plugins, ensure that no other binding exists for the target query 

input. To remove a binding from the query input, select the unlink icon next to the binding.

The breadcrumb is customizable, enabling you to add conditions for display navigation. Refer to Page 

Components (Classic)  (on page 653)  for common widget properties.
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Breadcrumb Properties

Field Name Description

Source Asset Context Select the source (asset name) for an asset context. The selected context 

appears as a default breadcrumb view in the end application. This asset 

name must exist in your asset model  (on page 338).

Target Asset Context Select the target for an asset context. This target defines where that output 

goes on selecting an asset in a breadcrumb, so that it can be fed either to a 

query or a global.

Target Extension Query for 

Asset Context Properties

Select the target for an extension query. This is a formatted string with a 

list of properties that defines the hierarchy of the breadcrumb in the end 

application. For example, consider these crumbs in a hierarchy - first is 

‘pump’, second is ‘pump pressure’, ‘pump frequency’, ‘pump vibration’, or 

‘pump flow’.
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DateTime Range Picker
Use preset date ranges or create your own custom ranges for the calendar.

The datetime range picker widget is available under INTEGRATION  > GENERAL. When designing 

application pages  (on page 376), drag-and-drop GEDateTimeRangePicker  to a container.

The following list of properties are specific to this widget. For common properties, refer to Page 

Components (Classic)  (on page 653).

DateTime Range Picker Properties

Field Name Description

Label Enter a label name for the datetime range picker.

Default Duration This is the default date range set for the widget.

Preset Ranges These are pre-defined datetime ranges. Select the check box of the range 

to add to your calendar.

Auto update at startup Select the check box to allow the datetime range picker to automatically 

update the value of an input element it's attached to at initialization and 

when the selected dates change.

Note:

Selecting the auto-update option disables datetime selection in the 

calendar.

Custom Ranges Create one or many customized datetime ranges to add to the calendar.

Data Targets Configure one or more target outputs to receive values from the widget.

Note:

For Historian queries, format data target values as StartLocalISO 

and EndLocalISO  for Start Time and Stop Time respectively.

Data Sources Configure one or more data sources to get values for the widget.

Show Scroll Buttons Select the check box to allow scrolling through the dates.
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Datetime Range Picker at Runtime

Dropdown
Allows for multi-select, search, and select values.

Use this widget to select between multiple choices, search through a large list of choices, perform 

multiple selections, include a header, etc. For a simpler version, use a standard Dropdown  (on page 

414).

The dropdown widget is available under INTEGRATION  > GENERAL. When designing application pages 

(on page 376), drag-and-drop GEDropdown  to a container.

The following list of properties are specific to this widget. For common properties, refer to Page 

Components (Classic)  (on page 653).

Dropdown Properties

Field Name Description

Source - Dropdown Data Use any of these options to provide values from a data source to populate 

the dropdown.

• Select the Query  tab. Choose a query that can return dropdown val

ues as output. Add as many output fields as required. Here's a sam

ple query response:

{"status":{"success":true,"code":0,"reason":"Ok"},

"result":[
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{"State 

 Data.value":"dd-historian://

${his1}/KALYANMR2_Simulation.Simulation00002","State Data.key":"graduate"},

{"State 

 Data.value":"dd-historian://

${his1}/KALYANMR2_Simulation.Simulation00003","State Data.key":"school"}

],"more":false}

• Select the Global  tab. Choose an output field value that is available 

as a global parameter.

• Select the Manual  tab. In the text field, enter the output field value 

you want to pass.

• Select the Formula  tab.

◦ Select Add Formula  > Add text.

◦ Enter the output field value in the text field.

◦ Select Done  to save and add the formula to the dropdown 

widget.

These are the two basic formats to manually enter values for a dropdown.

[

   {"key1":"abc", "value1" : "1"},

   {"key2":"def","value2":"2"},

]

(OR)

[{"key1": "value1"}, {"key2":"value2"}]

Target - Dropdown Target Use any of these options to specify the target source for a dropdown value. 

At runtime, when you select a value from the dropdown, the value gets as

signed to the target specified in this property.

• Select the Query  tab. Choose a query input value as target.

• Select the Global  tab. Add or choose a global value as target.

Output Format Specify whether the output value should be an array or string format.

Manual Input You can also use this property instead of using options in Dropdown Data 

property.
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Field Name Description

Manually create values for a dropdown widget:

1. Select +Add Item  to add a dropdown item.

2. Enter Display Name  and Value.

3. Add as many items as required.

4. Use  and  to rearrange the items order of display in a drop

down.

5. To delete an item, select  next to it.

Note:

If you configured both Manual Input  and Dropdown Data  properties 

for the widget, then the dropdown is populated with a list of com

bined values. Make sure to validate and rectify your data to avoid 

duplicates in the dropdown.

Label Enter a label name that appears above the dropdown widget. For example, 

Choose an item

Dropdown Placeholder Enter the placeholder text that appears in the dropdown. For example, 

-Select-

Dropdown height (px) Set a height for the dropdown list in pixels.

Multiple selection Allows to select multiple values from a dropdown. If you select this proper

ty, specify the Output Format  and Output Separator.

Max Selections Specify the maximum number of values that can be selected from the drop

down.

Enable search Select the check box to enable a search option for dropdown values.

Output Separator By default, multiple values are separated by a comma. You can also use 

other symbols like semicolon.

Width (px) (0 equals Dy

namic)

Enter a width for the dropdown. If set to 0, the widget occupies 100% of its 

container, and fills the area in the application.

Favorite Organizer
Use the widget to create folders and organize your favorite trend charts.
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This widget allows you to group all your favorites under a meaningful folder structure, and get to them 

quickly. The favorite organizer can be used along with the trend card on the same page to display 

favorites effortlessly.

When you import/export apps in Operations Hub, only favorites are imported/exported as unparented 

items. The folder structure is not imported/exported.

The favorite organizer widget is available under Integration  > General. When designing application pages 

(on page 376), drag-and-drop GEFavoriteOrganizer  to a container.

Favorite Organizer Properties

Field Name Description

Title Provide a title name for the favorite organizer.

Unparented items folder By default, the folder that contains the unparented items is called Unorga

nized. You can modify the default name.

Unparented items are orphaned favorites, which are not yet organized in a 

tree folder structure.

Permissions Visible Select/Clear the check box to show/hide the option to set folder/favorite 

permissions.

If selected, permissions appear in the Favorite Organizer next to each fold

er/favorite at runtime. See Manage Permissions  (on page 603).

Height Set the height for the favorite organizer widget.

Header Background Color Set a background color for the favorite organizer header.

Header Color Set a color for the favorite organizer header text (if a title name is set).

Toolbar Background Color Set a background color for the favorite organizer toolbar (contains menu 

options to create, rename, refresh, and delete folders).

Icons You can customise the icons that represent folders and favorite items. You 

can also assign unique icons to distinguish between the folders/favorites 

that are shared with you, and those created by you. Choose icons from Font 

Awesome or DevExtreme icon libraries.

To use a Font Awesome icon, you need to specify that it is from the font 

awesome library, such as fa fa-star. https://fontawesome.com/icons

https://fontawesome.com/icons
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Field Name Description

To use a DevExtreme icon, use the icon name (such as folder). https://

js.devexpress.com/Documentation/Guide/Themes_and_Styles/Icons/

Source > Input Selection Select a global parameter to control the selected favorite within this wid

get. This global drives the selection of the favorite in the tree.

Target > Output Selection Select a global parameter for capturing output selection. When you select a 

favorite item in the favorite organizer at runtime, your selection is published 

to this global.

Select Output Format  from these options:

• Favorite Name: When you select a favorite in the favorite organizer, 

the name of that favorite is published to this global.

• Favorite JSON: When you select a favorite in the favorite organizer, a 

string containing a JSON representation of the data stored in that fa

vorite (depending on the format selected), is published to this global.

Favorite Organizer at Runtime

Use the toolbar menu to create  (on page 603), rename  (on page 603), delete  (on page 603), and 

refresh folders.

https://js.devexpress.com/Documentation/Guide/Themes_and_Styles/Icons/
https://js.devexpress.com/Documentation/Guide/Themes_and_Styles/Icons/
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Create a Folder

1. Select  to access the Add Folder  screen.

2. Enter a name for the new folder.

3. Select Add. The new folder is created under its parent folder.

4. Drag and drop the favorites into the newly created folder.

Rename a Folder

1. Select the folder to rename.

2. Select  to access the Rename Folder  screen.

3. Enter the new name for the folder.

4. Select Rename.

Delete a Folder

Deleting a folder does not delete favorites in the folder.

1. Select the folder to delete.

2. Select . The Remove Folder  confirmation dialog appears.

3. Select Delete. Any favorites in the deleted folder are moved to Unorganized  folder.

Manage Permissions

Share your favorites and favorite folders with other users. By default, favorites/folders are set to private 

when you create them, and are not visible to other users. You can change the default permission, and 

share with all or select users belonging to groups.

Note:

If upgrading from an older version (2022.4.1 or before), then existing favorites are visible to all 

groups.

1. Select the permission next to the favorite/folder you want to share.
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When you set folder-level permission, the favorites in that folder are not automatically shared. You 

need to share favorites by setting individual permissions.

2. In the Manage Permissions  screen, you can choose to share or keep your favorite/folder private.

Field Description

Name Name of the favorite/folder.

Owner Owner of the favorite/folder.

All Groups Select this option if you want to share your fa

vorite/folder with all groups.

Selected Groups Select this option if you want to share your fa

vorite/folder with only selected groups. A field 

appears to browse through a list of groups for 

selection. Child Groups  appear based on the 

selected groups for further selection.

To filter the list and show only GE groups, se

lect Only GE Groups.

Private Select this option if you want to keep your fa

vorite/folder private.

Note:

An administrator can access and mod

ify all favorites/folders, including pri

vate.

3. Select Save Permissions  to save and close the screen.

You do not have permission to modify or delete the favorites/folders shared with you. You can only load 

the shared favorites.

Organizing Favorites/Folders

To organize favorites/folders, drag and drop favorite and folder items into other folders. To do this, you 

must be the owner of both the items - dragged item and target folder. Administrators are not bound by 

this restriction because they have read/write permissions to all favorites/folders.
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Histogram
This plug-in provides a graphical representation of the distribution of numerical data.

The histogram widget is available under Integration  > General. When designing application pages  (on 

page 376), drag-and-drop GEHistogram  to a container.

See Configuring Histogram  (on page 606).

Histogram Properties

Field Name Description

Source > Default Sampling 

Mode

Set a default sampling mode for histogram. Use any of these options to get 

values from a data source:

• Select a query output.

• Select a global parameter.

• Enter source data manually.

• Add a formula.

Source > Height Set the height of the histogram chart.

Source > Chart Title Provide a title name for the histogram chart. The value must be a text 

string.

Source > Show Header 

Controls

Specify a boolean value. True  shows chart header controls. False  hides 

chart header controls.

Source > Scroll Percentage Configure the scroll percentage based on the total time range.

Background Color Adds a background color to the histogram chart.

Show Border Select the check box to add a border to the histogram chart.

Border Color If you choose to add a border, then set a color for the border.

Source > Logging Level Applies to log messages. You can control the level of data logged to the 

browser console. The default value is info. Other valid values are step, 

trace, debug, warning, error, and none.

Source > Historian Legend Specify whether to show/hide legend by default.

Number of Bins Enter the default number of bins to appear on histogram.

Bins Color Set a default color for the bins.
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Field Name Description

Normalized Curve Color Set a default color for the normalized curve.

Configuring Histogram
This topic describes how to configure a histogram chart at runtime.

You need a Historian data source. See Create a Data Source (Classic)  (on page 352).

1. Run the histogram application.

2. From the toolbar menu, select  to access the Histogram Configuration  settings.

3. Use these settings to configure your Histogram chart:

Setting Description

Duration Specify a duration to plot the data. This duration is subtracted from the 

specified End  time. You can go back in time in minutes, hours, or pro

vide a customized duration for the histogram chart. Choose from any of 

these options:

◦ 1, 5, or 30 minutes

◦ 1, 2, 4, 8, or 24 hours

◦ Select Custom  to enter a different duration in the time format 

text box.

End You have the option to either choose a custom datetime using the cal

endar, (or) set the current system datetime.
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Setting Description

Select  to set a custom end date and time for data.

Now Use this option to update the End  time to your current system data and 

time. The toggle is enabled by default. Choosing a different end date 

and time (using calendar) automatically disables the toggle.

Select  to refresh charts set to 'Now'. The refresh option instantly 

updates the end time to current time.

Display Use this option to set a display style for the tag added to the histogram 

chart. You can choose any of these display styles:

◦ Tag Name: Displays only tag name.

◦ Tag Description: Displays only tag description. Lengthy descrip

tions are truncated with an ellipsis. Move your cursor over ...  to 

reveal the complete description. In the absence of a description, 

tag name is displayed by default.

◦ Tag Name and Description: Displays both tag name and descrip

tion.

Sampling Increment Select whether you want to increment the sampling data based on time 

or count, and then specify the time or count, respectively.

Note:

The sampling increment may not always be honored. The max

imum number of data points plotted on the histogram chart 

is 3000 when sampling by time, and 8000 when sampling by 

count. You can zoom in to view more accurate data.

No. of Bins Indicates the default number of bins to appear on a histogram chart. 

You have the option to increase/decrease the bin count at runtime.
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Setting Description

Note:

You can add any number of bins from 1 to 200.

Auto-detect Data 

Range

If auto-detect is enabled, the X-axis values are automatically populated 

from the tag added to histogram. You have the option to modify the au

to-detected value range for the chart.

To disable auto-detect, turn off the toggle and enter manual Data Range 

X-axis  values. The histogram chart is updated to show the data analysis 

based on the newly specified X-axis values.

Normalized Curve Use this option to format the normalized curve (bell curve) in a his

togram chart.

◦ Apply a color to the curve.

◦ If auto scale is enabled, the Y-axis values on the right side of the 

graph are automatically populated from the tag added to his

togram. You can disable the auto scale option to enter specific 

Min  and Max  values.

◦ To show or hide the curve on the histogram chart, select the eye 

icon in settings, (or) the Normalized Curve  label on the chart.

Counts Use this option to format histogram counts that appear on the left Y-ax

is of the graph.

◦ Apply a color to the bins.

◦ If auto scale is enabled, the Y-axis counts on the left side of the 

graph are automatically populated from the tag added to his

togram. You can disable the auto scale option to enter Min  and 

Max  count values. In case, the counts range is reduced, then less 

number of bins appear on the chart even if the default is set to a 

higher number.

◦ To show or hide the bins on the chart, select the eye icon in set

tings, (or) the Counts  label on the chart.
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Setting Description

Sources Select Add Tag for Histogram  to browse the Proficy Historian data 

source, and select a tag to add to histogram.

Note:

You can add only one tag.

4. Use the toolbar menu options to achieve the following tasks:

Task Procedure

Show/Hide legend
Select  to show or hide the histogram chart legend.

View statistics
Select  to show/hide the statistical data for Historian tags. The 

statistics appear below the chart.

Export data
Select  and then select Export  to export and save the histogram 

chart data to a CSV file.

Print data
Select  and then select Print. Enter the title and print.

Note:

The x-axis and y-axis scale values may change when printing 

the histogram. However, the graph remains functionally accu

rate.
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Task Procedure

Reset histogram chart
Select  and then select Reset. Any changes made to the duration, 

start time, axis preferences, and properties are reverted.

Zoom in/out Mouse-click and drag anywhere on the chart to zoom in.

Select Reset zoom  to zoom out.

Trend Card
Use the trend card widget to build trend charts in your application.

Refer to Trend Chart Overview  (on page 613)  for more information.

The trend card widget is available under Integration  > General. When designing application pages  (on 

page 376), drag-and-drop GETrendCard  to a container.

Trend Card Properties

Field Name Description

Source > Asset Name (Op

tional Override)

Select an asset name.

Source > Select Favorite With this property, you can configure the trend chart to load an existing fa

vorite at runtime.

To use this property along with the Favorite Organizer  (on page 600)  wid

get, configure the Target Output Selection global with an Output Format 

(on page 602)  of Favorite Name, then bind the output of favorite organizer 

widget to this property in order to drive the trend chart via favorite.

Source > Trend Config In

put

The selected input value (global or query) contains a JSON representa

tion of the data to trend. The format of this JSON is same as the output of 

Trend Config Output, and is very similar to a trend favorite (excluding fa

vorite name).

This property is typically used along with the Favorite Organizer  (on page 

600)  widget. Set the favorite organizer Output Format  (on page 602)  to 

Favorite JSON, then bind the output of favorite organizer widget to this in

put property in order to drive the trend chart without selecting the favorite 

at runtime.
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Field Name Description

Target > Trend Config Out

put

The output of this property is a string representation of the configuration 

of the currently trending chart. This contains all of the data that is saved as 

part of a favorite, such as trend mode (realtime/historical), time settings, 

selected tags, etc.

Source > Default Sampling 

Mode

Select a sampling mode. This mode is set as default, and loaded at runtime 

for historical sources on both Live and Historical trends.

Source > Height Set the height of the trend chart.

Source > Stacked Height Set the height of an individual trend chart in a stack. This property applies 

when you opt for a stacked Y-axis mode for the trend chart.

Source > Tabular View 

Height

Set the height of the table. This property applies when you opt for a tabular 

view mode for the trend chart.

Source > Chart Title Provide a title name for the trend chart. The value must be a text string.

Source > X-Axis Label Provide a label name for the x-axis. The value must be a text string.

Source > Y-Axis Label Provide a label name for the y-axis. The value must be a text string. De

pending on the plotted data, the y-axis label is displayed either on the left or 

right side of the chart.

The label name appears on the y-axis only if you opted for a single y-axis 

configuration  (on page 628).

Source > Historian Tag 

Page Size

Paginates large tag lists from Historian.

Source > Show Header 

Controls

Specify a boolean value. True  shows chart header controls. False  hides 

chart header controls.

Source > Show Trend Val

ue Axes

Specify minimum and maximum axis values for the trend chart.

Source > Show Trend Leg

end

Select to show legend on a trend chart.

Source > Show Favorites Select to show favorites on a trend chart.

Source > Scroll Percentage Configure the scroll percentage based on the total time range.
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Field Name Description

Historical Time Selection 

Mode

• Start Time + Duration: With this option, you can select a start time 

and a duration for which you want to view data. Example: View data 

for the past 7 days starting from a specific date and time.

• Start Time + End Time: With this option, you can select a start time 

and an end time for which you want to view data. Example: View 

data for a specific month of the year by selecting the start and end 

dates of that month.

• Duration + End Time: With this option, you can select a duration and 

an end time for which you want to view data. Example: View data for 

the last 30 days up until a specific date and time.

Background Color Adds a background color to the trend chart.

Tooltip Type By default, all tooltips are of shared type. You can choose to display any of 

these tooltip types on your trend card:

• Shared: Displays a single value for a specific point in time and is 

shared across all data series.

• Single: Displays a single value for a specific point in time and is spe

cific to each data series.

• Split: Displays multiple values for a specific point in time and is 

specific to each data series.

Tooltip Opacity (0-100%) Enter the opacity percentage for the tooltip. If 100%, you will not be able to 

see the data behind the tooltip. By lowering the percentage, you can make 

the tooltip background transparent.

Show Border Select the check box to add a border to the trend chart.

Border Color If you choose to add a border, then set a color for the border.

Source > Logging Level Applies to log messages. You can control the level of data logged to the 

browser console. The default value is info. Other valid values are step, 

trace, debug, warning, error, and none.

Source > LoggedIn User

name

A default user name, which is used to add annotations in the trend chart.

Enable Compact View 

Mode

Select the check box to allow for a maximized chart area. This is a view-on

ly mode. You cannot pan across the chart in this mode. You can hide the 

toolbar and legend.
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Trend Chart Overview
The trend chart allows you to plot real time data from OPC UA servers and historical data from Historian 

servers. You can plot the data using the context of a model or browse for a Historian or OPC UA server. 

You can then add tags to the chart.

The model contains asset types and assets. The assets have properties associated with them, which are, 

in turn, associated with tags defined in Historian or OPC UA.

The following image shows an example of a trend chart.

The following table describes the tasks that you can perform on a trend chart.

Task Procedure

Access the properties 

used in a trend chart.

The properties used in a trend chart appear in the Legend  section.

Show/Hide the plotted da

ta

To display this option, select a property from the trend chart legend. Use 

 to show or hide the data on the chart.
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Task Procedure

Remove a property from 

the trend chart.

To delete plotted data from the trend chart, select the respective property 

from the legend, then select .

Increase the area of a 

trend chart.
• Hide the toolbar by selecting .

• Hide the Legend  section by selecting .

Pause the data flow of a 

trend chart.

This option is available only for the live mode.

• On the toolbar, select  to pause trending.

• You can resume the data flow by selecting .

View the delta value be

tween two data points.

The delta values for the trend is displayed in the Legend  section.

On the toolbar, select , and select the two data points whose delta val

ue you want to view.

Display units on the Y-axis If a source tag has engineering units, then the unit information appears on 

the chart's y-axis, legend, and tooltip.
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Task Procedure

Units do not appear on a single y-axis. If you opted for a single y-axis con

figuration  (on page 628), the units appear only on the chart's legend and 

tooltip.

Drill down a trend chart.
On the toolbar, select  to drill down or zoom into a trend chart for more 

granular information. To zoom out, select .

If you want to zoom in or zoom out a single axis, select the axis in the drop-

down list box next to .

If you want to enlarge an area on the chart, select , and then select the 

area on the chart.

Data is re-fetched only in historical mode when zoomed in/out (changes 

chart start time/duration) of a chart. For example, consider trending 500 

samples from 1-2pm, then zoom in to 1:00 - 1:10pm to request 500 sam

ples data for that 10 minute span.

Pan across a trend chart. You must zoom in/out of a chart to be able to pan across a trend chart. The 

pan icon is enabled when you perform the zoom operation.

The pan icon is visible only in the Live  mode.

• Zoom in/out of a chart  (on page 615).

• On the toolbar, select , and then drag the icon to the area on the 

chart that you want to view.

• Move the icon left/right to pan across the x-axis.

• Move the icon up/down to pan across the y-axis.

In Historical  mode:
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Task Procedure

• Zoom in/out of a chart  (on page 615).

• Use the scroll icons  (on page 618)  for Shift Left/Right to move hor

izontally on the x-axis.

• Use the scroll icons  (on page 618)  for Shift Up/Down to move ver

tically on the y-axis.

Mark a trend chart view as 

favorite. It is an easy way 

to view the trend chart for 

commonly used configura

tion settings.

On the toolbar, select , enter a name for the view, and then select Add.

Important:

Special characters ? / \ # ; %  are not supported. Do not include 

them in your favorite name.

To load a favorite view, select the view from the drop-down list box next to 

.

You can also access the list of saved favorites while creating application 

pages  (on page 376)  in Operation Hub. Under Trend Card widget proper

ties, select a favorite chart view from Select Favorite  drop-down list. The 

selected view loads by default when you launch the trend chart at runtime.

View the statistics of tags 

plotted on a trend chart. On the toolbar, select  to show/hide the statistical data for Historian 

tags used in the trend chart. The statistics appear below the chart.

In historical mode, tag statistics are re-fetched on zooming in/out (changes 

chart start time/duration) of a chart.

Trend Card This is the default chart type. There are three chart types:

• Stacked Y-axis

• Trend Card

• Tabular View
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Task Procedure

You can access other chart types from the trend chart toolbar.

Stacked Y-axis On the toolbar, select Stacked Y-Axis  to stack multiple charts. For example, 

if you choose to trend four tags, the chart appears with a common x-axis 

and a stacked y-axis. With a stacked y-axis, you can:

• View delta  (on page 614)  for all the charts in a stack.

• Mouse-over each chart in a stack to view tooltips.

• Configure a source tag to change the chart type to line, area, or scat

ter.

• Configure a source tag to apply a label name along the y-axis for the 

chart.

Note:

• Zooming into Y-axis and X/Y-axis is disabled.

• It is recommended to use the scroll bar to scroll through 

the stacked charts. If using any other means of scrolling 

(mouse scroll wheel, touch pad/screen) to scroll through the 

charts, the tooltips appear inconsistently when you hover 

from one tag to other. To fix this, move your mouse pointer 

out of the chart area, and then mouse-over the tag to view 

its tooltip.

Tabular View On the toolbar, select Tabular View  to display data in a table format.

• Tags appear as column headers. You can choose a display style for 

tags  (on page 622). If Tag Name and Description  is selected as 

display style, mouse-over the the column (tag) name to view its de

scription.
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Task Procedure

• You can select the number of rows to display per page, whether 50, 

100, 200, or 500.

• Filter data in each column to search for the exact values.

• Sort the TIMESTAMP  column values in an ascending/descending or

der.

Export the trend chart da

ta.

The trend chart data is exported and saved as a CSV file.

On the toolbar, select , then select  to export data.

Print a trend chart.
On the toolbar, select , then select .

You have the option to provide a title that appears above the trend chart.

Reset the trend chart op

tions.
On the toolbar, select , then select . Any changes you have made to 

the duration, start time, axis preferences, and properties are reverted.

Scroll through the histori

cal data.
Select  and  to move back and forth in the chart, and access histor

ical data. Scrolling back and forth changes the start time for the chart.

For example, if you are currently viewing trends during 1-2pm, you can 

scroll back in time to view 12:45-1:45pm, then return to current view.
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Recommendations While Using a Trend Chart

When you create a trend chart, we recommend that you apply the following guidelines:

• When you add a trend chart to a page using the page designer, use separate containers for the 

breadcrumb and the chart. For the trend chart, set the height to 100%.

• When accessing a trend chart on a mobile device:

◦ Use a device with medium to high resolution.

◦ Use the device in landscape mode.

◦ To print a trend chart using an Android device, use the screen capture feature rather than 

selecting .

◦ Configure the trend chart using a desktop rather than an Android device. This is because 

when you attempt to search for an asset or a Historian tag on an Android device, the in-built 

keyboard of the device appears, which may not allow you to enter the search criteria.

◦ When you view the delta between two data points, the value may not be clearly readable on 

a mobile device with low to medium resolution. Therefore, we recommend that you view the 

delta value on a desktop or a mobile device with high resolution.

◦ When you view statistical data, the trend chart area may be limited. To avoid this issue, plot 

up to two properties on the trend chart.

◦ To pan across the trend chart or drill down the trend chart on an iPad, use the Zoom feature 

of the iPad rather than selecting , , or , respectively.

Configuring a Trend Chart
Use the trend configuration settings to create or modify your charts.

Create a Data Source (Classic)  (on page 352)  for Historian or OPC UA.

For information on building trend charts, refer to these topics:

• Use the Trend Widget for OPC UA Data Sources  (on page 110)

• Use the Trend Widget for Historian Data Source  (on page 85)

1. Access the trend chart whose settings you want to configure.

2. In the toolbar of the chart, select .

The Trend Configuration  window appears.
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3. Modify the trend chart settings as specified in the following table.

Field Name Description

Mode Select the mode of the trend chart. The following options are avail

able:

◦ Live: Plots real-time data from a Historian server and/or OPC 

UA server.

◦ Historical: Plots historical data from a Historian server.

Note:

Changes made to Live affect Historical as well. For example, 

if you add/delete properties from the chart in the Live mode, 

these changes reflect when you move to the Historical mode 

as well.

Duration Select a duration for which you want to plot the data. The selected du

ration is subtracted from the End  time to deliver past trends. You can 

go back in time in minutes, hours, days, or provide a customized dura

tion.
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Field Name Description

◦ 1, 5, or 30 minutes

◦ 1, 2, 4, 8, or 24 hours

◦ 1 week

◦ 30 days

◦ Choose Custom  and enter a different duration in the time for

mat text box.

End Allows to set an end date and time for trending historical data.

Select  to update a specific date and time.

◦ If you have set a date and time in the past, select Done  to apply.

◦ If you want to set the current date and time, select Now  to ap

ply. The current time can also be set by enabling the toggle 

switch.

Now Allows to update the End  time to your current system time. The toggle 

is enabled by default when you enter the Historical  mode for the first 

time. Choosing a different date and time automatically disables the 

toggle.

◦ Select  to refresh ‘Now’ configured charts. Use this option 

to instantly update the end time to current time if the chart is al

ready configured for ‘Now’.

◦ You can also save a 'Now' configured chart as your favorite. 

When you reload such charts from favorites, the end time is set 

to the current system time, and trends are displayed.

Note:

After upgrading to 2.1, values from previously saved fa

vorites are updated to represent the range for end time 

instead of the start time. The ‘Now’ toggle remains dis

abled for old favorites.

Sampling Increment Select whether you want to increment the sampling data based on 

time or count, and then specify the time or count, respectively.
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Field Name Description

Note:

The sampling increment may not always be honored. The 

maximum number of data points plotted on the trend chart 

is 3000 when sampling by time, and 8000 when sampling by 

count. You can zoom in to view more accurate data.

Display You have the option to set a display style on how tags appear across 

the trend card. The selected display style applies to configured source 

tags  (on page 625)  (except third party OPC UA and asset model 

tags), chart tooltip/legend, and Historian statistical data  (on page 

616). Choose from these options:

◦ Tag Name: Displays only tag name.

◦ Tag Description: Displays only tag description. Lengthy descrip

tions are truncated with an ellipsis. Move your cursor over ... 

to reveal the complete description. In the absence of a descrip

tion, tag name is displayed by default.

◦ Tag Name and Description: Displays both tag name and de

scription.

Notes You can add notes only to historical trends, and not for OPC UA based 

trends.

Switch the toggle to enable viewing or adding a note on the trend 

chart.

On the trend chart:

◦ To add a note for the first time for a specific data point, select 

the data point, and then select .

◦ To access a note, select .
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Field Name Description

Note:

You cannot modify or delete a note; if you want to aug

ment a note, you can add additional notes.

◦ To add an additional note for a data point, select .

◦ To navigate through multiple notes, use  and .

When you access an existing note, the timestamp and tag values that 

appear during the initial loading of the note correspond to the x-axis 

and y-axis values for the data point, respectively. If you select each in

dividual note, the actual raw and timestamp values to which the com

ment was added in the Historian archive appear.

If you add a note to an interpolated value, it is added to the nearest 

raw value. Due to this, the value displayed in the note may not always 

match the value plotted on the chart.

Query Criteria Applies to Historical mode, and for Historian data sources only. This 

option allows you to query tag data based on timestamps.

Note:

Trend via Tag Query can be performed on the tags of the 

same Historian server only, and not from multiple Historian 

sources.

If you want to change to a different Historian data source to 

query tags, do the following:

a. Clear the check box for all the tags from the current da

ta source and select Apply.

b. Reopen Tag Query Criteria.

c. Select the (different) data source tags to add query 

condition/s.

For example, consider you have two tags in your system - Tag1, Tag2. 

You can configure a query criteria wherein you request to plot the 
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Field Name Description

Tag1 data for last one hour that matches with the conditions applied 

to the Tag2 data.

a. Select a duration  (on page 620)  to plot the data. For example, 

select 1H.

b. Select Add Tag Query Criteria  to access the Tag Query Criteria 

screen.

c. Select a tag from the Proficy Historian data source. The select

ed tag appears under ADD CONDITIONS.

d. Expand the tag and set up a condition. You can set up multiple 

conditions using AND, OR  operators.

For example, you can query Tag1 (multiple tags can be trend

ed) data for the timestamps wherein Tag2 is greater than 100 

AND Tag3 is less than 500  OR Tag4 is equal to 300  in the 

specified time range.

e. Select Apply.

The query fetches only the timestamp values where the condi

tion/s are met. Any data that does not match the query criteria 

is filtered out from the trend chart display. As a result, you may 

find interrupted trend lines in the chart.

To modify or update any added query conditions, select the pencil 

icon.
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Field Name Description

Sources Data can be plotted to the trend chart using properties from an asset 

model. In the absence of an asset model, you can also directly browse 

the data source address space and select tags for the trend chart.

Select Add Tags for Trend  to select the properties or tags that you 

want to add to the trend chart  (on page 368).

Tags marked as  are from the Historian data source. Tags marked 

as  are from the real time data sources such as iFIX, CIMPLICITY, 

and any other OPC UA server.
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Field Name Description

Note:

Nodes only work for plotting historical data. They do not work 

in Live mode.

SAMPLING MODE For each tag SOURCE, you can add multiple sampling modes. This op

tion is available only for the historical mode.

Select [Add Sampling Mode]  to add additional sampling modes for a 

tag. For example, you can have 3 different sampling modes for a sin

gle tag in the trend chart. Highlight each mode with a different line col

or, style, and thickness.

These are the modes available to plot data:

◦ Trend To Raw

◦ Minimum

◦ Maximum

◦ Average

◦ Total

◦ Standard Deviation

◦ Interpolated

◦ Lab



Operations Hub for Windows  | 3 - User Guide  | 627

Field Name Description

◦ Lab To Raw

◦ Delta

◦ Delta Positive

◦ Delta Negative

You can trend each tag-sampling mode combination only once. For ex

ample, if Trend To Raw  mode is applied to Water Temp  tag, this mode 

becomes inactive for this tag. The other modes are available to use.

To delete a plotted sampling mode, select  next to the tag.

For more information on the sampling modes, refer to the Historian 

documentation.

Specification Limits To monitor a process performance, you can define upper, lower, or 

targeted limits (from varied data sources) and plot these lines on the 

trend chart.

Provide specification limits for UPPER LIMIT, TARGET, LOWER LIMIT 

as follows:

◦ Enter values manually, (OR)

◦ Select Browse  to browse the data source and select a tag to 

populate realtime data (current value).

To highlight each plotted line with a unique line color, thickness, and/

or style, choose a COLOR, LINE WEIGHT, and LINE STYLE.



Operations Hub for Windows  | 3 - User Guide  | 628

Field Name Description

To remove a plotted limit from the chart, select  next to the specifi

cation limit. You can set the specification limits for both live and his

torical mode, and save the chart to favorites.

Chart Y Axis Configura

tion

Allows to compare two or more tags/sources by having a common 

Y-axis on the trend chart. This option is disabled if you selected the 

Stacked Y-axis mode.

◦ Individual Y Axis for each source: Select this option to include 

an individual Y-axis for each source on a trend chart. For exam

ple, if you have multiple tags trending on your chart, each tag 

has its own Y-axis.

◦ Single Y Axis for all sources: Select this option to include a 

common Y-axis for all the sources on a trend chart. For exam

ple, if you have multiple tags trending on your chart, all the tags 

share only a single Y-axis.
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Field Name Description

SHOW Y-AXIS Select the toggle to switch between showing or hiding the y-axis on a 

trend chart. This option is available under each tag/source if you se

lected individual y-axis for each source.

AUTOFETCH LIMITS By default, the toggle is always turned on, to automatically fetch min

imum (Low) and maximum (High) limits. Turn off the toggle if you 

want to provide manual limits for the chart. Enter values for AXIS LOW 

and AXIS HIGH  to trend the data accordingly. In case you do not enter 

High and Low limits when the toggle is off, the values are auto scaled.

For Individual Y-axis, the option to set limits is available under each 

tag/source.

For Single Y-axis, you can browse and select the tag/source, and set 

custom limits. Turn on the toggle to be able to browse tag/source.

Task Client

Configure the Task Client
This topic describes how to enable the task client widget to operate in the Operations Hub web server 

environment.

Install the Workflow and the Operations Hub applications on different servers.

To configure the task client widget, equipment models from the Workflow application are exported to 

a .csv file, and imported into the Operations Hub application.

1. In the Workflow server, do the following:

a. Select an equipment model you want to export, and then select Generate Operations Hub 

Model.

b. Provide a location to save the exported file, and select Generate.
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The equipment model data is exported to a .csv file format, and saved in the specified 

location.

2. In the Operations Hub server, do the following:

a. Import the .csv file created in step 1 to Operations Hub. For steps, refer to the Import 

Equipment Model  (on page 631)  topic.

b. In the main navigation menu, select APPS, and then select Workflow Tasklist application.

The Pages workspace appears.

c. Select Tasklist View.

The pages associated to the task list appear in a container. TASK LIST, and TASK COUNT  are 

system widgets that cannot be deleted.

d. Select the Task List  page in the container.

The GETASKLIST PROPERTIES  tab settings appears on the right pane.

e. Provide DATA  settings as specified in the table below:

Note:

Scroll down in the settings section to find the data settings after the general and 

display settings.

Parameter Selection Description

WorkflowServer Manual Enter the URL address of the Workflow server to 

connect.
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Parameter Selection Description

RefreshRate Manual Enter the time in seconds at which rate the task 

client will refresh to get the latest data from the 

Workflow server (for example, 5).

Height Manual Enter the preferred height of the task client wid

get (for example, 600).

f. Select Save App.

The application settings are saved.

Log in to the Operations Hub web client to connect and work with the task client widget. Refer to the 

Access the Task Client  (on page 631)  topic.

Import Equipment Model
By importing the Workflow equipment models, you can manage the tasks assigned to you from within the 

Operations Hub application.

Ensure that the Workflow equipment models are exported to a Web HMI model .csv file.

An equipment model is configured in the Workflow application. For more information, refer to the 

Equipment Model topic in the Resource Information and Configuration  section of the complete Workflow 

user guide.

1. Access Operations Hub.

2. In the main navigation menu, select ADMIN.

3. In the Admin workspace, select Import/Export.

The Model Import/Export  page appears.

Tip:

Select  to hide the navigation pane that overlaps the page.

4. To import, browse and select the exported .csv file from Workflow, and select Import.

The imported information is visible under Objects and Object Types in the Admin workspace.

Access the Task Client
Use the Task Client widget to display task lists from the Workflow application in Operations Hub.
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Create identical user accounts for the Operations Hub web server and the Workflow server. You must 

be able to log in to both the servers using the same username and password combination. Refer to the 

Configure the Task Client  (on page 629)  topic.

The Workflow Task List is integrated with Operations Hub. You do not have to log in to the Workflow 

application to manage your tasks. You can log in to the Operations Hub application, and connect to 

Workflow with the help of the task client widget to manage tasks.

1. Log in to the Operations Hub web client.

The login page to connect to the Workflow server appears.

2. Enter the details as specified in the following table:

Field Name Description

Username The account username that has permission to access the Workflow 

application.

Password The password for the username you entered in the Username  box.

Server Address The URL address to connect to the Workflow server. This URL is popu

lated based on the properties provided for the Task Client widget in Op

erations Hub.

3. Select Log On.

The task count icon indicates the status of your workflow connection.

Status Description

Indicates that the Workflow server is disconnected due to either of 

these reasons:

◦ You are not logged in to the server.

◦ Internet connection is lost.

◦ Workflow server is down.
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Status Description

Note:

All tasks in Operations Hub remain disabled until a connec

tion is established.

Indicates that the Workflow server is connected.

Once connected, the task count shows the number of workflow tasks. 

If the count is 0, it means there are no workflows.

The user login credentials are encrypted and stored under ENTITIES  in Operations Hub. You will not 

be prompted for login details again for the saved user accounts.

Note:

Whenever the Workflow server is down, or if there is no internet, the lost connection 

status is indicated in red. All tasks in Operations Hub remain disabled until a connection is 

established.

4. Select  to show the workflow equipment context navigation.

For more information, refer to the Equipment Context topic in the Operator Task List in the 

Workflow Client  section of the complete Workflow user guide.

5. Select  or  to navigate and select any of these equipment contexts: Big Enterprise, Big Unit, 

or Big Area.

The equipment context set up shown in Operations Hub is created in the Workflow application.

The list of tasks for the selected equipment context appears. Based on the list of tasks, the task 

count number  also gets updated.

Note:

Logged in users in Operations Hub can view only the tasks that are assigned to them in the 

Workflow application.

6. Use these options to work with the tasks:
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Icon Description

Select to filter tasks or task steps by task name, priority, personnel as

signment, step state, and expiry values. For more information, refer to the 

Task List Filtering topic in the Operator Task List in the Workflow Client 

section of the complete Workflow user guide.

Select the Tasks for Equipment  toggle to show or hide the tasks associat

ed to the equipment location only.

Select to start and run scheduled tasks. For more information, refer to the 

Start Task topic in the Operator Task List in the Workflow Client  section 

of the complete Workflow user guide.

Select to manually start a specific task step.

Select to view and save a copy of the linked documents. For more infor

mation, refer to the Document(s) topic in the Operator Task List in the 

Proficy Client  section of the complete Workflow user guide.

Select to view the instructions to complete a task or task step. This op

tion is available only when there are work instructions defined for the task 

or task steps.

Select to access the following menus, and perform task related actions:

◦ Set Priority: You can set a priority number for the task to run.

◦ Jump to Task Step: You can skip some steps and jump to a specif

ic task step in a scheduled flow.

◦ Enter Expiry Comment: You can enter a reason for the task delay. 

The option to add a comment is available only after the task or 

task step has expired.

◦ Cancel Task: You can cancel running a specific task or task step.

◦ Reassign Personnel: You can reassign specific task steps to a dif

ferent person or equipment location.

◦ Acquire: You can acquire a specific task step if it is available.

◦ Release: You can only release those steps that you have acquired. 

When you release a task step, it is available for other operators to 

acquire.

For more information, refer to the complete Workflow user guide.
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Icon Description

Select to access the forms attached to a task step, and update them. For 

more information, refer to the Forms and User Displays Authoring Guide 

section of the complete Workflow user guide.

Note:

You can load only HTML forms in the Operations Hub Task Client. 

Windows presentation framework (WPF), Silverlight, and .NET 

rich client forms are not supported.

Note:

For added security, electronic signatures are configured in Workflow for specific tasks, 

task steps, or forms. In such cases, a dialog box appears requesting you to sign in for 

verification before accomplishing any task related action.

Indicator
Use the indicator widget to monitor and interpret the status of your industrial systems.

You can apply different colors and introduce gif animations to communicate a value or state effectively. 

The indicator widget helps to draw attention towards the changing status of a system and the indication 

to take corrective actions, if necessary. For a simpler version, use Simple Indicator  (on page 590).

The indicator widget is available under Integration  > General. When designing application pages  (on page 

376), drag-and-drop Indicator  to a container.

Bind the widget to a query and set the properties to appear at runtime. You can define unique properties 

for values within specific ranges, and also for values that are outside of any range.
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Important:

This rule applies if you have upgraded to a SIM version. Make sure to upgrade your applications 

(on page 223)  before attempting to modify them in Operations Hub.

Indicator Properties

Field Name Description

Multistate Indicator Value The value is populated when you bind the indicator widget to a query.

Indicator Mode Select to display output in any of these modes:

• Analog: In this mode, the widget provides analog values as output. 

You can choose to add a background image, and use several other 

options to indicate the current status.

• Status: In this mode, the widget functions as a simple indicator sta

tus. It provides a push button to indicate the change in current sta

tus. You can also choose to show the analog values.

• Image: In this mode, you can provide a background image to indi

cate the change in current status. You can also choose to show the 

analog values along with the image.

Display Value? Select the check box to display the analog value.

Repeat Background Image Analog  indicator mode:
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Field Name Description

Select the check box to apply the background image repeatedly to provide 

a continuous background across the widget.

Width Analog  indicator mode:

By default, the indicator widget occupies the width of its container. Reset 

the width in percentage or pixels.

Height Analog  indicator mode:

By default, the indicator widget occupies the height of its container. Reset 

the height in percentage or pixels.

Size Image  and Status  indicator modes:

For the image mode, enter the image size in pixels.

For the status mode, enter the size to set the diameter of the indicator but

ton.

Use Raw Format Select the check box to display numbers in raw format.

For example, a numeric value with 5 or more decimal places is shown as it 

is, and not rounded off.

Number of decimals This option appears if you do not want to display numbers in raw format.

In that case, enter the decimal places (0-7) to consider after the decimal 

point to format large numbers. Based on the decimals, the value is rounded 

off to the nearest whole number.

Insert Commas Select the check box to use comma as a thousands separator. A comma is 

inserted for every three digits.

Prefix Units Enter the unit of measurement to appear as a prefix for the value.

Suffix Units Enter the unit of measurement to appear as a suffix for the value.

Label Above Enter the text to appear above the value.

Label Below Enter the text to appear below the value.

Font Size Enter the size of the font for the label text.

Font Family Select a font family for the label text.
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Field Name Description

Font Color Select a font color  (on page 660)  for the label text.

Background Color Select a color  (on page 660)  to fill in the background for labels and val

ues.

Background Image Mode Use these options to set a background image for the widget.

Type: If you choose to set a background image, then select from these two 

types:

• File: Browse and select the file you want to use.

• URL: Enter the complete URL address for the image from a server.

Note:

Applies to importing applications from an older version of 

Operations Hub Classic to Operations Hub 2023.

When you import an App to v2023, the Indicator plug-in’s 

Background Image Mode  > Type  is altered in the new sys

tem.

To rectify in the imported App, go to the Designer and select 

the Indicator plug-in to access its properties. Change the 

Type  back to the originally set type. The original source in

formation (if exists) is retrieved.

Background Image Fit: Determines how the image fits into its container, 

whether to align horizontal (or) vertical. Background Image Position: Deter

mines the position of the image, whether the image should be placed be

hind value only, (or) behind value and labels.

Border Type: Select from different types of border styles to apply to the 

background image.

Border Width (Pixels): Enter the width size if the widget has a border.

Border Radius (Pixels): Enter the radius size to style the corners of a bor

der.
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Field Name Description

Border Color: Select a color  (on page 660)  for the border.

+Add Item Select to customize settings for values within a specific range. Create an 

input range and highlight with unique colors and style.

Input Range Low (Greater 

than or Equal)

Enter the lowest value to create an input range.

Input Range High (Less 

than)

Enter the highest value to create an input range.

Hidden

About Custom Range Settings

You can add several custom ranges to the widget; each with a different input range. The custom ranges 

are implemented in the specified order, from first to last. If the input ranges overlap with each other, the 

custom range setting at the top of the order is applicable. Arrange the custom ranges in the order you 

want them to be implemented.

• Select  for the custom range to move upwards in a list.

• Select  for the custom range to move downwards in a list.

• Select  for the custom range to remove from the list. These inputs are deleted.

HTML Editor

In Operations Hub page designer, navigate to System  > General  to access GE Html Editor.

Operations Hub also provides an older version of Html  (on page 452).

HTML Editor Properties

Field Name Description

Code Editor You can write and edit HTML, CSS, and JavaScript code to display the re

sult in the end application.

• To write new code, select Code Editor.

• To edit existing code, select Edit Code.
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Field Name Description

With the code editor, you can write a JavaScript code to:

• Embed external resources such as documents, or any other media.

• Use global (variable as data source) option to set as many output 

data targets as necessary. The Html Editor plug-in can render multi

ple target globals to use with other plug-ins in Operations Hub.

Source Value Define the data source to get values for the Html Editor plug-in. Use the 

available data binding options. See Bind Your Data to Plug-ins  (on page 

157).

Target Value Choose any of these options to send values from the Html Editor plug-in to 

your data source (target data).

• Query: Select a query from your list of available queries followed by 

the output field/s you want to add to the plug-in.

• Global: Select a global from your list of available global parameters.

Scoped css? Indicates whether the CSS code should be applied only to the plug-in or 

globally.

• If you want the CSS code to be applied only to the elements in the 

html editor, select this check box.

• If you want the CSS code to be applied globally, clear this check box.

Hidden

Batch

Batch Widgets Overview
This topic describes the widgets used for batch processing.
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Note:

The batch widgets are available only in Operations Hub Classic version.

Within Operations Hub, the batch widgets provide the same functionality as Proficy Batch Execution  thick 

client. Also refer to Set up Batch  (on page 123). The batch widgets use their own data source.

The batch widgets are available under INTEGRATION  > BATCH. When designing application pages  (on 

page 376), drag-and-drop the respective batch widget to a container and configure its properties.

1. Batch Menu  (on page 643)

2. Batch List  (on page 644)

3. Batch SFC  (on page 644)

4. Batch Prompt  (on page 645)

5. Batch Binding Prompts  (on page 646)

6. Batch Alarms  (on page 647)

7. Batch Phase Control  (on page 647)

8. Batch Control  (on page 648)

9. Batch Parameter  (on page 650)

10. Batch Recipe Info  (on page 651)

11. Batch Reports  (on page 651)

12. Batch Step Control  (on page 652)

13. Batch Step List  (on page 652)

Properties

Field Name Description

Style Theme Select either Light  or Dark  display theme for all the batch widgets across 

the application. Do not mix and match themes.

API Base URL Enter the REST API base URL you want to access.

Data Source Select the batch data source.

Source > Batch Serial 

Number

Source > Procedure ID

Source > API Batch ID

Configure the properties to these global variables.

• SELECTED_BATCH_SERIAL_NUMBER

• SELECTED_BATCH_ID

• SELECTED_BATCH_RECIPE_ID

• SELECTED_STEP

https://www.ge.com/digital/documentation/batch/index.html
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Field Name Description

Source > Batch Id

Source > Step Id

Source > Recipe ID

Target > Selected Batch 

Serial Number

Target > Selected Batch ID

Target > Selected Batch 

Description

Target > Selected Recipe 

ID

Target > Selected Recipe 

Version

Target > Selected Step

Target > Selected Batch 

SFC Branch

Target > Selected Batch 

Procedure ID

• SELECTED_SFC_BRANCH

• SELECTED_PROCEDURE_ID

• SELECTED_BATCH_CMD_MASK

• SELECTED_STEP_CMD_MASK

• SELECTED_BATCH_RECIPE_TYPE

The global parameter values contain batch instance information to execute 

batch related operations. Global variable can be a string or a number.

Enable hide columns Select/Clear the check box to hide/show columns at runtime.

Request Interval (Se

conds)

At runtime, the widget is updated with new information in the set amount of 

time in seconds.

eSignature Requirement By default, e-Signatures are turned off for batch widgets, which is None. To 

enable e-Signatures, select any of the following options:

• Performed By: If you select this option, enter the user authorized to e-

sign in the Performed By  field.

• Performed By/Verified By: If you select this option, enter the user/s 

authorized to e-sign and verify in the Performed By  and Verified By 

field.
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Field Name Description

Note:

To e-sign and verify, user/s should be part of the Windows domain 

group on the Batch system.

e-Signature is available for Batch Control, Batch Step Control, Batch Para

meter, Batch Phase Control, Batch Prompts, and Batch Binding Prompts.

This is an example of an e-sign user name and password request at run

time:

Batch Menu
Set up a navigation menu for other batch widgets.

Configure batch menu in Operations Hub designer:

1. Drag-and-drop Batch Menu  to a container.

2. On the properties tab, go to the BEHAVIOR  section.

3. To set up an action for each batch menu header, select Go to page, and then select the batch 

widget you want to link.

At runtime, the horizontal menu bar provides quick access to Batch List  (on page 644), Batch SFC  (on 

page 644), Batch Prompts  (on page 645), Batch Binding Prompts  (on page 646), Batch Alarms  (on 

page 647), and Batch Phase Control  (on page 647).
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Batch List
Provides a list of your batch instances at runtime.

Select a batch from the list and use the Batch Control  (on page 648)  widget to perform operations.

Batch SFC
Manage your batch instances in a sequential and controlled manner.

To set up the batch SFC page in Operations Hub designer:

1. In the main container, drag-and-drop Batch Menu.

2. Add a secondary container and drag-and-drop Batch Step List, Batch SFC, Batch Reports  and 

Batch Step Control.

3. In the main container, drag-and-drop Batch Parameter  and Batch Recipe Info.

4. Configure properties for all the widgets added to the SFC page.

At runtime, select the SFC  tab to review batch related sequential tasks, and control their execution 

process. A flow chart provides a visual representation of the executed steps.



Operations Hub for Windows  | 3 - User Guide  | 645

Batch Prompts
Monitor and acknowledge prompts at runtime.

To set up the batch prompts page in Operations Hub designer:

1. In the main container, drag-and-drop Batch Menu  and Batch Prompts.

2. Configure properties for all the widgets added to the prompts page.

At runtime, the Prompts  tab is highlighted to indicate pending items for acknowledgment.

Acknowledge Prompts

1. Select the Prompts  tab.

2. Select the prompt you want to acknowledge.

3. If e-Signature is enabled, enter the user name and password to proceed.

The Acknowledge Operator Prompt  screen appears.
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4. Select a Value  and select OK.

A message appears on acknowledging the prompt.

Batch Binding Prompts
Monitor and acknowledge binding prompts at runtime.

To set up the batch binding prompts page in Operations Hub designer:

1. In the main container, drag-and-drop Batch Menu  and Batch Binding Prompts.

2. Configure properties for all the widgets added to the binding prompts page.

At runtime, the Binding Prompts  tab is highlighted to indicate pending items for acknowledgment.

Acknowledge Binding Prompts

1. Select the Binding Prompts  tab.

2. Select the binding prompt you want to acknowledge.

3. If e-Signature is enabled, enter the user name and password to proceed.

The Acknowledge Binding Prompt  screen appears.

4. Select Binding Units  and select OK.
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A message appears on acknowledging the binding prompt.

Batch Alarms
Displays alarms triggered during batch processing.

To set up the batch alarms page in Operations Hub designer:

1. In the main container, drag-and-drop Batch Menu  and Batch Alarms.

2. Configure properties for all the widgets added to the alarms page.

At runtime, the Alarms  tab is highlighted to draw your attention to the triggered alarms.

Batch Phase Control
Allows to individually execute a phase in a batch process.

To set up the batch phase control page in Operations Hub designer:

1. In the main container, drag-and-drop Batch Menu  and Batch Phase Control.

2. Configure properties for all the widgets added to the phase control page.

At runtime,
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1. Select the Active Phases  tab.

2. Select a Unit  and Phase.

3. Select Acquire Phase.

4. After acquiring the phase, select a Command  to execute from the available commands for the 

phase.

The commands are based on the status of the acquired phase.

5. Enter the batch ID for the phase and select OK.

Go to Batch List  tab to verify that the phase is executed.

Batch Control
Create and manage batch instances at runtime.
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Create a Batch

1. Select the Batch List  tab.

2. Select ADD.

If e-Signature is enabled, you are prompted to enter user name and password to proceed.

The Recipe List  screen appears.

3. Select a recipe and select OK.

The Batch Creation  screen appears.

4. Enter the Batch ID  and select OK.
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5. Select the newly created batch and select START.

6. If e-Signature is enabled, you are prompted to enter user name and password to proceed.

The batch state appears as RUNNING.

Batch Parameter
Displays parameters for batch processing.

Select the SFC  tab to review the parameters.
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Batch Recipe Info
Displays batch recipe information.

Select the SFC  tab to review the recipe information.

Batch Reports
Generates a report for specified steps.

You can configure reports while creating your batch recipes. If a specific step in a batch is configured for 

reports, then a report is generated after the completion of the step at runtime.

Select the SFC  tab to view reports.
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Batch Step Control
Run operations on selected batch steps at runtime.

Select the SFC  tab to access step control options.

Batch Step List
Displays the status of each step in a batch process.



Operations Hub for Windows  | 3 - User Guide  | 653

Select the SFC  tab to review batch related steps.

General Reference

Page Components (Classic)
This topic describes the various UI components that you can use to design your page and configure the 

data.

Design your application pages using various widgets/plug-ins  (on page 409). Drag and drop them on to 

the page to configure their properties.

Configure Properties

To access the properties of a plug-in component, select the component (a container, graph, or a 

breadcrumb).
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Note:

Some of these fields are displayed based on the selected component. This list is not 

comprehensive.

Field Name Description

Label The text that appears for components such as check boxes and drop-down 

list boxes.

Global Data Allows the data to be available globally for use by other components or 

query inputs. This check box is enabled only after you specify an Id  for the 

component.

Allow Export Indicates whether data that appears in the component can be exported. By 

default, this check box is cleared.

Tooltips Indicates whether data in a table cell should contain tooltips displaying the 

content. By default, this check box is cleared.

Type The data type of an input component. If you are configuring the settings of 

an component of the type graph or gauge, this field contains a list of graph 

or gauge types.

Style The style of a meter-type gauge component.

Conditions Applies a condition that executes an action at runtime. For example, you 

can create a condition for the component/widget to display a control but

ton or a warning image if the temperature recorded by the sensor exceeds 

40 degrees Celsius.

Select Add conditions  to build and apply conditions  (on page 657).

Hidden Select the check box to hide the component/widget at runtime. By default, 

this check box is cleared.

When a component/widget is marked as hidden, it can be shown only on 

associating with a button  (on page 421)  using the toggle show/hide ac

tion.

As a best practice, either use Conditions  or Hidden. Avoid using these prop

erties together.
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Field Name Description

Show on Indicates that the component/widget is visible in the selected devices. By 

default, the options Mobile, Tablet, and Desktop are selected.

X-axis Label The label of the horizontal axis of an component of the type graph.

Y-axis Label The label of the vertical axis of an component of the type graph.

Required Indicates whether it is mandatory to enter a value for the component that is 

used as an input to a query. By default, this check box is cleared.

Target Data The query input that is the target for the value of the component.

Source The source from which data should be retrieved to initialize the component. 

If you are configuring the settings of an input component, you can select 

one of the following options:

• Data: Fetches data that from a global variable or the output value of 

a query.

• Manual: Allows you to enter a value manually.

• Formula: Allows you to create a formula using global variables and 

the output values of a query.

If you are configuring the settings of a display component, you can select 

one of the following options:

• Data: Displays data from a global variable or the output value of a 

query.

• Manual: Allows you to enter a value manually.

• Formula: Allows you to create a formula using global variables and 

output values of a query.

• URL: Displays an image from a URL.

• File: Allows you to upload an image for the component.

Group By Enables to group the data in a graph by the selected tag name.

Options Indicates whether the values in the component are hard-coded or displayed 

dynamically from a query.

Actions The action that should be triggered when the component is selected.

First Option The first option that appears in an component of the type drop-down list 

box (for example, select an asset).
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Field Name Description

Step The step value used for a slider component.

Minimum The minimum value for an component that contains a range (such as a 

slider or a gauge).

Maximum The maximum value for an component that contains a range (such as a 

slider or a gauge).

True Label Customized text that appears when a toggle or an indicator is active.

False Label Customized text that appears when a toggle or an indicator is inactive.

Width The width of the component of the type toggle.

Show <number> rows at a 

time

The number of rows that can appear at a time in an component of the type 

grid.

Validation The validations to be applied on the value entered in an input component. 

You can select the following options:

• Capital: Select this check box if you want application users to enter a 

value only in uppercase.

• Minimum character: Select this check box if you want to set a min

imum character limit to values entered in the component, and then 

enter the number of minimum characters that application users 

must enter in the component.

• Range Limit: Select this check box if you want to set the maximum 

and minimum values that can be entered in a numeric, date, or time 

input component.

Disabled Indicates whether you want the component to appear as disabled in the ap

plication.

Range Limit The range of values that application users can enter in the component.

Stacked Indicates whether the bars displayed in an component of the type graph 

should be stacked. By default, this check box is cleared.

Rounded Corners Applies rounded corners for the selected component.

Custom Colors Select the check box to set these options:
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Field Name Description

• Add text color.

• Add container background color.

• Add container border color, width, and style.

Horizontal Alignment Aligns the component left, right, or center.

Columns/Rows Allows to create a grid layout to design your pages. You can split the page 

into vertical columns and horizontal rows for better organization of page 

components. Enter the number of columns/rows in the text box. You can 

add upto 36 columns and 6 rows.

Tip:

• Use minimal columns while designing for smaller devices 

such as, tablets and mobile phones.

• If adding more than 12 columns, avoid using nested contain

ers.

• For pages with more columns, it is recommended to test 

them across devices to ensure good user experience.

• Consider the column gutter space and margins while plan

ning your page layout. Columns with no content are added 

to the DOM and occupy few pixels of screen space.

Responsive Pattern Select how the container layout must respond on web pages.

Apply Conditions
Build conditional statements that execute actions at runtime.

Create an application page, and add widget/s to a container.

1. Select the widget for which you want to add a condition.

2. Navigate to the widget's properties tab, then under DISPLAY, select .

The conditions screen for the widget appears.

3. Create a condition using these options:
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Populates values from the 

query/entity added to the 

component/widget.

Select the first value, which is used to build a conditional statement.

Use the operators to ex

press the relationship be

tween two values and re

turn results that match.

◦ =  returns true if the value on the left is equal to  the value on 

the right.

◦ >  returns true if the value on the left is greater than  the value 

on the right.

◦ <  returns true if the value on the left is less than  the value on 

the right.

◦ >=  returns true if the value on the left is greater than or equal 

to  the value on the right.

◦ <=  returns true if the value on the left is less than or equal to 

the value on the right.

◦ <>  returns true if the value on the left is less than or greater 

than  the value on the right.

◦ Has value  returns true if the value on the left has any value.

◦ Doesn't have value  returns true if the value on the left is 

NULL.

Manual Allows to enter a hardcoded value.

Flow Allows to select a value from a query.

To delete a condition, select  next to it.

4. Optional:  Select  to create more conditional statements and combine them.

◦ Select AND  to get values that satisfy two or more conditions.

◦ Select OR  to get values that satisfy atleast one from the multiple conditions specified.

5. Select Done  to save and add the condition/s to the widget.

Globals
Globals are variables with a global scope, and are available to use with all the widgets/plug-ins in 

Operations Hub.

Globals are applied outside of a query. A global enables multiple widgets/plug-ins to access the same 

data. You can also declare globals as:
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• Page Global: Indicated with P, this global variable is applicable only to the page.

• App Global: Indicated with A, this global variable is applicable to all the pages in an application.

Note:

If multiple widgets/plug-ins use the same Source Input (query), then the target global must be 

unique. The global is applicable to the last assigned widget/plug-in.

• For example, consider abc, xyz, and 123  as globals. You can assign each of these global 

variables as input only once on a page.

• If you first assign abc  to a radio button as input, and assigned it later to a slider as input, 

then abc  is applicable as input for the slider plug-in.

However, multiple widgets/plug-ins can use the same global as Output Target.

To modify an added global, select to switch between Page Global and App Global.

You can create the following types of globals in Operation Hub:

• System Globals: These are global variables used to store computer system related information 

such as system-wide settings, or configuration parameters.

• Output Globals: These are global variables meant to be used as an output. The output global can 

be used to store the result of a query. This output global can be accessed and used without having 

to run the query again.

• UI Globals: These are global variables that can be used on any part of the user interface (UI). For 

example, a UI global can contain the current user's name and be used to display the user's name in 

multiple parts of the UI.
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• Custom Globals: These are global variables defined by the user. For example, a custom global can 

be used to store a configuration setting, or a shared resource.

• URL Parameters: These are global variables that store the parameters added towards the end of 

a URL, which pass additional information to a web server. A URL parameter global can be used to 

pass information that is required by multiple web pages. For example, the current user's session ID 

or a referral code.

Sample Page with Historical Data
This topic describes how to create a sample page using historical data.

1. Create an application  (on page 204).

2. Create a page  (on page 376).

3. Design a page layout using widgets such as a guage, line graph, etc.

Refer to Page Components (Classic)  (on page 653).

4. Select the graph in the page container to access its PAGE DATA.

5. Under the page data tab, select Tag Browser  from the dropdown list.

A list of data options appear.

6. Select Historical data from the dropdown list.

7. Select Browse  to search the data source and select tags  (on page 368).

8. Drag this data and drop it on the graph.

A message appears that the data is bound successfully.

9. Select Save App.

10. Select Open App.

The application page opens in a web browser.

Select Colors
Use the color picker to select and apply a color to text, borders, and backgrounds.

You can:
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• Select and apply a basic color scheme.

• Slide across the color wheel and make it lighter or darker.

• Enter the hexadecimal or RGB values to get the exact color.

• Use the alpha (A) value to set the transparency of the color.

LIKE Operator with Wildcards
The LIKE operator is used with wildcard characters to compare a string to a pattern, and return matched 

values from the database.

You can use these wildcards with LIKE to build your pattern:

• %  The percent symbol stands for zero or more characters in a sequence.

• _  The underscore symbol stands for only one character. This single character can also be a number 

or any punctuation character.

Note:

If using the MS Access database, use these wildcards instead of % (percent) and _ (underscore):

• *  Asterisk to represent zero or more characters in a sequence.

• ?  Question mark to represent a single character.
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The LIKE pattern is case insensitive, and is set in single quotes. Employ % and _ with any other character/

s (denoted by XY in the table) to search through your database. The wild cards can also be used in 

combination.

Pattern Description

LIKE '%X' Returns values that end with X. These values can have zero or more 

characters before X.

LIKE '%XY' Returns values that end with XY.

LIKE 'X%' Returns values that start with X. These values can have zero or more 

characters after X.

LIKE '%X%' Returns values that contain X. These values can have the X character in 

any position (start, end, second, fourth, etc.)

NOT LIKE '%X%' Returns values that do not contain X.

LIKE 'X%Y' Returns values that start with X and end with Y. These values can have 

zero or more characters between X and Y.

LIKE 'X_' Returns values that start with X and has one character after X.

LIKE 'X___' Returns values that start with X and has three characters (3 under

scores) after X.

LIKE 'X__Y' Returns values that start with X and end with Y, and has two characters 

(2 underscores) between X and Y.

LIKE 'X__%' Returns values that start with X and has two characters (2 underscores) 

after X, followed by zero or more characters.

LIKE '%_X_%' Returns values that contain X if matches with these rules:

• X cannot be in the first or last position.

• Implies atleast 3 characters including X.

• Can have zero or more characters before and after the 3 charac

ters.

Whitelist Websites
Operations Hub allows to load content from whitelisted URLs.
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With Operations Hub v2.1 release, third party websites are no longer allowed to use iframe to embed End 

Apps into their pages because of security considerations.

Starting with Operations Hub v2.1 SIM2, it is possible to whitelist trusted sites to use iframe with End 

Apps. Note at this time, this whitelist applies to all End Apps.

1. Gather a list of one or more websites that you want to use iframe to embed EndApps.

a. Format each website URL as follows with the actual hostname and port number:

https://hostname:port

b. For hostname, enter simple names or fully qualified domain names (FQDNs). It is 

recommended to include all referenced aliases.

c. Ignore the port if it is 443.

2. On the host machine where Operations Hub is installed, add an environment variable 

TRUSTED_FRAME_SITES.

a. Open the Windows Run command.

b. Enter sysdm.cpl  and select OK.

The System Properties  window appears.

c. On the Advanced  tab, select Environment Variables

The Environment Variables  window appears.

d. Select New  to create a system variable with Variable name  TRUSTED_FRAME_SITES.

e. For Variable value, enter a comma-separated list of the sites gathered in the previous step.

For example, https://siteb.company-domain.com,https://sitec.company-domain.com:8443
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3. Save and close all the windows.

4. Restart GE Operations Hub IQP EndApp service for this change to take effect.

You have successfully set up a list of whitelisted websites.

Note:

• An End App authenticates users for access. Recent versions of Chrome have enforced a 

default SameSite policy on cookies. Hence, sites that embed an End App must be on the 

same parent domain as the Operations Hub’s host domain. For example, if Operations Hub 

is on domain ophub.company-domain.com, thenfoo.company-domain.com  is acceptable, but not 

bar.company.local.

• By default, Operations Hub End Apps can embed 3rd party contents using iframes without 

restriction. However, customers may choose to whitelist such 3rd party contents using an 
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environment variable TRUSTED_FRAME_SOURCES  similar to TRUSTED_FRAME_SITES. In such cases, 

ensure that the certificates used for https protocol by 3rd party websites are trusted on 

client (browser) nodes.

Language Support

Updated language support is provided with a SIM, which includes additional translated strings for all 

languages. Operations Hub currently supports these languages:

• Chinese

• Czech

• English

• French

• German

• Italian

• Japanese

• Korean

• Portuguese (Brazilian)

• Russian

• Spanish

• Turkish

You need to update your browser settings to translate in your preferred language. For example, to change 

the language in Chrome browser:

1. Open Chrome Settings.

chrome://settings/

2. From the menu, go to Advanced  > Languages.

3. In the languages screen, select Language  to expand.

4. If your preferred language is not listed, select Add languages.

5. Select the check box for the language you want to show up in the list.

6. Select the More actions  icon next to your preferred language.

7. Select the check box for Display Google Chrome in this language.

8. Restart Chrome to apply the changes.
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APIs

Operations Hub  M2M Device RESTful APIs

Operations Hub  allows sensors to connect directly to the Operations Hub  server using RESTful services 

to broadcast sensor data and receive commands. The connection to the Operations Hub  server uses 

Standard REST POST calls.

The Operations Hub  gateway identifies the information source based on the following parameters::

• Remote Device Unique Identifier: By remote device, we refer to gateways of any type supporting an 

http connection. Usually, the best way to create a unique ID is by using the gateway’s MAC address.

• Remote Sensor/Controller Unique Name: Any name can be used as long as it is unique to the 

gateway. It could be a logical name (for example, Sensor1 or the address of the sensor (if it has 

one)).

• The Operations Hub  Account: Account username and password.

API Handshakes

The handshakes define the message structure and message types exchanged between the device and the 

Operations Hub  cloud. The Operations Hub  API supports 3 types of request:

• Login: The device asks to be authenticated.

• Publish: The device sends new sensor data to Operations Hub.

• Subscribe: The device requests new commands or control instructions from Operations Hub.

JSON Message Format

Messages exchanged between the Operations Hub  server and the device client are in the JSON format. 

JSON is a string representation of data; it is lighter than XML, and hence, it is more suitable for M2M 

messages. JSON messages are formatted as name/value pairs: "variable name":"variable value"

Messages can contain more than one variable using a comma as the delimiter: {"variable 

name1":"variable value1","variable name2":"variable value2"}

The variable value can be a list of parameters, enclosed in curly braces {} using a comma as the delimiter. 

For example: {"variable name":{"parameter1":"value1","parameter2":"value2"}}

Client Login

Before communicating with the Operations Hub  server, the device client must login to the server. The 

login URL is: https://<Operations Hub_Site_URL>/app/iqp/rest/login
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1. To login, the client sends a login request: {"handshake":{"stage":"login"},"login":

{"username":"user name of the user","password":"password of the user"}}

2. The server responds with a success or failure message: If authentication succeeds; 

the server responds with code 1 and provides the client with a token: {"handshake":

{"stage":"login","code":"1"},"token":"token number"}. If authentication fails, the server 

responds with code 0: {"handshake":{"stage":"login","code":"0"}}. If the login fails, the client 

must request the login again.

3. The token returned by the server is a unique identifier, which serves to identify the client during 

further communications with the server. The token must be included in all the publish and 

subscribe messages from the client to the server. The token remains valid as long as the client 

communicates with the server. If the device is inactive for 20 minutes or longer, the token will 

expire. If the client attempts to communicate with the server using the token after it has expired, 

an unauthorized message will be returned by the server. When this happens, the client must login 

again to receive a new token.

Publishing M2M Data

The publish stage is used by the Gateway/Device/Sensor to send new data to the Operations Hub  server. 

The publish URL is: https://Operations Hub  site URL/app/iqp/rest/publish. The published data is in the 

form of a JSON string. Each message contains the following information:

• Data Channel: The Data Channel tells the server where the data is coming from. The source is 

represented as a data source path, which is composed of 3 parameters, a combination of its 

Account name/Gateway id/Sensor id. For example: "REST_DEMO/01-23-45-67-89-ab/temperature0".

◦ For the Gateway id, it is recommended to use the device MAC Address or IMEI number.

◦ The Sensor id can be any logical name. The name must be unique to this gateway.

Note:

The application developer in Operations Hub  will use the sensor name to build their 

application. For this reason, it is recommended to use a logical name describing the 

sensor or device. For example, if the device represents a temperature sensor, use the word 

temperature in the name and add a number to make it unique: temperature9

Important:

For HTTP requests, avoid using spaces in names and ids.
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• Metrics: The Metric Data Message defines a set of data from the sensor/device as a series of 

keyname:value pairs. The “keyname” in the keyname value pair defines the field in the Operations 

Hub  M2M_data entity where the “value” will be stored. The following Keynames are supported.

Keyname M2M_data Field Storage Format

met metric String Developer-defined String (compulsory 

field)

val data String Developer-defined value (compulsory 

field)

lat latitude String WGS84 recommended for online map 

compatibility (common field)

long longitude String WGS84 recommended for online map 

compatibility (common field)

time timestamp DateTime ISO 8601 “YYYY-MM-DDThh:m

m:ss.sss±TZ” (common field)

alt altitude String Developer-defined value (common 

field)

desc description String Developer-defined string

type data_type String Data type of the data field “String” or 

“Number”

gen1 generic_1 String Developer-defined string or value

gen2 generic_2 String Developer-defined string or value

◦ All Operations Hub  payload messages must contain the metric and data keyname value 

pairs.

◦ All other keyname value pairs are optional.

◦ The order of the keyname value pairs in the payload is not compulsory.

◦ If included, Timestamps must be formatted according to the ISO 8601 format specified 

above.

◦ The Data Type entry can be used in cases where Operations Hub  does not automatic 

identify the data type correctly.

• The Publish request process: To publish a message to the server, the client uses the following 

format:
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{"handshake":{"stage":"publish"},"token":"token number","messages":[

                        {"dc":"data channel","cloud":"cloud server timestamp","data":[

                        {"alt":"value","lat":"value","long":"value","time":"timestamp recorded in the 

 device","mets":[

                       

 {"met":"value","val":"value","type":"value","desc":"value","gen1":"value","gen2":"value",}

                        ]

                        }

                        }]}

The server will respond with a success failure message: {"handshake":

{"stage":"publish","code":"<0/1>","dc":"data channel"}}, where code=1 represents success, 

and code=0 represents failure to process the message. The returned Data channel is the channel 

that was sent in the publish request that the response is replying to.

• Sending Multiple Metrics: Multiple metric data entries can be sent in a single publish message 

using the JSON array format. Arrays in JSON are in the format of "[array data]". For example: one 

published payload could contain several messages for a car’s speed, engine temperature, fuel 

level, odometer, etc. or from an intermediary data server, it could contain multiple messages from 

several different devices. An example of a JSON publish request containing several entries:

{"handshake":{"stage":"publish"},"token":"00000000-00000000-00409DFF-FF521DB2", "messages":[

                        {"dc":"Operations 

 Hub_Testing/REST_Device/Vehicle2","cloud":"2015-03-26T18:46:38.237+09:00","data":[

 

                       

 {"alt":"1234","lat":"35.587562","long":"139.668916","time":"2015-03-26T18:44:38.195+09:00","mets":[

                        {"met":"Speed","val":"100","type":"double","desc":"kmh"},

                        {"met":"Heading","val":"180","type":"double","desc":"degrees"},

                        {"met":"Temperature","val":"98","type":"double","desc":"degrees"}

                        ]

                        },

                       

 {"alt":"1240","lat":"35.587565","long":"139.668920","time":"2015-03-26T18:45:38.195+09:00","mets":[

                        {"met":"Speed","val":"75","type":"double","desc":"kmh"},

                        {"met":"Heading","val":"237","type":"double","desc":"degrees"},

                        {"met":"Temperature","val":"96","type":"double","desc":"degrees"}

                        ]

                        }
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                        ]

                        }]}                        

Subscribing to receive M2M commands

The subscribe stage is used by the Gateway/Device/Sensor to check the Operations Hub  server for 

commands. The subscribe URL is: https://<Operations Hub_Site_URL>/app/iqp/rest/subscribe. In the 

M2M world, Gateways/Devices can lose connection to the server from time-to-time. For this reason, the 

Operations Hub  server does not push commands to devices. It is up to the embedded code in the device 

to periodically check with the server for any available commands. Subscribe requests use the following 

information:

• Data channel: The Gateway/Device asks the server for all commands available for a Data channel. 

Command requests may be for specific sensors, for all commands for a Gateway/Device or all 

commands for an account. The corresponding Data channel formats are as follows:

◦ Specific sensor: Account_name/Gateway_ID/Sensor_ID

◦ Specific Gateway: Account_name/Gateway_ID

◦ Specific account: Account_name

• Request type: The request type identifies what stage of the subscription process we are in. The 

available request types are:

◦ subscribe: The client requests for available commands.

◦ command_list: The server sends a list of the commands.

◦ no_commands: The server notifies the client that no commands are available.

◦ result: The server replies to confirm whether or not the request has been processed 

correctly.

• Commands: The command or commands to execute. Commands are usually vendor-specific or 

device-specific. The commands could be AT commands or client code specific implementation 

commands.

Subscribe requests have the following stages.

1. Client to Server: The client requests for available commands. The client initiates 

the process by sending a subscribe request to the server: {"handshake":{"stage": 

"subscribe"},"token":"<token>", "payload":{"dc":"<channel>","request_type":"subscribe"}}

2. Server to Client: The server sends a list of commands to the client. If the server has 

commands available for the device, it will return a command list: {"handshake":

{"stage":"subscribe"},"payload":{"request_type":command_list", commands: 

[{"dc":"<channel>","command":"<command>"}]}}
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Important:

The server will return an array of channel specific commands. If the subscribe request was 

for all available commands for an account Data channel. The server response will be an 

array of commands where the Data channel for each command is specific to the gateway, 

device, or sensor that the command is assigned to.

If the server has no commands available for the device, it will return a no_commands response: 

{"handshake":{"stage":"subscribe"},"token":"<token>","payload":{"request_type":" 

no_commands","dc":"<channel>"}}. The datachannel, in this case, is the channel of the original 

request. For example, if it was for a device, it would be account/device.

M2M Device API Error codes

If an error occurs while processing requests, the server will return the following message: {"handshake":

{"stage":"error","code":"<code>"}}

Possible error codes are:

• 1: Bad JSON Format

• 2: Unauthorized user

Operations Hub  REST APIs for Integration

In addition to the existing APIs that allow devices to send data to the M2M_data entity, Operations Hub 

provides REST Integration APIs that enable 3rd party servers to pull data from the M2M_data entity. There 

are also APIs for pulling data from any custom entity in the Operations Hub  database and for inserting 

data into custom entities.

Authentication

Before using the integration APIs, the client system must pass authentication on the Operations Hub 

server. The integration API login URL is https://<Operations Hub_Site_URL>/app/iqp/api/rest/login.

Message sent by the client: {"username":"<user>","password":"<pass>"}

Response of the server:
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• If authentication succeeds, the server responds with code 1 and provides a token for the client to 

use in further communications: {"code" : "1" , "token" : "<token>"}

• If authentication fails, the server responds with code 0 and provides a reason for the failure: 

{"code" : "0" , "reason" : "<reason>"}. If the authentication fails, the client will need to request 

for authentication again before proceeding.

Get M2M data

The Get M2M data API allows a 3rd party server to retrieve data from the Operations Hub  M2M_data 

entity: The URL for the API is: https://<Operations Hub_Site_URL>/app/iqp/api/rest/iot/data

Message sent by the client:

{"token": "<token>", "filters":

                [

                {"filter_type":"<column_name>","value":"<search_value>","value_type":"<type>","operator":"<operator>"}

                    ]

                    }            

• “<token>”: The token provided to the client at login.

• “<column _name>”: The name of a valid field in the M2M_data entity.

• “<search_value>”: The value to search for in the selected field.

• “<type>”: The data type of the selected field. The following values are supported:

◦ Boolean

◦ Number

◦ Real

◦ String

◦ Long string

◦ Free text

◦ Date

◦ Time

◦ DateTime

◦ File

• “<operator>”: The operator to use in the search. The following values are supported:

◦ =

◦ >

◦ <

◦ >=

◦ <=
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◦ <>

◦ LIKE  (on page 661)

Tip:

If required, multiple filters can be provided to filter the search results. All filters are treated as 

{filter_1} AND {filter_2} AND … {filter_n}.

An example of a request to retrieve all M2M_data for the device “REST_Device” after 12:00pm on 

2015-03-19:

{"token":"08ad9058-9ec9-4363-85f1-c9071004d9992","filters":

                    [

                    {"filter_type":"device_id","value":"REST_Device","value_type":"String","operator":"="},

                   

 {"filter_type":"iqp_timestamp","value":"2015-03-19T12:00:00.000Z","value_type":"DateTime","operator":">"}

                    ]

                    }

Response of the server:

• If there is data to match the search results, the server will respond with all of the matching rows in 

the following format:

{"rows":

                        [

                        {"row":[<list of  <column_name>:<value>  pairs for all M2M_data columns>]},

                            {"row":[<list of <column_name>:<value>  pairs for all M2M_data columns>]},

                                ….

                                ]

                                }                    

• If there is no data to match the search results, the server will respond with an empty list:

{"rows":[]}

Get Entity data

The Get Entity data API allows a 3rd party server to retrieve data from any custom entity in the Operations 

Hub  database: The URL for the API is https://<Operations Hub_Site_URL>/app/iqp/api/rest/DB/data/get.

Message sent by the client:
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{"token": "<token>", "entity_name":"<entity_name>", "filters":

                    [

                    {"filter_type":"<column_name>","value":"<search 

 value>","value_type":"<type>","operator":"<operator>"}

                        ]

                        }                

• “<token>”: The token provided to the client at login.

• “<entity_name>”: The name of a valid custom entity.

• “<column _name>”: The name of a valid field in the specified entity.

• “<search_value>”: The value to search for in the selected field.

• “<type>”: The data type of the selected field. The following values are supported:

◦ Boolean

◦ Number

◦ Real

◦ String

◦ Long string

◦ Free text

◦ Date

◦ Time

◦ DateTime

◦ File

• “<operator>”: The operator to use in the search. The following values are supported:

◦ =

◦ >

◦ <

◦ >=

◦ <=

◦ <>

◦ LIKE  (on page 661)

Tip:

If required, multiple filters can be provided to filter the search results. All filters are treated as 

{filter_1} AND {filter_2} AND … {filter_n}.

An example of a request to retrieve all data from the custom entity “MathsData”, where the value in the 

column “Angle” is between “180” and “270” degrees:
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{“token”:”5aad6209-bd6f-440c-9581-26ea80ec6fd32”,”entity_name”:”MathsData”,”filters”:

                [

                {“filter_type”:”Angle”,”value”:”180”,”value_type”:”number”,”operator”:”>=”},

                {“filter_type”:”Angle”,”value”:”270”,”value_type”:”number”,”operator”:”<=”}

                ]

                }            

An example of a request to retrieve all rows of data from the custom entity “MathsData” with no 

conditions:

{“token”:”5aad6209-bd6f-440c-9581-26ea80ec6fd32”,”entity_name”:”MathsData”,”filters”:[]}

Response of the server:

• If there is data to match the search, the server will respond with all of the matching rows in the 

following format:

{"entity_name":"<entity_name>","rows":

                        [

                        {"row":

                        [

                        {"col_name":"<column_name>","type":"<column_type>","value":"<value>"},

                            {"col_name":"<column_name>","type":"<column_type>","value":"<value>"},

                                ….

                                ]

                                }

                                ….

                                ]

                                }                    

◦ “<entity_name>”: The name of the entity the data was retrieved from.

◦ “<column _name>”: The name of the field this value is from.

◦ “<column_type>”: The data type of the field as specified in the entity.

◦ “<value>”: The value of the field.

• If there is no data to match the search, the server will respond with a blank list: 

{"entity_name":"<entity_name>","rows":[]}
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Insert Entity data

The Insert Entity data API allows a 3rd party server to insert data into any custom entity in the Operations 

Hub  database: The URL for the API is https://<Operations Hub_Site_URL>/app/iqp/api/rest/DB/data/

insert.

Message sent by the client:

{"token": "<token>","entity_name":"<entity_name>","rows":

                    [

                    {"row":

                    [

                    {"col_name":",column_name>","type":"<type>","value":"<value>"},

                        {"col_name":"<column_name>","type":"<type>","value":"<value>"},

                            ….

                            ]

                            }

                            ….

                            ]

                            }

• “<token>”: The token provided to the client at login.

• “<entity_name>”: The name of the custom entity that you want to insert data into.

• “<column _name>”: The name of the field in the specified custom entity that this value will be 

inserted into.

• “<type>”: The data type of the specified field. The following values are supported:

◦ Boolean

◦ Number

◦ Real

◦ String

◦ Long string

◦ Free text

◦ Date

◦ Time

◦ DateTime

◦ File
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Note:

The type specified in the API call must be the same as the type specified for the field in the 

entity.

• “<value>”: The value to insert into the field.

An example of a message to insert 2 rows of data into the custom entity “MathsData”:

{"token":"9eb64909-3d08-43e8-b5ed-eae57bce32402","entity_name":"MathsData","rows":

                [

                {"row":

                [

                {"col_name":"Angle","type":"number","value":"370"},

                {"col_name":"SIN","type":"real","value":"0.1736"},

                {"col_name":"COS","type":"real","value":"0.9848"},

                {"col_name":"TAN","type":"real","value":"0.1763"}

                ]

                },

                {"row":

                [

                {"col_name":"Angle","type":"number","value":"380"},

                {"col_name":"SIN","type":"real","value":"0.342"},

                {"col_name":"COS","type":"real","value":"0.9397"},

                {"col_name":"TAN","type":"real","value":"0.364"}

                ]

                }

                ]

                }            

Response of the server:

• If the insert is successful, the server will respond with code 1: {"code" : "1"}

• If the insert fails, the server will respond with code 0 and a reason: {"code" : "0", "reason" : 

"<reason>"}
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Operations Hub  REST APIs for App, Group, and Page Permissions

Operations Hub  provides REST APIs for App, Group, and Page Permissions. The following sections outline 

what these APIs are and how they work.

Authentication

For proper authentication, obtain a valid UAA token with a valid scope that includes iqp.developer.

Import App

The Import App API takes a zip or xml file (same as from the UI) and returns the application id of the 

imported App.

• If the App is not already present, the type parameter is not required.

• If the App is already present and the type parameter is not provided, then the default is to duplicate.

• The type parameter can be explicitly provided as replace or duplicate.

Sample request for HTTP POST is as follows:

https://<hostname>/site/api/apps/import

https://<hostname>/site/api/apps/import?type=replace

https://<hostname>/site/api/apps/import?type=duplicate

The zip or xml file is part of the Request body with the key as file.

Sample response:

Http 200 Ok

{

     "uuid": <app id>

}                     

Get Apps

The Get Apps API returns all Apps from within Operations Hub .

Sample request for HTTP GET is as follows:

https://<hostname>/site/api/apps

The Get Apps API returns all of the Apps that are present.

Sample response:
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Http 200 Ok

[

    {

        "name": "app name",

        "uuid": "app id"

    },

    {

        "name": "app name",

        "uuid": "app id"

    }

]

To filter a single App by name, the name parameter is used.

Sample request for HTTP GET is as follows:

https://<hostname>/site/api/apps?name={appname}

Sample response:

Http 200 ok

[

    {

        "name": "appname",

        "uuid": "app id"

    }

]

Get App Details for App Id

This API takes the App Id and returns the details of the App, including the UAA permitted groups.

Sample request for HTTP GET is as follows:

https://<hostname>/site/api/apps/{app id}

Sample response:

{

    "name": "app name",

    "id": "appid",

    "permittedUaaGroups": [],
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    "pages": [

        {

            "id": "pageid",

            "name": "page name",

            "permittedUaaGroups": [],

            "queries": [

                {

                    "id": "query id",

                    "name": "query name",

                    "permittedUaaGroups": [

                        {

                            "id": "id",

                            "displayName": "group name"

                        }

                    ]

                }

            ]

        }

    ]

}          

• Empty permission groups for App denotes NONE  of the groups have permission to access the App.

• Empty permission groups for Page denotes ALL  the groups have permission to access the Page.

• Empty permission groups for query denoted ALL  the groups have permission to access the query.

Update App UAA Group Permissions

This API takes the application's universally unique identifier (UUID) and the list of UAA permissions to be 

updated. The permissions provided will overwrite the permission list already existing in Operations Hub.

Group id and name should match UAA group id and group name.

Sample request for HTTP POST is as follows:

https://<hostname>/site/api/apps/{app id}/permittedUaaGroups

Request body

[

  {

    "id": "group id",

    "displayName": "group name"
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  },

  {

    "id": "group id",

    "displayName": "group name"

  }

]

Sample response:

Http 204 No content. 

Update Page UAA Group Permissions

This API takes page's universally unique identifier (UUID) and the list of UAA permissions to be updated. 

The permissions provided will overwrite the permission list already existing in Operations Hub.

Group id and name should match UAA group id and group name.

Sample request for HTTP POST is as follows:

https://<hostname>/site/api/pages/{page id}/permittedUaaGroups

Request body

[

  {

    "id": "group id",

    "displayName": "group name"

  },

  {

    "id": "group id",

    "displayName": "group name"

  }

]

Sample response:

Http 204 No content.

Update Query UAA Group Permissions

This API takes the query's universally unique identifier (UUID) and the list of UAA permissions to be 

updated. The permissions provided will overwrite the permission list already existing in Operations Hub.

Group id and name should match UAA group id and group name.



Operations Hub for Windows  | 3 - User Guide  | 682

Sample request for HTTP POST is as follows:

https://<hostname>/site/api/queries/{query id}/permittedUaaGroups

Request body

[

  {

    "id": "group id",

    "displayName": "group name"

  },

  {

    "id": "group id",

    "displayName": "group name"

  }

]

Sample response:

Http 204 No content.

Get Query Id from Query Name

This API takes the query name and returns the query id.

Sample request for HTTP GET is as follows:

https://<hostname>/site/api/queries?name={query name}

Sample response:

Http 200 OK

{

    "uuid": <query id>

}

Get Query UAA Permissions for Query Id

This API takes the query id and returns the UAA permission group list present in Operations Hub.

Sample request for HTTP GET is as follows:

https://<hostname>/site/api/queries/{query id}/permittedUaaGroups

Sample response:
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Http 200 Ok

 

[

  {

    "id": "group id",

    "displayName": "group name"

  },

  {

    "id": "group id",

    "displayName": "group name"

  }

]

Delete App

The Delete App API removes the application from Operations Hub.

Sample request is as follows:

https://<hostname>/site/api/apps/{app id}

Sample response:

Http 204 no content.

Message Queuing Telemetry Transport (MQTT) APIs

Operations Hub  MQTT Message Broker

Operations Hub  includes an MQTT client. In the Operations Hub  administrative console, the MQTT 

client can be pointed at any MQTT broker that is accessible from the network where the Operations Hub 

platform is installed. If there is no existing MQTT broker, a local broker can optionally be installed on the 

Operations Hub  server during the Operations Hub  installation. Refer to the Deployment section of the 

document.

Operations Hub  MQTT implementation

Operations Hub  receives status messages from devices and stores the information in the M2M_Data 

entity. Operations Hub  defines a standard for the MQTT topic structure and how the payload is formatted 

in order to allow the server to identify the device source and correctly store the M2M data.
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The messages contain the following information:

• Cloud ID: When a Operations Hub  tenant account is created, it is assigned a unique cloud ID on the 

server. The cloud ID allows Operations Hub  to control how the data from the device is collected 

and stored.

• Device ID: A device or asset could be a single machine with one or more sensors communicating 

directly with Operations Hub. Alternatively, a device could be a gateway device on a production 

line, acting like a router to forward data from multiple machines along the line to Operations Hub. 

All devices have unique IDs that often represent network card numbers, IMEI numbers, or MAC 

addresses. The device ID is the minimum requirement for Operations Hub  to identify the data 

source.

• Instance: If you have multiple assets connected to Operations Hub  through a single gateway 

device, the instance name provides the ability to identify which asset from which the data has been 

sent. The instance name is usually a logical name uniquely identifying the asset or sensor.

• Metric: The metric is a term used by Operations Hub  to define the nature of the data send from a 

device (for example, temperature, speed, air pressure, fuel level). Metrics in the M2M_Data entity 

allow the application developer to define queries and events for retrieving data and triggering 

responses to specific conditions.

Operations Hub  MQTT Topic Structure

When Operations Hub  receives a message, it needs to identify the message source. The MQTT message 

format is defined as: <topic> <payload>

Operations Hub  defines a standard topic format so that the server knows the source of the message.

The Operations Hub  topic structure contains the following three components in the given order:

• Cloud_ID: This value must be the cloud_id defined in the entity cloud_users.

• Device_ID: This value can be anything. Normally, it identifies a specific device or gateway.

• Instance_Name: This value can be anything. Normally, it identifies a specific asset. It is optional.

A topic with an instance name appears as follows: <Cloud_ID>/<Device_ID>/<Instance_Name>

A topic without an instance name appears as follows: <Cloud_ID>/<Device_ID>

Operations Hub  MQTT Payload Structure

For each message, Operations Hub  needs to identify the metric. (For example, identify whether 32 is the 

reading for temperature or light.)
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Operations Hub  supports the following basic formats for the payload:

• Basic Payload format: The basic Operations Hub  payload is usually used for simple sensors. The 

Operations Hub  payload is formatted using keyname value pairs: keyname=<value>. The keyname 

value pairs are separated by a Tilde character (~). The basic Operations Hub  Payload message 

uses two keyname value pairs to indicate the metric and the data. met=<value>~data=<value>

Example: met=Temperature~data=32

• Multi Sensor Device/Gateway Payload format: For devices or gateways with multi sensor capability 

the Operations Hub  payload supports extra keyname value pairs to allow them to send extra data.

Supported keynames: The following table provides the keynames that are supported.

Keyname M2M_data Field Storage Format

Met metric String Developer-defined string

Data data String Developer-defined string

Lat latitude String WGS84-recommended for online map 

compatibility

Long longitude String WGS84-recommended for online map 

compatibility

Time timestamp DateTime ISO 8601 “YYYY-MM-DDThh:m

m:ss.sss±TZ”

Alt altitude String Developer-defined value

Desc description String Developer-defined string

Type data_type String Data type of the data field String or Num

ber

gen1 generic_1 String Developer-defined string or value

gen2 generic_2 String Developer-defined string or value

Note:

• All Operations Hub  payload messages must contain the metric and data keyname value 

pairs. All other fields are optional.

• The order of the keyname value pairs in the payload is not compulsory.
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• If included, Timestamps must be formatted according to the ISO 8601 format specified 

above.

• Data Type can be specified in cases where Operations Hub  does not automatically identify 

the data type correctly. For example if you are sending a numeric ID, it should be treated as 

a String.

The keynames in the keyname value pairs define the field in the Operations Hub  M2M_data entity where 

the value will be stored.

Note:

The latitude and longitude values are also combined and added to the M2M_data LatLong field.

Payloads with location and timestamp information

Some devices also have a built-in GPS (for example, a car). These devices can also send 

GPS latitude and longitude co-ordinates indicating the location of the reading. Many modern 

devices can also include the timestamp for the date and time the data was recorded. In this 

case, the payload is formatted as a set of keyname value pairs such as met=Speed~data=120~ 

lat=35.678~long=135.678~time=2014-12-23T07:14:30.546+09:00

Payloads with multiple metrics

In order to reduce the number of calls required to send data from the device, a device that collects 

several metrics can send multiple metrics in a single payload. For example, a car device may send speed, 

odometer reading, and fuel level as one payload. This can be achieved by concatenating multiple metrics 

together in the payload using a semi-colon (;) as the delimiter.

A payload with three metrics appears as follows: 

met=Temperature~data=32;met=Pressure~data=12;met=Wind Speed~data=5.

A payload for two metrics with GPS co-ordinates appears as follows: 

met=Speed~data=120~lat=35.678~long=135.678;met=Fuel~data=12~ lat=35.678~long=135.678.

A payload including GPS and time details from a multi-sensor weather device appears as follows:

met=Temperature~data=36~lat=35.388628~long=139.673573~time=2014-12-23T07:14:30.546+09:00;

                met=Humidity~data=70~lat=35.388628~long=139.673573~time=2014-12-23T07:14:30.546+09:00;

                met=Pressure~data=1.2~lat=35.388628~long=139.673573~time=2014-12-23T07:14:30.546+09:00
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Troubleshooting

Basic Troubleshooting
This topic contains information to help you troubleshoot issues.

• Resolving Extension Query Error  (on page 687)

• Tags are Not Displayed with an OPC UA Data Source  (on page 688)

• Domain Redirect Error  (on page 688)

• Importing App Creates Duplicate Data Sources  (on page 688)

• Resolving SQL Connector EndApp Performance Issues  (on page 688)

• Unable to Access Data Sources on Single Machine Install  (on page 689)

• Invalid Token Fix  (on page 689)

• Services Not Starting After Reboot  (on page 690)

• Error While Loading Data Sources  (on page 690)

• Resolving Proficy Authentication Issue During Workflow Task Client Install  (on page 690)

• Resolving External Proficy Authentication Issue During Operations Hub Install  (on page 691)

• Workflow Task Client is unable to connect to the Proficy Server  (on page 691)

• Resolving Operations Hub Blank Login Screen  (on page 691)

• Resolving 2022.4.1 Uninstallation Fail  (on page 691)

• Events with Device Conditions are not Triggered  (on page 691)

• Timestamp from SQL Database gets converted to Local Time  (on page 692)

• Missing Plug-in Properties after Upgrade  (on page 692)

To troubleshoot errors returned for OPC UA and Historian out-of-the-box (OOTB) queries, refer to Error 

Codes  (on page 693)  description.

To troubleshoot data source test connection errors, refer to Error Messages  (on page 710)  description.

Resolving Extension Query Error

If you do not have sufficient privileges to read or write operations, you may run into an error when 

attempting to execute the extension query in the end application. The error displays a generic message.

For example on a write failure, the console shows the following message:

{ "status":{ "success":false,"code":9998,"reason":"Data distributor response: Write request failed: Fail"} }

The Data Distributor log (dataDistributor.log) located at C:\ProgramData\OphubLogs\DataDistributor 

displays the following message:
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Failed to write to NodeId ns=2;s=Channel1.testr.ss on server 

 urn:CHEWY:Intellution.IntellutionGatewayOPCServer:UA%20Server with OPC UA error BadUserAccessDenied. Connection to 

 server failed.

To resolve this issue, validate your data source connection, and the credentials to connect to the data 

source. In the above example, you would need to check the OPC UA server.

Tags are Not Displayed with an OPC UA Data Source

If tags are not getting displayed when you browse your correctly configured OPC UA data source, you may 

have to restart the GE Operations Hub OPC UA Browse Service in your Services console to resolve this 

issue.

Domain Redirect Error

DNS issue occurs while trying to access Operations Hub from different machines. To avoid the error, add 

hostname  and ip address  of the machine (where Operations Hub is installed) on to your host file located 

here: windows/system32/drivers/etc/hosts.

Importing App Creates Duplicate Data Sources

If you import the application on a clean install, duplicate data sources are created in Operations Hub. This 

occurs when Operations Hub does not have a model. When you import an application containing a model 

(in a .csv file) and some datasources (in the .xml file), all the data sources (containing details) that were 

exported during application export, are also imported. The model is also imported, which leads to the 

import of data sources again (without the details for the OPC UA data sources). This leads to some data 

sources appearing twice (once from the model, once from the app xml file).

Workaround: Configure the data source without the alias string for restoring application connectivity. 

Delete the duplicate (containing the alias string) if required.The model is associated with the data sources 

imported from the model file i.e the ones without the alias name.

Resolving SQL Connector EndApp Performance Issues

Implement these changes to achieve the best perfomance for your end applications using the SQL 

connection database.

1. Browse to the location directory on the machine where Operations Hub is installed: ..\ProgramData

\GE\Operations Hub\iqp-config\IQP\app

2. Open the setting.conf  file in a text editor.

3. Enter sqlconnector_runtime_simplejdbccall_lifetime=60000  in a new line at the end of the file.
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This means that the stored procedure meta data cache is refreshed every 60000  milliseconds (one 

minute). You can modify the refresh time to your requirement, but enter its value in milliseconds.

4. Search for sqlconnector_maxConnectionPoolSize=10  and increase the pool size to your requirement.

Currently, the pool size indicates that you can configure 10 connections for your SQL end 

application.

5. Save and close the file.

6. Restart the Operations Hub machine for the changes to take effect.

Unable to Access Data Sources on Single Machine Install

If you installed Historian followed by Operations Hub on the same machine, you were not able to access 

DATASOURCES  (on page 352)  in Operations Hub. An error message appears stating, Unable to load 

data sources.

The error occurs only when the host name in the URL has mixed/upper-case letters, which get converted 

to lower case. To resolve this issue, modify the registry.

1. Run regedit  to open the Registry Editor.

2. Navigate to \HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Apache Software Foundation\Procrun 

2.0\WebhmiTomcat\Parameters\Java.

3. In the right pane, double-click Options.

The Edit Multi-String  dialog appears.

4. Modify the property -Dwebhmi.services.auth.fastTokenServices.trustedIssuers=https://pp-

hist3/uaa/oauth/token  to append a new URL entry based on the mixed/upper-case host name.

The property is a comma-separated list of multiple URLs. For 

example, a URL with upper-case PP-HIST3  is appended to the list here: 

-Dwebhmi.services.auth.fastTokenServices.trustedIssuers=https://pp-hist3/uaa/oauth/

token,https://PP-HIST3/uaa/oauth/token).

5. Restart the GE Operations Hub WebHMI Tomcat Web Server service.

Invalid Token Fix

If upgrading from 2.0 to 2.1, restart the WebClient services to allow the Plant Applications Web Client to 

connect successfully to Operations Hub.
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• If using Enterprise WebClient version, restart the Docker service.

• If using Standard WebClient version, restart the GE PlantApps WebClient Master Control service.

Services Not Starting After Reboot

If services do not start up on rebooting a machine, visit the link for steps to modify the registry and fix the 

issue:

https://docs.microsoft.com/en-US/troubleshoot/windows-server/system-management-components/

service-not-start-events-7000-7011-time-out-error

The operating system related issue may vary from system to system depending on the resources being 

utilized at start up.

Error While Loading Data Sources

After installing Operations Hub 2.1, the error "Can't load DataSources" appears while trying to access the 

data sources screen. This issue may occur due to any of the following reasons:

• A Java class cache file may have been corrupted. This file once created, does not change until it is 

deleted.

1. Stop the webhmi tomcat service.

2. Delete the only file in this location folder C:\ProgramData\GE\Operations Hub\webhmi-tomcat

\j9aot

3. Start the webhmi tomcat service.

• There may be a mismatch of letter case in the UAA host name. The hostname should be ideally in 

lowercase. But, if UAA (standalone or as a part of Historian install) is installed with a mixed case or 

capital case, the mismatch can occur leading to the issue.

• IQP tomcat can start up much quicker than webhmi during system start up. It is possible that the 

delayed webhmi tomcat start up is interfering with accessing the web UI. A generous wait period 

usually resolves this issue.

Resolving Proficy Authentication Issue During Workflow Task Client Install

Proficy Authentication (UAA) server validation fails during installation of Workflow Task Client due to the 

change made to UAA for TLS 1.2.

Workaround: To successfully install Workflow Task Client with Operations Hub 2022, do the following:

https://docs.microsoft.com/en-US/troubleshoot/windows-server/system-management-components/service-not-start-events-7000-7011-time-out-error
https://docs.microsoft.com/en-US/troubleshoot/windows-server/system-management-components/service-not-start-events-7000-7011-time-out-error
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1. Modify Registry for TLS 1.2  (on page 715).

2. Install the Workflow Task Client plugin from the Workflow installer on your Operations Hub Server 

host.

Resolving External Proficy Authentication Issue During Operations Hub Install

The test button used to test connectivity to an external Proficy Authentication instance fails with a 

message Could not create SSL/TLS secure channel.

Workaround: To successfully test connectivity to an external Proficy Authentication instance, do the 

following:

1. Modify Registry for TLS 1.2  (on page 715).

2. Install Operations Hub 2022 referencing the external Proficy Authentication instance.

Workflow Task Client is unable to connect to the Proficy Server

If user upgrades from an older version of Operations Hub (still using TLS 1.1) that has the Task Client 

widget, and then upgrades to version 2022 or greater (which supports only TLS 1.2), then Task Client is 

unable to connect to the Proficy Server.

Workaround: To resolve the connectivity issue, perform the steps provided in the topic Modify Registry for 

TLS 1.2  (on page 715).

Resolving Operations Hub Blank Login Screen

If using an older version of Chrome or Firefox, you may be presented with a blank login page.

To resolve this issue, go to your browser's settings to download the latest version of your browser, or 

download and install the latest updates.

Resolving 2022.4.1 Uninstallation Fail

Uninstallation of Operations Hub 2022.4.1 fails due to error in kafka uninstallation.

Workaround: Stop iqp-kafka  service, and proceed to uninstalling Operations Hub 2022.4.1 on your 

machine.

Events with Device Conditions are not Triggered

In case events are not generated, it is recommended to do the following:
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1. Stop the Operations Hub services, in particular:

◦ iqpTomcat

◦ iqpKafka

◦ iqpZookeeper

2. Delete the log files in these data log folders:

◦ C:\ProgramData\OphubLogs\iqp-kafka

◦ C:\ProgramData\OphubLogs\iqp-zookeeper

3. Restart all services.

Timestamp from SQL Database gets converted to Local Time

The issue does not occur if using Operations Hub to store DateTime data into the SQL database. Because 

Operations Hub expects DateTime data to be in UTC and reads as UTC from the SQL database. The issue 

occurs only in the following conditions:

• If using a third party application to store DateTime data into the SQL database, wherein DateTime 

data is in local timezone, and

• DateTime data is read in Operations Hub via relational database query, wherein Operations Hub 

expects DateTime to be in UTC.

Workaround: Follow these steps to access and modify the stored procedure in your database:

1. Launch SQL Server Management Studio.

2. Log in to the SQL Server.

3. Navigate to your application database to access the stored procedures.

4. Right-click the DateTime stored procedure and select Modify.

For the DateTime column, enter at time zone  in select statement and provide the local timezone of 

the machine where Operations Hub is installed. Example:

SELECT [DateTime] at time zone "Eastern Standard Time" from [dbo].[DateTime]

Missing Plug-in Properties after Upgrade

After upgrading Operations Hub, some of the plug-ins are missing properties. Clearing the cache and 

performing a hard reload using the Inspect tool in a web browser can help resolve issues with web pages 

not loading correctly or displaying outdated content. Do the following to clear the cache and perform a 

hard reload:
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1. Right-click anywhere on the page and select Inspect. This action enables the browser's refresh icon 

to display more options.

2. Right-click the refresh icon and select Empty Cache and Hard Reload.

In case you want to use a third party tool to clear the cache, then reload the browser after clearing the 

cache.

Error Codes

The following table outlines the error codes returned to Operations Hub from OPC UA and the Data 

Distributor. These codes are returned for OPC UA and Historian out-of-the-box (OOTB) queries as integers, 

and can be useful in troubleshooting.

Note:

• Make sure your Operations Hub logged in user matches with the user configured in the 

CIMPLICITY project or iFIX node.

• For inline writes to an iFIX or CIMPLICITY mimic with direct tag bindings, make sure that 

your data source matches with that of the CIMPLICITY project or iFIX node name.

Code Integer String Description

0x80010000 2147549184 BadUnexpectedError An unexpected error occurred.

0x80020000 2147614720 BadInternalError An internal error occurred as a result 

of a programming or configuration 

error.

0x80030000 2147680256 BadOutOfMemory Not enough memory to complete the 

operation.

0x80040000 2147745792 BadResourceUnavailable An operating system resource is not 

available.

0x80050000 2147811328 BadCommunicationError A low level communication error oc

curred.

0x80060000 2147876864 BadEncodingError Encoding halted because of invalid 

data in the objects being serialized.
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Code Integer String Description

0x80070000 2147942400 BadDecodingError Decoding halted because of invalid 

data in the stream.

0x80080000 2148007936 BadEncodingLimitsExceeded The message encoding/decoding 

limits imposed by the stack have 

been exceeded.

0x80B80000 2159542272 BadRequestTooLarge The request message size exceeds 

limits set by the server.

0x80B90000 2159607808 BadResponseTooLarge The response message size exceeds 

limits set by the client.

0x80090000 2148073472 BadUnknownResponse An unrecognized response was re

ceived from the server.

0x800A0000 2148139008 BadTimeout The operation timed out.

0x800B0000 2148204544 BadServiceUnsupported The server does not support the re

quested service.

0x800C0000 2148270080 BadShutdown The operation was cancelled be

cause the application is shutting 

down.

0x800D0000 2148335616 BadServerNotConnected The operation could not complete 

because the client is not connected 

to the server.

0x800E0000 2148401152 BadServerHalted The server has stopped and cannot 

process any requests.

0x800F0000 2148466688 BadNothingToDo There was nothing to do because 

the client passed a list of operations 

with no elements.

0x80100000 2148532224 BadTooManyOperations The request could not be processed 

because it specified too many oper

ations.

0x80DB0000 2161836032 BadTooManyMonitoredItems The request could not be processed 

because there are too many moni

tored items in the subscription.
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Code Integer String Description

0x80110000 2148597760 BadDataTypeIdUnknown The extension object cannot be 

(de)serialized because the data type 

id is not recognized.

0x80120000 2148663296 BadCertificateInvalid The certificate provided as a para

meter is not valid.

0x80130000 2148728832 BadSecurityChecksFailed An error occurred verifying security.

0x81140000 2165571584 BadCertificatePolicyCheck

Failed

The certificate does not meet the re

quirements of the security policy.

0x80140000 2148794368 BadCertificateTimeInvalid The certificate has expired or is not 

yet valid.

0x80150000 2148859904 BadCertificateIssuerTimeInvalid An issuer certificate has expired or 

is not yet valid.

0x80160000 2148925440 BadCertificateHostNameInvalid The HostName used to connect to a 

server does not match a HostName 

in the certificate.

0x80170000 2148990976 BadCertificateUriInvalid The URI specified in the Application

Description does not match the URI 

in the certificate.

0x80180000 2149056512 BadCertificateUseNotAllowed The certificate may not be used for 

the requested operation.

0x80190000 2149122048 BadCertificateIssuerUseNotAl

lowed

The issuer certificate may not be 

used for the requested operation.

0x801A0000 2149187584 BadCertificateUntrusted The certificate is not trusted.

0x801B0000 2149253120 BadCertificateRevocationUn

known

It was not possible to determine if 

the certificate has been revoked.

0x801C0000 2149318656 BadCertificateIssuerRevocation

Unknown

It was not possible to determine if 

the issuer certificate has been re

voked.

0x801D0000 2149384192 BadCertificateRevoked The certificate has been revoked.
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Code Integer String Description

0x801E0000 2149449728 BadCertificateIssuerRevoked The issuer certificate has been re

voked.

0x810D0000 2165112832 BadCertificateChainIncomplete The certificate chain is incomplete.

0x801F0000 2149515264 BadUserAccessDenied User does not have permission to 

perform the requested operation.

0x80200000 2149580800 BadIdentityTokenInvalid The user identity token is not valid.

0x80210000 2149646336 BadIdentityTokenRejected The user identity token is valid but 

the server has rejected it.

0x80220000 2149711872 BadSecureChannelIdInvalid The specified secure channel is no 

longer valid.

0x80230000 2149777408 BadInvalidTimestamp The timestamp is outside the range 

allowed by the server.

0x80240000 2149842944 BadNonceInvalid The nonce does appear to be not a 

random value or it is not the correct 

length.

0x80250000 2149908480 BadSessionIdInvalid The session id is not valid.

0x80260000 2149974016 BadSessionClosed The session was closed by the 

client.

0x80270000 2150039552 BadSessionNotActivated The session cannot be used be

cause ActivateSession has not been 

called.

0x80280000 2150105088 BadSubscriptionIdInvalid The subscription id is not valid.

0x802A0000 2150236160 BadRequestHeaderInvalid The header for the request is miss

ing or invalid.

0x802B0000 2150301696 BadTimestampsToReturnInvalid The timestamps to return parameter 

is invalid.

0x802C0000 2150367232 BadRequestCancelledByClient The request was cancelled by the 

client.

0x80E50000 2162491392 BadTooManyArguments Too many arguments were provided.
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Code Integer String Description

0x810E0000 2165178368 BadLicenseExpired The server requires a license to op

erate in general or to perform a ser

vice or operation, but existing li

cense is expired.

0x810F0000 2165243904 BadLicenseLimitsExceeded The server has limits on number of 

allowed operations / objects, based 

on installed licenses, and these lim

its where exceeded.

0x81100000 2165309440 BadLicenseNotAvailable The server does not have a license 

which is required to operate in gen

eral or to perform a service or opera

tion.

0x002D0000 2949120 GoodSubscriptionTransferred The subscription was transferred to 

another session.

0x002E0000 3014656 GoodCompletesAsynchronously The processing will complete asyn

chronously.

0x002F0000 3080192 GoodOverload Sampling has slowed down due to 

resource limitations.

0x00300000 3145728 GoodClamped The value written was accepted but 

was clamped.

0x80310000 2150694912 BadNoCommunication Communication with the data 

source is defined, but not estab

lished, and there is no last known 

value available.

0x80320000 2150760448 BadWaitingForInitialData Waiting for the server to obtain val

ues from the underlying data source.

0x80330000 2150825984 BadNodeIdInvalid The syntax of the node id is not 

valid.

0x80340000 2150891520 BadNodeIdUnknown The node id refers to a node that 

does not exist in the server address 

space.
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Code Integer String Description

0x80350000 2150957056 BadAttributeIdInvalid The attribute is not supported for the 

specified Node.

0x80360000 2151022592 BadIndexRangeInvalid The syntax of the index range para

meter is invalid.

0x80370000 2151088128 BadIndexRangeNoData No data exists within the range of in

dexes specified.

0x80380000 2151153664 BadDataEncodingInvalid The data encoding is invalid.

0x80390000 2151219200 BadDataEncodingUnsupported The server does not support the re

quested data encoding for the node.

0x803A0000 2151284736 BadNotReadable The access level does not allow 

reading or subscribing to the Node.

0x803B0000 2151350272 BadNotWritable The access level does not allow writ

ing to the Node.

0x803C0000 2151415808 BadOutOfRange The value was out of range.

0x803D0000 2151481344 BadNotSupported The requested operation is not sup

ported.

0x803E0000 2151546880 BadNotFound A requested item was not found or a 

search operation ended without suc

cess.

0x803F0000 2151612416 BadObjectDeleted The object cannot be used because 

it has been deleted.

0x80400000 2151677952 BadNotImplemented Requested operation is not imple

mented.

0x80410000 2151743488 BadMonitoringModeInvalid The monitoring mode is invalid.

0x80420000 2151809024 BadMonitoredItemIdInvalid The monitoring item id does not re

fer to a valid monitored item.

0x80430000 2151874560 BadMonitoredItemFilterInvalid The monitored item filter parameter 

is not valid.

0x80440000 2151940096 BadMonitoredItemFilterUnsup

ported

The server does not support the re

quested monitored item filter.
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Code Integer String Description

0x80450000 2152005632 BadFilterNotAllowed A monitoring filter cannot be used in 

combination with the attribute spec

ified.

0x80460000 2152071168 BadStructureMissing A mandatory structured parameter 

was missing or null.

0x80470000 2152136704 BadEventFilterInvalid The event filter is not valid.

0x80480000 2152202240 BadContentFilterInvalid The content filter is not valid.

0x80C10000 2160132096 BadFilterOperatorInvalid An unrecognized operator was pro

vided in a filter.

0x80C20000 2160197632 BadFilterOperatorUnsupported A valid operator was provided, but 

the server does not provide support 

for this filter operator.

0x80C30000 2160263168 BadFilterOperandCountMis

match

The number of operands provided 

for the filter operator was less then 

expected for the operand provided.

0x80490000 2152267776 BadFilterOperandInvalid The operand used in a content filter 

is not valid.

0x80C40000 2160328704 BadFilterElementInvalid The referenced element is not a 

valid element in the content filter.

0x80C50000 2160394240 BadFilterLiteralInvalid The referenced literal is not a valid 

value.

0x804A0000 2152333312 BadContinuationPointInvalid The continuation point provide is 

longer valid.

0x804B0000 2152398848 BadNoContinuationPoints The operation could not be 

processed because all continuation 

points have been allocated.

0x804C0000 2152464384 BadReferenceTypeIdInvalid The reference type id does not refer 

to a valid reference type node.

0x804D0000 2152529920 BadBrowseDirectionInvalid The browse direction is not valid.

0x804E0000 2152595456 BadNodeNotInView The node is not part of the view.



Operations Hub for Windows  | 3 - User Guide  | 700

Code Integer String Description

0x81120000 2165440512 BadNumericOverflow The number was not accepted be

cause of a numeric overflow.

0x804F0000 2152660992 BadServerUriInvalid The ServerUri is not a valid URI.

0x80500000 2152726528 BadServerNameMissing No ServerName was specified.

0x80510000 2152792064 BadDiscoveryUrlMissing No DiscoveryUrl was specified.

0x80520000 2152857600 BadSempahoreFileMissing The semaphore file specified by the 

client is not valid.

0x80530000 2152923136 BadRequestTypeInvalid The security token request type is 

not valid.

0x80540000 2152988672 BadSecurityModeRejected The security mode does not meet 

the requirements set by the server.

0x80550000 2153054208 BadSecurityPolicyRejected The security policy does not meet 

the requirements set by the server.

0x80560000 2153119744 BadTooManySessions The server has reached its maxi

mum number of sessions.

0x80570000 2153185280 BadUserSignatureInvalid The user token signature is missing 

or invalid.

0x80580000 2153250816 BadApplicationSignatureInvalid The signature generated with the 

client certificate is missing or in

valid.

0x80590000 2153316352 BadNoValidCertificates The client did not provide at least 

one software certificate that is valid 

and meets the profile requirements 

for the server.

0x80C60000 2160459776 BadIdentityChangeNotSupport

ed

The server does not support chang

ing the user identity assigned to the 

session.

0x805A0000 2153381888 BadRequestCancelledByRe

quest

The request was cancelled by the 

client with the Cancel service.
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Code Integer String Description

0x805B0000 2153447424 BadParentNodeIdInvalid The parent node id does not to refer 

to a valid node.

0x805C0000 2153512960 BadReferenceNotAllowed The reference could not be created 

because it violates constraints im

posed by the data model.

0x805D0000 2153578496 BadNodeIdRejected The requested node id was reject be

cause it was either invalid or server 

does not allow node ids to be speci

fied by the client.

0x805E0000 2153644032 BadNodeIdExists The requested node id is already 

used by another node.

0x805F0000 2153709568 BadNodeClassInvalid The node class is not valid.

0x80600000 2153775104 BadBrowseNameInvalid The browse name is invalid.

0x80610000 2153840640 BadBrowseNameDuplicated The browse name is not unique 

among nodes that share the same 

relationship with the parent.

0x80620000 2153906176 BadNodeAttributesInvalid The node attributes are not valid for 

the node class.

0x80630000 2153971712 BadTypeDefinitionInvalid The type definition node id does not 

reference an appropriate type node.

0x80640000 2154037248 BadSourceNodeIdInvalid The source node id does not refer

ence a valid node.

0x80650000 2154102784 BadTargetNodeIdInvalid The target node id does not refer

ence a valid node.

0x80660000 2154168320 BadDuplicateReferenceNotAl

lowed

The reference type between the 

nodes is already defined.

0x80670000 2154233856 BadInvalidSelfReference The server does not allow this type 

of self reference on this node.

0x80680000 2154299392 BadReferenceLocalOnly The reference type is not valid for a 

reference to a remote server.
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Code Integer String Description

0x80690000 2154364928 BadNoDeleteRights The server will not allow the node to 

be deleted.

0x40BC0000 1086062592 UncertainReferenceNotDeleted The server was not able to delete all 

target references.

0x806A0000 2154430464 BadServerIndexInvalid The server index is not valid.

0x806B0000 2154496000 BadViewIdUnknown The view id does not refer to a valid 

view node.

0x80C90000 2160656384 BadViewTimestampInvalid The view timestamp is not available 

or not supported.

0x80CA0000 2160721920 BadViewParameterMismatch The view parameters are not consis

tent with each other.

0x80CB0000 2160787456 BadViewVersionInvalid The view version is not available or 

not supported.

0x40C00000 1086324736 UncertainNotAllNodesAvailable The list of references may not be 

complete because the underlying 

system is not available.

0x00BA0000 12189696 GoodResultsMayBeIncomplete The server should have followed a 

reference to a node in a remote serv

er but did not. The result set may be 

incomplete.

0x80C80000 2160590848 BadNotTypeDefinition The provided Nodeid was not a type 

definition nodeid.

0x406C0000 1080819712 UncertainReferenceOutOfServer One of the references to follow in 

the relative path references to a 

node in the address space in anoth

er server.

0x806D0000 2154627072 BadTooManyMatches The requested operation has too 

many matches to return.

0x806E0000 2154692608 BadQueryTooComplex The requested operation requires 

too many resources in the server.
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Code Integer String Description

0x806F0000 2154758144 BadNoMatch The requested operation has no 

match to return.

0x80700000 2154823680 BadMaxAgeInvalid The max age parameter is invalid.

0x80E60000 2162556928 BadSecurityModeInsufficient The operation is not permitted over 

the current secure channel.

0x80710000 2154889216 BadHistoryOperationInvalid The history details parameter is not 

valid.

0x80720000 2154954752 BadHistoryOperationUnsupport

ed

The server does not support the re

quested operation.

0x80BD0000 2159869952 BadInvalidTimestampArgument The defined timestamp to return 

was invalid.

0x80730000 2155020288 BadWriteNotSupported The server does not support writing 

the combination of value, status and 

timestamps provided.

0x80740000 2155085824 BadTypeMismatch The value supplied for the attribute 

is not of the same type as the at

tribute's value.

0x80750000 2155151360 BadMethodInvalid The method id does not refer to a 

method for the specified object.

0x80760000 2155216896 BadArgumentsMissing The client did not specify all of the 

input arguments for the method.

0x81110000 2165374976 BadNotExecutable The executable attribute does not al

low the execution of the method.

0x80770000 2155282432 BadTooManySubscriptions The server has reached its maxi

mum number of subscriptions.

0x80780000 2155347968 BadTooManyPublishRequests The server has reached the maxi

mum number of queued publish re

quests.

0x80790000 2155413504 BadNoSubscription There is no subscription available 

for this session.
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Code Integer String Description

0x807A0000 2155479040 BadSequenceNumberUnknown The sequence number is unknown to 

the server.

0x807B0000 2155544576 BadMessageNotAvailable The requested notification message 

is no longer available.

0x807C0000 2155610112 BadInsufficientClientProfile The client of the current session 

does not support one or more Pro

files that are necessary for the sub

scription.

0x80BF0000 2160001024 BadStateNotActive The sub-state machine is not cur

rently active.

0x81150000 2165637120 BadAlreadyExists An equivalent rule already exists.

0x807D0000 2155675648 BadTcpServerTooBusy The server cannot process the re

quest because it is too busy.

0x807E0000 2155741184 BadTcpMessageTypeInvalid The type of the message specified in 

the header invalid.

0x807F0000 2155806720 BadTcpSecureChannelUnknown The SecureChannelId and/or Token

Id are not currently in use.

0x80800000 2155872256 BadTcpMessageTooLarge The size of the message specified in 

the header is too large.

0x80810000 2155937792 BadTcpNotEnoughResources There are not enough resources to 

process the request.

0x80820000 2156003328 BadTcpInternalError An internal error occurred.

0x80830000 2156068864 BadTcpEndpointUrlInvalid The server does not recognize the 

QueryString specified.

0x80840000 2156134400 BadRequestInterrupted The request could not be sent be

cause of a network interruption.

0x80850000 2156199936 BadRequestTimeout Timeout occurred while processing 

the request.

0x80860000 2156265472 BadSecureChannelClosed The secure channel has been 

closed.
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Code Integer String Description

0x80870000 2156331008 BadSecureChannelTokenUn

known

The token has expired or is not rec

ognized.

0x80880000 2156396544 BadSequenceNumberInvalid The sequence number is not valid.

0x80BE0000 2159935488 BadProtocolVersionUnsupport

ed

The applications do not have com

patible protocol versions.

0x80890000 2156462080 BadConfigurationError There is a problem with the configu

ration that affects the usefulness of 

the value.

0x808A0000 2156527616 BadNotConnected The variable should receive its value 

from another variable, but has never 

been configured to do so.

0x808B0000 2156593152 BadDeviceFailure There has been a failure in the de

vice/data source that generates the 

value that has affected the value.

0x808C0000 2156658688 BadSensorFailure There has been a failure in the sen

sor from which the value is derived 

by the device/data source.

0x808D0000 2156724224 BadOutOfService The source of the data is not opera

tional.

0x808E0000 2156789760 BadDeadbandFilterInvalid The deadband filter is not valid.

0x408F0000 1083113472 UncertainNoCommunication

LastUsableValue

Communication to the data source 

has failed. The variable value is the 

last value that had a good quality.

0x40900000 1083179008 UncertainLastUsableValue Whatever was updating this value 

has stopped doing so.

0x40910000 1083244544 UncertainSubstituteValue The value is an operational value 

that was manually overwritten.

0x40920000 1083310080 UncertainInitialValue The value is an initial value for a vari

able that normally receives its value 

from another variable.
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Code Integer String Description

0x40930000 1083375616 UncertainSensorNotAccurate The value is at one of the sensor lim

its.

0x40940000 1083441152 UncertainEngineeringUnitsEx

ceeded

The value is outside of the range of 

values defined for this parameter.

0x40950000 1083506688 UncertainSubNormal The value is derived from multiple 

sources and has less than the re

quired number of Good sources.

0x00960000 9830400 GoodLocalOverride The value has been overridden.

0x80970000 2157379584 BadRefreshInProgress This Condition refresh failed, a Con

dition refresh operation is already in 

progress.

0x80980000 2157445120 BadConditionAlreadyDisabled This condition has already been dis

abled.

0x80CC0000 2160852992 BadConditionAlreadyEnabled This condition has already been en

abled.

0x80990000 2157510656 BadConditionDisabled Property not available, this condition 

is disabled.

0x809A0000 2157576192 BadEventIdUnknown The specified event id is not recog

nized.

0x80BB0000 2159738880 BadEventNotAcknowledgeable The event cannot be acknowledged.

0x80CD0000 2160918528 BadDialogNotActive The dialog condition is not active.

0x80CE0000 2160984064 BadDialogResponseInvalid The response is not valid for the dia

log.

0x80CF0000 2161049600 BadConditionBranchAlready

Acked

The condition branch has already 

been acknowledged.

0x80D00000 2161115136 BadConditionBranchAlready

Confirmed

The condition branch has already 

been confirmed.

0x80D10000 2161180672 BadConditionAlreadyShelved The condition has already been 

shelved.
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Code Integer String Description

0x80D20000 2161246208 BadConditionNotShelved The condition is not currently 

shelved.

0x80D30000 2161311744 BadShelvingTimeOutOfRange The shelving time not within an ac

ceptable range.

0x809B0000 2157641728 BadNoData No data exists for the requested 

time range or event filter.

0x80D70000 2161573888 BadBoundNotFound No data found to provide upper or 

lower bound value.

0x80D80000 2161639424 BadBoundNotSupported The server cannot retrieve a bound 

for the variable.

0x809D0000 2157772800 BadDataLost Data is missing due to collection 

started/stopped/lost.

0x809E0000 2157838336 BadDataUnavailable Expected data is unavailable for the 

requested time range due to an un-

mounted volume, an off-line archive 

or tape, or similar reason for tempo

rary unavailability.

0x809F0000 2157903872 BadEntryExists The data or event was not success

fully inserted because a matching 

entry exists.

0x80A00000 2157969408 BadNoEntryExists The data or event was not success

fully updated because no matching 

entry exists.

0x80A10000 2158034944 BadTimestampNotSupported The client requested history using a 

timestamp format the server does 

not support (i.e requested Server

Timestamp when server only sup

ports SourceTimestamp).

0x00A20000 10616832 GoodEntryInserted The data or event was successfully 

inserted into the historical database.
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Code Integer String Description

0x00A30000 10682368 GoodEntryReplaced The data or event field was success

fully replaced in the historical data

base.

0x40A40000 1084489728 UncertainDataSubNormal The value is derived from multiple 

values and has less than the re

quired number of Good values.

0x00A50000 10813440 GoodNoData No data exists for the requested 

time range or event filter.

0x00A60000 10878976 GoodMoreData The data or event field was success

fully replaced in the historical data

base.

0x80D40000 2161377280 BadAggregateListMismatch The requested number of Aggre

gates does not match the requested 

number of NodeIds.

0x80D50000 2161442816 BadAggregateNotSupported The requested Aggregate is not sup

port by the server.

0x80D60000 2161508352 BadAggregateInvalidInputs The aggregate value could not be 

derived due to invalid data inputs.

0x80DA0000 2161770496 BadAggregateConfigurationRe

jected

The aggregate configuration is not 

valid for specified node.

0x00D90000 14221312 GoodDataIgnored The request specifies fields which 

are not valid for the EventType or 

cannot be saved by the historian.

0x80E40000 2162425856 BadRequestNotAllowed The request was rejected by the 

server because it did not meet the 

criteria set by the server.

0x81130000 2165506048 BadRequestNotComplete The request has not been processed 

by the server yet.

0x00DC0000 14417920 GoodEdited The value does not come from the 

real source and has been edited by 

the server.
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Code Integer String Description

0x00DD0000 14483456 GoodPostActionFailed There was an error in execution of 

these post-actions.

0x40DE0000 1088290816 UncertainDominantValue

Changed

The related EngineeringUnit has 

been changed but the Variable Val

ue is still provided based on the pre

vious unit.

0x00E00000 14680064 GoodDependentValueChanged A dependent value has been 

changed but the change has not 

been applied to the device.

0x80E10000 2162229248 BadDominantValueChanged The related EngineeringUnit has 

been changed but this change has 

not been applied to the device. The 

Variable Value is still dependent on 

the previous unit but its status is 

currently Bad.

0x40E20000 1088552960 UncertainDependentValue

Changed

A dependent value has been 

changed but the change has not 

been applied to the device. The qual

ity of the dominant variable is uncer

tain.

0x80E30000 2162360320 BadDependentValueChanged A dependent value has been 

changed but the change has not 

been applied to the device. The qual

ity of the dominant variable is Bad.

0x00A70000 10944512 GoodCommunicationEvent The communication layer has raised 

an event.

0x00A80000 11010048 GoodShutdownEvent The system is shutting down.

0x00A90000 11075584 GoodCallAgain The operation is not finished and 

needs to be called again.

0x00AA0000 11141120 GoodNonCriticalTimeout A non-critical timeout occurred.

0x80AB0000 2158690304 BadInvalidArgument One or more arguments are invalid.
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Code Integer String Description

0x80AC0000 2158755840 BadConnectionRejected Could not establish a network con

nection to remote server.

0x80AD0000 2158821376 BadDisconnect The server has disconnected from 

the client.

0x80AE0000 2158886912 BadConnectionClosed The network connection has been 

closed.

0x80AF0000 2158952448 BadInvalidState The operation cannot be complet

ed because the object is closed, 

uninitialized or in some other invalid 

state.

0x80B00000 2159017984 BadEndOfStream Cannot move beyond end of the 

stream.

0x80B10000 2159083520 BadNoDataAvailable No data is currently available for 

reading from a non-blocking stream.

0x80B20000 2159149056 BadWaitingForResponse The asynchronous operation is wait

ing for a response.

0x80B30000 2159214592 BadOperationAbandoned The asynchronous operation was 

abandoned by the caller.

0x80B40000 2159280128 BadExpectedStreamToBlock The stream did not return all data 

requested (possibly because it is a 

non-blocking stream).

0x80B50000 2159345664 BadWouldBlock Non blocking behaviour is required 

and the operation would block.

0x80B60000 2159411200 BadSyntaxError A value had an invalid syntax.

0x80B70000 2159476736 BadMaxConnectionsReached The operation could not be finished 

because all available connections 

are in use.

Error Messages
A list of connection errors, their cause, and action to be taken.
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These are some of the errors you may encounter when testing a data source connection:

Note:

• Make sure your Operations Hub logged in user matches with the user configured in the 

CIMPLICITY project or iFIX node.

• For inline writes to an iFIX or CIMPLICITY mimic with direct tag bindings, make sure that 

your data source matches with that of the CIMPLICITY project or iFIX node name.

Error Message Description

Test Connection Failed - Server not 

reachable.

Cause:  The hostname or the IP address of the server is incor

rect.

Action:  Enter the correct hostname or the IP address.

Test Connection Failed - Security 

mode or policy not supported.

Cause:  The selected security policy is not supported by the serv

er.

Action:  Select a security policy supported by the server.

Test Connection Failed - Authentica

tion Failed.

Cause:  The user name or password to login to the sever is incor

rect.

Action:  Enter the correct user name or password.

Test Connection Failed - Server not 

trusted.

Cause:  The server certificate is not trusted by the Operations 

Hub client.

Action:  To trust, access the untrusted server certificate, then se

lect Trust. The server certificate gets copied to the Operations 

Hub trusted folder.

Test Connection Failed - Server 

doesn't trust this client.

Cause:  Operations Hub client certificate is not trusted by the 

server.

Action:  Log in to the server, and add the Operations Hub client 

certificate to their trusted list.

Test Connection Failed - Certificate 

Uri is Invalid.

Cause:  If upgrading from Operations Hub 2.0 to 2.1, you need to 

revert the changes made to the ServerConfig.xml  file.
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Error Message Description

Action:  Follow these steps:

1. Go to C:\Program Files\GE\Operations hub\BrowseSer

vice.

2. Open ServerConfig.xml  and search for:

<ServerUri>urn:<machine name in capital 

 letters>:proficy:webhmi:dataservices</ServerUri>

Replace <machine name in capital letters>  with [Node

Name].

3. Save and close the XML file.

4. Go to Operations Hub trusted store C:\ProgramData\GE

\Operations Hub\pki\trusted\certs  and delete the exist

ing certificate.

5. Visit your data sources and trust them all over again to 

reissue the certificate.

Test Connection Failed - Connection 

limit on OPC UA server exceeded.

Cause:  You have exceeded the license limitation of clients on 

this server.

Action:  Get a license issued for this client.

Test Connection Failed to connect the 

opcua endpoint.

Cause:  The endpoint url could be incorrect.

Action:  Enter the correct endpoint URL in this format: opc.tcp://

hostname:port.

Test Connection Failed - Fields are 

not filled properly.

Cause:  The information to establish a connection is either miss

ing, or invalid.

Action:  Enter the correct information.

Configure Logs to Troubleshoot Licensing Issue
With Operations Hub licensing enforcement, you may be asked to purchase a license even when you have 

a valid license activated on your license client.

In the event of a licensing issue, follow these steps to enable logging and reveal potential problems before 

contacting GE Support.
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1. Open the logback.xml  file located here:

<Directory where Operations Hub is installed>\iqp-tomcat\webapps\<site/app/eventengine>\WEB-INF

\classes\logback.xml

2. Find the following line of code and change "ERROR"  to "DEBUG".

<Logger name="com.iqp" level="ERROR">

3. Save and close the logback.xml  file.

4. Replicate the licensing error to log messages in the app.log/site.log  or eventengine.log  file 

located here:

C:\ProgramData\OphubLogs\iqp-tomcat

5. Look for log entries similar to the following:

"2021-3-2 13:24:11  - Project65.isLicenseVersionValid() : lc_license_ophub = 20

2021-03-02 14:37:41,720 [pool-6-thread-1] DEBUG com.iqp.common.utils.other.lc - 

 LicenseClient.getLicenseValue(): isLicenseDateValid() = 1 isLicenseVersionValid() = 1 isLicenseVersionValid() 

 = 4"

Tip:

Look for keywords such as Project65, LicenseClient, and LicenseService to investigate 

licensing related issues.

6. Provide the log file details to the Support team.

Configuration of Logging for Services

You can find log configuration for every service at the following location.

• WebHMI Services: <Directory where Operations Hub is installed>\webhmi-tomcat\webapps

\<Service>\WEB-INF\classes\logback.xml

• IQP Apps: <<Directory where Operations Hub is installed>\iqp-tomcat\webapps\<site/app/

eventengine>\WEB-INF\classes\ logback.xml

Important Configurations

MaxHistory: https://logback.qos.ch/manual/appenders.html#tbrpMaxHistory. For more information, refer 

to https://logback.qos.ch/manual/appenders.html#SizeAndTimeBasedRollingPolicy.

https://logback.qos.ch/manual/appenders.html#tbrpMaxHistory
https://logback.qos.ch/manual/appenders.html#SizeAndTimeBasedRollingPolicy
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To configure package level logging or any changes on the logging configuration that do not require restart 

of the tomcat container.

(http://logback.qos.ch/manual/configuration.html#autoScan  scan=true) which detects runtime changes 

on log level without need to restart the service. But currently it is kept disabled, as it has runtime impact.

You can configure package level logger highlighted as below:

https://logback.qos.ch/manual/configuration.html#loggerElement

http://logback.qos.ch/manual/configuration.html#autoScan
https://logback.qos.ch/manual/configuration.html#loggerElement
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UAA Services

<Directory where Operations Hub is installed>\uaa-tomcat\webapps\uaa\WEB-INF\classes\log4j2.properties

Modify Registry for TLS 1.2
This topic describes how to modify the registry setting on the Operations Hub server to allow for TLS 1.2.

The following steps serve as a workaround to troubleshoot these issues:

• Resolving Proficy Authentication Issue During Workflow Task Client Install  (on page 690)

• Resolving External Proficy Authentication Issue During Operations Hub Install  (on page 691)

• Workflow Task Client is unable to connect to the Proficy Server  (on page 691)
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1. Access the following registry paths and modify the DWORD  value name SchUseStrongCrypto  with the 

value data as 1.

◦ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\.NETFramework\v4.0.30319

◦ HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Microsoft\.NETFramework\v4.0.30319

2. If the registry value does not exist, then create a new one with the same value name and value 

data.

Note:

For more information, refer to Microsoft suggested actions.

Scalable Vector Graphic (SVG) Editor Tools
Scalable Vector Graphic (SVG) is a vector image file type. The SVG images are scalable, that is, you can 

modify the shapes, lines, curves, and so on or, resize the SVG images without affecting the image quality.

You can edit the SVG vector graphics by importing the SVG images to editor tools such as Figma, 

PowerPoint, Adobe Illustrator, and others. The SVG images can be rendered over the supporting web 

browsers such as Google Chrome, Mozilla Firefox, and Apple Safari. When compared to the common 

image types (JPEG, PNG) the SVG format images can be exported to other editor tools without affecting 

the image quality. You can customize the SVG images as per the design specific needs and animate the 

images for interactive sessions. As the SVG vector format images are based on XML code language, you 

can edit the elements such as <svg>, <rect>, <circle>, and <path>. These elements can be modified using 

the CSS or JavaScript thus provides the flexibility to create vector images and publish the SVG images 

over the web.

Troubleshooting SVG Issues

When you import the SVG images into Operations Hub SVG Editor tool, if the import is not successful 

due to the additional features provided by the third-party SVG editing tool that are incompatible, you 

can troubleshoot these issues using the SVG file XML coding. When you try to import the SVG files into 

Operation Hub, you may notice some transformation issues in your SVG file. To rectify, you can apply the 

following steps to troubleshoot the issues while you import SVG files using the SVG editing tools such as: 

Figma, PowerPoint, and Adobe Illustrator.

Working with SVG Editor Tools
Figma

You can choose to import the SVG files from your computer to Figma tool using the File menu import 

option or, you can drag and drop the SVG file into the canvas and edit the SVG files as desired. As the 

https://docs.microsoft.com/en-us/security-updates/securityadvisories/2015/2960358#suggested-actions
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SVG files are vector format files you can edit individual elements, resize, adjust the properties using the 

Figma tools and different layers. You can also add new elements to the SVG file and design the shapes, 

lines, and edit the text, as required. The advantage of using working on Figma tool using SVGs is that 

you can easily collaborate with other members working on the same SVG file, share the files, and provide 

comments on specific elements in the file.

After you save the changes, when you try to export the SVG file, you can choose to:

• Save the file format to SVG (that is <file name>.SVG).

• Set the file size using scale factor (you will not lose the clarity or resolution using scale factor).

• Export the specific section of the file or, entire Figma file.

• Set the background color or, image to the exported SVG file (if required).

• Use custom fonts (if you want the text to be editable and animated).

To make the use of custom fonts, you must export the texts in SVG file as glyphs. A glyph is a graphical 

representation of a letter or, a symbol that represents as a character in a specific format. In Figma, you 

can convert the text to outlines and can be edited as a shape, and thus when you export text layer as an 

SVG file, the Figma converts each letter or symbol in the text and is indicated as glyph.

Note:

1. If you want the text to be editable and animated in Operations Hub, ensure not to select the 

Outline  text in the settings.

2. To browse and search for a specific element in SVG image, ensure to select Include ID 

attribute  in the settings.

3. Save the above settings to persist the Figma settings.

For Figma help guide, refer to https://help.figma.com/hc/en-us/articles/360040028114-Guide-to-exports-

in-Figma  for more information.

PowerPoint

The PowerPoint tool is not used to create complex HMI graphics, however you have the access to SVG 

editor in Operations Hub that have same capabilities as that of PowerPoint to edit simple SVG graphics. 

You can export SVG images into PowerPoint to project SVG images in the PowerPoint presentation mode. 

Following examples illustrate the troubleshooting steps for various issues you may come across in the 

SVG files.

Sample SVG:  PowerPoint SVG Export

https://help.figma.com/hc/en-us/articles/360040028114-Guide-to-exports-in-Figma
https://help.figma.com/hc/en-us/articles/360040028114-Guide-to-exports-in-Figma
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<svg width="1741" height="903"

    xmlns="http://www.w3.org/2000/svg"

    xmlns:xlink="http://www.w3.org/1999/xlink" xml:space="preserve" overflow="hidden">

    <defs>

        <clipPath id="clip0">

            <rect x="268" y="277" width="1741" height="903"/>

        </clipPath>

    </defs>

    <g clip-path="url(#clip0)" transform="translate(-268 -277)">

        <text font-family="Arial,Arial_MSFontService,sans-serif" font-weight="400" font-size="83" transform="matrix(1 0 

 0 1 317.751 383)">Left Aligned Text

            <tspan font-size="83" x="967.083" y="334">Right Aligned Text</tspan>

            <tspan font-size="83" x="456.248" y="728">Center Aligned Text</tspan>

        </text>

    </g>

</svg>

Tspan

When you save the Power Point slide as an SVG file, the text elements in the saved SVG image or the slide 

will be exported as SVG text elements. And if the SVG text elements contains nested tspan elements 

then the same tspan elements will be exported into SVG file. When you try to import the PowerPoint SVG 

image to the SVG editor in the Operations Hub, the SVG editor tool do not support the tspan elements, but 

the SVG editor tool will convert each tspan elements into text elements. Thus, using the SVG editor tool 

in Operation Hub for an imported PowerPoint SVG image, you can format and animate each text element. 

Following is the example of tspan element transformation into text element.

Transformed SVG

<svg width="1741" height="903"

    xmlns="http://www.w3.org/2000/svg"

    xmlns:svg="http://www.w3.org/2000/svg" xml:space="preserve">

    <defs>

        <clipPath id="clip0">

            <rect height="903" id="svg_1" width="1741" x="268" y="277"/>

        </clipPath>

    </defs>

    <g class="layer">

        <title>Layer 1</title>
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        <g clip-path="url(#clip0)" id="svg_2" transform="translate(-268 -277)">

            <text font-family="Arial,Arial_MSFontService,sans-serif" font-size="83" font-weight="400" id="svg_3_0" 

 transform="matrix(1 0 0 1 317.751 383)" x="0" y="0">Left Aligned Text</text>

            <text font-family="Arial,Arial_MSFontService,sans-serif" font-size="83" font-weight="400" id="svg_3_1" 

 transform="matrix(1 0 0 1 317.751 383)" x="967.08" y="334">Right Aligned Text</text>

            <text font-family="Arial,Arial_MSFontService,sans-serif" font-size="83" font-weight="400" id="svg_3_2" 

 transform="matrix(1 0 0 1 317.751 383)" x="456.25" y="728">Center Aligned Text</text>

        </g>

    </g>

</svg>

Alignment

When you import the SVG PowerPoint slide into SVG editor tool of Operations Hub, you can notice that 

the SVG text elements settings are not imported, because the SVG text elements have different attributes 

and values that do not align with the PowerPoint text alignments. To troubleshoot this issue, you must 

manually select the alignment options in the SVG editor tool settings. Following is the example with text 

alignment applied.

Transformed SVG with Text Alignment

<svg width="1741" height="903"

    xmlns="http://www.w3.org/2000/svg"

    xmlns:svg="http://www.w3.org/2000/svg" xml:space="preserve">

    <defs>

        <clipPath id="clip0">

            <rect height="903" id="svg_1" width="1741" x="0" y="0"/>

        </clipPath>

    </defs>

    <g class="layer">

        <title>Layer 1</title>

        <g clip-path="url(#clip0)" id="svg_2">

            <text font-family="Arial,Arial_MSFontService,sans-serif" font-size="83" font-weight="400" id="svg_3_0" 

 text-anchor="start" transform="matrix(1 0 0 1 0 0) matrix(1 0 0 1 317.751 383)" x="-268" y="-277">Left Aligned 

 Text</text>

            <text font-family="Arial,Arial_MSFontService,sans-serif" font-size="83" font-weight="400" id="svg_3_1" 

 text-anchor="end" transform="matrix(1 0 0 1 0 0) matrix(1 0 0 1 317.751 383)" x="699.08" y="57">Right Aligned 

 Text</text>

            <text font-family="Arial,Arial_MSFontService,sans-serif" font-size="83" font-weight="400" id="svg_3_2" 

 text-anchor="middle" transform="matrix(1 0 0 1 317.751 383)" x="188.25" y="451">Center Aligned Text</text>
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        </g>

    </g>

</svg>

Unique IDs

When you try to import multiple SVG files from PowerPoint to SVG Editor tool in Operations Hub, you will 

notice that the SVG elements with the same IDs from SVG files may overlap and thus create the problem 

while styling or scripting the SVGs. As a reason, you will not be able to transfer the SVGs between 

PowerPoint and SVG editor. Also, the animation and other graphic settings will be lost. You will also notice 

the items defined in the definition section such as clip path in the above example should be manually 

renamed such that each element will possess unique name (Example: element number 1, element 

number 2, and so on). If the SVG elements do not have unique IDs, the elements in the SVG graphic may 

not be generated accurately, that is, anything outside the clip path will be invisible or certain area will be 

clipped off from the view in the page builder and in end app. To troubleshoot this issue, you must rename 

the SVG element IDs with unique IDs, following is the example to rename the IDs.

Transformed SVG with Unique IDs

<svg width="1741" height="903"

    xmlns="http://www.w3.org/2000/svg"

    xmlns:svg="http://www.w3.org/2000/svg" xml:space="preserve">

    <defs>

        <clipPath id="clip0_graphic1234">

            <rect height="903" id="svg_1" width="1741" x="0" y="0"/>

        </clipPath>

    </defs>

    <g class="layer">

        <title>Layer 1</title>

        <g clip-path="url(# clip0_graphic1234)" id="svg_2">

            <text font-family="Arial,Arial_MSFontService,sans-serif" font-size="83" font-weight="400" id="svg_3_0" 

 text-anchor="start" transform="matrix(1 0 0 1 0 0) matrix(1 0 0 1 317.751 383)" x="-268" y="-277">Left Aligned 

 Text</text>

            <text font-family="Arial,Arial_MSFontService,sans-serif" font-size="83" font-weight="400" id="svg_3_1" 

 text-anchor="end" transform="matrix(1 0 0 1 0 0) matrix(1 0 0 1 317.751 383)" x="699.08" y="57">Right Aligned 

 Text</text>

            <text font-family="Arial,Arial_MSFontService,sans-serif" font-size="83" font-weight="400" id="svg_3_2" 

 text-anchor="middle" transform="matrix(1 0 0 1 317.751 383)" x="188.25" y="451">Center Aligned Text</text>

        </g>

    </g>
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</svg>

Adobe Illustrator

Overriding Classes

When you create SVG graphics using Adobe Illustrator and when you try to import the SVG graphics to 

SVG editor tool in Operations Hub, the animations may not work correctly. This is because the Adobe 

Illustrator uses classes to apply styles and SVG editor tool uses attributes, the classes applied by the 

illustrator override the attributes in SVG code when imported. As a result, the animations will not work 

correctly or, do not appear when viewed in a browser. To troubleshoot this issue, you must edit the SVG 

code to manually remove the conflicting classes and apply the styles using the attributes as indicated in 

the following example.

Illustrator SVG Export

<?xml version="1.0" encoding="UTF-8"?>

<svg id="Layer_1" data-name="Layer 1"

    xmlns="http://www.w3.org/2000/svg" viewBox="0 0 253.76 402.25">

    <defs>

        <style>

      .cls-1 {

        fill: #a7a9ac;

      }

 

      .cls-2 {

        fill: #6d6e71;

      }

 

      .cls-3 {

        fill: #808285;

      }

    </style>

    </defs>

    <g id="Mixer">

        <rect class="cls-1" y="187.12" width="253.76" height="97.85"/>

        <polyline class="cls-1" points="0 295.04 85.88 369.23 167.01 369.23 253.27 295.04"/>

        <path class="cls-1" d="M0,178.12c21.51-10.5,63.49-27.5,118.96-27.96,60.69-.5,113.17,16.93,134.8,27.96"/>

        <rect class="cls-1" x="101.61" y="376.45" width="50.54" height="25.81"/>

    </g>

    <g id="Motor">
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        <rect class="cls-2" x="118.82" y="94.65" width="11.56" height="54.83"/>

        <g>

            <g>

                <rect class="cls-3" x="100.54" y="83.36" width="48.39" height="11.29"/>

                <path class="cls-3" d="M98.85,13.03c1.25-1.59,10.05-12.4,25.27-13,16.82-.67,26.94,11.71,27.96,13"/>

                <rect class="cls-3" x="163.44" y="19.38" width="5.38" height="63.98"/>

                <rect class="cls-3" x="154.84" y="26.37" width="11.29" height="50.54"/>

                <rect class="cls-3" x="94.62" y="19.38" width="60.22" height="63.98"/>

            </g>

            <g>

                <rect class="cls-1" x="101.75" y="24.99" width="5.99" height="52.69"/>

                <rect class="cls-1" x="111.42" y="24.99" width="7.3" height="52.69"/>

                <rect class="cls-1" x="122.72" y="24.99" width="5.99" height="52.69"/>

                <rect class="cls-1" x="132.04" y="24.99" width="5.99" height="52.69"/>

                <rect class="cls-1" x="142.03" y="24.99" width="5.99" height="52.69"/>

            </g>

        </g>

    </g>

</svg>

Transformed SVG

<svg width="253.76" height="402.25"

    xmlns="http://www.w3.org/2000/svg"

    xmlns:svg="http://www.w3.org/2000/svg" data-name="Layer 1">

    <g class="layer">

        <title>Layer 1</title>

        <g id="Mixer">

            <rect fill="#a7a9ac" height="97.85" id="svg_1" width="253.76" y="187.12"/>

            <polyline fill="#a7a9ac" id="svg_2" points="0 295.04 85.88 369.23 167.01 369.23 253.27 295.04"/>

            <path d="m0,178.12c21.51,-10.5 63.49,-27.5 118.96,-27.96c60.69,-0.5 113.17,16.93 134.8,27.96" 

 fill="#a7a9ac" id="svg_3"/>

            <rect fill="#a7a9ac" height="25.81" id="svg_4" width="50.54" x="101.61" y="376.45"/>

        </g>

        <g id="Motor">

            <rect fill="#6d6e71" height="54.83" id="svg_5" width="11.56" x="118.82" y="94.65"/>

            <g id="svg_6">

                <g id="svg_7">
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                    <rect fill="#808285" height="11.29" id="svg_8" width="48.39" x="100.54" y="83.36"/>

                    <path d="m98.85,13.03c1.25,-1.59 10.05,-12.4 25.27,-13c16.82,-0.67 26.94,11.71 27.96,13" 

 fill="#808285" id="svg_9"/>

                    <rect fill="#808285" height="63.98" id="svg_10" width="5.38" x="163.44" y="19.38"/>

                    <rect fill="#808285" height="50.54" id="svg_11" width="11.29" x="154.84" y="26.37"/>

                    <rect fill="#808285" height="63.98" id="svg_12" width="60.22" x="94.62" y="19.38"/>

                </g>

                <g id="svg_13">

                    <rect fill="#a7a9ac" height="52.69" id="svg_14" width="5.99" x="101.75" y="24.99"/>

                    <rect fill="#a7a9ac" height="52.69" id="svg_15" width="7.3" x="111.42" y="24.99"/>

                    <rect fill="#a7a9ac" height="52.69" id="svg_16" width="5.99" x="122.72" y="24.99"/>

                    <rect fill="#a7a9ac" height="52.69" id="svg_17" width="5.99" x="132.04" y="24.99"/>

                    <rect fill="#a7a9ac" height="52.69" id="svg_18" width="5.99" x="142.03" y="24.99"/>

                </g>

            </g>

        </g>

    </g>

</svg>

iFIX

iFIX supports exporting SVG files, and you can import the SVG files into SVG Editor tool in Operations 

Hub. When you import an iFIX generated SVG file into the Operations Hub SVG Editor tool, some of the 

elements from iFIX will not be supported (scripts, animations, data binding) or, not translated in SVG 

editor tool within Operations Hub.

Issue with iFIX Tool tips

When you import the iFIX SVG file into the SVG editor tool in Operations Hub, you may notice text 

distortion issues due to tool tip elements in iFIX SVG file may not be compatible or supported in SVG 

editor tool within Operations Hub. To troubleshoot this issue, you must manually remove the tool tip 

elements from the original text in the SVG file.

Remove tool tips from SVG

<tooltipOption>TooltipDescription</tooltipOption>

Issue with Referenced Images

When you import the iFIX SVG file into the SVG editor tool in Operations Hub, you may notice that the 

referenced images in the SVG file may not display correctly or appear with broken icon image. This is 
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because the referenced image file path is not accessible, or the image file path is not relative to the 

location of the SVG file. To troubleshoot this issue, you must import each SVG image separately using the 

SVG editor toolbar.
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